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Safety information

Important information

Read these instructions carefully and look at the equipment to become familiar with
the device before trying to install, operate, service or maintain it. The following spe-
cial messages may appear throughout this bulletin or on the equipment to warn of
potential hazards or to call attention to information that clarifies or simplifies a pro-
cedure.

The addition of either symbol to a "Danger" or "Warning" safety label indicates
that an electrical hazard exists which will result in personal injury if the instruc-
tions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal injury
hazards. Obey all safety messages that follow this symbol to avoid possible
injury or death.

DANGER
DANGER indicates an imminently hazardous situation which, if not avoided,will result in death or
serious injury.

WARNING
WARNING indicates a potentially hazardous situation which, if not avoided, could result in death
or serious injury.

CAUTION
CAUTION indicates a potentially hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury. The safety alert symbol shall not be
used with this signal word.

Please note

Electrical equipment should be installed, operated, serviced and maintained only by qualified personnel.
No responsibility is assumed by Schneider Electric for any consequences arising out of the use of this
material.

A qualified person is one who has skills and knowledge related to the construction, installation, and oper-
ation of electrical equipment and has received safety training to recognize and avoid the hazards involved.



Safety precautions
During installation or use of this software, pay attention to all safety messages
that occur in the software and that are included in the documentation. The
following safety messages apply to this software in its entirety.

WARNING
UNINTENDED EQUIPMENT OPERATION

• Do not use the software for critical control or protection applications where human or equipment
safety relies on the operation of the control action.

• Do not use the software to control time-critical functions because communication delays can occur
between the time a control is initiated and when that action is applied.

• Do not use the software to control remote equipment without securing it with an authorized access
level, and without including a status object to provide feedback about the status of the control oper-
ation.

Failure to follow these instructions can result in death or serious injury.

WARNING

INACCURATE DATA RESULTS

• Do not incorrectly configure the software, as this can lead to inaccurate reports and/or data results.
• Do not base your maintenance or service actions solely on messages and information displayed by

the software.
• Do not rely solely on software messages and reports to determine if the system is functioning cor-

rectly or meeting all applicable standards and requirements.
• Consider the implications of unanticipated transmission delays or failures of communications links.

Failure to follow these instructions can result in death, serious injury, equipment damage, or per-
manent loss of data.

WARNING

POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND CONFIDENTIALITY

• Change default passwords to help prevent unauthorized access to device settings and information.
• Disable unused ports/services and default accounts to help minimize pathways for malicious attack-

ers.
• Place networked devices behind multiple layers of cyber defenses (such as firewalls, network seg-

mentation, and network intrusion detection and protection).
• Use cyber security best practices (for example: least privilege, separation of duties) to help prevent

unauthorized exposure, loss, or modification of data and logs, or interruption of services.

Failure to follow these instructions can result in death, serious injury, and equipment damage.
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Introduction
Welcome to the help file for PowerSCADA Expert, v8.2. To navigate through the file,
you can use the search options on the left. Additionally, you can access other related
PowerSCADA Expert help files.

In this section, you will find these topics:

PowerSCADA Expert—A Complete Solution on page 16
Assumptions on page 16
What is SCADA? on page 16
What is PowerSCADA Expert? on page 17

Prepare for PowerSCADA Expert on page 17
Components of a Project on page 17

Configuration Tools on page 17
Runtime Environment on page 18

Supported Device Types and Protocols on page 18
System Requirements and Installation Instructions on page 25
Uninstall and Reinstall PowerSCADA Expert on page 25
IEC 61850 System Setup Workflow on page 25
Get More Information on page 26

Manuals on page 26
Help files on page 26
Customer support on page 26

PowerSCADA Expert—A Complete Solution
The PowerSCADA Expert system provides a complete solution for the monitoring and
control of any electrical distribution network. Using PowerSCADA Expert 8.2 with
Advanced Reporting and Dashboards as the engine, this product includes additional
tools that users will use to acquire data from various devices, and then to apply the
data for HMI viewing, alarming, trending, and reporting.

In this section, you will find these topics:

Assumptions on page 16
What is SCADA? on page 16
What is PowerSCADA Expert? on page 17

Assumptions
The person who installs the product will have received training in the entire
PowerSCADA Expert product and will understand the application’s basic functions.

What is SCADA?
SCADA (Supervisory Control and Data Acquisition) is a system that collects data from
various points, both local and remote, and then stores the data at a central location.
The system also can control equipment at an installation.
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What is PowerSCADA Expert?
This product includes several tools that use the PowerSCADA Expert engine to collect
information from all PowerLogic devices:
• In the Profile Editor, you create, configure, and modify profiles for device types that

use the same tags (for example, to set up alarms and trends).
• In the I/O Device Manager, you add and modify devices in the PowerSCADA Expert

system.
• In the One-Line Configuration utility, you can review genie configurations, and then

make necessary repairs before you compile your project.
• In the Graphics Builder (design time mode), you create one-line drawings, into

which you can incorporate objects (genies). Genies are versatile objects that
include variables or other expressions that are specified when you view the
drawing.

• In the Graphics Builder (runtime mode), users can view the final one-line drawings,
including alarms, events, and history data. With the appropriate degree of
password-controlled authority, users can also perform advanced tasks, such as
changing alarm setpoints and racking devices in and out.

Prepare for PowerSCADA Expert
For a full discussion about preparation for a project, see Plan a Project in the
CitectSCADA.chm help file (Program Files > Schneider Electric > PowerSCADA Expert
> v8.2 > bin). This section of the help discusses physical layout, requirements such as
architecture and security, and project design.

Components of a Project
For detailed information about the components that make up a project, see
Components of a project in the citectSCADA.chm help file (Program Files>
Schneider Electric > PowerSCADA Expert > v8.2 > bin). The project components
include graphic components, tags, alarms, system components, communications
components, I/O Server components and Cicode/CitectVBA.

Configuration Tools
Configuration tools consist of:

Profile Editor: Use this tool to select tags to be used by device types (tags must be
consistent with IEC 61850 naming conventions), create device profiles for individual
devices, and create projects that include the device profiles to be used in a single
installation. You can specify real-time tags, PC-based alarm tags, onboard alarm tags,
trend tags, and reset tags to be generated for this device.

I/O Device Manager: Using this tool, you will import device profile information from the
Profile Editor into a project. This tool is simply a means of moving device profile
information into the project and converting it into formats that PowerSCADA Expert can
use.

PowerSCADA Studio: Use the Studio for basic navigation. From here, you also
choose the active project. Use it also for entering database-type information, such as
adding clusters and servers, creating new users, and editing tags within projects.

Graphics Builder, Design-Time environment: Use the Graphics Builder to create one-
line drawings that users can view in the runtime environment. These drawings are
populated with interactive objects that are generated by genies. You can also use the
graphics tool to set up system alarms and trends.
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Runtime Environment
The runtime environment is where the end user views system information. This
environment includes (from the information added in the design-time page) one-line
pages with interactive objects, alarm and event pages, and analysis pages (trends and
waveforms).

Supported Device Types and Protocols
When you install the product, you are prompted to choose the drivers that you will use.
A certain number of generic drivers are installed by default (including PowerLogic
device types), and you are not prompted for them. Device types and protocols
supported in PowerSCADA Expert are:
• Generic MODBUS (includes BCPM and any device, such as a PLC or UPS, that

communicates via MODBUS). When adding a controllable device in the Profile
Editor, such as a circuit breaker, use the “Controllable Device” driver; otherwise,
use the “Generic Power Device” driver. For JBus devices, select Generic JBus
Device.

• Sepam 20, 40, and 80 Range, 2000
• Masterpact MicroLogic 5P and 6P, A, H
• Compact NSX (MicrologicV)
• Micrologic MTZ (MicrologicX)
• CM2000
• CM4000 series
• PM650
• PM800 series
• PM5000 series
• PM700 series
• ION protocol devices
• IEC 61850 protocol devices
• IEC 870-5-104
• DNP3
• BCPMA (branch circuit power meter, full feature support)
• CSI SER (Cyber Sciences SER)
• ProTime 100 SER (Monaghan Engineering)

How Do Drivers Work?
The following paragraphs describe driver subscriptions. For each unique tag request
made, the I/O server adds one point to the point count. Tag subscriptions are limited
based on the point count in the license. Exceeding the subscribed point count will
ultimately cause the I/O server to shut down.

Two Subscription Types
There are two different types, one used between the graphics level and I/O server, and
one for polling devices and cache refreshing. The subscription between drivers and
polling devices does not increase point count. Only the subscription that begins at a
client system and ends up in the I/O server will increase point count. Via this
subscription, requests are sent to the drivers with value changes propagating all the
way back to the client system. The client system could be the display client, alarm
server, trend server and so on. What a driver then chooses to do with the requests—in
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terms of coupling this to a physical request to a field device—can differ, depending on
the protocol. Some simple protocols propagate the request straight through to the field
device; others have their own polling scheme to the field device and merely service the
driver requests from a cache.

Subscription Expirations
If a tag is no longer being read, the cache refreshes in this manner: Graphics client
subscriptions are immediately unsubscribed when the graphics page is closed.
Although most drivers release subscriptions if no client is requesting them, the
IOServer is capable of background polling (configurable on a per-device basis). These
tag subscriptions are not released, and the driver still polls them. However, they are not
counted anywhere, because nothing is consuming the data for those tags on the
IOServer. On the other hand, once a subscription goes against the point count, it
remains in the count as long as the project is running.

Expiration is immediate if no clients are subscribed to the tag. An "expiration time-out
value" is not configurable.

Edit Driver Parameters
Certain IEC 61850 devices may have driver parameters associated with them. You can
edit the datasets and report control blocks that will then be exported to PowerSCADA
Expert.

To begin editing driver parameters: from the Create Device Profiles tab, click the
Parameters sub-tab.

To begin editing datasets, click Edit in the DataSets line. Follow instructions in Edit IEC
61850 Datasets on page 62 for help.

To begin editing report control blocks, click Edit in the Report Control Blocks line.
Follow instructions in Edit IEC 61850 Report Control Blocks on page 63 for help.

Problems with Duplicate Devices using PowerLogic Drivers
If you have duplicate devices that use PowerLogic drivers, you will have system
problems. The PowerLogic drivers that are affected are:
• Generic Power Device
• MicroLogic
• MicroLogic A
• CM4000
• PM800
• SEPAM20
• SEPAM40
• SEPAM80

A duplicate device is created when two or more I/O devices in a system communicate
with a single physical device. For this to be true, the I/O devices would have the same
IPaddress, same TCP port, and same MODBUS device address.

System performance would be affected, and there would be problems with onboard
alarms. More seriously, it could result in a system crash.

Add a Project Using the Project Setup Tool
There are two methods for adding a project:
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You can use the PowerSCADA Studio, (see The Design Time Environment ), which is
a more manual process. Use PowerSCADA Studio to ensure that you have covered
everything, and for further modification of your project.

Or, you use this tool to rapidly deploy a project. Using Project Setup, you can do the
following:
• create and name a project
• select screen resolution and determine whether you will use normal or high

contrast
• specify primary and secondary server connections
• specify the Advanced Reports and Dashboards connection
• add users and Windows authentication
• add devices
• add default pages to your project
• add menus to display pages in runtime
• choose the landing page for each monitor in a multi-monitor project

If you are using optional components (see below), you need to install them separately.

After you create the project and its features, you can edit other settings, such as
devices in the CSV file, and use it to update your project.

You save time when you use Project Setup, as you are able to change a variety of
parameters. When you do not use Project Setup, you then must navigate to a variety of
locations to change or set up these parameters. For a list of parameters that you can
set in Project Setup, see:

Parameters Changed In Project Setup on page 106

For help on any of the Project Setup pages, you can:
• click "?" to the left of the top line to view the entire PowerSCADA Expert help file
• hover your mouse over fields to read tooltips

To launch Project Setup, launch the PowerSCADA Studio. From the Projects tab, click
Add > Create and Configure Project. You see the Introduction page.
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This page lists optional components that you may want to install. The install files are on
the root of the PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards
installation media.
• PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards. Use this

component to view advanced reports and dashboards from Power Monitoring
Expert. Install this component from the PowerSCADA Expert installation media.

• Extract Transform Load (ETL) module. Use this component to extract reporting
information from PowerSCADA Expert and transfer it to Power Monitoring Expert,
for use in reports).

• Event Notification Module (ENM). Use ENM to set up email and text messaging for
project alarms.

Click Next to display the System Definition screen.

System Definition

On this screen, you determine whether you are creating a new project or editing an
existing one, and the "view" of the project.

1. Click either Create New or Edit Existing.
2. If you click Create New, type a project name. If you click Edit Existing, choose a

project from the list that displays. Use only alphanumeric characters and
underscores.

3. In the Resolution box, choose the screen resolution that you want for the graphics
pages in this project. This should match the resolution of the monitor that will
display graphics pages.

4. In the Style box, choose whether you want Standard or High Contrast. Standard
uses a white background. High contrast uses a black background, which makes it
easier to view graphics pages.

5. Click Next to display the Servers page.

NOTE: After you click Next, the project is created. You cannot change or delete it
here. To make changes or to delete it, you must use the PowerSCADA Studio.

You can also set high contrast via the parameters in the PowerSCADA Studio.
Open your project in the PowerSCADA Studio, then click Settings > Parameters.
The parameter name is IsHighContrast. 0 = normal; 1 = high contrast.
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Servers

Use this screen to define the server information for your primary server and the server
for Advanced Reports and Dashboards.

The Project Setup detects the number of servers that are in your starter project. If you
only have one server (for example, using the loopback IP address), you see all of the
fields in the screen above. If you are using a project that has two or more servers
identified, you only see the bottom section, Advanced Reports and Dashboards.
1. Server Name or IP Address: Type the Server Name or IP Address for the project's

primary server, or select it from the drop-down list.
2. Redundant System: If this is a redundant system, check Redundant System.

Checking this box enables the Standby Server Name or IP Address prompt.
3. Standby Server Address: Type the Server Name or IP Address of the standby

server, or select it from the drop-down list.
4. Advanced Reports and Dashboards: If you have installed the Advanced Reports

and Dashboards component (WebReach is also assumed to be on this server),
check this box, which will enable the Advanced Reports prompts.

5. Advanced Reports Server Name or IP Address: Type the Server Name or IP
Address of the Advanced Reports server, or select it from the drop-down list.

6. User Name/Password/Confirm Password: These fields are only enabled after you
check Advanced Reports and Dashboards. Type the user name and password
used for the Advanced Reports and Dashboards server. (Note that you must enter a
user name and password if you check the Advanced Reports and Dashboards
box.)

Retype the password in the Confirm Password field.
7. Click Next to view the Users screen.

When You Set Up More than two I/O Servers per Cluster
If you need to add more than two I/O servers to a cluster, you need to define a
redundant I/O device called NetworkTagsDev for each of the servers. If you do not do
this, you can lose device status information during runtime.
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If the cluster includes only one or two I/O servers, the I/O devices are automatically
added when you add the cluster during I/O Device Manager configuration (see Add the
Cluster, Network Address, and Servers). If a system has more than two I/O servers in a
cluster, you must manually add the NetworkTagsDev I/O device for the remaining
servers (after the first pair).

To create the board, port, and NetworkTagsDev I/O device, ensure the following:
• all redundant NetworkTagsDev I/O devices have the same number
• the Startup Mode field is set to Standby; do this for all standby NetworkTagsDev I/O

devices, including the one created by the I/O Device Manager
• the Equipment field is set to <Cluster>_NetworkTagsDev

The field values for the forms in each of the I/O servers should be:

Boards Form
Board Name: <any unique name> (suggestion: BOARDy_SVRz)
Board Type: DISKXML
Address: 0
Leave everything else blank.

Ports Form
Port Name: <any unique name> (example: Px_BOARDx_PRJz)
Port Number: <any unique number within the I/O server> (suggestion: x)
Board Name: <use the board name defined above>
Leave everything else blank.

I/O Devices Form
Name: NetworkTagsDev
Number: <same number as the one defined in the corresponding device>
Address: NetworkTagsDev
Protocol: DISKXML
Port Name: <use the port name defined above>
Startup Mode: Standby
Equipment: <Cluster> _NetworkTagsDev
Leave everything else blank.

Notes:
• Startup Mode is only visible when in extended form mode (press F2 to toggle

between simple form mode and extended form mode, while in the I/O device form).
• The Equipment field is hidden by default. To change it to visible, open units.dbf (in

the project folder) in Excel.
• If the system has one or two I/O servers per cluster, the startup mode of the standby

NetworkTagsDev I/O device could be set to StandbyWrite in the I/O Device
Manager. If the system has more than two I/O servers per cluster, the startup mode
of all standby NetworkTagsDev I/O devices must be set to Standby.

One side effect of this is that, when the system switches to a redundant I/O server,
affected devices will momentarily lose communication as the system transitions to
the redundant server.

• If the primary and redundant alarms servers are synchronizing, data will be slow to
display in the Alarm Log and Events Log.
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Port Names
The I/O Device Manager does not take into account that multiple projects might be
'linked together' via a global include project. For instance, it does not allow you to
specify a unique port name and port number, such that they will not conflict with other
projects.

There are three possibilities:
• Protocols that support port name changes: includes Generic TCP and MODBUS

TCP
• Protocols that support re-use of ports only: see the table below for protocols and

settings that need to match
• Protocols that do not support port name changes: all protocols not mentioned

above

The table below shows the settings that must match between the protocols for that
column. For example, if you combine two generic serial protocols or a generic serial
with a DNP3 via serial, all of the checked items need to match between them.

Generic Serial,
DNP3 via Serial

MODBUS RTU
via Serial

DNP3 via TCP/IP,
IEC 60870-5-104
via TCP/IP,
MODBUS RTU via
Gateway

Board Type X X X

I/O Server Name X X X

Port Number X X

Baud Rate X X

Data Bits X X

Stop Bits X X

Parity X X

IP Address X

Network Port Number X

All attached I/O devices must use the
same protocol.

X X

Using the Port Settings page in the wizard, you can name ports. See Define One I/O
Device in a Project on page 118 for more information.

Enter Copy for Translation
There are several “description” or “comment” fields throughout this tool. These fields
can be used to create copy for translation purposes. If you type a Comment in this
format:

@(XXX), where XXX = the copy that is to be translated,

the copy you typed in the comment field is added to the default language, named
English.DBF. After the project is compiled, this file is located in Documents and
Settings\All Users\Application Data\Schneider Electric\PowerSCADA Expert 8.2 with
Advanced Reporting and Dashboards\User\[your project]. English.dbf contains terms
that will be translated from English.

To create another language file for translation, set the Citect.ini parameter [Language]
LocalLanguage to the specified language, then re-compile. So, for example, if you set
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this parameter to French, a French.dbf file is created in the project folder when you
compile. You can then enter the translated text in the LOCAL field of the file. Repeat
this same step for each additional language file you want in this project.

After translation, there will be an additional .dbf file for each translated language. At
runtime, the user will be able to choose the .dbf file that is to be used in the display,
thus changing the language used in the display.

System Requirements and Installation Instructions
See the Vijeo Citect Installation and Configuration Guide for a complete discussion of
system requirements and installation instructions. A PDF copy is on the installation
disk.

Uninstall and Reinstall PowerSCADA Expert
Use Add/Remove Programs in the Control Panel to uninstall these programs:
• PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards (if you

uninstall this, you also uninstall the Profile Editor)
• PowerSCADA Expert Profile Editor
• Any additional PowerSCADA Expert programs, such as the WebServer, that you

installed

If you uninstall programs after you have already created projects, the project data will
not be deleted. It is in [Project Drive]\Documents and Settings\ All Users\Application
Data\Schneider Electric\PowerSCADA Expert 8.2 with Advanced Reporting and
Dashboards. The first time you launch the application after you re-install it, it will locate
the project data and re-link it.

IEC 61850 System Setup Workflow
These are the basic steps you need to follow to set up an IEC 61850 device in your
project.

1. List all of the SCL files (ICD, CID) for the IEC 61850 devices in your installation. ICD
files are preferred. Pay special attention to data concentrated devices (for example,
the G3200 with multiple devices communicating through it; see G3200 Device
Setup on page 67).

2. Import the first ICD file into the Profile Editor (see Import Filter Screen on page 77).

a. Create the device type.
b. Match or verify tags for PowerSCADA Expert.
c. Complete the import.

3. Create a device profile for the IEC 61850 device type (see Add an IEC 61850
Device to a Project on page 125).

a. If needed, add/edit datasets and report control blocks (see Edit IEC 61850
Datasets on page 62 and Edit IEC 61850 Report Control Blocks on page 63).

b. Select the appropriate tags for PowerSCADA Expert to monitor for this device.
4. Repeat steps 2 and 3 for additional ICD files.
5. Create a Profile Editor project, adding the device profiles. Configure as needed.
6. Export to PowerSCADA Expert, and to SCL.

— PowerSCADA Expert creates the equipment.profiles file for the I/O Device
Manager.
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— SCL will create an IID file for the profile. If newly added datasets and/or report
control blocks are to be used, this IID file is required for step 7. Otherwise, you
can use the original ICD file.

7. Use the appropriate IEC 61850 configuration tool for the device to configure a CID
file from the ICD/IID file. Then download it to the device.

8. Create the project.

a. From within PowerSCADA Expert, add a new project.
b. Add the appropriate clusters, networks, and servers.

9. Using the I/O Device Manager, add your devices to PowerSCADA Expert.

When you are prompted for the SCL file, use the CID file you created in step 7.

For more information, see Add an IEC 61850 Device to a Project on page 125.
10. Compile and run the project.

Get More Information
For additional information, use one of these options:

Manuals on page 26
Help files on page 26
Customer support on page 26

Manuals
In addition to this System Integrator’s Guide, there are these additional documents that
may provide helpful information:
• Vijeo Citect Installation Guide: a PDF copy is on the installation disk
• Release Notes: located on the installation disk, this file includes information

specific to this release of the product
• Readme file: located on the installation disk, this file also includes late-breaking

information about this release

Help files
In addition to the help file released with this product, there are several related help
files. They are located in the PowerSCADA Expert Bin folder: \Schneider
Electric\PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards\Bin).

Customer support
The following is the contact information for customer support:

Schneider Electric

35, rue Joseph Monier

CS 30323

F - 92506 Rueil Malmaison Cedex

www.schneider-electric.com
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Use the Migration Utility
The migration utility allows you to migrate previous versions of PowerSCADA Expert to
version 7.3. You only need to run this utility one time. This is a single migration that
updates system data. All future upgrades require that you back up your project,
uninstall the old version, install the new version, and restore your database.

The table below describes the changes that will be made.

1. Before you run the migration utility, back up your system.
2. If necessary, restore the project that you want to migrate (use the Restore function

from PowerSCADA Studio > Projects tab > Backup > Restore).
3. Launch the Citect Migration Tool in PowerSCADA Studio: on the Projects page,

click Migration Tool > Citect Migration Tool.
4. From the Citect Migration window, select the options shown below:

5. Click Migrate.

When the migration is complete, an information window displays information about
what was converted or upgraded, and where the resulting log file is stored.

6. Launch the PowerSCADA Migration Utility: from the Projects tab > click Migration
Tool > PowerSCADA Expert Migration Tool.

7. From the Master.dbf Location drop down list, choose the location for the Master.dbf.
8. From the Select Project drop down list, choose the project that you are migrating.
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9. In the bottom section. check the boxes for the elements you want to update in the
runtime database (see table below for descriptions).

NOTE: The items with asterisks will be updated in the Equipment.profiles file at
every migration. When you check an item with an asterisk, it will also update the
Profile so that future information added to it will be in sync with the current version.
So, for example, if you run the migration and check "Update Variable Tag Names,"
future variable tags will be correctly formatted for the current version.

10. Click Migrate.
11. Verify that you have backed up the project, then click Yes.
12. If there is already a PageMenu.dbf file that is creating a menu for your graphics

pages, you see a message telling you that the PageMenu.dbf is not empty. Click
Yes to override this file, which overwrites the menu, leaving it blank. Click No to
retain the menu for version 7.4.

Element Description Changes

v7.30 and earlier:

Update Digital Tag
Format

This option will update all DIGITAL
tags in Variable.dbf to FORMAT "##."

This causes digital tags in PowerSCADAExpert
to display without decimals ("1" or "0," but not
"1.000."

Update Alarm and
Variable Tag
Names

Previously, some device-specific
tags were renamed to fit a generic
naming convention for version 7.40.

This option renames all existing tags
to the new convention names.

Check this box to rename all new convention
names. For example, the old "Sepam Not Reset"
is now "Generic Not Reset."

v7.20 and earlier:

Populate Tag
Prefix-Equip.dbf

Equipment Name, which was used to
build tag names, is now the
equipment hierarchy name (can no
longer be used to build tag names)

TagPrefix field added. It is now used to build tags.

If the TagPrefix field is empty, IODevice name is
used to populate Tag Prefix. If IODevice name is
also empty (in a composite device),
EquipmentName is used IF there are no periods
in the name.

Populate
Composite Field -
Equip.dbf

The Parent field (previously used to
determine the parent piece of
equipment) has been removed from
the .dbf file.

The Composite field replaces the Parent field.
The Composite field will display the Parent field
information, if applicable.

Fix Metadata
ID Compiler
Warnings

The Cicode function StrToLocal no
longer allows partially translated text.
For example, in@(Protection),2,
"Protection" must be translated.

Also, "2" is themetadata ID; in all
custom fields (1-8) of all alarm tags,
the ID part of the field must be
removed.

All custom fields in alarm tags will remove the ID
part (1-8) of the field, IF the translation identifier is
present. Thus, in@(Protection), 2 the "2" is
removed; it will be changed to@(Protection).

When migration is complete, a summary screen lists the results of the
migration, including updates and errors. The following is an example:
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13. Pack the databases and compile the project (from the Projects tab, click Pack. To

compile, click on the System menu, on the left.
14. After you install version 7.3, you need to:

a. Back up the project.
b. Uninstall (if you are using the same computer to reinstall).
c. Install the new version.
d. Add the One-Line device (seeOne-Line Device (zOL) on page 136).
e. Run the Advanced One Line tool (seeWork in the Configuration Utility on page

143).
15. If you are going to upgrade to a later version, you need to:

a. Back up your project.
b. Uninstall version 7.3.
c. Install the new version.
d. Restore your project.
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The Profile Editor
This section describes how to use the Profile Editor to create device type tags, and
then to use these tags as building blocks for device types. Secondly, there are
instructions for creating device profiles for unique devices. Finally, there are
instructions for creating projects for each installation or customer.

In this section, you will find these topics:

Overview of the Profile Editor on page 31
Typical Workflow Illustration on page 31

Launch the Profile Editor on page 35
Add Engineering Unit Templates, Units, and Conversions on page 37
Define Device Types and Tags on page 41

Device Type Screens and Workflow on page 41
Print the .CSV File on page 47
Add Custom Tags and Tag Addresses on page 49
Add, Edit, or Delete a Device Type on page 44
Edit Tag Addresses on page 52
Edit Generic Tag Addresses on page 56
Edit Functional Addresses on page 49

Create Device Profiles on page 57
Enable Waveforms on page 57
View Device Profiles on page 57
Add Edit or Delete Device Profile on page 59
Edit IEC 61850 Datasets on page 62
Edit IEC 61850 Report Control Blocks on page 63
IEC 61850 System Setup Workflow on page 25
Create Data Concentrator Device

G3200 Device Setup on page 67
Set Up Projects in the Profile Editor on page 68

Project Screens and Workflow on page 69
The Set Up Projects Tab on page 70
Add, Edit, or Delete a Project on page 70
Create a Composite Device Type

Edit and Delete Information in a Project on page 72
Customize Tag Names on page 72
Import and Export Project Files on page 72
Tag Types on page 83
Customize Tag Names on page 72
IEC 61850 Tag Construction on page 83
Define an Enumeration on page 84
Format Code Definitions on page 85
Logic Codes on page 87
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Overview of the Profile Editor
The Profile Editor is a multiple-screen application that allows you to perform four basic
tasks: create device types, create device profiles, and set up projects.

Use the Define Device Type Tags tab and its screens to add and edit information for
real-time, onboard alarm, control and reset tags and to create and edit device types.
See Define Device Types and Tags on page 41 for complete instructions.

Use the Create Device Profiles tab and its screens to add and edit individual profiles
for specific devices. A device profile is a subset of the possible variable tags, alarm
tags, and trend tags for a particular device type. See Create Device Profiles on page
57 for complete instructions.

Use the Set Up Project tab and its screens to bring together all of the system attributes
for a single customer or installation. For example, the customer installation will include
a certain combination of device profiles (depending on the devices installed at the
site). The project allows a specific unit template to be applied, converting units (such as
watts) into units used by the customer (such as megawatts). This causes tags to display
in the converted format. Projects also allow you to rename tags to suit a customer’s
needs (for example, Current A could be renamed to Current Phase A). See Set Up
Projects in the Profile Editor on page 68 for complete instructions.

This product uses the IEC61850 tag-naming convention to create tags that measure
device quantities. Although most of the tags you will use are already entered into the
system, you can add custom tags. For more information, see Tag Types on page 83.

Typical Workflow Illustration
The following four flow charts illustrate the use of the Profile Editor. The first illustration
provides an overview, and the following illustrations show:
• creating/editing a device type
• creating/editing a device profile
• creating/editing unit templates
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Workflow Overview
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Create/Edit Device Type
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Create/Edit Device Profile
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Create/Edit Unit Templates

Launch the Profile Editor
To launch the Profile Editor, click Start > Programs > Schneider Electric >
PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards > Config Tools >
Profile Editor.

The Profile Editor screen displays with the Define Device Tags tab selected. There are
two other tabs, used to create device type profiles and projects.

Locked and Custom Icons
Two icons may appear to the right of the Add/Edit button on some screens: the locked
icon and the custom icon.

The Locked Icon :

This icon indicates that the selected file (e.g., device type, profile, or project) cannot be
edited. All standard device types (for example, Circuit Monitor 4000, MicroLogic Type
P, Power Meter 800) are automatically locked; they cannot be unlocked.

To lock a device type that you create, follow these steps:
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1. From the Define Device Type Tags screen, click Add/Edit.
2. On the Add/Edit Device Type screen, you can choose Create New, Create From, or

Edit Existing.
3. Enter the new device information, or select the device to be edited.
4. To lock the device, check the box named Lock This Device Type.
5. Click Save & Exit to save the “lock” and exit the screen.

After you lock a device type, you cannot unlock it. However, you can restore it in this
manner: Copy the locked device type (Create From on the Add/Edit Device Type
screen), then save the copy with a new name.

The Custom Icon :

This icon indicates that a device type or profile is user-created. It may have been
created new, created from an existing device type or profile, or created by editing an
unlocked custom device type or profile.

Set the Screen Resolution
Depending on the screen resolution you use, some of the Profile Editor screens may
take up the entire viewing area. We recommend that you use at least 1024 x 768
resolution.

Options are:

Setting Resolution (height x width)

VGA 640 x 480

SVGA 800 x 600

XGA 1024 x 768

SXGA 1280 x 1024

WUXGA 1920 x 1200

User user-defined height and width

You can also auto-hide the taskbar to provide more room.

Profile Editor Main Menu Options
The main menu options (File and Settings) on each of the major tabs of the Profile
Editor are described below.

Field Name/Valid Entries Comments

File >Save Saves any current changes.

File >Create CSV file
Creates .CSV file of basic tag data. Store the file in a folder you designate.
Can be viewed in Excel.

File >Print Tag Selections
Displays a print preview of all of the tags for this device type. You can then
print the spreadsheet.

File > Import

You can import projects from other instances of the Profile Editor. These
must be PLS or ICD files.

To begin importing, click File > Import. For ,more information, see Import
and Export Project Files on page 72.
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Field Name/Valid Entries Comments

File > Export

You can export a PLS or ICD file to be used in another instance of the
Profile Editor, or to be used as a backup.

To begin exporting, click File > Import. For ,more information, see Import
and Export Project Files on page 72

Settings >Display Advanced
Properties

Causes additional “advanced information” columns to display.

Settings > Remove Import
Templates

You can delete any import template that has been added to the project. To
add import templates, seeUsing Import Templates on page 81.

Settings >Set Up Custom Tags
Displays the Add/Edit Custom Tags screen. SeeSet Up Custom Tags on
page 49 for a description of this screen.

Settings >Set Up Device Type
Categories

Displays the Set Up Device Type Categories. SeeSet Up Device Type
Categories on page 47 for a description of this screen.

Settings >Set Up Engineering Unit
Templates

Displays the Set Up Engineering Unit Templates screen. Click Set Up
Engineering Templates and Select Conversions on page 37 for a
description of this screen.

Settings >Set Up Trend
Definitions

Displays the Set Up Trend Definitions screen. Click Set Up Trend Intervals
on page 61 for more information.

Add Engineering Unit Templates, Units, and Conversions
An engineering unit is a part of a tag. Use engineering unit templates to simplify the
conversion between base units and their conversions (such as inches to centimetres)
and to provide consistency in recording data in reports and on-screen viewing. For
example, in one project you might want to see amperes reported as kiloamps. In
another, you might want to see amperes as milliamps. You will use the Units screens to
determine the conversion for standard units and custom units (tied to custom tags) that
you create.

You can also create templates to organize user-created unit/conversion pairs. Each
template will include all of the predefined engineering units and conversions, as well
as the ones you assign to it. These templates can then be used in system projects (see
the Set Up Project tab for creating projects).

In this section, you can learn about:

Set Up Engineering Templates and Select Conversions on page 37
Add or Edit a Base Engineering Unit or Conversion on page 40

Set Up Engineering Templates and Select Conversions
Use the Set Up Engineering Unit Templates screen when you want to add, edit, or
delete an engineering unit template, or to make changes to how the unit is reported.

To view the Set Up Engineering Units screen, click Settings > Set Up Engineering Unit
Templates. The following table describes the parts of the Set Up Engineering Unit
Templates screen (it assumes that Display ‘Advanced’ Fields is checked). When you
have finished making change, click Save & Exit.
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Field
Name Valid Entries Comments

Template
Options box

Create New Click to begin creating a new engineering unit template.

Create From
Click to create an engineering units template that is based on an
existing template.

Edit Existing
Only available if you have added a template.

Click to edit an engineering unit or its conversion.

Delete
Only available if you have added a template.

Click to begin deleting an engineering unit and its conversion. You
cannot delete a locked template.

Unit
Template to
Create From

From the drop-downmenu,
select the template you
wish to copy, in order to
create a new template.

This field is live only whenCreate From is chosen as the option.
The new template will initially include all of the units/conversions of
the original; but you can add units and change the conversion
settings.

Unit
Template
Name

This field is blank if you
selectedCreate New or
Create From; type the
name of the new template.
A name displays if you
have selected a template
to edit; you can change the
name.
A name displays, but it is
greyed out if you selected a
template to delete.
Click Save to save the
changes youmake.

When creating a new template or creating from an existing
template, type the name of the new template.

To change the name of an existing template, choose it from the
Unit Template to Deletemenu, then change the name here.

Lock this
Template

Click to prevent the
template from being edited
in the future.

The only way to “edit” a locked template is to delete it, and add
back a new one with the edits entered.

Display
Associated
Projects

Live only when in “Edit”
mode. Displays all projects
that use this template.

You only need this if you want to delete a template that is
associated with a project. Note the projects that display in the list,
then go to the Set Up Project tab. For each project that you noted,
change the unit template.

Display
‘Advanced’
Fields

Check this box to display
additional columns of
information about the
template.

Unchecked: displays the unit and its abbreviation only. Checked:
displays also the conversion, and its abbreviation andmultiplier.

Default Units Subtab

Use this subtab tomanage unit templates and to add global changes to a unit.

Base Unit n/a
Many standard units are pre-defined; they cannot be edited or
deleted. To add a unit or edit a user-created unit, seeAdd or Edit a
Base Engineering Unit or Conversion on page 40.

Abbreviation n/a
Added for the unit when the selected unit was created. To edit a
user-created unit, seeAdd or Edit a Base Engineering Unit or
Conversion on page 40.

Selected
Unit

Click the down arrow to
display and select the
preferred conversion for
the unit.

Many conversions are pre-defined. To add or edit a conversion
unit, seeAdd or Edit a Base Engineering Unit or Conversion on
page 40.

Fahrenheit to Celsius temperature conversions must be handled
by editing Cicode (Citect.ini).

Abbreviation n/a
This is abbreviation for the selected unit. When the Selected Unit is
changed, this field changes accordingly.
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Field
Name Valid Entries Comments

Multiplier n/a

Added for the unit and for the conversion when the base unit was
created. Pre-defined units/conversions cannot be changed. To edit
a user-created unit, seeAdd or Edit a Base Engineering Unit or
Conversion on page 40.

Offset n/a
Used for units that havemore than one scale. For example, for
temperature, if the base is degree Celsius, and you want to offset
to Fahrenheit, you would type 32 here (and 1.8 in themultiplier).

Add/Edit
Units button

Click to display the
Add/Edit Units screen.

Use that screen to add units/conversions, or to edit user-created
units/conversions.

Unit Exceptions Subtab

Use this tab to apply "exceptions" for individual tags, changing the way the unit is reported for the tag(s). This is
most commonly used for WAGES tags.

Tags
Choose an individual tag or
tag subgroup.

This tag will be reported with the new settings.

Options

1. From the dropdown list,
choose the unit you want to
use for this tag/tag group.

2. Click the radio button for
the exception to bemade.

3. Either double-click the
tag, or click the right arrow
tomove it to the Exception
list.

1. If you choose Apply Unit Conversion, the tag will be reported
according the unit you select. For example, if you want to report Air
Volume in gallons, rather than cubic meters, choose "gallon" from
the Select Unit dropdown list.

2. Click "Apply Unit Conversion" to convert and report the tag
according to the unit you selected. Click "Apply Unit NameOnly" to
add the unit name to it, but not convert it, when it is reported.

Exception
List

Review your changes.

You can check or uncheck tags here, changing them from one
conversion option to the other. When you uncheck a tag, you do
not remove it, you change it from being converted to simply being
reported according the unit you selected.

Apply Conversions
Use this screen to apply unit conversions to a template. To add a new conversion, see
Add or Edit a Base Engineering Unit or Conversion on page 40.

To apply a conversion:

1. From the main window of the Profile Editor, click Settings > Set Up Engineering Unit
Templates.

2. Click Edit Existing, then select the template for which you want to select unit
conversions.

3. In the Selected Unit column, click the down arrow and select the conversion you
want to use. Fahrenheit to Celsius temperature conversions are handled by offsets
(see Add or Edit a Base Engineering Unit or Conversion on page 40).

4. Repeat step 3 for all units that you want to change.
5. Click Save to save the change, or click Save & Exit to save changes and close the

screen.

Delete a Template
You cannot delete either the standard template or a locked template.

To delete a template:
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1. From the Define Device Type Tags tab, click Settings > Set Up Engineering Unit
Templates.

2. Click the Delete radio button, on the left, to delete a template.
3. Choose the template from the drop-down list.
4. Click Delete, on the right, to delete the selected template. At the Confirm Delete

prompt. click Yes.

Add or Edit a Base Engineering Unit or Conversion
Use the Add/Edit Units screen to add, edit, or delete base units and conversion units
for custom tags. You cannot make any changes to predefined units (those that are
greyed out).

Click Settings > Set Up Engineering Unit Templates. At the Set Up Engineering Units
screen, choose the template you want to edit, and click Add/Edit Units. The following
table describes the fields of the Add/Edit Units screen. Instructions for editing and
deleting units are after the table.

Field Name Valid Entries Comments

Unit Conversions

n/a for pre-defined
units/conversions (greyed
out)

Select user-created units to
begin edits.

All base engineering units and their conversions
display. Greyed-out items are predefined; they
cannot be edited or deleted. Note that predefined
units can have custom conversions, which are
editable.

Add Base
Click to begin adding a new
base unit.

The Base Unit and Base Unit Abbreviation fields
become live.

Add Conversion
Click to begin adding a
conversion to a base unit.

The Base Unit field displays the unit you highlighted;
the Conversion Unit, Conversion Abbreviation, and
Multiplier fields become live.

Edit Unit/

Delete Unit

Click to either edit a custom
unit/conversion, or to delete
it.

These buttons are live when you select a custom
unlocked unit.

Base Unit

When editing a
unit/conversion, select the
unit from this drop-down
menu.

When adding a new base
unit, type the name.

Used in the Profile Editor only; not passed to projects
for graphics viewing.

Base Unit Abbreviation
Type the abbreviation for the
selected base unit.

If there is no conversion, this is passed to projects
for viewing graphics.

Conversion Unit

Type the name of the
conversion unit, such as
milliamps, when amps is the
base unit.

Becomes live only when you highlight a unit.

Used in the Profile Editor only; not passed to projects
for graphics viewing.

Conversion Abbreviation
Type the abbreviation for the
conversion unit.

This is passed to projects for viewing graphics.

Multiplier

Use this field to determine
the number of base units
that are in the conversion
unit.

Type themultiplier “M,”
where Conversion Unit x M =
Base Unit.

Example: There are 1,000 bytes in a kilobyte; so, the
conversion unit multiplier is 1000, If you have 17.3
kB,
17.3 x 1,000 =17300 bytes
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Offset
Use this field to determine a
numeric offset.

Example: If degrees Celsius is the base unit, and
you are creating a conversion unit for Fahrenheit,
you would enter amultiplier of 1.8 and an offset of
32.

Edit a Base Engineering Unit or Conversion
Changes are global, for all templates. You cannot change any predefined engineering
units/conversions (greyed out).

To edit a unit or conversion:

1. To edit the unit: With the base unit highlighted, click Edit Unit. You can edit the base
unit and base unit abbreviation. Click OK to save the changes.

2. To edit a conversion: With the conversion highlighted, click Edit Unit. You can edit
the conversion unit, abbreviation, and multiplier. Click Save to save the changes or
click Save & Exit to save the changes and close the screen.

Delete a Base Engineering Unit or Conversion
Deletions are global, for all templates. You cannot delete units any predefined
units/conversions (greyed out).

To delete a unit or conversion:

1. To delete a unit: With the base unit highlighted, click Delete Unit. At the Confirm
Delete prompt, click Yes. Click OK to close the screen.

2. To delete a conversion: With the conversion highlighted, click Delete Unit. At the
Confirm Delete prompt, click Yes. Click Save & Exit to save the changes and close
the screen.

Define Device Types and Tags
The Define Device Type Tags tab and its related screens are used to define device-
related data: custom tags, device types, and base units/conversions. You will use
several screens to add and manage this data.

To access these screens, click the Define Device Type Tags tab on the main Profile
Editor screen.

In this section, you can learn about:

Device Type Screens and Workflow on page 41
Use the Define Device Type Tags Tab on page 42
Add, Edit, or Delete a Device Type on page 44
Print the .CSV File on page 47
Set Up Device Type Categories on page 47
Edit Functional Addresses on page 49

Device Type Screens and Workflow
On the Define Device Type Tags tab, follow these general steps to add tags and
devices to your system:

1. To manage the units and unit conversions that you will use (such as amperes into
milliamperes), see Add or Edit a Base Engineering Unit or Conversion on page 40.

2. To manage the tags you will use, see Define Device Types and Tags on page 41.
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3. To add and edit custom tags, see Add Custom Tags and Tag Addresses on page
49.

4. To add or edit device types, see Add, Edit, or Delete a Device Type on page 44.
5. To establish device type categories and subcategories, used in reporting, see Print

the .CSV File on page 47.
6. To edit tag addresses, see Edit Tag Addresses on page 52.

The PowerSCADA Expert system uses the IEC61850 tag naming convention. For
information about the types of IEC61850 tags and their configuration, see Tag Types
on page 83.

Use the Define Device Type Tags Tab
The Define Device Type Tags tab displays device types and the tags that may be
associated each device type. This includes real-time, onboard alarm, control, and reset
tags. Most of the fields on this tab are read only (they can be changed on other
screens). The following table describes this tab. The tags listed assume that Advanced
Properties has been checked. Not all elements appear on every sub-tab.

Field Name/Valid Entries Comments

Device Type Name/Select the device
type.

Each device type includes a different number of tag categories, which
also changes the list of tags that display.

The device list includes the default device types, as well as any that
have been created for this system.

Add/Edit button/Click to open the
Add/Edit Device Type screen.

Provides ameans of adding new device types and editing custom
device types (user-created device types that are not locked). Also
provides ameans of adding new custom tags and editing existing tags.

Locked/Custom icons: Locked icon indicates that the list of selected tags cannot be edited.
Custom icon indicates that the device type was created by a user. See
Locked and Custom Icons on page 35 for complete information.

Tag groups (left-hand pane)

Select a tag group; the tags included
in that group display on the right.

Each tag belongs to a group. The group is determined when the device
is added to the system. For custom tags, this is on the Add/Edit
Custom Tags screen. Tags for standard device types are pre-
determined and cannot be changed.)

Note: If a tag group displays in red copy, there is at least one address
that is not valid for the tag to which it is assigned. To correct this issue,
click the tag group, ensure that Display Advanced Properties is
selected, then scroll down through the tags in the right-hand column.
The tags that have invalid addresses will have the “Edit...” displayed in
red. Click this field to open the Edit Address page; correct the errors in
the address.

Tag tabs: Real Time, OnBoard Alarm, Control, and Reset

Click a tab to view the tags of that type that are included for the selected device type.

If the device type is not locked, you can use the Add/Edit Device Type screen to edit the list of tags.

Tag Description (all tag types)
/Display only

This is the tag name, hard-coded for standard tags. For custom tags:
The name is from the Tag Name field in the Add/Edit Custom Tags
screen.

Units/Display only
Lists the abbreviation, added when creating the engineering unit
template.
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Field Name/Valid Entries Comments

IEC Tag Name/Display only
Tag name that conforms to IEC61850 standard. See Tag Types on
page 83 for more information.

Type (Real Time only)/Display only Displays the data type chosen when the tag was created.

Address (not Control tags)/

To edit, click the Edit Address link.

Displays the address information for this tag, including elements such
as type of register, number of registers, and scaling and bitmasking
data. Tag Types on page 83 for a detailed description of address
construction.

Normally Closed (Control tags only)/

Check the box to invert the
functionality of the control. See
description.

For a control with one command, writing a 1 to the tag will cause the
command to occur. (This option is greyed out.)

For a control with two commands that is either static or normally open,
writing a 1 to the tag will cause the first command to occur; writing a 0
will cause the second to occur. (Checkbox not checked.)

For a control with two commands that is normally closed, writing a 1 to
the tag will cause the second command to occur; writing a 0 will cause
the first command to occur. (Checkbox checked.)

Edit Addr/Click to display Edit
Address screen. (Real Time and
Onboard Alarm only)

Provides themeans of changing the elements of an unlocked real-time
tag address (for example, the number of registers, their numbers, and
whether they are consecutive).

SeeEdit Tag Addresses on page 52. for detailed information.

Register 1/Display only (Real Time
tags only)

This field contains first register used to store this tag. If there are
additional registers, they are indicated in the address. The total number
of registers is listed in the Num Registers column. This field allows you
to verify and/or change the value of Register 1 without having to open
the Edit Address screen. Note: If you enter a number that is not
compatible with other address

settings, you are prompted to go to the Edit Address screen.

Num Registers/Display only (Real
Time tags only)

Displays the number of registers used by this tag.

Formatting/Select the format type
from the drop-down list (Real Time
tags only)

After you change formatting for a tag andmove the cursor to another
field, you are asked whether you want to open the Address Editor. If you
click No, the format is unchanged; if you click Yes, the Edit Address
screen opens for you to enter the appropriate changes for this tag. See
Edit Tag Addresses on page 52.

Scaling Register/View or enter the
register number (Real Time tags only)

This is entered in the Edit Address screen, but it can be edited here. It is
the register used to read the value for scaling. Note: If you enter a
number that is not compatible with other address settings, you are
prompted to go to the Edit Address screen.

Functional Address/Display only
(Real Time, Onboard Alarm, Control,
and Reset tags)

If you have added a functional address for this tag, it displays here. To
add or edit this address, use the Edit Functional Address field.

Note: Functional addressing is described inAppendix 4: Glossary on
page 272.

Edit Functional Address/Add the code
for the address

Typically used for data concentrators, the functional address is a
means of entering the individual data points needed to definemultiple
addresses. Entered as a formula (must be in C#), it will contain the
variables the user must enter when the block is instantiated by the
I/O DeviceManager.

A simple example:

Address =

"T:MV;m:" + (startingpoint + 1005).ToString() + ";L:P:22"

You would then define "startingpoint" when instantiatiing the profile in
the I/O DeviceManager.
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Field Name/Valid Entries Comments

Tag ID/Display only/Display only
Assigned by the system when the tag was created. If this is a custom
tag, it will be a negative number.

Category Type (real-time only)

Utility Type (real-time only)

Statistical Type (real-time only)

Quantity (real-time only)

Each of these types is a real-time filter, added when the tag was
created. SeeSet Up Custom Tags on page 49 for more information.

Categorization (onboard alarm only)

Subcategorization (onboard alarm
only)

Alarm Type (onboard alarm only)

Alarm Group (onboard alarm only)

Alarm Level (onboard alarm only)

Each of these is an onboard alarm folder, added when the tag was
created. SeeSet Up Custom Tags on page 49 for more information.

Add, Edit, or Delete a Device Type
Use the Add/Edit Device Type screen to begin adding, editing, or deleting a device
type from the system. To view this screen, click the Define Device Type Tags tab; then
click Add/Edit, to the right of the Device Type Name field.

The following table describes the parts of the Add/Edit Device Type screen.

For instructions on editing or deleting device types, see the steps below the table.

Field Name Valid
Entries Comments

Create New

Click one of the
radio buttons to
select the
action you want
to take.

Click to add a device type that is not based on an existing
type.

Create From Click to copy an existing device type.

Edit Existing Click to edit an unlocked device type.

Delete Existing
Click to delete an unlocked device type that is not associated
with a profile.

Device Type (to Create
From/to Edit/ to Delete)

select type
Select the device type that you want to create from, edit, or
delete.

Copy Addressing

Active when you choose Create From. Check this box if to
copy the addressing of the “from” device. This gives each tag
in the new device type the same address string as the
matching tag in the “from” device.

Device Type Name

Type or select
the name:

maximum 32
characters,

do not use \ / : *
? < > |

If creating a device type, type the name. If editing a device
type, the device type that was selected for editing displays
here. You can change the name here.

Lock this Device Type

Check to lock
device, so that
it cannot be
edited.

This action cannot be undone.

You cannot edit a locked device type. If it is a standard device
type, you cannot edit or delete it. If you added the device type,
you can delete it but not edit it.
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Field Name Valid
Entries Comments

Device Category
Choose the
category for
this device.

To create categories, seePrint the .CSV File on page 47.

In addition to predefined categories, you can add custom
categories. SeeSet Up Device Type Categories on page 47
for instructions. Categories are used in the Device Creation
wizard, and are ameans of shortening the list of devices you
must view.

Subcategory

Choose the
subcategory for
this device, if
needed.

Default options areMonitoring Device, PLC, or Protection
Device. Depending on the device you select at the top of the
page, this field is filled in for you.

As with categories, subcategories are created in thePrint the
.CSV File screen.

Driver
Select the
driver for the
device type.

Predefined drivers are created for all PowerLogic compatible
devices, though youmay need to use these drivers for multiple
device types. For example, you would use the CM4000 driver
for a CM3000.

Use the Generic Power Device driver for third-party devices.
The Controllable Device driver is currently not used. Use
Generic JBus Device driver for JBus devices.

Display Associated Profiles

(Active only in
Edit mode)

Click to display
a list of profiles
that are
associated with
the selected
device type.

This list is used when you want to delete a device type that is
associated with a profile. In Edit mode, select the device type
you want to delete; then click this button. Note the profile(s)
associated with the device type.

Before you can delete the device type, go to the Add/Edit
Device Profile screen, locate each profile in the list. You
cannot save an empty profile, so youmust either select
another device type for it or delete the profile. Then you can
delete the device type.

IEC Tags n/a

This list includes all tags that have been added to the system,
standard tags as well as custom tags that you have added.
Tags are listed in their groups (such as 100ms, Onboard
Alarm, Power Factors).

Selected Tags

Select tags
from Tags;
click the right
arrow tomove
them to this
box.

You canmove single tags or entire tag groups. They must be
moved one at a time (cannot shift+click to select).

Note: You cannot deselect tags for a device type if that device
is associated with a device profile.

Add/Edit Custom Tags
Click to begin
adding a
custom tag.

Live when creating or editing a tag. Opens the Add/Edit
Custom Tags screen. SeeAddCustom Tags and Tag
Addresses on page 49 for instructions.

If you add a custom tag here, you are prompted to save the
device type. After adding the tag, you have the option of
adding that tag to the device type.

Edit a Device Type
You cannot edit any locked device type. When a device type is locked, the locked icon
displays on the Define Device Type Tags tab:

If you want an edited version of a locked device type, you must create a new device
type from it and then delete the original device type. Certain “standard” device types
can be used to create new types, but they cannot be deleted. Examples: Circuit Monitor
4000, Power Meter 800, and Sepam S42.
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There are two ways to edit device types:
• From the Define Device Type Tags tab, select a device type; make these changes:

Edit the functional address (see Edit Functional Addresses on page 49).

Real Time Tags sub-tab: you can edit the address (see Edit Tag Addresses on
page 52) and choose a different format.

• From the Define Device Type Tags tab, select the device type you want to edit, then
click Add/Edit. Follow through the screens to edit additional information:

In the Device Type Options box, click Edit Existing.

Click the Device Type to Edit list to display the Select Device box. Select the device
type that you want to edit.

You can change the device type name, category, subcategory, and driver. You can
also lock the device.

Select tags and tag groups and move them into or out of the Selected Tags list.

If a device type is associated with a device profile, you cannot deselect tags.

After all of the appropriate changes are made, click Save to save your current
settings.

To create additional custom tags, click Add/Edit Custom Tags; otherwise, click Save
& Exit to save your settings and close the window.

If you add a tag to a group that is already included in a device type, you must then
individually add the tag to that device type.

Delete a Device Type
You cannot delete any standard device type or any custom device type that is
associated with a device profile; those device types do not display in this option.

To view a list of profiles associated with a device type, switch to the Edit Existing view,
then select the device type you want to delete. Click List Profiles associated with this
Device Type to display all associated profiles. Before you can delete the device type,
return to the Add/Edit Device Profile screen for each profile in the list; either select a
new device type for the profile or delete the profile entirely.

To delete a device type:

1. From the Define Device Type Tags tab, click Add/Edit.
2. In the Device Type Options box, click Delete.
3. From the drop-down list, select the device type you want to delete (the list includes

only unlocked or custom device types; you cannot delete any of the “standard”
device types or custom device types that are associated with a profile.

4. Click Delete. At the Confirm prompt, click Yes.

Assign Tags to Generic I/O Points
Device types have default tags that have the appropriate formatting and addressing
assigned for all the generic I/O points. It may be necessary to redefine a generic I/O
point by assigning it to a tag that has a specific meaning.

Example 1: The Branch Circuit Monitor 42 has been configured to read 42 current
channels. To assign channel 1 to Current A, follow these steps:

1. From the Branch Circuit Monitor 42 device type, choose the “Ch.01 Current tag.”
2. Note the addressing and formatting for the tag.
3. Locate and add the standard tag that you want to assign to this channel. In the

example above, you would add “Current A.”

© 1990–2017 Schneider Electric All Rights Reserved 46



4. Edit the address of the Current A tag to match the address of Channel 1.

Example 2: If the Sepam I11 / I12 have been configured to represent circuit breaker
position, you may choose to redefine the tag name. Follow these steps:

1. From the Sepam 40 Series device type, choose tags “Input Status I11” / “Input
Status I12.”

2. Note the addressing and formatting for each tag.
3. Locate and add the standard tag that you want to assign to these I/’O points. In the

example above, you would add “Device Closed.”
4. Edit the address of the Device Closed tag. In order to create the “device closed”

functionality, you must combine inputs 11 and 12 into an enumerated status
(choose the Enumerated Status logic code for the indicated address for I11 and
I12),

Print the .CSV File
For each device type, device profile, or project, you can create a .CSV file that includes
the following data:

Type of File Data Included

Device Type tag descriptions, IEC tag names, type, and address

Device Profile tag descriptions, IEC tag names

Project data profiles and custom tag names included in the project

Follow these steps to create the CSV file:

1. Display the device type, profile, or project for which you want the file. For example,
to create a CSV file for the Sepam 42 Full device profile, select the Create Device
Profiles tab and choose Sepam S42 Full from the drop-down list.

2. Click File > Create CSV File.
3. From the Save As window, choose a location for the file and rename it, if you wish.

Click Save.
4. The file is created in the location you specified.
5. For viewing and printing, open the file in Microsoft Excel.

Set Up Device Type Categories
Use the Set Up Device Type Categories screen to add, edit, and delete categories.
These categories are used in the I/O Device Manager to logically group the list of
profiles that display, and to make them easier to locate.

When you add device types in the Add/Edit Device Type screen, you associate a
category and subcategory with each device.

To view the Set Up Device Type Categories screen, click Settings > Set Up Device
Type Categories.

The following table describes the parts of this screen. Detailed instructions are after the
table.

Field Name Valid Entries Comments

Categories
Options box

Create New Click to begin adding a new device type that is not based on an
existing type.
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Field Name Valid Entries Comments

Edit Existing Click to begin editing the category or subcategory name.

Delete Existing
Click to begin deleting a category. You cannot delete a
category that is associated with a device type.

Category Name

If new: Type the name.

If editing or deleting, select the name from the drop-down
menu.

Predefined categories do not display. Currently, there is one
predefined category: Schneider Electric.

Subcategories
Options box.

As with categories, you can
create new, edit existing, or
delete.

If new: Type the name.

If editing or deleting, select the name from the drop-down
menu.

You cannot delete a subcategory that is associated with a
device type.

Predefined subcategories do not display. Currently, the
predefined subcategories are: Protection Device, Monitoring
Device, and PLC.

Add a Category or Subcategory
To add a category/subcategory:

1. Click Create New in the appropriate box (Categories or Subcategories).
2. In the Name field, type the name of the new category or subcategory.
3. Click OK to save the new entry and close the screen.

Edit a Category/Subcategory Name
To change the name of a category or subcategory:

1. From the appropriate box, click Edit Existing.
2. From the dropdown menu, select the category or subcategory that you want to edit.
3. Type the new name for this category or subcategory.
4. Click Save to make the change, or click Save & Exit to save changes and close the

screen.

Delete a Category or Subcategory
Predefined categories/subcategories, or those associated with a device type, do not
display for deletion. To delete a device type associated with a category/subcategory,
change to the “Edit” view, select the category or subcategory, then click the List Device
Types... button. Note the device types and go to the Add/Edit Device Types screen.
Change the category/subcategory on that page. Then you can return to the Set Up
Device Type Categories screen to delete the category/subcategory.

To delete a category or subcategory:

1. From the appropriate box, click Delete Existing.
2. From the dropdown menu, select the category or subcategory that you want to

delete.
3. Click Delete.
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4. At the Confirm prompt, click Yes.
5. Click Save to save the change, or click Save & Exit to save changes and close the

screen.

Edit Functional Addresses
Use this feature to add variables to addressing. You can re-use a variable by
copying/pasting parts of it into other addresses, then making changes to the code for
use in other tags. You will be prompted for these variables in the I/O Device Manager.

To access the Edit Functional Address screen, click the Edit Functional Address button
for a real time tag, onboard alarm tag, control tag, or reset tag. The fields on this screen
are used in this way:
1. Tag Name and Original Address: These fields display from the tag you selected;

you cannot edit this information.
2. Device Variables: Click New to begin adding new variable properties. The

following fields become live:

a. Name: This name must be in format %NNN%, where NNN includes only letters
or underscores.

b. Description: This required field is free-form. It displays in the I/O Device
Manager and will help you ensure that you have the correct information
entered.

c. Regular Expression: You can use one of the pre-defined expressions, or you
can create your own

d. Test Value: This will become the default in PowerSCADA Studio; use it here for
testing the new address.

e. Help: Use this optional field to add more definition to this address. It displays in
the I/O Device Manager.

3. Code Body: Enter the code in C# to define the action you want to take place.
4. Return: Type the return statement that you want from C# code. It might look like:

string.Format("SomeString{0}SomeOtherString", someVariable)
5. Result: Click Test in the lower right corner of the screen. If there is a compile error,

check your C# code. Otherwise, the result displays. Verify that it is what you
wanted.

Add Custom Tags and Tag Addresses
PowerSCADA Expert comes with most of the tags that are needed for each device
type. However, you can create custom tags to assign to device types and device
profiles. You can also edit address attributes for any tag.

NOTE: To avoid potential communication errors, you should use the Profile Editor to
create all custom tags that will communicate with equipment.

In this section, you can learn about:

Set Up Custom Tags

Edit Tag Addresses on page 52
Edit Tag Addresses

Set Up Custom Tags
Use the Add/Edit Custom Tags screen to edit the information about a custom tag. To
view this screen, click Add/Edit Custom Tags at the bottom of the Add/Edit Device Type
screen; or, from the upper left of the Profile Editor screen, click Settings > Set Up
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Custom Tags. The Add/Edit Custom Tags screen displays. The following table
describes the fields.

Instructions for editing or deleting a custom tag are after the table.

Field Name Valid Entries Comments

Custom TagOptions

Create New Click to begin adding a new tag.

Create From
Click to begin adding a new tag that is based on an
existing custom tag. For example, youmight want to
changemetadata for another custom tag.

Edit Existing Click to edit the attributes of an existing tag.

Delete Existing
Click to delete a tag (tag cannot be associated with a
device type).

Tag to Create From

Tag to Edit

Tag to Delete

From the drop-downmenu, select the tag you want to
create from, edit or delete.

Delete button
Live only when Delete Existing is selected. Click to
delete the tag. You can only delete custom tags not
associated with a device type.

Display Associated
Device Types

Click to display device
types that are
associated with this tag.

Live only when in Edit mode. Click to list device types
that are associated with this custom tag. Note the
device types so that you can delete the tag from them (in
the Add/Edit Device Type screen) before you delete the
tag.

SeeDelete a Custom Tag on page 52 for instructions on
using this button.

Tag Name

Type the new tag name;
or type the changed
name for a tag you are
editing.

Maximum 32 characters; can include any alpha or
numeric character, as well underscore (_) and backslash
(\). Must begin with either an alpha character of
underscore.

Display Name

Type the name that you
want to display when
selecting the tag and in
other displays.

Youmight use this field for additional information on the
Add/Edit Custom Tags screen. For example, you could
describe the data that it logs. It does not display
anywhere else in the system.

Group Select the group.
Includes all of the real-time groups (such as 100ms,
controls, currents) plus onboard alarms, resets, and
controls.

Data Type Select the data type.

These are PowerSCADAExpert tag data types. They
affect the logic codes that are available for display in the
Edit Address screen. See Logic Codes on page 87 for the
data type that matches each logic code.

Eng. Units Select the base unit.
These are the base engineering units for tags, from
Engineering Unit Setup.

Ignore Unit Conversion

Check to cause the
system to ignore any
conversions that were
added for this tag.

Causes reporting to be according to the base unit, rather
than the conversion that was chosen for this tag in the
template that is being used.

Add Eng Unit

Click to open the
Add/Edit Units screen,
to add a new engineering
unit and/or conversion.

Provides a quicker means of adding an engineering unit
that had been overlooked.

PowerSCADA Studio
Format

Select the numerical
format.

This is used for display purposes in PowerSCADA
Expert graphics pages. It determines where the decimal
displays.
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Field Name Valid Entries Comments

Choose the reporting format, to be used in PowerSCADA
Expert, from ## to #0.#####. For example, if you select
#.##, the number 8.12579 would be displayed as 8.12.

Polling Priority Low, Normal, or High

Indicates the level of priority PowerSCADAExpert uses
when reading data from devices.

Note: In the address field, a priority of 1 =High, 2 =
Medium,
3 = Low.

Alarm On Text
For onboard alarms only:
enter the text for when
the alarm is On.

This text displays on the Create Device Profiles tab for
the onboard alarm tag, when it is selected for the device
type in the profile. It also displays in the Alarm Log.

Alarm Off Text
For onboard alarms only:
enter the text for when
the alarm is Off.

Display ‘Advanced’ filter
selections

Check to display
additional filter options in
the Real Time Filter and
Alarm Filter tabs

Displays several additional filter options on the two
“Filter” tabs. These options will be useful in the future for
reporting purposes.

You can include additional filters for either real time filters or alarm filters. Though not currently used, these filters
will providemetadata for later reporting. Standard tags have some of these filters selected.

A typical usage for these filters might be: when creating a custom tag from an already existing standard tag, you
can creatematchingmetadata by using the filters that have been built in to the standard tag.

Real Time Filters tab (dropdown lists are expanded when “Display ‘Advanced’ filter selections” is
checked)

Category Type
Select a category for this
tag.

This field provides metadata about the tag. It will be used
in future reports.

Utility Type Select a utility type. Metadata for future use in reporting.

Statistical Type Select a statistical type. Metadata for future use in statistical reporting.

Quantity Select a quantity. Metadata for future use in statistical reporting.

Alarm Filters tab (dropdown lists are expanded when “Display ‘Advanced’ filter selections” is
checked)

Categorization
Select the alarm
category

Used for filtering and sorting alarm data. Alsometadata
for future use in statistical reporting.

Alarm Type Select the alarm type.
Used for filtering and sorting alarm data. Alsometadata
for future use in statistical reporting.

Alarm Group Select the group.
Used for filtering and sorting alarm data. Alsometadata
for future use in statistical reporting.

Subcategorization Select a subcategory.
Used for filtering and sorting alarm data. Alsometadata
for future use in statistical reporting.

Alarm Level
Select the severity level
of the alarm.

Used for filtering and sorting alarm data. Alsometadata
for future use in statistical reporting.

Edit a Custom Tag
You can edit any custom tag. To edit a tag:

1. Open the Add/Edit Custom Tags screen (from the Add/Edit Device Type screen,
click Add/Edit Custom Tags).

2. In the Custom Tag Options box, click Edit Existing.
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3. You can change any of the tag attributes. (This does not change the tag’s
assignment status; if it is selected for a device type, it does not move back to the
IEC Tags list.)

4. Click Save to save changes, or click Save & Exit to save changes and close the
screen.

Delete a Custom Tag
You can delete any custom tag that is not associated with a device type.

If the tag is associated with a device type, you must first deselect the tag:

1. Change the option to Edit Existing and display the tag you want to delete.
2. Click Display Associated Device Types to display all device types that include this

tag. Make a note of the device types.
3. Return to the Add/Edit Device Type screen. For each device type listed, deselect

the tag that you want to delete.

Continue deleting the tag:

1. Open the Add/Edit Custom Tags screen.
2. In the Custom Tag Options box, click Delete Existing.
3. From the drop-down menu, choose the tag you want to delete.
4. Click Delete. At the Confirm prompt, click Yes.
5. Click Save to save the change, or click Save & Exit to save changes and close the

screen.

Edit Tag Addresses
Use the Edit Address screen to edit the attributes of a single tag address. If a device
type is locked, you cannot edit any of its tag addresses; they will be greyed out. A
thorough discussion of IEC61850 tags and their construction is included in Tag Types
on page 83 and Logic Codes on page 87.

NOTE: Case and order are critical in the tag address. Be careful to observe the exact
address order. For address order, see Logic Codes on page 87. Also, be sure you use
the correct case. For example, use M for register numbers in hexadecimal, and use m
for register numbers in decimal.

To view the Edit Address screen, open the Define Device Type Tags tab, choose the
device type, then click the Edit... field for the tag that you want to change. The Edit
Address screen is different for real-time and alarm tags. Each type of tag (real-time,
onboard alarm, reset, and control) is described separately in the following tables.

Real-Time Tag Addresses

The following table describes the fields of the Edit Address screen for real-time tags.

Field Name Entry Comments

Data Type For display only
You can edit this field in the Add/Edit Custom Tags
screen.

Priority
High, Normal, or Low

Logic Code:
You can edit this field either here or in the Add/Edit
Tag screen.

Logic Code
Select the logic code
for this tag.

The logic code list depends on the Data Type for
this tag. For more information about logic codes,
see Logic Codes on page 87.
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Field Name Entry Comments

Display
Registers in:

hexadecimal/decimal
Click the radio button for the way you want to view
register information.

Module Select module
Choose the type of module in which the tag is used.
Used for Micrologic at this time.

Register Type Select register type
Select the type of register that is to be written or
read.

Number of
Registers

Select the total number
of registers for this
address (1-10).

Is Consecutive, check
if the registers are to
be consecutive
(determined in the logic
code).

Enables for editing the appropriate registers in the
lines below.

Fixed
Scale/Register
Scale

Click the radio button
for the correct type of
scale.

A fixed scale is the actual value of the scale. A
register scale is the register address where the
scale is held.

The value will be scaled in this manner: Value x 10x

where X = the scale.

Scales can only be –10 to 10.

Conversion
Factor

Enter themultiplier to
convert the base units
to the desired
conversion.

Conversion factors are used for straight
multiplication with the value. The conversion factor
could also be changed in the Add/Edit Units screen
(Settings >Select Units >Add/Edit Units.

Conversion factors take this form:

####E##. For example,

123E-2 becomes 123x10-2

which becomes 1.23.

Offset y = ,x + b

y = the final value reported by PLSCADA
b = the offset
m = the conversion factor
x = the original value in themeter
b = rarely used, mainly in temperature conversion

The offset is added to the final value (after the
conversion factor is applied).

Register 1-4
Enter the register
number.

Be aware of whether you chose hexadecimal or
decimal. Use the same format here.

Bitmask for
Register 1-4

For digital input/output
tags: Set the bits to 1
or 0 tomatch the
pattern for “True” in the
device register.

When all bits match exactly the pattern in the
register, the status is True. When any one bit does
not match the pattern in the register, the status is
False.

Note: On PM8s and CM4s, there is a device-
specific format, DIgIn and DigOut. In each case,
youmust first specify the indicator register (which
becomes the first register). The second register will
have themask.

Invert Result
Check this box to
invert.

Will turn False to True or vice versa; typically used
for Normally Open or Normally Closed.

Onboard Alarm Tag Addresses

The following table describes the fields of the Edit Address screen for onboard alarm
tags.
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Field Name Entry Comments

Tag Name For display only
This is the tag name, which cannot be
changed.

File Number Select the number.
This is the file number for the alarm file on the
device.(Sepam has no file number; enter 0.)

Module Select themodule.
Choose the type of module in which the tag is
used. Used for Micrologic at this time.

Unique ID Choose the identifier.

This unique identifier must be used to ensure
that alarms will annunciate correctly. For CM4,
PM8, PM5000, andMicrologic, the unique ID
must be decimal. For Sepam, the unique ID is
the coil bit address that indicates the alarm; it
must be in hexadecimal.

Hexadecimal check box
Check this box if you want to display the ID in
hexadecimal, rather than decimal.

Has Unique
Sub ID

check box
Check if this tag has a unique sub-identifier
(Micrologic, CM4000, PM800, and PM5000
devices).

Unique Sub ID Enter the Sub ID.
Enter the unique sub-identifier. Active only if
Unique Sub ID box is checked.

Reset Tag Addresses

NOTE: Once the tag is set up, writing a 1 to the tag will cause the “write” to occur.

Standard device types include some pre-defined resets. These pre-defined commands
cause proprietary functions within the device. Do not edit these commands.

To add a custom reset that will operate by writing to a register, do the following:

1. From the Add/Edit Custom Tags screen, set the Group to Resets and the Data Type
as Digital. Save the tag.

2. Add the new tag(s) to the appropriate device type(s).
3. From the Define Device Type Tags tab, locate the tag and click Edit.

The following table describes the fields of the Edit Address screen for reset tags.

Box Name Field Name Comments

Tag
Information

Command Type The Command Type and Command to Edit are already
selected.Command to Edit

Data
Information
box

Data Type: for display only You can edit this field in the Add/Edit Custom Tags screen.

Priority: High (default) Cannot be edited.

Logic Code: Select the logic
code for this tag.

Choose the appropriate logic code for this tag. See Logic
Codes on page 87.

Device
Information
box

Display Registers in:
hexadecimal/decimal

Click the radio button for the way you want to view register
information.

Module
Choose the type of module in which the tag is used. Used for
Micrologic at this time.

Register Type Select the type of register that is to be written or read.

Number of
Registers

There is only one register for
this address.

Enables for editing the appropriate registers in the lines below.
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Box Name Field Name Comments

Fixed
Scale/Register
Scale

n/a Not used for digital logic codes.

Conversion
Factor

n/a Not used for digital logic codes.

Register 1 Enter the register number.
Be aware of whether you chose hexadecimal or decimal. Use
the same format here.

Bitmask for
Register 1

For digital input/output tags:
Set the bits to 1 or 0 tomatch
the pattern for “True” in the
device register.

When all bits match exactly the pattern in the register, the
status is True. When any one bit does not match the pattern in
the register, the status is False.

Note: On PM8s and CM4s, there is a device-specific format,
DIgIn and DigOut. In each case, youmust first specific the
indicator register (which becomes the first register). The
second register will have themask.

Invert Result n/a Not used for resets.

Control Tag Addresses

NOTE: For a control with one command, once the tag is set up, writing a 1 to the tag
will cause the “write” to occur. For a control with two commands that is either static or
normally open, writing a 1 to the tag will cause the first command (ON) to occur; writing
a 0 will cause the second (OFF) to occur. For a control with two commands that is
normally closed, writing a 1 to the tag will cause the second command (OFF) to occur;
writing a 0 will cause the first command (ON) to occur.

Standard device types include some pre-defined controls. For example, Operate
(ENERGIZE). These pre-defined commands cause proprietary functions within the
device. Do not edit these commands.

To add a custom control that will operate by writing to a register, do the following:

1. From the Add/Edit Custom Tags screen, set the Group to Controls and the Data
Type as Digital. Save the tag.

2. Add the new tag(s) to the appropriate device type(s).
3. From the Define Device Type Tags tab, locate the tag and click Edit.

The following table describes the fields of the Edit Address screen for control tags.

Box Name Field Name Comments

Tag
Information

Command Type

For commands that have an opposite (such as On andOff),
choose Normally Open/Normally Closed or Static with Off
Command. For commands with only one action, choose
Static without Off Command.

Command to Edit
If you are editing a command with two parts, use the
Command to Edit drop-downmenu to select the On
Command.

Data
Information
box

Data Type: for display only You can edit this field in the Add/Edit Custom Tags screen.

Logic Code: Select the logic
code for this tag.

Choose the appropriate logic code for this tag. See Logic
Codes on page 87.
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Box Name Field Name Comments

Device
Information
box

Display Registers in:
hexadecimal/decimal

Click the radio button for the way you want to view register
information.

Module
Choose the type of module in which the tag is used. Used for
Micrologic at this time.

Register Type Select the type of register that is to be written or read.

Number of
Registers (1)

n/a Enables for editing the appropriate registers in the lines below.

Fixed
Scale/Register
Scale

Click the radio button for the
correct type of scale.

A fixed scale is the actual value of the scale. A register scale
is the register address where the scale is held.

The value will be scaled in this manner: Value x 10x

where X = the scale.

Scales can only be –10 to 10.

Conversion
Factor

n/a Not used for digital controls.

Register 1 Enter the register number.
Be aware of whether you chose hexadecimal or decimal. Use
the same format here.

Bitmask for
Register 1

For digital input/output tags:
Set the bits to 1 or 0 tomatch
the pattern for “True” in the
device register.

When all bits match exactly the pattern in the register, the
status is True. When any one bit does not match the pattern in
the register, the status is False.

Note: On PM8s and CM4s, there is a device-specific forma,
DIgIn and DigOut. In each case, youmust first specific the
indicator register (which becomes the first register). The
second register will have themask.

Invert Result n/a Not used for digital controls.

Edit Address Information

To edit address information for a real-time tag:

1. From the Define Device Type Tags tab, choose a device type (cannot be locked).
From the Real Time Tags sub-tab, highlight the tag whose address you want to edit.

2. In the Edit Address column, click “Edit” for the address you want to edit.

The Edit Address screen displays.
3. You can change any of the tag address attributes. See the preceding table for

descriptions of each field.
4. Click OK to save changes and close the screen.

Add a New Tag Address

You can also add a tag address, when none exists. As with editing addresses, click the
Edit Address column for a tag; then follow instructions in the table above.

Edit Generic Tag Addresses
This screen displays when you click Edit for an address of a non-PowerLogic
compatible device type, such IEC 61850 or DNP3.

The variable tag properties used in this screen are described in a topic in the
Citectscada help file. For detailed information, see Variable Tag Properties in the
citectSCADA.chm help file (Program Files> Schneider Electric > PowerSCADA Expert
> v8.2 > bin).
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Create Device Profiles
Use the Create Device Profiles screens to view and edit profiles for individual devices.
Profiles are predefined for the standard devices; you will mostly use this feature to add
third-party device profiles. Before you create profiles, you need to be sure that all of the
tags and device types that you need are created (see Define Device Types and Tags
on page 41). Also make sure that you have added any new units/conversions and
device type categories/subcategories that are needed.

In this section, you can learn about:

Enable Waveforms on page 57
View Device Profiles on page 57
Add Edit or Delete Device Profile on page 59
Select Trend Intervals on page 61
Set Up Trend Intervals on page 61
Edit IEC 61850 Datasets on page 62
Edit IEC 61850 Report Control Blocks on page 63
IEC 61850 System Setup Workflow on page 25
Create a Composite Device Type on page 65
Create Data Concentrator Device on page 66
G3200 Device Setup on page 67

DNP3 Protocol Support on page 68

Enable Waveforms
On the Create Device Profiles tab, in the Onboard Alarm Tags sub-tab, there is a
Waveform checkbox. Check the box for each alarm tag for which you want to be able to
view waveforms. On the device, the alarm must also be set up for the waveform to be
captured on event and stored in one of the device’s data logs.

To acquire waveforms for Sepam, use the CET manual. For PowerLogic devices,
reference the PMCU help file.

As device information is polled and received by PowerSCADA Expert, the waveform
becomes available for viewing. See The Alarm Log in View the Alarms/Events Page on
page 172 for information on viewing waveforms in the runtime environment.

View Device Profiles
The Create Device Profiles tab displays all of the tags that are included in each device
type profile. It is the starting point for creating/editing device profiles for individual
devices. Most of the data on this screen displays for information only; however, to
enable waveforms, you need to check the Waveform box (see Enable Waveforms on
page 57 for more information). To begin making changes, click Add/Edit. The following
table describes the fields on this tab. The tags listed assume that Advanced Properties
has been checked. Not all elements appear on every sub-tab. Detailed instructions are
after the table.
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Field Name Valid Entry Comments

TagGroups (left-
hand pane)

Click a group to display the
groups of tags that have
been selected for the chosen
device profile.

To associate tags and tag groups with a
device type (thus creating a device
profile), click Add/Edit.

Device Profile
Choose the device for which
you want to view profile
details.

Device Profiles are created on the
Add/Edit Device Profile screen (click
Add/Edit).

Add/Edit button
Click to display the Add/Edit
Device Profile screen.

Use that screen to add device profiles
and to associate PC-based alarms and
trends.

Tag type sub-tabs

Click to display the selected
tags for each type of tag:
real-time, trend, PC-based
alarm, onboard alarm,
control, or reset.

Organized according to tag groups.

Tag Description n/a
This is the tag name used when adding
the tag.

IEC Tag Name n/a
This is the IEC61850-compatible name
created when the tag was added.

Waveform

(Onboard Alarm)

Check this box as part of the
process of enabling
waveform viewing.

Youmust also set up the alarm and
waveform capture in the onboard files
of the device. Waveforms will then be
viewable in the runtime environment.

Category Type

(Real Time)
n/a

These are real-time filters. They
providemetadata to be used in future
reporting.

Utility Type

(Real Time)
n/a

Statistical Type

(Real Time)
n/a

Quantity

(Real Time)
n/a

Categorization
(PC Based and
Onboard Alarm)

n/a

These are alarm filters. They can be
used for filtering and sorting alarm data
in the runtime environment. They also
providemetadata to be used in future
reporting.

Subcategorization

(PC Based and
Onboard Alarm)

n/a

Alarm Type

(PC Based and
Onboard Alarm)

n/a

Alarm Group

(PC Based and
Onboard Alarm)

n/a

Alarm Level

(PC Based and
Onboard Alarm)

From the drop-down list, you
can edit the alarm level.

If PC-based and/or onboard alarms are
set for this profile, you can change their
levels here.

To view profile information, select the device profile from the drop-down menu. Use the
tag tabs (such as real-time, trend) to view the tag groups included in this device profile.

To begin adding, editing, or deleting a profile, click Add/Edit.
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Add Edit or Delete Device Profile
Use the Add/Edit Device Profile screen to add device profiles to the system. To view
this screen, go to the Create Device Profiles tab.

Add a Profile
1. Open the Create Device Profiles tab (from the Create Device Profiles tab, click

Add/Edit).
2. In the Profile Options box, click Create New or Create From.

If you are creating from another device profile, choose it from the Device Profile to
Create From drop-down menu.

3. Click Next to make the name and description fields live.
4. Type a unique Device Profile Name, maximum 32 characters;

do not use \ / : * ? < > |
5. If you want to lock this profile, preventing anyone from editing it, check the Lock this

Device Profile box. This action cannot be undone. If you wish to edit a locked
profile, you must use the Create From option to add a new one, then delete the
locked one.

6. (optional) Type a device description. This will display as a tool tip in later screens.
7. Click Next again to make the remaining fields live.
8. From the Available Devices list, highlight the first device or device group

(Protection, Monitoring, Composite) to be included in this profile. Click the right
arrow button to move it to the Selected Devices box. You must select and move
devices or device groups one at a time (no shift+click to select multiples).

9. If you will want to import this project into another instance of the Profile Editor, see
Add Project Parameters on page 72.

10. When you have all of the devices you want, click Next. 
11. From the Device Type Tags list on the left, select the tags you want to include in this

profile. You can select entire tag groups or individual tags from a group; but you
must select them one at a time.

12. After each addition, the tag or tag group displays in the Selected tags box. You can
override any tag name (typically for generic I/O devices with multiple tags, such as
inputs, for which names alone would not be intuitive in runtime. To override a tag,
select it, then click Override Tag Name. Choose the tag you want. Click OK. The
new tag will correctly display the value of the original tag, but will take the
appearance of the override tag (such as description, metadata).

13. The final column, Is Device Tag, displays only for composite devices. Check this
box to tie a tag back to its actual physical device. For example, if the same tag is in
three devices, and you set PC-based alarms for each device, you need to be able
to determine which device has a problem in runtime. To prevent confusion, check Is
Device Tag to cause PowerSCADA Expert to report the tag for its physical device,
rather than the composite device.

14. When you have selected all tags, click Next.

NOTE: If you have duplicate tags from multiple devices, you need to resolve this by
using an override for one of the tags.

15. On the next page, choose whether each tag will have a PC-based alarm and/or
trend associated with it. Click Finish.

When the project is added to the project, PC based alarms are added to the Analog
Alarms or Digital Alarms file. When the project is added to the project, historical
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trends are added to the Trend Tags file. Logging will automatically begin when the
tag is added to the project.

By default, there are two different intervals for scanning trend tags. All selected tags
are scanned every 15 minutes with FIFO storage of 12 months. For the following
tags, there is an additional “short” scanning interval of 5-seconds, with FIFO storage
of two weeks:

Current A, Current B, Current C, Voltage A-B, Voltage B-C, Voltage C-A, Power
Factor Total, Apparent Power Total, Reactive Power Total, Real Power Total, and
Frequency.

For instructions on changing the “short” scan interval settings, see Trend Tag Scan
Intervals on page 163.

To change a trend interval for a tag, see Select Trend Intervals on page 61 To add
additional trend tags, see Set Up Trend Intervals on page 61.

16. The Driver Parameters box contains options that you can check for IEC61850
devices. If a device includes datasets and report control blocks, you can edit the
information on the Edit IEC 61850 Datasets on page 62 and Edit IEC 61850 Report
Control Blocks on page 63 screens.

17. Check the Close Wizard box, and click Finish to return to Create Device Profiles
tab/. Or, leave it unchecked, and click Finish to return to the Add/Edit Device Profile
screen.

Edit a Profile
Only unlocked profiles are available for editing.

1. Open the Create Device Profiles tab (from the Create Device Profiles tab, click
Add/Edit).

2. In the Profile Options box, click Edit Existing.
3. From the drop-down menu, choose the profile you want to edit.
4. You can change any of the attributes that have been selected for this profile.
5. Click Save to save the change, or click Save & Exit to save changes and close the

screen.

There are two ways to edit tags:
• From this first screen, you can select a profile and then:

— Trend Tags sub-tab: choose trend intervals (to create or edit intervals, see Set
Up Trend Intervals on page 61).

— PC Based Alarms or Onboard Alarms sub-tabs: change alarm levels (this will
override the default that is set in Set Up Custom Tags on page 49).

— Onboard Alarms sub-tab: enable waveform capture for on-board alarms (see
Enable Waveforms for Onboard Alarms on page 156 for complete instructions
on enabling these waveform captures).

— Onboard Alarms sub-tab: add Alarm On and Alarm Off text. What you enter here
will override the default setting that comes from the custom tag (see Set Up
Custom Tags on page 49 for more information).

— Parameters sub-tab: Edit parameters for IEC 61850 driver parameters (see Edit
Driver Parameters on page 19 for more information).

• Click Add/Edit to progress through several screens to edit all aspects of the profile.
See the tables below for detailed instructions.

Delete a Profile
You cannot delete standard profiles or custom profiles that have been associated with
projects. To delete a custom profile that is associated with a project, you need to go to
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the Set Up Project tab.

1. Open the Create Device Profiles tab (from the Create Device Profiles tab, click
Add/Edit).

2. In the Profile Options box, click the Delete Existing radio button.
3. From the drop-down menu, highlight the profile you want to delete.
4. Click Delete.
5. At the Confirm prompt, click Yes.
6. Exit the screen.

Select Trend Intervals
Use the Select Trend Intervals screen to edit settings for existing trends for specific
device profile/tag combinations. To create new trends, see Set Up Trend Intervals on
page 61.

To change a trend interval, follow these steps:

1. On the Create Device Profiles tab, choose the device profile, then click the Trend
Tags sub-tab.

2. Locate the tag for which you want to change the trend. Click Edit.
3. At the Select Trend Intervals screen, you can select one or all of the interval

options.
4. Click OK.

Set Up Trend Intervals
For any of the trend definitions that are in the system, you can add or edit trend
intervals.

To add a trend interval:
1. Access the screen: Click Settings > Set Up Trend Definitions.
2. From the Set Up Trend Definitions screen:

a. Click New to begin adding a new trend
b. Select a trend, then click Copy to create a new trend from an existing trend.

3. Type a name: must begin with either an alpha character (A-Z or a-z) or the
underscore character (_). Any following characters must be either alpha characters
(A-Z or a-z), digit characters (0 - 9), backslash characters (\), or underscore
characters (_).

4. Type the appropriate information in the following fields. For detailed information,
see Trend Tag Properties in the citectSCADA.chm help file (Program Files>
Schneider Electric > PowerSCADA Expert > v8.2 > bin).

5. Click OK to save the new trend definition, which displays in the left-hand box.

To edit a trend interval:
1. From the Set Up Trend Definitions screen, select the trend name, then click Edit.
2. You can edit any of the fields except the trend name.

To delete a trend interval:
1. From the Set Up Trend Definitions screen, highlight the name of the trend to be

deleted.
2. Click Delete, then click Yes when you are asked to confirm.
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Edit IEC 61850 Datasets
Use this screen to add and edit IEC 61850 tag datasets to a profile. To access this
screen, display the Create Device Profiles tab for a device that includes ICD files. Click
the Parameters sub-tab, then click Edit on the DataSets line.

NOTE: Not all ICD files allow you to add, edit, or delete datasets. If all fields are greyed
out, you will not be able to change the set.

In the upper left corner are the device profile name and device type names that come
from an imported ICD file. All of the entry fields are initially greyed out. The device type
datasets (upper box) are resident in the ICD. The device profile datasets (lower box)
have been created or copied from other datasets in the device type or device profile.

Create a New DataSet

1. To begin creating a dataset, click Create New beside the Device Profile DataSets
box.

The fields on the right side of the screen become live.
2. Type a name and description for the new dataset. These are free-form fields, but

they must comply with IEC 61850 standards.
3. Choose the appropriate logical device, then choose the logical node for that

device.
4. Choose the functional constraint for the content. This will filter the display of device

type objects/topics in the box below.

When you choose All, you must then choose an object that already has a functional
constraint in it. If you choose a specific constraint, the list of available objects is
filtered to display only those that include that constraint.

5. From the Device Type Objects, choose the appropriate objects for this profile.
6. Click OK.

The new dataset is added in the lower left, to the Device Profile list.

Create a DataSet from an Existing DataSet

You can create a new dataset either from one that resides in the ICD (from the device
type) or from the device profile.

1. To begin creating a dataset from another block, click the dataset (either device type
or device profile) to be used as the starting point for the new dataset. Click Create
From.

2. Make the appropriate changes. You must change the name. All datasets in a single
profile must have unique names.

3. Click OK.

The new name displays under the Device Profile List.

Copy a DataSet to a Device Type

This feature will not typically be used. If, however, you delete a dataset from the device
type, but later decide you want to add it back, follow this procedure. (You cannot delete
datasets that are used by a report control block.)

1. From the Device Type DataSets box, highlight the dataset you want to add back.
2. Click Copy To.
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The dataset displays under the Device Type list in the Device Profile DataSets.

Edit and Delete DataSets

You cannot edit or delete datasets that are being used by a report control block or
those that belong to the device type.

To edit a dataset, highlight its name, then click Edit. Make the desired changes, then
click OK.

To delete a dataset, highlight its name. Click Delete, then click OK.

Edit IEC 61850 Report Control Blocks
Use this screen to edit report control blocks for device type information that comes from
imported ICD files. To access this screen, display the Create Device Profiles tab for a
device that includes ICD files. Click the Parameters sub-tab, then click Edit on the
Report Control Blocks line.

NOTE: Not all ICD files allow you to add, edit, or delete report control blocks. If all
fields are greyed out, you will not be able to change the set.

In the upper left corner are the device profile name and device type names that come
from an imported ICD file. All of the entry fields are initially greyed out. The device type
report control blocks (upper box) are resident in the imported ICD file. The device
profile report control blocks (lower box) have been created or are copied from report
control blocks in the device type or device profile.

Create a New Report Control Block
1. To begin creating a new report control block, click Create New beside the Device

Profile Report Control Blocks box.

The fields on the right side of the screen become live.
2. Type a name and description for the new report control block, conforming to the IEC

61850 naming conventions.
3. Choose the appropriate dataset for this block. Datasets are added/edited in the

Add/Edit DataSets screen, accessed from the Parameters sub-tab on the Create
Device Profiles tab.

4. Type a report ID, again conforming to the IEC 61850 convention.
5. ConfRev determines the version number of the report control block. 
6. If this is a buffered block (BRCB), check Buffered and enter the time and integrity

period. (Indexing is currently unavailable in PowerSCADA Expert).
7. Check the appropriate boxes for trigger conditions and report content.
8. Click OK.

The new report control block is added in the lower left, to the Device Profile list.

Create a Report Control Block from an Existing Report Control Block
You can create a new report control block either from a block that resides in the ICD
(from the device type) or from the device profile.

1. To begin creating a block from another block, click the report control block (either
device type or device profile) to be used as the starting point for the new
block. Click Create From.

2. Make the appropriate changes. You must change the name. All report control
blocks in a single profile must have unique names.

3. Click OK.
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The new name displays under the Device Profile List.

Copy a Report Control Block to a Device Type
This feature will not typically be used. If, however, you delete a report control block
from the device type, but later decide you want to add it back, follow this procedure.

1. From the Device Type Report Control Blocks box, highlight the block you want to
add back.

2. Click Copy To.

The report control block displays under the Device Type list in the Device Profile
Report Control Blocks.

Edit and Delete Report Control Blocks
You cannot edit or delete datasets that belong to the device type.

To edit a report control block, highlight its name, then click Edit. Make the desired
changes, then click OK.

To delete a report control block, highlight its name. Click Delete, then click OK.

Create Third Party Modbus Device Type
You can create a third party Modbus device and add it to your PowerSCADA Expert
project. Follow the steps below:

1. Find the Device Modbus Reference. This should be included in a document from
the manufacturer for the device you want to add.

2. Familiarize yourself with the manner that the Modbus device specification.
3. Verify the PowerSCADA Expert supports the device: The following table lists

allowed values for each data type:

Data Type Variable Size Allowed Values

String string 256 bytes (maximum) ASCII (null terminated)

Digital digital 1 bit or 1 byte 0 or 1

Long long integer 4 bytes –2,147,483,648 to 2,147,483,647

Real floating point 4 bytes –3.4E38 to 3.4E38

4. Verify that the tags you want to use are compliant with PowerSCADA Expert. To
ensure that data is reported for reporting, LiveView tables, and breaker graphics.
Refer to the Common Data Model (CDM), which is located in C:\Program Files
(x86)\Schneider Electric\PowerSCADA Expert\v8.2\Applications\AppServices\bin..

a. Find the best fit tags: From the Profile Editor tag library, find the tag that comes
closest to the quantity you want to measure.

b. Verify the tag you have chosen by comparing it with the CDM. The
DisplayName

5. Create the device type in the Profile Editor: Use PwrModbus as the driver.
6. Select the appropriate tags (CDM)
7. Configure the Modbus tags: Continuing on the Define Device Type Tags tab, edit

the tag addresses to map them to the Modbus register of the device (these tags will
be red). You can locate instructions on editing addresses in the PowerSCADA
Experthelp file.

8. Create the device profile: Click Add/Edit to launch the Add/Edit Device Profile
window. Create the new profile and choose the device(s) that you want.
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9. On the next screen, move the tags into the Selected Tags pane. Select Trend for all
tags that require it.

10. Continue with setting up the project and exporting as you do with other device
profiles.

Create a Composite Device Type
A composite device is a device profile that includes more than one device type. Each
device type can use its own protocol for communication.

With the composite device type, the user can use two devices for a single monitoring
point. For example, a circuit breaker and a monitoring device can provide data to this
single point. Because PowerSCADA Expert combines the functionality of the multiple
devices, end users only need to consider a single device when analysing a location in
their system.

Cyber Sciences Sequence of Events Recorders (SER)

For instructions on setting up and using Cyber Sciences SERs, refer to the system
technical note (STN) entitled How can I Use Cyber Sciences SERs with
PowerSCADA Expert?

Follow these steps to create the composite device type:
1. From the Create Device Profiles tab, click Add/Edit.
2. At the Add/Edit Device Profile screen, choose whether you are creating a new

device or creating from an existing device. If you are creating from a device type,
select it. Click Next.

3. Still on the Ad/Edit Device Profile screen, give the composite device type a name.
Optionally, add a description (which will become a tool tip display in later screens).
Click Next. 

4. Choose the device types to be in the composite. Click Next. 

The Add/Edit Device Profile displays with only device type tags available for
selection.

5. Add the tags you need for each device type listed on the left. To add all of the tags
for a device type, highlight the device type name and click the right green arrow.

You may find, especially when dealing with generic I/O, that the tag name is not
descriptive enough to determine what it is when reading data in runtime mode.
Thus, you may want to override the generic name with something more meaningful.

For example, a device may have ten inputs: Ind1, Ind2, Ind3, and so on. Using
those names, you have no idea what each input is reading. If you override the tag,
the tag's value will still come from the original tag (it still keeps the addressing from
the device); however the tag's appearance (name, metadata, display name) will be
taken from the new tag.

6. To override a tag:

a. Highlight the tag, then click Override Tag Name.
b. From the Select Tag window, choose the tag you want. If necessary, enter a

search term, then click Search to display related tags.
c. Choose the tag, then click OK.

Only for composite devices, the Is Device Tag check box displays. Use this box to
tie a tag back to its actual physical device. For example, you might have the same
tag in each of three devices, and you want to set PC-based alarms for each one.
Normally, the composite device would generate a single alarm, but you would not
be able to specify which physical device has the problem. To prevent confusion,
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you would check the Is Device Tag, which will cause PowerSCADA Expert to report
this tag for its physical device.

7. Check Is Device Tag to read this tag as specific to the physical device, not the
entire profile..

8. Click Next to begin selecting tags for PC-based alarms and trends.
9. For each tag in the profile, determine whether it should have a PC-based alarm

and/or trend associated with it. Check the boxes as appropriate.

When the profile is added to the project, PC based alarms are added to the Analog
Alarms or Digital Alarms file.

When the profile is added to the project, historical trends are added to the Trend
Tags file. Logging will automatically begin when the tag is added to the project.

There are two different intervals for scanning trend tags. All selected tags are
scanned every 15 minutes with FIFO storage of 12 months. For the following tags,
there is an additional “short” scanning interval of 5-seconds, with FIFO storage of
two weeks:
Current A, Current B, Current C, Voltage A-B, Voltage B-C, Voltage C-A, Power
Factor Total, Apparent Power Total, Reactive Power Total, Real Power Total, and
Frequency.

For instructions on changing the “short” scan interval settings, see Trend Tag Scan
Intervals on page 163.

10. The Driver Parameters box allows you to specify certain parameters to be attached
to device profiles. Currently used in IEC61850 devices, the available parameters
will automatically populate this box. See the illustration below for an example.

In this example, Device 2 has two parameters, DataSets and Report Control Blocks.
11. Check the parameter(s) that you want to include in this profile.

To edit, this parameter, return to the Create Device Profiles tab, and click the
Parameters sub-tab. See Edit IEC 61850 Datasets on page 62 and Edit IEC 61850
Report Control Blocks on page 63 for information on editing these two parameters.

12. Check the Close Wizard box, and click Finish to return to Create Device Profiles
tab/ Or, leave it unchecked, and click Finish to return to the Add/Edit Device Profile
screen.

Create Data Concentrator Device
When you create a data concentrator and/or a data-concentrated devices in the Profile
Editor, all of the related devices must use the same protocol. Examples of data
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concentrators are PLCs that use inputs from various devices or an RTU that
concentrates data from multiple devices.

To add a data concentrator to your project, follow these steps in the Profile Editor:
1. From the Define Device Type Tags tab, add a custom device type for the data

concentrator. Use the Generic Power Device driver.
2. Add the tags that are specific to the data concentrator (such as device date and

time).
3. Add addresses for any custom tags you created.
4. Add the data-concentrated device. Use the Generic Power Device driver, as you

did for the data concentrator.
5. Add the tags for the data-concentrated device (such as currents, voltages, and

breaker status).
6. Add addresses for these tags (or add functional addressing for them).
7. Repeat steps 4 through 6 for additional data-concentrated devices.
8. From the Create Device Profiles tab, add a device profile for each data-

concentrated device type you included.
9. From the Set Up Projects tab, add the profiles to a project.

G3200 Device Setup
Use these instructions to set up a G3200 gateway in PowerSCADA Expert.

For use with multiple devices
Before you begin, create the ICD files for each unique device type that will
communicate via the G3200.

In the Profile Editor

1. Import each unique ICD file.
2. Create the profiles for each device.
3. Modify existing profiles, as needed (adding/modifying tags, and so on).
4. Create the project that will include the GS3200 (mark profiles under the G3200 as

data concentrated devices).

a. Ensure that "Add As Default" is not checked for the project.
b. Add the first device profile.
c. At the Select Profiles screen, enter the Configured Name, and check the "Data

Is Concentrated" box.
d. Continue with steps "b" and "c" for additional device profiles.

5. Run PowerSCADA Expert and SCL exports. 

In CET850

Create the CID file for the G3200 gateway.

In PowerSCADA Expert

1. Open the I/O Device Manager.
2. To the System Devices, add an IEC 61850 data concentrator for the G3200.

a. Enter instance information screen, select the BRCBs that you need.
b. Select the CID file you created in CET850.
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c. Complete the remaining steps in the I/O Device Manager. 
3. Add a new device for each device under the G3200.

a. From the Enter instance information screen, change the logical device as
needed. Select the unit name of the G3200 device for the data concentrator.

For use with a single device
Although we recommend that you add individual G3200 devices as described in the
section above, you can also do it this way:

Before you begin, create the ICD files for the device type that will communicate via the
G3200.

In the Profile Editor

1. Import the ICD file.
2. Create the device profile.
3. Modify the profile as needed
4. Create the project, but do not mark it as Data Concentrated Devices.

In CET850

Create the CID file for the G3200 gateway.

In PowerSCADA Expert

1. Open the I/O Device Manager.
2. Add the device.

a. From the Enter instance information screen, select the BRCBs that you need.
b. Change the logical device as needed.
c. Select the CID file you created in CET850.
d. Complete the remaining steps in the I/O Device Manager. 

DNP3 Protocol Support
You can create device types and profiles that use the DNP3 protocol. See Add a
DNP3_TCP Device on page 123 or Add a Serial Device to a Project on page 120 for
more information.

You will then be able to enter DNP3 addresses, although the Profile Editor will not
verify that the address has an allowed format.

The Profile Editor will include device types, and will include profiles for ION 7650,
which natively supports DNP3. The Profile Editor will include device types for Sepam
20, 40, and 80 that have the ACE969TP module (which supports DNP3).

Set Up Projects in the Profile Editor
The Set Up Projects tab and screen are used to create separate projects for each
customer or installation. This tab makes it easy to select only the devices that are used
at that site. Project data is exported to PowerSCADA Expert for use in the Device
Creation Wizard.

To access these screens, click the Set Up Projects tab on the main Profile Editor
screen.

In this section, you can learn about:
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Project Screens and Workflow on page 69
The Set Up Projects Tab on page 70
Add, Edit, or Delete a Project on page 70
Create a Composite Device Type on page 65
Edit and Delete Information in a Project on page 72
Customize Tag Names on page 72

Project Screens and Workflow
This section contains two screens:

The Set Up Project tab has three sub-tabs:
• The Selected Device Profiles tab displays all of profiles that are included in the

Project that is displayed in the drop-down menu.
• The Customize Tag Names sub-tab provides a means of customizing individual tag

names.
• The Project Parameters sub-tab allows you to add optional lines of information

about this project. This information will be exported and can be used for verification
or identification when you want to import the project (for example, you might add a
version number or creator name).

You can click Export Project to create an .XML file that contains all of the project data
necessary for use in the I/O Device Manager. If PowerSCADA Expert is installed and
the corresponding PowerSCADA Expert project has been created, this also copies the
file that is used by the Device Creation Wizard to the PowerSCADA Expert project.

On the Add/Edit Project screen, you can add, edit, or delete projects.

Typical Workflow
To create a project file, you must first have established tags, device types, and device
profiles. Additionally, you need to set up at least one base unit/conversion template.
After these files are created, follow these steps:

1. Open the Add/Edit Project screen.
2. Add a new project, or copy and edit an existing project.
3. Select the device profiles that you want to use for this installation.
4. If a device profile has multiple drivers, choose the driver, and determine whether

the individual device types will use functional addresses and act as data
concentrators.

5. Save the project and close the Add/Edit Project screen.
6. To customize tag names: From the Set Up Project tab, click the Customize Tag

Names sub-tab. Change the name of any tag. For example, the customer might
need “Current A” to read “Current Phase A.” The customized tag name will be used
in all device profiles in the project for which you have created the customized tag.
For this change to be in the PowerSCADA Expert project: you need to delete the
device profile from that project and then re-export it.

7. To add optional project information: From the Set Up Project tab, click the Project
Parameters sub-tab. You can add optional information that will help verify or
identify this project later. You could, for example, add the version or the creator's
name. This information will be available when you import this project at a later date.

8. To refresh tags: From the Set Up Project tab, click the Selected Device Profiles sub-
tab. Click the Refresh Tags button for any profile. You are prompted to confirm that
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you want to update changes you have made to this tag for the selected profile. For
this change to be in the PowerSCADA Expert project: you need to remove the
device profile from that project and then re-add it.

9. Click Export Project to create an Equipment.Profiles file of all of the profiles
included in the project. To view Equipment.Profiles, click the folder button, to the
right of the Export button:

The Set Up Projects Tab
Use the Set Up Project tab to begin adding, editing, or deleting projects. A project
includes all of the tags that belong to the device profiles that you have created and
added to the project. From this screen you also export individual projects to the .XML
file format, which you can add via the I/O Device Manager.

This screen includes three tabs:
• Selected Device Profiles: (read only) You can view all of the profiles that are

included in each project in the system. Profiles are listed with their descriptions.
• Customize Tag Names: You can customize tag names (for example, instead of

Current A, you might need to use Current Phase A) within a single project. See
Customize Tag Names on page 72.

• Project Parameters: You can add optional information to be associated with the
export. This information can help you identify the correct project when you are
importing. See Add Project Parameters on page 72.

To add or edit project information, click Add/Edit. The Add/Edit Project screen displays.
See Add, Edit, or Delete a Project on page 70 for more information.

To export a project, select it from the Project drop-down menu, choose the export
option you want (File > Export), then click Export. See Export a Project on page 73 for
more information.

To specify a tag to be used for onboard waveform captures, click the Onboard Alarm
Tags sub-tab. Locate the tag and check the Waveform box.

To view the most recently exported project, click the folder button to the right of the
Export button:

Add, Edit, or Delete a Project
Use the Add/Edit Project screen to begin adding, editing, or deleting projects. A project
includes all of the tags that belong to the device profiles that you have created and
added to the project. From this screen you also export individual projects to the format
that can be added to PowerSCADA Expert (using the I/O Device Manager).

Adding a Project
To add a project:

1. First ensure that you have set up the tags, device types, and device profiles that you
want to include. Also, add at least one unit template.

2. Click the Set Up Projects tab, and click Add/Edit.
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3. In the Project Options box, click Create New or Create From.

If you are creating from another project, choose it from the Project to Create From
drop-down list.

4. Type a Project Name: maximum 32 characters; name must be alpha-numeric only,
must begin with an alpha character, no punctuation allowed. Do not use:

\ / : * ? < > |
5. To view a list of projects that have already been added to PowerSCADA Expert,

click the Display Projects button:

A list displays with the projects that have been added (greyed out if there are no
projects yet or if the Profile Editor is not on the same computer as the server). To
open a project for editing, select it and click OK.

6. If you want to lock the project, preventing anyone from editing it, check the Lock this
Project box. This action cannot be undone. If you wish to edit a locked project, you
must use the Create From feature to add a new one, then delete the locked one.

7. Type a Description for the project. This description displays as a tool tip when you
hover over the project name on the main Set Up Project tab.

8. Select a Unit Template from the drop-down list. Unit templates are created on the
Units screens. See Set Up Engineering Templates and Select Conversions on
page 37 for instructions on creating templates.

To add a new unit template, click Set Up Eng. Unit Templates. The Set Up
Engineering Unit Templates page displays. See Add or Edit a Base Engineering
Unit or Conversion on page 40 for help.

9. From the Device Profiles box, select the first profile you want to include in this
project.

If this device profile will NOT have functional addressing or data concentration,
check the "Add As Default" box at the bottom of the screen. (For a description of
functional addressing, see the Functional Addressing entry in Appendix 4: Glossary
on page 272.)

Click to move the device profile to the Selected Device Profiles box.
If the Select Profile Drivers screen displays, one of the following is true.
— You did not check the "Add As Default" box for a device type, so the system

does not know how to use the functional address/data concentrator option.
Check the appropriate box to turn the related option "on."

— At least one of the device types in this profile includes multiple drivers. For each
multiple-driver device type listed, choose the driver that you want to use in this
project. Additionally, you can check either of the Functional Address or Data Is
Concentrated boxes to enable those features.

10. Give the device type a Configured Name. This name might indicate its status (which
driver it uses, whether it has a functional address, and so on) in future project
references.

11. When all profiles are added, click Save to save the changes, or click Save & Exit to
save changes and close the screen.

Edit a Project
You can only edit projects that are unlocked.

To edit a project:

1. Open the Add/Edit Project tab (from the Set Up Project tab, click Add/Edit).
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2. In the Project Options box: Select the project to be edited from the drop-down list,
then click Edit Existing.

3. You can change any attribute of the project.
4. Click Save to save the change, or click Save & Exit to save changes and close the

screen.

Delete a Project
You can only delete unlocked projects.

To delete a project:

1. Open the Add/Edit Project tab (from the Set Up Project tab, click Add/Edit).
2. In the Project Options box: Select the project to be deleted from the drop-down list,

then click Delete Existing.
3. Click Delete.

Edit and Delete Information in a Project
After you have exported a project to a PowerSCADA Expert project, you still need to
use the Device Creation Wizard to add system information to the PowerSCADA Expert
project. See Before You Use the I/O Device Manager on page 117 for information
about this process.

Customize Tag Names
From the Set Up Project tab, click the Customize Tag Names sub-tab. You can add a
custom name for any tag in the system, predefined and custom tags. The customized
name will be used anywhere the original name would be used, but only for the project
that is selected in the drop-down menu. When you use the Export option, it will be used
by the I/O Device Manager.

Add Project Parameters
The Project Parameters sub-tab allows you to add optional lines of information about
this project. This information can be used for verification or identification when you
want to import the project.

To add project parameters:

1. From the Set Up Projects tab, click the Project Parameters sub-tab.
2. On the first available line, type a name and value for this information. Example: If

you want to track versions, in the Name field, you might type "Version." Then, in the
Value field, type the appropriate version for this project.

The new parameter is added. It will help you identify the project when you want to
import it into another instance of the Profile Editor.

Import and Export Project Files
In the Profile Editor, you can import and export these files:
• Export all of the tags and devices from a Profile Editor project into a project; see

Export a Project on page 73.
• Export SCL files, which allows you to export IID files that have been previously

imported from an SCL file. The IID file can then be imported into other instances of
the Profile Editor. See SCL Export on page 75.
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• Export a Profile Editor project. This makes a backup copy, which you can later
import into a different instance of the Profile Editor. This is useful when you want to
share custom tags and devices. See Profile Editor Export on page 74.

• Import a project from another instance of the Profile Editor or from an IEC61850 file.
• Import SCL files. You can import from the profile data of IEC61850-compliant

devices and create device types. These files can be exported as an IID profile or as
a PowerSCADA Expert profile.

• Import ICD files. You can import either functional constraints or report control
blocks.

The import process works the same for each type of import. The only exception is that
you cannot import profiles when you are importing SCL files. See Import Files into the
Profile Editor on page 76.

When importing data, you will need to reconcile the import information with the
information that exists in the Profile Editor.

You can also use templates, both in exporting and importing. See Using Import
Templates on page 81.

Export a Project
Use this feature to export a project from the Profile Editor into PowerSCADA Expert.

If the Profile Editor is on the same computer with PowerSCADA Expert, and if you have
created a matching project in the PowerSCADA Expert project, this process will copy
all project data—device tags, device types, and device profiles—into that project. If the
Profile Editor is not on a computer with PowerSCADA Expert, you need to manually
move the exported file to the PowerSCADA Expert server. See To Move Files if the
Profile Editor is not with the Server, below.

Before you export
If you are exporting a project for the first time to the PowerSCADA Expert project, you
need to create a matching project in PowerSCADA Expert. To do this:
1. From the PowerSCADA Studio Projects tab, add a new project. Be sure that

Template Resolution is SXGA.

If you have questions about any of the fields, click Help.
2. Add your project to the Profile Editor, ensuring that the name matches exactly the

one that you added in PowerSCADA Expert (to ensure that it correctly exports to its
matching project).

To export a Profile Editor project to the PowerSCADA Expert project:
1. Open the Set Up Projects tab.
2. From the Project list, select the project to be exported.
3. Click File > Export; then check the PowerSCADA Expert option. (The selected

export(s) are indicated beneath the Export Project button.)
4. Click Export Project.

NOTE: If you have added custom tags to devices, but the tag addressing is
incomplete, a message displays with the name(s) of the device profile(s) that
contain the tag(s). Return to the Define Device Type Tags tab. Locate any tags for
which “Edit...” is red. Click Edit... to open the Edit Address screen. Make the
necessary changes. From the Set Up Project tab, refresh the tags for those profiles.
Then try exporting again.
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A progress bar displays while the various profiles are saved. The resulting files are
exported to these locations in the Profile Editor (assuming that you accepted the
default locations during installation):
— Each Project file, used by the Profile Editor, is stored in Documents and

Settings\All Users\Application Data\Schneider Electric\Profile
Editor\v8.2\Projects.

— Each I/O Device Manager profile file is stored in Documents and Settings\All
Users\Application Data\Schneider Electric\Profile Editor\v8.2\WizardProfiles\
[project name]. A single file for each included profile.

— The Equipment.Profiles file (contains all of the I/O Device Manager profile
information and the base profile information used by the I/O Device Manager) is
stored in ProgramData\Schneider Electric\PowerSCADA Expertr\v8.2\User\
[project name].

In PowerSCADA Expert, files are located in the following folders:
— DeviceProfiles contains .XML files for every profile (these are used by the

Profile Editor).
— DeviceTypes contains .XML files for all device types (these are used by the

Profile Editor).
— Projects contains all .XML files for all projects (these are used by the Profile

Editor).
— DeviceWizardProfiles contains the exported device profiles and equipment

profiles files, organized by project (these are used by the I/O Device Manager).
5. Use the Profile Editor to add device information.

To Move Files if the Profile Editor is not with the Server (Reuse of a Pro-
ject)
When the Profile Editor is not on the same computer as the PowerSCADA Expert
server, you need to move the export file to the server computer. Follow these steps:

1. Export the project from the Profile Editor.

a. Click the folder icon beside the Export link:

b. Copy the file (Equipment.profiles) that displays and move it to a portable drive.
2. On the PowerSCADA Expert server computer, paste Equipment.profiles in this

location:

[Drive Letter]:\Documents and Settings\All Users\Application Data\Schneider
Electric\PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards\User\
[Project]

where:

[Drive Letter]: is the drive on which you installed the PowerSCADA Expert server

the Application Data and ProgramData folders cannot be hidden (set the folder
view for “view hidden folders”)

[Project] is the name of the project you are creating; you must have already added
this project to PowerSCADA Expert (see Before you export, above).

3. Use the I/O Device Manager to begin adding device information to the
PowerSCADA Expert project.

Profile Editor Export
To back up a project file, see PowerSCADA Expert Backup on page 158.

© 1990–2017 Schneider Electric All Rights Reserved 74



Use this procedure when you want export (back up) a Profile Editor project for re-use in
another instance of the Profile Editor. This is useful when you have custom tags and
custom devices that you want to share in other projects. After you export the project,
you can use the Import feature to apply this project to another version 7.20 or later
Profile Editor project.

1. From within the Profile Editor, click the Set Up Projects tab.
2. From the Project drop down box, select the project you want to back up.
3. Click File > Export, then ensure that the Profile Editor Export option is checked.
4. See Customize Tag Names on page 72 and Add Project Parameters on page 72

for the information you need to make the changes that you want.
5. Click Export Project.

Exported projects will include, in addition to the project data:
• a unique project name, the date of the export
• the name of the computer to which it was saved
• the (optional) description added when the source project was created.

The project (which will be named YOUR PROJECT.pls) is exported to the following
location:

C:\Program Data\Schneider Electric\PowerSCADA Expert\v8.2\Applications\Profile
Editor\Projects\YourProjectName.pls.

SCL Export
Use this feature to export IID files (previously imported from an SCL file). The IID file
can then be imported into other instances of the Profile Editor.

This process does not correct any errors in the files. If the imported file was an IID file
from a different instance of the Profile Editor, it will contain the same configuration and
communication information as the original. If the imported file was a Gateway SCL file
with multiple devices, you can export each device as a separate IID file (the
configuration and communication information is taken directly from the Gateway SCL
file).

The only ways you can edit these files are:
• You can delete data sets, and then add new ones.
• You can edit report control blocks (buffered or unbuffered).

Perform these edits in the device profile before you export, and they will be exported to
the IID file.

Exporting the File
Follow these steps to export IID files:

1. From the Set Up Projects tab, select the project from which you want to export. (The
project must have devices that include ICD files.)

2. Click File > Export; then check the SCL Export box.

NOTE: The export(s) that you select display beneath the Export Project button, on
the right side of the screen.

3. Click Export Project.

The Export Summary displays with the results of the export. When the export displays
under the Success topic, the listed files were exported. When the export displays under
the Warnings topic, the reason that the export did not succeed is listed for the device
types shown.
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The exported files, listed according to their device types, will be saved in: 

[Project Drive]\Program Data\
SchneiderElectric\PowerSCADA Expert\v8.2\Applications\Profile
Editor\WizardProfiles\<project name>\SCL Export\sclFileName.iid).

Import Files into the Profile Editor
Use this feature to import either an existing project or SCL files into the Profile Editor.
This is commonly used to share project information by importing custom tags and
devices from another instance of the Profile Editor; but you can also import SCL files
from an IEC 61850 device.

For Profile Editor projects, you can import tags, device types, and profiles. For SCL
imports, you cannot import profiles.

NOTE: You cannot complete the import until you match, merge, or reject every item.

Follow these steps to import data into the Profile Editor:

1. Before you begin, consider the source of the information you want to import. We
strongly recommend that you use a master PC from which you draw this
information. This will ensure that you are using a single source. Also, back up your
data folder before you start. This gives you data to revert to, in case you
accidentally lose data.

2. Note the location of the project file or other file (SCL, CID) that you want to import.
3. From the Profile Editor, click File > Import.
4. At the Import File Selection window, click browse (  ), then navigate to the

location of the file you want to import.

The Import Properties box displays the _ProjectName, _Description, _DateTime,
and _ComputerName information. These lines were automatically generated for
this file. Any additional lines will be information that you added on the Project
Parameters sub-tab when you created or exported the project.

Use this information to verify that you are about to import the files that you want.
5. If desired, select an import template from the drop down list. (To create a template,

see Creating a New Template During Import in Using Import Templates on page
81.) If you select a template, the import will accept default properties from the
template. For example, if the template has alarm settings from a device, and you
are importing tags for that device, the import will use those alarm settings.

6. When you locate the desired file, click Open to choose it. Then click Start Import.

The system analyses the import and attempts to match imported items with existing
items on the local machine.

If you are importing a .pls file, skip to step 8.

If you are importing IEC 61850 data, the Import Filter screen displays. Use this
screen to perform an initial filter on functional constraints or on report control
blocks. SeeImport Reconciliation Screen on page 78 for more information.

7. Make your selections, then click Continue.
8. When the Import Reconciliation screen displays, you can begin the process of

matching or rejecting individual tags.See Import Reconciliation Screen on page 78
for a description of the parts of this screen.

9. On the Import Reconciliation screen, click an item in middle pane. Respond to the
item according to your preference for it. You must set the status first for units, then
tags, and finally the device type.
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10. After you match or ignore all items in the import list, the Complete Import button
becomes live. Click Complete Import.

After the import is saved, the Save Import Template dialog displays. See Using
Import Templates on page 81 for instructions on creating, using, and deleting
import templates.

Import SCL Files
You can import SCL files from individual devices, provided the files conform to
IEC61850 specifications. You can also import an individual device from a Gateway
SCL file that contains multiple devices.

NOTE: You can only import SCL files that meet the schema requirements for Ed 1.4 of
IEC61850. If an SCL file does not meet these requirements, an error message will
display, telling you that the scheme must validate against the scheme of Ed. 1.4. The
Profile Editor will accept SCL files that use either Ed. 1 or Ed. 2 data structures; but it
will apply data structures only as defined in Ed. 2.

During this import, you need to reconcile mismatches; and data will be available for
creating device types, device profiles, and projects. If you import an SCL for a PM700,
note that all tags for date and time are excluded by default.

You can save the information in one of two ways:
• IID file: This IID file will maintain all of the configuration and communication

information that comes from its device. The only items you can change are:
— You can delete datasets and control blocks, and add new ones.
— You can edit buffered and unbuffered control blocks (provided you have created

them in the Profile Editor).
• PowerSCADA Expert profile: The data will then follow the normal rules for the

profiles in this project.

Import Filter Screen
This screen displays after you choose an IEC 61850 file to import (.ICD, .CID, or .IID
extension) and click Start Import. Use this screen to begin filtering data for import. You
choose whether to filter on functional constraints or report control blocks.

Functional Constraints
1. Click the Functional Constraint button.
2. Choose the functional constraints that you want to include.

The filters the list of devices for which you will import data to those that contain one
or more of the selected functional constraints.

3. Check the device(s) that you want to include.

Report Control Blocks
1. Click the Report Control Block button.

The list of devices and their related report control blocks that are included in the
import file displays in the middle column.

2. Check the devices and/or related report control blocks that you want to include in
the import. If you check a device, all of the report control blocks under it are
included.

The right-hand column displays the IEDs/report control blocks that you have
selected.
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NOTE: Use the filter above the middle pane to search. You can enter partial names
separated by dots to further shorten the list.

The figure below illustrates an example in which a search was done first on "bcu"
and then on "incomer" (note that entries are not case sensitive). The search string
would be:

bcu.incomer

The result would look something like this:

When you have selected either the functional constraints or report control blocks, click
Continue. The data is filtered on the last filter option that you chose (you cannot
combine filters).

The Import Reconciliation screen displays. See Import Reconciliation Screen on page
78 for help finishing the import.

Import Reconciliation Screen
Use the Reconcile Import Screen to find matches for the items you are importing and to
filter import tags to determine whether items are matched or not matched. The first
figure below shows the screen before import is complete. The second one shows the
results after import has been completed.
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The screen is divided into three panes:

Left-hand pane:
The selections made in this pane provide an initial filter for what you view in the middle
pane (see below). The tree view at the top shows the imported file data categories:

For .pls files imported from the Profile Editor, the categories are: device
profiles, device types, tags, and units.

For IEC61850 files, the categories are: Data, Datasets, Unbuffered Reports,
Buffered Reports, and GOOSE.

Select a category to filter the list in the middle pane to only the items belonging to that
category.

To further filter the middle pane, click one of the matched status lines (matched,
partially matched, unmatched) to view only items of that status. The number of items in
that status also displays.
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Middle pane:
This pane shows a tree view with data.

Filter: To filter on a specific item, type the name (such as phsA for phase A current).
The entry can be the exact name, or you can enter a partial name or even a wildcard
(*). The filter is not case sensitive.

The data in the middle pane is filtered to include only the items for the tag you specify.
To clear the filter so you can enter a new one, click the "x" beside the filter box.

Collapse All/Expand All: Click Collapse All to collapse all nodes on the screen.
Only the top-level nodes will display. Conversely, click Expand All to open all nodes,
displaying all of the information on all nodes.

The bottom section of the middle pane displays, in tree form, the data that you selected
in the left-hand pane:
• For files imported from the Profile Editor (.pls files), you can view: Show All, Device

Profiles, Device Types, Tags, and Units.
• For IEC 61850 files, you can view: Data, Datasets, Unbuffered Reports, Buffered

Reports, and GOOSE.

The bullets indicate:

: exact match; item is either a perfect match to a local item, or you accepted a

merge for it

: unverified match; item is a partial match to a local item

: no match; item does not match any local item

Items that have no icon beside them are ignored during the import.

Re-match Items within a Logical Node

Because IEC 61850 tags are often imported with prepended information (logical node:
LN) that prevents the import from matching them, you may find several unmatched
items. You can use the re-match feature to enable matching for them.

To do this, right-click the logical node where the unmatched items are found, and
choose Re-match.

The import feature will then exclude the logical node, and use the remaining
information in the item name to find matches. In the screen shown above, it would
include functional constraint (FC) ST, data objects (DO) PhyHealth and Proxy, and
five data attributes below them:

ST.PhyHealth.q

ST.PhyHealth.t

ST.Proxy.q

ST.Proxy.stVal

ST.Proxy.t

Right-hand pane:
This pane illustrates the status of each of the tags. Click a tag and read the information
for it:
• Property: The property for which the other columns provide definitions.
• Imported: The value of the item in the import file.
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• Local: The closest local match for the imported item.
• Result: The item as it will be added in this import; by default, this item is inherited

from the local status.

New: At the bottom of the list, click this button to add an item as a custom topic. The
Add/Edit Custom Tag screen displays for you to create the tag.

Force Edit: Check Force Edit to display a screen that lets you edit the item's
information. You can make changes to an item, even though it may be an exact match
with a local item. This new information will be applied to the item after you complete the
import.

Select: After importing, you can manually match an unmatched item. To do this,
highlight the tag in the middle pane, the type matching information in the Search field
in the upper right corner of the screen. Choose the matching item and click Select. This
yields an unverified match (yellow bullet). To confirm the match, click Match on the
right.

Complete the Import
1. Right click the first item that you want to review/change in the middle pane, then

select the option for how you want the import to handle this item. Each item's status
controls the options you will see:

Item Status Right-Click Options Description

Ignored New
The custom tag screen opens for you to add the
attributes for a new tag.

Unmatched Ignore, New

Ignore: Changes the status so that the import will
exclude this tag.

New: The custom tag screen opens for you to add the
attributes for a new tag.

Matched
Ignore,
Set to Unmatched

Ignore: The import will exclude this tag.

Set to Unmatched: The tag is no longer matched; but
the import will not succeed. All unmatched tags must
bematched or ignored before you complete the
import.

Partial Match
Ignore,
Set to Unmatched, Match

Ignore: The import will exclude this tag.

Set to Unmatched: The tag is no longer matched; but
the import will not succeed. All unmatched tags must
bematched or ignored before you complete the
import.

Match: The tag attributes will change to the
information you see in the Results column.

2. Continue through all of the items until you have set the match status for each one.
3. Click Complete Import.

Using Import Templates
You can create, edit, and apply templates when you import files. You can also delete
import templates. A template will include tags that you import into the Profile Editor from
a project in another instance of the Profile Editor, or it will contain ICD files from an IEC
61850 device.

You will want to create a template for custom situations, like when you are importing
SCL files or adding custom tags and devices.
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Creating a New Template During Import
To create a new template:

1. From the either type of import (Profile Editor or SCL), choose the file (.pls or .icd)
that you want to import.

2. Complete the matching for the items.
3. Click Complete Import.
4. At the Save Import Template prompt, click Yes.
5. Click the New radio button, then type a name for the new template. The name must

begin with a letter. It can contain alpha-numeric characters, as well as dashes and
spaces. Click OK to save it.

In future imports, you will be able to apply this template. When you do, the system will
automatically match, where appropriate, the import items with the local items.

Applying a Template During Import
In this procedure, you will import files, and you will either create a new import template,
or you will edit an existing one.

NOTE: Be careful when applying a template: you will overwrite an existing template on
the local computer with the information that you choose during matching. Once
completed, you cannot undo this.

To apply an existing template:

1. From the Set Up Projects tab, select a project for which you want to import data.
2. Click File > Import, then choose the file (.pls or .icd) that you want to import.
3. From the Import Template drop down list, choose the template you want to use. This

is just a starting point for this import to make it quicker to match items. You will apply
the template in step 7.

4. Click Start Import.

After the import completes, the Import Reconciliation screen displays. The list in the
left-hand pane should have some exact and partial matches.

5. As you work through the items, you must either designate that each a match or
ignored.

6. When all items are completed, click Complete Import.
7. At the Save Import Template dialog, click No to import without applying a template.

Or click Yes to either save a new template or edit the one you chose in step 3:
— To create a new template for this import, click New, then type an Import

Template Name.
— To edit a template, click Edit, then select the template from the drop down menu.

This will edit the template by adding the changes you made during matching.
This cannot be undone after you click OK.

8. Click OK.

The import is completed, and the new template is created, or the existing template is
edited to include the changes you made during matching.

Deleting a Template
You can delete any import template, even if it was applied during a previous import.

To do this:

1. Click Settings > Remove Import Templates.
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2. At the Import Templates dialog, select the template you want to delete, then click
Delete.

The template is deleted.

Tag Types
This product includes a variety of tag types: real-time, alarm, and trend. Most of the tags
that you will need are already added. However, you can add custom tags to suit
special needs. This section describes how tags are constructed and provides further
specific information about the construction of format codes, logic codes, and
addresses.

In this section, you can learn about:

IEC 61850 Tag Construction on page 83
Define an Enumeration on page 84
Format Code Definitions on page 85
Logic Codes on page 87
Block Writes on page 98

IEC 61850 Tag Construction
IEC 61850 tags are flexible, which allows them to specify how functions are
implemented in devices. The IEC 61850 tag was developed for medium-voltage and
high-voltage applications, such as monitoring, control, and substation automation.

Some of our devices include data and functionality that are not yet covered by IEC
61850. For these devices, the general IEC61850 formatting was followed when
creating tags.

If you are writing Cicode (see Use Cicode to Customize a Project on page 159). You
will need to know the IEC 61850 tag name that you added to the device profile for that
device. You can print the .csv file to view tag names (see Print the .CSV File on page
47). Apart from that, you would only need to add tags if you are installing a third-party
device that is not standard to PowerSCADA Expert. If you do need to add tags, create
any category you wish, and follow the format shown below.

Tags shall be no longer than 29 characters. Use a backslash as a separator between
tag parts. Tags are constructed in this manner:

EquipmentName\Logical_Node\Data Object\Data Attribute (may have more than one)

The following table lists the main categories for the common logical nodes. After the
table, the most commonly used category (Mxxx: metering and measurement) is
described.

Category
Name Description

Axxx automatic control; e.g., ATCC (tap changer), AVCO (voltage control)

Cxxx supervisory control; e.g., CILO (interlocking), CSWI (switch control)

Gxxx generic functions; e.g., GGIO (generic I/O)

Ixxx interfacing/archiving; e.g., IARC (archive), IHMI (HMI)

Lxxx system logical nodes; e.g., LLNO (common), LPHD (physical device)

Mxxx
metering andmeasurement; e.g., MMXU (measurement), MMTR (metering), MSTA (metering
statistics), MSQI (sequence and imbalance), MHAI (harmonics and interharmonics)
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Category
Name Description

Pxxx
protection; e.g., PDIF (differential), PIOC (instantaneous overcurrent or rate of rise.), PDIS
(distance), PTOV (time-overvoltage)

Rxxx protection related; e.g., RREC (auto reclosing), RDRE (disturbance)

Sxxx sensors, monitoring; e.g., SARC (arcs), SPDC (partial discharge)

Txxx instrument transformer; e.g., TCTR (current), TVTR (voltage)

Xxxx switchgear; e.g., XCBR (circuit breaker), XCSW (switch)

Zxxx other equipment; e.g., ZCAP (cap control), ZMOT (motor)

The following example illustrates the IEC 61850 tag for current A:

EquipmentName\MMXU1\A\PhsA

where:

M = the category

MXU = measurement of currents, voltages, power, and impedances

1 = the instance (there could be multiple MMXU tags)

A = the data object, current

PhsA = the attribute that further defines the data object, phase A

All of the tags that are currently used in the system can be viewed from the Profile
Editor, Define Device Type Tags tab. Click Settings > Display Advanced Properties to
display the full tag names.

Define an Enumeration
An enumeration is a single value (0-15) that is used to define a condition that is
determined by multiple-bit input. You will add enumerations to handle scenarios that
are more complicated than simply true-false, to allow for dynamic contingencies. For
example, when you need to use multiple bits to describe the position of a circuit
breaker, you might do the following:

Bit y (closed) | Bit x (open). Note that the least significant bit is register 1.

Bit x | Bit
y Status Circuit Breaker Position Returned

Value

0 | 0 Indeterminate Circuit breaker is neither open nor closed 0

0 | 1 Open Circuit breaker is open. 1

1 | 0 Closed Circuit breaker is closed. 2

1 | 1 Error
Circuit breaker is reporting both open and closed
condition.

Possible device/wiring error
3

Using the enumerated status, we place the register and bitmask for the open position
in register 1 (least significant) and the register and bitmask for the closed position in
register 2 (most significant).
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Use Special Tags to Control Circuit Breaker Status
When you want to include a device that does not have a pre-defined device profile
(such as a third-party circuit breaker), you must identify the registers that the device
uses for the operations you want, then choose the correct tags and tag addresses to
write to these registers. Finally, when creating the one-line on the graphics page, you
will choose the appropriate genie:

1. Determine the device registers used for the open and close operations on the
circuit breaker.

2. In the Profile Editor, choose the tag needed for each operation.
3. Ensure that tag address references the correct action and register(s). See Edit Tag

Addresses on page 52 for instructions on editing the address,
4. When adding a genie for the circuit breaker on the graphics page, choose from the

default library (see Appendix 1: Default Genie Library on page 239), or create a
custom genie (see Create New Genies on page 115).

Format Code Definitions
The address field is part of the tag. It includes a variety of attributes, some of which are
required, and some optional. The following tables list the attributes, whether they are
required, and their possible modifiers. All parts of a tag are case sensitive. The order of
the fields is fixed; and all fields are separated by semi-colons. See Logic Codes on
page 87 for templates of constructed tags.

Real-Time Format Code Definitions

Attributes Modifiers Comments

T (type)

Required

SS = single status

DS =double status
enumeration

ST = string

UT =UTC time

MV =measured value
(float)

CM =complex
measured value (float)

BC =binary counter
(integer)

Temporarily, this may return a string; when PowerSCADA
Expert is upgraded to handle large integers, this will change.

D (module—
Micrologic devices)

B =BCM

P=PM

M =MM

C =CCM

M/m/S/s/C/c/I/i
(register type)

M =holding registers in
hexadecimal

m =holding registers in
decimal

S = input coil (status
register) in hexadecimal

s = input coil (status
register) in decimal

C =output coil (writable
only) in hexadecimal
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Attributes Modifiers Comments

c = output coil (writable
only) in decimal

I = input register (read
only) in hexadecimal

i = input register (read
only) in decimal

Register Number
Modifiers (register
number from 1–4)

u## =## registers are
unsigned, ## is a
decimal

s## = ## registers are
signed; ## is a decimal

After themodifier, theremay be a number indicating scaling
factor. See “V,” below in this table. Used for conversion to SI
units, this number will be:

RegisterValue x scale

For SS and DS: theremust be a 1U default; themodifier will
be a bitmask:

- Themask must use hex only, 16 bits/register

- Attach the ones, then the zeromask, to the register; if
you only have ones masks, just attach them

- Only one register cases can be inverted. Add :I after the
masks for inversion.

N (scale)
numerical entries;
range is -10 to 10

N defines a constant scale; the logic code knows how to use
it.

R (scale register) the register number in
decimal

R defines the holding register where the scale is held; the
logic code knows how to use it.

E (priority)

single digit: 1, 2, or 3;
default 2 is used if this
is not included

(1 = high, 2 = normal, 3
= low)

Defines the priority PowerSCADAExpert uses in processing
data.

V (conversion factor)
Use scientific notation
without the decimal.

Examples: 354E-3 = 0.354

354E1 =3540
Will bemultiplied before the value is returned.

L:P (logic code)

Required The number that is
used comes from the
Logic Codes table.

L:P is the logic code for PowerLogic. Other codes may
follow, such a L:I for ION.

For logic code descriptions, see Logic Codes on page 87

Alarm Format Code Definitions

Attributes Modifiers Comments

T (type)

Required
ALM =alarm

D (module—optional for
Micrologic devices)

B =BCM

P=PM

M =MM

C =CCM

BCM is straight addressing, and
therefore, optional.

F (file)

Required
File number will be in decimal, up
to 5 digits

Q (unique ID)

Required
Unique ID will be in decimal. This number can be huge.

Control Format Code Definitions Rules of Operation
These rules are true for predefined and custom codes:
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Address structure Result

C:N;(action) If 1, perform action. If 0, undefined.

C:N;(action1);(action2)

C:NO;(action1);(action2)
If 1, perform action1. If 0, perform action 2.

C:NC;(action1);(action2) If 1, perform action2. If 0, perform action1

Predefined Control Format Codes

Attributes Modifiers Comments

C (command)

Required

NO=normally open

NC =normally closed

N =normal operation Normal operation does not have a closed/open status.

OPERATE (command word) n/a Two required for NO and NC.

Predefined Reset Format Codes

Attributes Modifiers Comments

Reset (command word) n/a Entering a one to this tag causes the reset to take place.

Custom Control and Reset Format Codes

Attributes Modifiers Comments

C (command)

Required

NO=normally open

NC =normal closed

N =normal operation
Normal operation does not have a
closed/open status.

Followed by one or two entire “write” addresses; used only for logic codes 101, 102, 103. For logic code
descriptions, see Logic Codes on page 87.

Write Address format: T:SS;m:##:#;L.:P:101

Example: C:NO;T:SS;m:1234:1;L:P101;T:SS;m:3456:1;L:P101

Logic Codes
Logic codes tell the PowerSCADA Expert program how to mathematically operate on
the values in device registers to give users the desired values. The following table lists
each logic code with its related information.

Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

READS

Invalid
Block

(L:P:0)

IB LONG

Up to
1,000
sequenti
al
register
s

No
Generic
only

Defines invalid blocks of memory in the
device. The driver does not include
these registers in block reads.
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

Date /
Time
(L:P:1)
(3
register)

UT LONG

3
sequenti
al
register
s

No
Generic –
if it fits

Register N:

High byte =Month 1–12
Low byte =Day 1–31

Register N+1:

High byte =Year 0–199 (+1900)

Low byte =Hour 0–23

Register N+2:

High byte =minutes 0–59
Low byte = seconds 0–59

Date /
Time
(L:P:2)
(6
register)

UT LONG

6
sequenti
al
register
s

No
Generic

- if it fits

Register N: Seconds 0–59

Register N+1: Minutes 0–59

Register N+2: Hours 0–23

Register N+3: Day 1–31

Register N+4: Month 1–12

Register N+5: Year 0–199 (+1900)

Date /
Time
(L:P:3)
(3 or 4
register
--Circuit
Monitor/
Power
Meter)

UT LONG

3 or 4
sequenti
al
register
s

No CM/PM

Register N:

High byte =Month 1–12,
Low byte =Day 1–31

Register N+1:

High byte =Year 0–199 (+1900)

Low byte =Hour 0–23

Register N+2:

High byte =minutes 0–59
Low byte = seconds 0–59

Register N+3:

msec = 0–999 (unused)

Date /
Time
(L:P:4)
(3 or 4
register
s
SEPAM)

UT LONG

3 or 4
sequenti
al
register
s

No SEPAM

Register N:

Bits 0–6 =Year: 0 –70 (2000– 2070)

71 – 99 (1971–1999)

Register N+1:

Bits 8-11 =Month

Bits 0-4 =Day

Register N+2:

Bits 8-12 =Hour

Bits 0-5 =Minutes

Register N+3: msec = 0-59,999
(seconds arems/1000)

Date/Ti
me

(L:P:5)

3-
register
Microlog
ic

UT LONG

3
sequenti
al
register
s

No micro

Register N:

High byte =Month 1–12,
Low byte =Day 1–31

Register N+1:

High byte =Year 0–69 (+2000), Year 70–
99 (+1900)

Low byte =Hour 0–23

Register N+2:
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

High byte =minutes 0–59
Low byte = seconds 0–59

Date/Ti
me

(L:P:6)

4-
register
Microlog
ic

UT LONG

4
sequenti
al
register
s

No micro

Register N:

High byte =Month 1–12,
Low byte =Day 1–31

Register N+1:

High byte =Year 0–69 (+2000), Year 70–
99 (+1900)

Low byte =Hour 0–23

Register N+2:

High byte =minutes 0–59
Low byte = seconds 0–59

Register N+3:

msec = 0–999 (unused)

Date/Ti
me

(L:P:7)

3-
register
Argos

UT LONG

3
sequenti
al
register
s

No Argos

The number of seconds since
01/01/2000 (00:00:00)

register 1 =MSB

register 2 = LSB

register 3 =milliseconds

Date/Ti
me

(L:P:8)

4-
register
IEC
870-5-4

UT LONG

4
sequenti
al
register
s

No generic

Register N:

Bits 0–6 =Year: 0 –127 (2000– 2127)

Register N+1:

Bits 8-11 =Month

Bits 0-4 =Day

Register N+2:

Bits 8-12 =Hour

Bits 0-5 =Minutes

Register N+3: msec = 0-59,999
(seconds arems/1000)

Modulo
10k
(L:P:10)

BC STRING
Up to 4
register
s

No generic

Result is a string representation.

Range is 0 to 9,999,999,999,999,999

Each register has a range of 0 to 9,999

Result is:
– R4*10,000^3 +R3*10,000^2 +
R2*10,000 +R1

Modulo
10k Val

(L:P:11)
BC REAL

Up to 4
register
s

No generic

Result is a string representation.

Range is 0 to 9,999,999,999,999,999

Each register has a range of 0 to 9,999

Result is:
– R4*10,000^3 +R3*10,000^2 +
R2*10,000 +R1

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

Modulo
10k
Energy

(L:P:12)

BC STRING
Up to 4
register
s

No generic

Result is a string representation.

Range is 0 to 9,999,999,999,999.9

Each register has a range of 0 to 9,999

Result is
– (R4*10,000^3 +R3*10,000^2 +
R2*10,000 +R1)/1000

Modulo
10k
Energy
Val

(L:P:13)

BC REAL
Up to 4
register
s

No generic

Result is a string representation.

Range is 0 to 9,999,999,999,999.9

Each register has a range of 0 to 9,999

Result is
– (R4*10,000^3 +R3*10,000^2 +
R2*10,000 +R1)/1000

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

PL
Digital
Input SS

(L:P:20)

SS LONG
2
register
s

No CM/PM

First register (100–199 inclusive)
indicates that this is a digital input
register.

Second register is masked to test for
either one 1 or one 0.

Result is: 0 = off and 1 =on.

This result can be inverted.

PL
Digital
Input
DS

(L:P:21)

DS LONG
2
register
s

No CM/PM

Same as PLDigital Input SS except:

Result is 0 = intermediate, 1 = off, 2 = on,
3 = bad-state.

Inversion will invert only off and on
states.

PL
Digital
Input TF

(L:P:22)

SS DIGITAL
2
register
s

No CM/PM

Same as PLDigital Input SS except:

Result is: 0 = false and 1 = true.

This result can be inverted.

PL
Digital
Output
SS

(L:P:23)

SS LONG
2
register
s

No CM/PM

First register (200–299 inclusive)
indicates that this is a digital output
register.

Second register is masked to test for
either one 1 or one 0.

Result is: 0 = off and 1 =on.

This result can be inverted.

PL
Digital
Output
DS

(L:P:24)

DS LONG
2
register
s

No CM/PM

Same as PLDigital Output SS, except:

Result is:
0 = intermediate, 1 = off, 2 = on, 3 = bad-
state.

Inversion will invert only off and on
states.
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

PL
Digital
Output
TF

(L:P:25)

SS DIGITAL
2
register
s

No CM/PM

Same as PLDigital Output SS except:

Result is: 0 = false and 1 = true.

This result can be inverted.

Status
SS
(L:P:26)

SS LONG
Up to 4
register
s

No Generic

Each register is compared to a ones’
mask. Optionally it can be compared to a
zeros’ mask. (Use the Edit Address
screen in the Profile Editor to create
masks for the user.)

Result is: 0 = off and 1 =on.

If there is only one register, the result
can be inverted.

Status
OR SS

(L:P:22
6)

SS LONG
2 to 4
register
s

No Generic

Each register is compared to a ones’
mask. These results are OR’ed
together. Optionally, it can be compared
to a zeros’ mask. (Use the Edit Address
screen in the Profile Editor to create
masks for the user.)

Result is: 0 = off and 1 =on.

Status
DS
(L:P:27)

DS LONG
Up to 4
register
s

No Generic

Same as Status SS except:

Result is: 0 = intermediate, 1 = off, 2 =
on, 3 = bad-state.

Inversion will invert only off and on
states.

Status
OR DS

(L:P:22
7)

DS LONG
2 to 4
register
s

No Generic
Same as Status OR SS except:

Result is: 0 = intermediate, 1 = off, 2 =
on, 3 = bad-state.

Status
TF
(L:P:28)

SS DIGITAL
Up to 4
register
s

No Generic

Same as Status SS except:

Result is: 0 = false and 1 = true.

This result can be inverted.

Status
OR TF

(L:P:22
8)

SS DIGITAL
2 to 4
register
s

No Generic
Same as Status OR SS except:

Result is: 0 = false and 1 = true.

Status
Int
(L:P:29)

BC LONG
1
register

No CM/PM

One register is bit anded with onemask.
The result will be an integer that can be
used to choose the appropriate
enumeration.

Status
Enumer
ation

(L:P:22
9)

EN LONG
1 to 4
register
s

No Generic

Each register is compared to a ones’
mask. Optionally it can be compared to a
zeros’ mask. (Use the Edit Address
screen in the Profile Editor to create
masks for the user.)

Result is a combination of the results for
each register, using this formula:
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

result for register 1 * 2^0 + result for
register 2 * 2^1 +
result for register 3 * 2^2 + result for
register 4 * 2^3

PL
Analog
Input

(L:P:30)

MV/
CM

REAL
3
register
s

No CM/PM

First register (300–399 inclusive)
indicates that this is a analog input
register.

Second register is treated as a signed
value.

Third register can contain a value from –
3 to 3 and will be used to scale the
second register (R2*10^R3).

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Breaker
Rack
Status

(L:P:23
0)

EN LONG
2 to 3
register
s

No Generic

Register 1 = breaker racked in

Register 2 = breaker racked out

Register 3 = breaker in test (optional)

Results:

0 = racked in

1= racked out

2 = test

3 = error

4= in between positions

PL
Analog
Output

(L:P:31)

MV/
CM

REAL
2
register
s

No CM/PM

First register (400–499 inclusive)
indicates that this is a analog output
register.

Second register is treated as a signed
value.

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Scaled
Register
Signed

(L:P:32)

MV/
CM

REAL
1 or 2
register
s

Either

(optiona
l)

Generic

For a single register: treated as a signed
value from
–32,767 to +32,767. (-32768 will result in
a NA)

For two registers: the registers will be
concatenated together, the first register
filling bits 16–32 and the second register
filling bits 0–15. Values will range from

–2,147,483,648 to –2,147,483,647.

Values can be scaled using a fixed scale
or a scale register.

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

Scaled
Register
Unsigne
d

(L:P:33)

MV/
CM

REAL
1 to 4
register
s

Either

(optiona
l)

Generic

For a single register: treated as an
unsigned value from 0 to 65,535.

For two registers: the registers will be
concatenated together, the first register
filling bits 16–32 and the second register
filling bits 0–15. Values will range from

0 to 4,294,967,295.

Values can be scaled using a fixed scale
or a scale register.

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Scaled
Register
Signed
NoNA

(L:P:34)

MV/
CM

REAL
1 or 2
register
s

Either

(optiona
l)

Generic

Same as Scaled Register except that a
single register with value -32768 is
acceptable and will be reported as such.

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Scaled
Register
Signed
SEPAM
A

(L:P:35)

MV/
CM

REAL
2
register
s

Either

(optiona
l)

Generic

Same as Scaled Register except that
0xFFFFFFFF or 0x00007FFF will be
NA.

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Scaled
Register
Signed
SEPAM
B

(L:P:36)

MV/
CM

REAL
2
register
s

Either

(optiona
l)

Generic

Same as Scaled Register except that
0xFFFFFFFF will be NA.

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

IEEE 32
Real

(L:P:37)

MV/
CM

REAL

2
sequenti
al
register
s

No Generic

Uses the IEEE standard for floating-
point arithmetic (IEEE 754);

register 1 is MSB, register 2 is LSB

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Scaled
Register
Signed
SEPAM
2000
Format
B

(L:P:38)

MV/
CM

REAL
1
register

Either

(optiona
l)

Generic

For a single register: treated as a signed
value from
–32,767 to +32,767:

From the value of the unsigned register,
subtract 32768; then apply the scale.

0000 or FFFF will be NA.

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

PL
String
(L:P:39)

ST STRING

1 to 10
sequenti
al
register
s

No Generic
Each register can represent up to two
ASCII characters.

Sum
Register
s
(L:P:40)

MV/
CM

REAL
1 to 4
register
s

Either

(require
d)

Generic

Result is:

R1 +…+Rn * 10^scale

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Divide
Register
s

(L:P:41)

MV/
CM

REAL
3
register
s

Either

(require
d)

Generic

Result is:

R1/R2 * R3 * 10^scale

If R2 is zero, result will be #COM

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Multiply
Register
s

(L:P:42)

MV/
CM

REAL
1 to 4
register
s

Either

(require
d)

Generic

Result is:

R1 * … * Rn * 10^scale

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Average
Register
s

(L:P:43)

MV/
CM

REAL
1 to 4
register
s

Either

(require
d)

Generic

Result is:

Avg(R1…Rn) * 10^scale

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Average
Register
s WF

(L:P:44)

MV/
CM

REAL
2 to 4
register
s

Either

(require
d)

Generic

Result is:

Avg(R1…Rn-1) * Rn * 10^scale

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Sum
with
Scale

(L:P:45)

MV/
CM

REAL
2
register
s

Either

(require
d)

CM/PM

Result is:

(R1 * 10^scale) +R2

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Sum
with
Scale
Unsigne
d
(L:P:46)

MV/
CM

REAL
2
register
s

Either

(require
d)

CM/PM

Result is same as above, except
unsigned.

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

Vector
Math

(L:P:47)

MV/
CM

REAL
2
register
s

Either
(require
d)

Generic

Result is:

sqrt (R1^2 +R2^2) x scale

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Vector
Math
IEEE

(L:P:48)

MV/
CM

REAL
4
register
s

Either
(require
d)

Generic

Result is:

sqrt ([R1 R2]^2 + [R3 R4]^2) x scale

where [ ] indicates IEEE32
representation

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Multiply
Register
s 32-bit

(L:P:49)

MV/
CM

REAL
3 or 4
register
s

Either
(optiona
l)

Generic

Result is:

[R1R2] * [R3(R4)],

meaning Regs 1 and 2 are a 32 bit
number.

The number is multiplied by Reg 3 (if 16
bit) or Reg 3 and 4 (32 bit number)

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

CM4
Power
Factor
IEEE

(L:P:50)

MV/
CM

REAL
1
register

No CM4 Returns the IEEE power factor.

PM8
Power
Factor
IEEE

(L:P:51)

MV/
CM

REAL
1
register

No PM8

Returns the IEEE power factor
(converted from IEC mode as
necessary).

The devicemay be in IEEE or IEC mode
if the device firmware version is 11.6 or
higher. If the device firmware version is
below 11.6, IEC mode is not supported.

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

SP40
Power
Factor
IEEE

(L:P:52)

MV/
CM

REAL
1
register

No
SEPAM
40

Returns the IEEE power factor
(converted from IEC mode).

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

ML
Power
Factor
IEEE

MV/
CM

REAL
2
register
s

No ML
Returns the IEEE power factor
(converted from IEC mode as
necessary).
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

(L:P:53)

The second input register must be the
associated Reactive Power for the
Power Factor requested.

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Generic
Power
Factor

(L:P:54)

MV/
CM

REAL
2
register
s

No Generic

R2/sqrt (R2^2 +R1^2)

where:

R2 = real power
R1 = reactive power

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Generic
Power
Factor -
IEEE32
variation

(L:P:55)

MV/
CM

READ
4
register
s

No Generic

[R3 R4]/

sqrt ([R3 R4]^2 + [R1 R2]^2)

where:

R3 = real power IEEE32MSR

R4 = real power IEEE32 LSR
R1 = reactive power IEEE32 MSR

R2 = reactive power IEEE32 LSR

SP2000
Power
Factor
IEEE

(L:P:56)

MV/
CM

REAL
1
register

No
SEPAM
2000

Returns the IEEE power factor
(converted from IEC mode).

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Scaled
Register
Signed
64-bit

(L:P:57)

MV/
CM

REAL
4
register
s

Either

(optiona
l)

Generic

Reads a 64-bit signed integer and
returns a REAL value.

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Power
Factor
IEEE

(L:P:58)

MV/
CM

REAL
2
register
s

No Generic
Takes a 4 quadrant power factor
(IEEE32 real) and returns an IEEE power
factor

IEEE
64-bit
double

(L:P:59)

MV/
CM

REAL
4
register
s

No Generic

Uses the IEEE standard for floating-
point arithmetic (IEEE 754); returns the
value as 32-bit REAL.

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

IEEE
64-bit
double

(L:P:60)

MV/
CM

STRING
4
register
s

No Generic
Uses the IEEE standard for floating-
point arithmetic (IEEE 754); returns the
value as 64-bit STRING.
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

NOTE: This logic code (as with all REAL
logic codes) has an accuracy of 15
digits. Anything longer than 15 digits
should not be considered accurate.

WRITES (these are write-only; see below for Read/Write codes)

NOTE: If the device is capable of preventing (blocking) writes to its registers, verify that the "block" feature is
disabled before you implement the write.

Status
Write
Register

(L:P:10
1)

SS LONG
1
register

No Generic
If you input 1 to this tag it will write the
MASK value to the register.

Status
Write
Register
AND

(L:P:10
2)

SS LONG
1
register

No Generic

If you input 1 to this tag it will read the
register andAND theMASK with the
register (This puts a 0 wherever there is
a 1 in themask and leaves the rest
alone).

Status
Write
Register
OR

(L:P:10
3)

SS LONG
1
register

No Generic

If you input 1 to this tag it will read the
register andOR theMASK with the
register (This puts a 1 wherever there is
a 1 in themask and leaves the rest
alone).

Write
Register
Unsigne
d

(L:P:11
0)

MV/
CM

REAL
1
register

Either Generic

This will take the input value read in and
divide out the scale factor and the
conversion factor. It will then round to
the nearest whole number and if it is a
value from 0 to 65535 it will put this value
in the register.

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

Write
Register
Signed

(L:P:11
1)

MV/
CM

REAL
1
register

Either Generic

This will take the input value read in and
divide out the scale factor and the
conversion factor. It will then round to
the nearest whole number and convert
the signed value to an unsigned value
from 0 to 65535. It will put this value in
the register.

NOTE: This logic code (and all REAL
logic codes) has an accuracy of seven
digits. Anything longer than seven digits
should not be considered accurate.

READ/WRITES

Read/W
rite
Holding
Register

MV/
CM

LONG
1
register

No Generic
You can write any value from 0 to 65535
and read an unsigned value from the
same register.
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Logic
Code

IEC
Typ
e

PowerSC
ADA
Expert
Data
Type

Regist
er

Definit
ion

Scaled
Requir
ed?

(regist
er or
fixed)

Device
Specifi
c?

Notes

(L:P:12
0)

Read/W
rite Coil
Register

(L:P:12
1)

SS DIGITAL
1
register

No Generic
You can write 0 or 1 and read a value
from the same register.

Block Writes
Block writes represent blocks of registers that are updated in a single write operation.
There are two types of block writes:
• fixed: fully specified and compiled before run time. Writing the value of ‘1’ to such a

variable tag causes the specified fixed values to be written to the specified
registers.

• variable: specified on the fly. The registers and the values to be written are not
fixed; they are specified during run time by the user.

Fixed block writes have the following format:

T:BWF;[D:{B|C|M|P};]S:<start_register>,<values>

where

B, C, M, or P are applicable only to Micrologic devices (otherwise the D: section
is omitted) and is the module (manager) identifier (Circuit Breaker, Chassis,
Metering, Protection).

<start_register> is the first register number for a contiguous block of registers.

<values> is a comma-separated list of up to 10 values that will be written to the
registers starting from <start_register>.

For example:
T:BWF;S:100,1,2,3,4,-5

Variable block writes have the following format:
where

B, or C, or M, or P is applicable only to Micrologic devices (otherwise the D:
section is omitted altogether) and is the module (manager) identifier (Circuit
Breaker, Chassis, Metering, Protection)

For example:
T:BWV;

The start register and the values to be written follow exactly the same rules and syntax
as the definition for the Fixed Block Write, however, these are specified at the time the
write operation is performed. For example, specifying “S:100,1,2,3,4,-5” as the
write value for the tag “T:BWV;“ would write values 1,2,3,4, and -5 to the registers 100,
101, 102, 103, and 104.
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Add a Project Using the Project Setup Tool
There are two methods for adding a project:

You can use the PowerSCADA Studio, (see The Design Time Environment ), which is
a more manual process. Use PowerSCADA Studio to ensure that you have covered
everything, and for further modification of your project.

Or, you use this tool to rapidly deploy a project. Using Project Setup, you can do the
following:
• create and name a project
• select screen resolution and determine whether you will use normal or high

contrast
• specify primary and secondary server connections
• specify the Advanced Reports and Dashboards connection
• add users and Windows authentication
• add devices
• add default pages to your project
• add menus to display pages in runtime
• choose the landing page for each monitor in a multi-monitor project

If you are using optional components (see below), you need to install them separately.

After you create the project and its features, you can edit other settings, such as
devices in the CSV file, and use it to update your project.

You save time when you use Project Setup, as you are able to change a variety of
parameters. When you do not use Project Setup, you then must navigate to a variety of
locations to change or set up these parameters. For a list of parameters that you can
set in Project Setup, see:

Parameters Changed In Project Setup on page 106

For help on any of the Project Setup pages, you can:
• click "?" to the left of the top line to view the entire PowerSCADA Expert help file
• hover your mouse over fields to read tooltips

To launch Project Setup, launch the PowerSCADA Studio. From the Projects tab, click
Add > Create and Configure Project. You see the Introduction page.
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This page lists optional components that you may want to install. The install files are on
the root of the PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards
installation media.
• PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards. Use this

component to view advanced reports and dashboards from Power Monitoring
Expert. Install this component from the PowerSCADA Expert installation media.

• Extract Transform Load (ETL) module. Use this component to extract reporting
information from PowerSCADA Expert and transfer it to Power Monitoring Expert,
for use in reports).

• Event Notification Module (ENM). Use ENM to set up email and text messaging for
project alarms.

Click Next to display the System Definition screen.

System Definition

© 1990–2017 Schneider Electric All Rights Reserved 100



On this screen, you determine whether you are creating a new project or editing an
existing one, and the "view" of the project.

1. Click either Create New or Edit Existing.
2. If you click Create New, type a project name. If you click Edit Existing, choose a

project from the list that displays. Use only alphanumeric characters and
underscores.

3. In the Resolution box, choose the screen resolution that you want for the graphics
pages in this project. This should match the resolution of the monitor that will
display graphics pages.

4. In the Style box, choose whether you want Standard or High Contrast. Standard
uses a white background. High contrast uses a black background, which makes it
easier to view graphics pages.

5. Click Next to display the Servers page.

NOTE: After you click Next, the project is created. You cannot change or delete it
here. To make changes or to delete it, you must use the PowerSCADA Studio.

You can also set high contrast via the parameters in the PowerSCADA Studio.
Open your project in the PowerSCADA Studio, then click Settings > Parameters.
The parameter name is IsHighContrast. 0 = normal; 1 = high contrast.

Servers

Use this screen to define the server information for your primary server and the server
for Advanced Reports and Dashboards.

The Project Setup detects the number of servers that are in your starter project. If you
only have one server (for example, using the loopback IP address), you see all of the
fields in the screen above. If you are using a project that has two or more servers
identified, you only see the bottom section, Advanced Reports and Dashboards.
1. Server Name or IP Address: Type the Server Name or IP Address for the project's

primary server, or select it from the drop-down list.
2. Redundant System: If this is a redundant system, check Redundant System.

Checking this box enables the Standby Server Name or IP Address prompt.
3. Standby Server Address: Type the Server Name or IP Address of the standby

server, or select it from the drop-down list.
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4. Advanced Reports and Dashboards: If you have installed the Advanced Reports
and Dashboards component (WebReach is also assumed to be on this server),
check this box, which will enable the Advanced Reports prompts.

5. Advanced Reports Server Name or IP Address: Type the Server Name or IP
Address of the Advanced Reports server, or select it from the drop-down list.

6. User Name/Password/Confirm Password: These fields are only enabled after you
check Advanced Reports and Dashboards. Type the user name and password
used for the Advanced Reports and Dashboards server. (Note that you must enter a
user name and password if you check the Advanced Reports and Dashboards
box.)

Retype the password in the Confirm Password field.
7. Click Next to view the Users screen.

Users

On this screen, you define PowerSCADA Expert users, passwords, and roles. Add the
PowerSCADA user information for each user who will access the runtime pages in this
project.

Each user must be assigned to a role. You can also associate each role with a pre-
established Windows group. For more information about users and roles, see Add and
Modify User Accounts on page 237.

1. To begin adding an account, click Add User; a blank row displays in the user list.

If you are editing a user, click the user name.
2. Click the Role column for the user, and choose the appropriate role:

If you use the default startup project, you see these default roles:
Controller
Operator
Role0
Supervisor
User

If you have edited the roles in the default startup project of the
PowerSCADA Studio, this list will match the edited startup project that you are
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using.
3. To delete any user that you have added, highlight the user line and click Delete

Selected.
4. Type and confirm the password to be used by this user.
5. If desired, add a full name for this user. This simply provides a place for a more

descriptive name; it is not used to log on to the system.
6. In the Windows Authentication box, you can optionally assign a role to a Windows

group.

This provides central management of users through Windows. It also means that
Windows users who are in the specified Windows group will have the
PowerSCADA Studio privileges that are assigned to this role.

See "Use Windows Integrated Users" in Add and Modify User Accounts on page
237 for more information.

7. Click Next to display the Menus and Display Pages.

Menus and Display Pages

Use this screen to accomplish two tasks:
• determine the top-level menu items that will display in the runtime graphics pages
• determine the page that will display on any of the monitors that you have in a multi-

monitor installation

HMI Menus

Design the Level 1 (top line) menu structure for graphics pages: check the menu tabs
that you want to display on the graphics page. You can add more detail, such as
secondary levels, in the Menu Configuration page (PowerSCADA Studio >
Visualization tab > Menu Configuration).

Monitors

If you have multiple monitors in your system, type the number (up to 8) of monitors in
the Total Monitors box. You can also click the plus and minus buttons to increase or
reduce the number. The Runtime Landing Page prompts corresponding to the number
of Total Monitors will become enabled.
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For each monitor, click the drop-down menu to display available pages. Choose the
landing page you want to see when this monitor views PowerSCADA Expert.

When you are finished, click Next to display the Summary screen.

Device Profiles

This screen displays device profiles for the project. Profiles will display here only if they
exist in the Profile Editor and have been exported to this project.

If a profile is missing from this list, click Open Profile Editor to launch the Profile Editor.
Create the profile if it doesn't already exist and/or add it to the project there and export
the project. Return to this page and click Refresh Device Profiles to update the list.
Likewise, if you need to remove a profile, launch the Profile Editor, remove the profile
from the project, export the project, and then click Refresh Device Profiles.

When you see the profiles that you want in your project, click Next to view the Devices
page.
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Summary

This is read-only information. Verify that it is correct for your system. If you need to
change something, click Previous to return to that screen. When you are satisfied with
the information, click Save and Continue to display the Device Profiles page.

Devices

Finalize the devices that you have in your system. Use the IO Device Manager to
import one or several devices into the project.

To import multiple devices from a CSV file into your project, click Import Devices From
CSV. For detailed instructions, see Use a CSV File to Define Multiple Devices on page
132

To import a single file, click Manage a Single Device. For more information, see Define
One I/O Device in a Project on page 118.

Click Next to view the Finish page.
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Finish Page

Before you start work on this page, you can click "Open System Development Guide" to
find instructions on creating a project from beginning to end.

On this screen, compile the project. After it is compiled, it will open in the runtime
environment. In runtime, verify correct device communication using the Tag Viewer
screen or by viewing any Communication Failure Alarms.

In the Project Development Tools section, you can:
• launch the PowerSCADA Studio to make a variety of changes to the project
• launch the Graphics Builder page to make changes/additions to the graphics page

you are creating
• launch the Application Configuration Utility to edit or set up many project features

(see Application Configuration Utility for instructions)

Many of the settings made by Project Setup are also included in the Parameters file
(PowerSCADA Studio > Settings > Parameters). You can also change these
parameters in that file.

When you are finished, click Finish to leave Project Setup.

Parameters Changed In Project Setup
In the Project Setup wizard, you can easily set up a variety of project information. You
can edit many project parameters. Because the parameters are in a variety of places,
you will save time when you use Project Setup to quickly edit them. The parameters
below are organized according to the Project Setup page that lets you edit them.

System Definition screen

Project Setup Setting Section Parameter Name

Resolution MultiMonitors Resolution

Style MultiMonitors IsHighContrast

Servers
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Project Setup Setting Section Parameter Name

Advanced Reports Server Applications Hostname

Menus in Project Setup

For each page selected in Project Setup (Step 5), the menu configuration items are
added.

Project Setup Setting Section Parameter Name

Monitor Count MultiMonitors Monitors

Monitor 1 Landing Page MultiMonitors StartupPage1

Monitor 2 Landing Page MultiMonitors StartupPage2

Monitor 3 Landing Page MultiMonitors StartupPag3

Monitor 4 Landing Page MultiMonitors StartupPage4

Monitor 5 Landing Page MultiMonitors StartupPage5

Monitor 6 Landing Page MultiMonitors StartupPage6

Monitor 7 Landing Page MultiMonitors StartupPage7

Monitor 8 Landing Page MultiMonitors StartupPage8

In addition to parameters, you can do the following:

Servers, Network Addresses, and Computers

Project Setup Location Item

Step 3, Servers
Add I/O, Alarm, Trend, and Report Servers, primary and redundant

NOTE: Clusters are also added here.

Step 3, Servers Add network addresses, primary and redundant

Step 5, Display: Menus and Display Pages Create HMI menus: setup for graphics pages

Step 5, Display: Menus and Display Pages Determine runtime landing pages at various monitors used in the project

Step 7: Device Profiles Choose device profiles

Step 8: Devices
Add I/O devices; including equipment, ports, boards, I/O devices, variable tags,
alarm tags, trend tags

Step 9: Finish Compile and run the completed project
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The Design Time Environment
This chapter discusses how to use genies to create one-line diagrams for customers. In
this section, you will find these topics:

Typical Workflow on page 108
The PowerSCADA Expert Pages on page 109
Create a Project on page 109
Use PowerSCADA Expert One-Lines

One-Line Flowchart on page 134
What Are PowerSCADA Expert One-Lines? on page 135
One-Line Device (zOL) on page 136
One-Line Colors on page 137
Add INI Settings to AdvOneLine.ini and Citect.ini on page 137
Start and Stop One-Lines on page 139
Work with Genies on page 139
Work in the Configuration Utility on page 143

Work with Alarms on page 154
Alarms Overview on page 154
Add Setpoints and Delays on page 155
Set Up an Alarm Based on an Enumeration on page 155
Change an Alarm Severity on page 156
Enable Waveforms for Onboard Alarms on page 156
Set Parameters for Event Log Length and Historical Logging of Events on page 156
Add an Onboard Alarm Tag on page 157
Set Up Audible Alarms on page 157

Restore and Back Up Projects on page 158
Restore a Project on page 158
PowerSCADA Expert Backup on page 158

Use Cicode to Customize a Project on page 159
Work in the Configuration Utility on page 143
Work in the Configuration Utility on page 143
Trend Tag Scan Intervals on page 163
Disk Storage Calculation for Trends on page 164

Typical Workflow
When creating a graphics page, these are the steps you will usually follow:

1. Before you begin, make sure you have:

a. created a project in the Profile Editor
b. added a project with the same name to PowerSCADA Expert; added at least

one cluster, network address, and server
c. exported the project from the Profile Editor
d. used the I/O Device Manager to add devices to the project

2. From the Graphics Builder window, add a new page, using the style and page
template you prefer. Instructions assume that you will use the default template; but if
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you create your own template, use the Menu Configuration tool to add menu
headings that will display on the one-line in runtime. (See Use Menu Configuration
to Edit Pagemenu.dbf (Change the Graphics Page Appearance) on page 114 for
more information about changing the appearance of the graphics page.)

3. Add genies to the page to create the one-line drawing.
4. Compile and run the project. Note any errors and warnings; correct all errors.

Review warnings for problems such as missing tags.
5. Run the project to view the graphics page in the runtime environment.

The PowerSCADA Expert Pages
When you launch the product (v8.2), these windows are opened:
• PowerSCADA Studio: Use this application to explore and add projects. The

product is shipped with a project that has example page configuration. Project
names are listed in the left-hand pane.

• Graphics Builder: Use this application to build graphic display pages for a project.
A standard PowerSCADA Expert library of genies is provided. The genies contain
logic such as control outputs and rack-in/rack-out. Once assembled and opened in
the runtime environment, they provide an interactive view of an installation’s power
system.

Create a Project
The information in this section is based on the Normal template from the PLS_Style_1
library. The Normal template includes all of the tabs and buttons that are described in
the topics here. If you want to edit selections on the tabs and buttons, use the Menu
Configuration tool. For instructions on editing templates with the Menu Configuration
tool, see Use Menu Configuration to Edit Pagemenu.dbf (Change the Graphics Page
Appearance) on page 114.

When you modify the template or create a completely new template, the information
provided here for creating graphics pages may only apply as a guide.

When you rename a project in PowerSCADA Studio, you will see error messages
when you try to add new projects. To fix this problem, just shut down and then restart
PowerSCADA Expert.

In this section, you will find these topics:

Reuse Projects Created in the Profile Editor on page 109
Add a New Graphics Page on page 110
Set a New Page as the Project Startup Page on page 111
Create a One-Line on a Graphics Page on page 111
Use Menu Configuration to Edit Pagemenu.dbf (Change the Graphics Page
Appearance) on page 114
Create New Genies on page 115
Delete Information from PowerSCADA Expert on page 117

Reuse Projects Created in the Profile Editor
You may want to create a “standard” project that can be reused for different
installations. For instructions on saving and then reusing projects, follow these steps:

1. Export the project from the Set Up Project tab of the Profile Editor.
2. Click the folder icon beside the Export link:
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3. Copy the file (Equipment.profiles) that displays. If you need to use this file to
another computer, you can move it to a portable drive.

4. On the server computer, paste Equipment.profiles in this location, where:

[Drive Letter]: is the drive on which you installed the server

the Application Data and Program Data folders are not hidden (set the folder view
for “view hidden folders”)

[Project] is the name of the project you are creating; you must have already added
this project to PowerSCADA Expert (see Before You Export, above).

5. Be sure you have created the files described in Before You Begin on page 110.

Before You Begin
Before you start adding data in the project, make sure that you:
• use the Profile Editor to add all of the device types, device profiles, and projects
• from PowerSCADA Studio, create a project; add clusters, network addresses, and

servers
• export devices from the Profile Editor
• add devices into the PowerSCADA Expert project, using the I/O Device Manager

Add a New Graphics Page
You need to add a project in two places before you add pages. First add the project to
PowerSCADA Expert, from the PowerSCADA Studio Projects screen (see steps
below). Then add it to the Profile Editor. See Add, Edit, or Delete a Project on page 70
for instructions.

1. From the PowerSCADA Studio page, choose the project for which you will create a
graphic.

2. On the Graphics Builder screen, click File > New > Page.
3. On the Use Template popup, set the resolution to SXGA (or default), and uncheck

the Title Bar option. Select the page template (for example, normal). Click OK.

NOTE: If you use any style that is not preceded by “pls,” the PowerSCADA Expert
graphics features will not be included. If you want to change the attributes of the
default style, copy pls_style_1 and paste it in your project; rename it, and make the
desired changes. The new template can then be used for your pages.

The graphics page displays in design-time mode.
4. To make changes to the menus and tabs that display on the screen, use Menu

Configuration tool. See Use Menu Configuration to Edit Pagemenu.dbf (Change
the Graphics Page Appearance) on page 114 for instructions on making these
changes.

5. Save the graphics page, giving it the desired name and selecting the project that
you have just added.

Change the Background Color of Pages
You have the option of changing the background color of individual pages in your
project. To do this, follow these steps:

1. Create a new project, using "high contrast" as the starter project.
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This project will already include all of the pages that you will use. There will also be
a new parameter, called PageColorExt. This parameter includes the extension that
allows you to color backgrounds.

2. To designate background color for each page, pick the color in the Graphics Editor.

You can also change the genie font colors on your project pages. To do this see
Change the Genie Color in Project Pages on page 111.

Change the Genie Color in Project Pages
You have the option of changing the color of genies in pages of your project. To do
this:

In your project, add a new parameter to the Graphics section, called GenieFont. Enter
the value designation for the color you want to use. Make sure that there is sufficient
contrast between the two colors so that the genie colors will be visible.

NOTE: If you use the "high contrast" starter project to create your project, this
parameter is automatically added, as are all of the pages that you will use. For
instructions on changing the background color of your project pages, see Change the
Background Color of Pages on page 110.

Set a New Page as the Project Startup Page
After you add a new page, follow these steps to make it be the system starting page. If
you do not make these settings correctly, the system will not properly execute the
startup routine, and the browser navigation buttons will not work.

NOTE: You can also set a separate startup page (landing page) for each monitor in a
multi-monitor system. For instructions, see Menus and Display Pages on page 103.

Setting_To set the startup page on the main server:

1. Open the Parameters dialog (PowerSCADA Studio > Settings > Parameters).
a. In the Section Name field, type MultiMonitors.
b. In the Name field, type StartupPage.
c. In the Value field, type the name of the new page.
d. If you intend to use multiple monitors, and want to use a different startup page

for a particular monitor, you can specify it by adding another parameter with the
name of StartupPage<n>, where <n> is the monitor number (for example,
StartupPage2, for startup page on the second monitor).

2. In the Computer Setup Wizard (General Options Page), leave the ini settings as
<default>.

Create a One-Line on a Graphics Page
You will build a one-line by adding genies to the new page. For more information
about genies, see Genies and Super Genies in the citectSCADA.chm help file
(Program Files> Schneider Electric > PowerSCADA Expert > v8.2 > bin).

To begin creating a one-line, start adding genies to the page:

1. Click the “genie” icon on the toolbar:

2. From the Paste Genie screen, choose a library (to ensure that all PowerSCADA
Expert features are available, choose a library that begins with “pls”). If you want to
edit a genie or create a new one, see Create New Genies for instructions.
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3. From the available icons in the selected library, select a genie; click OK to paste the
genie on the graphics page.

4. A popup window displays for you to enter genie properties. Enter the requested
information for the appropriate object:

Configure a Busbar on page 140

Configure a Circuit Breaker or Switch on page 141

Configure a Meter on page 141

Configure a Source on page 142

Configure a Transformer on page 142

NOTE: An asterisk in any of the windows indicates that it is a required field.
5. If a message displays telling you that variable tags are not found, and asking if you

want to add the unknown tags, this is not a problem. The genie is expecting to see
a variable, but one may not exist in the equipment (for example, it could be looking
for a “racked out” variable in a Sepam). Click No to this message.

NOTE: To disable this message, go to the Citect Engineering Environment. Click

Options ( ) on the left hand side. From the Options dialog box, de-select
“Prompt on tag not exist.” Click OK.

The genie is added to the page.
6. Continue adding the genies to make up the graphics page.

After you create the graphics page, you need to compile it. You can run the page to
review its elements and correct any errors.

NOTE: Do not drag genies off of the page. They will disappear.
7. Compile the project: from the left hand side of PowerSCADA Studio, click Compile (

).
While the page is being compiled, the Compiler displays each file name as it is
being compiled. A message then displays, telling you that compilation was
successful.

8. If there are errors and/or warnings after the page is compiled, a message box
displays, telling you the number of errors and warnings. You must understand all
warnings and correct all of the errors. To begin, do the following:

a. Click OK at the Compiler message.
The Compile Errors window displays the first error.

b. Note the error message. For more information on each error, click Help; note the
Description for that Error Message.

c. To correct the error, click the GoTo link.
The appropriate window displays for you to correct that error.

9. Correct each error. Warnings do not need to be corrected in order to run the project;
but they should be checked to see if they impact the project (such as a tag that is
not defined).

10. If you delete any entries, click Projects > Pack to clean up the files.
11. Re-compile and verify that all of the errors have been addressed.

12. After all errors are corrected, run the project (click ).
The Graphics page displays in the runtime environment. Note: Until you edit the
Menu Configuration file, only basic tabs will display on the Graphics page.
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13. Before you can view your one-line, you need to edit the Menu Configuration file,
which controls the appearance of the graphics page in the runtime environment.
See Use Menu Configuration to Edit Pagemenu.dbf (Change the Graphics Page
Appearance) on page 114 for help.

Enable Lockout/Tagout

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

• Do not rely solely on the display of the icon on the one-line. Before working on the equipment, verify that
the device is physically locked out/tagged out before performing work on it or any downstream equipment.

• Ensure that all safety regulations and procedures have been followed before you work on the equipment.

Failure to follow these instructions will result in death or serious injury.

NOTE: Do not incorrectly configure the tag, as this can lead to unexpected equipment
operation. Also consider the possibility of communications loss that could yield false
readings.

With this feature, you can cause the "locked out" icon (shown above) to display on your
graphics page in runtime. The icon displays when a tag attribute for a device reaches a
specified value. For example, you might set a PLC tag to 0 when the equipment is in
lockout/tagout (the door is open), and to 1 when the equipment status indicates that the
door is closed.

This is a read-only feature; but it does not prevent controls to the device or area. This
feature is not available in PLS_Example.

Follow these steps to enable the icon for a device:

1. From the pls_gen_eq_2 genie library, add the lockout/tagout genie to the graphics
page. Position it beside the equipment that is being monitored.

2. From Variable Tags, choose the device tag (or create a custom tag) that you want,
and associate it with the device that will read the lockout/tagout status.

3. Define what indicates the status (for example, door status open, 0 = false and 1 =
true).

4. Edit the lockout/tagout genie to read the tag on the device. Make the lockout/tagout
genie visible when the device tag indicates that the device is in lockout/tagout
status; and make the icon hidden when the device is not in lockout/tagout. (By
default, lockout/tagout status is hidden when the tag property is "NOT [variable
tag].")

To continue the example, if the tag is reading door status open and the value = 0,
then the door is open and in lockout/tagout; if the value = 1, the door is closed and
not in lockout/tagout.

The following graphic illustrates how it might look in when adding the genie:
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Use Menu Configuration to Edit Pagemenu.dbf (Change the Graphics Page
Appearance)

The Menu Configuration form (PowerSCADA Studio > VIsualization tab > Menu
Configuration) edits Pagemenu.dbf in your project. This controls the runtime
environment screen appearance: tabs and menus on the screen. By the entries you
add there, you can also specify actions to be taken when an option is selected.

Because it takes much effort to create the items that display on a graphics page, you
can use the menu settings from the PLS_Example project as a template for your new
project template. From it, you can copy and paste settings into an individual project’s
menu configuration file.

The following illustrates a Menu Configuration page for the PLS_Example project (see
the table below for descriptions of the columns).

Menu Item Description

Levels 1 through 4
These items establish themenu levels that will display. For example, you
might use "Single Lines" for level 1, followed by the substation for level 2, and
the graphic name for level 3. (Each line: 256 characters maximum)

Menu Command

The Cicode expression that you want to execute. Typically, you will use the
"page display" command followed by the actual page you want to see. For
example:

PLSPageDisplay("CB_IEC_1")

which displays the page CB_IEC_1.

Order
The relative position within the final graphics page. If you leave this field blank,
the default value 0 is used. (64 characters maximum)

Symbol Displays a defined image along with the description for that level.
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Menu Item Description

Images must already be defined in the project/include project. They are
specified in the format <library name>,<symbol name>. For example, in PLS_
Example, the symbol used for the level 2 of Single Lines is Substation3,
entered as PLS_Icons.Substation3.

Different menu levels are designed to be used with different symbol sizes for
optimal display. For Level 1 items (tab), the recommended symbol size is 16 x
16 pixels. For Level 2 items, (buttons), the recommended symbol size is 32 x
32 pixels. Symbols are not displayed for menu items of Level 3 or beyond.

Page
The page on which this entry will display. If this is left blank, the entry will
display on every page.

Comment
You can use up to 128 characters to add a comment (will not display on
screen).

To make it easier to create the menu for a project, you can copy entire lines from
PLS_Example or another proejct into the new project.

Create New Genies
There are two ways to add new one-line genies to a project:

Copy a genie: Create a genie that is completely compatible with current genies, having
the same genie parameters and functionality. To do this, you can copy an existing
genie and change attributes. This type of genie must be added to the
SupportedGenies.xml File on page 143.

Create a unique genie: Create a genie that has unique parameters, validation
requirements, and output types. See instructions below for this. This type of genie must
be added to both the SupportedGenies.xml File on page 143.

The easiest way to create a new genie is to make a copy of a similar genie from the
standard library and edit it in your project. We recommend, when adding layers, that
you keep the dimensions of the new layers the same as the original. For a list of all of
the standard PowerSCADA Expert genies, including all of the smaller parts that you
could use to create genies, see Appendix 1: Default Genie Library on page 239.

When you modify a genie, the modifications will be in effect for all instances of that
genie in the project.

To create a copy of a genie:
1. Open the genie that you want to use as a template: From the Graphics Builder, click

File > Open. Click the Genie tab, then select the library and the template genie.
Click OK.

2. Save the genie with a new name in your local project.
3. To separate the genie into layers, click the genie and drag a layer to the bottom

right.
4. Repeat the process to pull all of the layers apart.

Each layer is a sub-genie that controls a different aspect of the overall genie.
5. Make the changes that you wish to the genie.

NOTE: Be careful to maintain the same dimensions for any new layers that you
create.

6. To re-assemble the genie, draw a marquis around all of the parts; then click
Arrange > Align, and choose Top and Left. Click OK.
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The newly created genie, when applied to a page, will display with the generic input
form. To create a customized form similar to those found with the default genies, you
must create a new .FRM file. Examples are found in the PLS_Include project directory.

You can rotate any of the genies.

To create a custom symbol for a custom genie:
PowerSCADA Expert genies are complex genies with the added ability to animate
color during runtime (showing changing states). These genies are comprised of
multiple symbols that have the same attributes (all call the same Cicode function).

1. Create the new symbol.
2. Configure the symbol to display the customized colors in the runtime environment

by calling the PLS_GetBusColorIndex(INT nColorIndex) function, which is provided
in PowerSCADA Expert. This function must be called from the Array Condition area
of the Symbol properties window.

Each Array symbol can display up to 255 colors. Please ensure that the default
color palette matches the palette used in PLS_Include. The parameter for PLS_
GetBusColorIndex(INT nColorIndex) is the busbar number that determines the
animated color. Always use the %variable% notation. Using this notation permits
you to reuse genies.

See the default symbols in the PowerSCADA Expert libraries that begin with PLS_.
3. Save the symbol and use it in a custom genie.

Set Up IEC 61850 Advanced Control
The advanced control window provides two advanced controls (synchro check and
interlock check) that you can use with IEC 61850 IEDs.

See Perform IEC 61850 Advanced Control on page 185 for information on using these
advanced controls.

WARNING

UNINTENDED EQUIPMENT OPERATION

• Do not incorrectly configure the tag, as this can lead to unexpected equipment operation.
• Ensure that you understand the effects of using the "bypass" option so you do not shut down critical equip-

ment.
• Also consider the possibility of communications loss that could yield false readings.
• Ensure that all safety regulations and procedures have been followed before you work on the equipment.

Failure to follow these instructions can result in death or serious injury.

Enable the Advanced Control
Before you can use the advanced control, you must add the appropriate variable
STRING tag to be used when you send the command. For breaker control, the
"operate" tag typically used is:

S33K_A_INC\CSWI1\Pos\ctVal

For this tag, you need to then add the corresponding STRING tag:

S33K_A_INC\CSWI1\Pos\ctVal\str

If you are using select before operate (SBOw), you also need to add a STRING tag for
it.
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Delete Information from PowerSCADA Expert
If you find you need to delete any data that you have entered (clusters, servers, genies,
and so on), follow the normal procedure to delete the data, then use the Pack
command to completely delete it. To do this, launch the PowerSCADA Studio; from the
Projects tab, click Pack.

Manage I/O Devices in the Project
The I/O Device Manager tool provides a quick way to add one or many devices to a
PowerSCADA Expert project. Instead of adding device and device manager Rather
than having to "build" devices one tag at a time in the PowerSCADA Studio, use the I/O
Device Manager to create or many devices, and to update or remove devices.

To begin, launch the I/O Device Manager from Start menu (Start > Schneider Electric
> IO Device Manager.

Click Import Devices from CSV to go to a wizard that walks you through managing
devices that are in a CSV file. Or click Manage a Single Device to go to a wizard that
walks you through creating, removing, or updating a single device.

Throughout the I/O Device Manager wizard, there are fields that will only accept a valid
entry. They are marked with a red asterisk (!). The asterisk remains there until you enter
a response that is of the correct length or includes only the acceptable characters. The
asterisk disappears when you have entered a valid response.

Click a link for what you want to do.
• Define One I/O Device in a Project on page 118
• Remove a Single I/O Device From a Project on page 127
• Use a CSV File to Define Multiple Devices on page 132
• Update One or All Devices in Project on page 132

The following links provide additional information that you need to know.

When You Set Up More than two I/O Servers per Cluster on page 22

Port Names on page 24

Before You Use the I/O Device Manager
Before you can add device profiles, you need to establish the folder structure and
network addresses in the project: Launch the product: click Start > Programs >
Schneider Electric > PowerSCADA Studio.

Have a copy of each device’s connection information: communications protocol and IP
address. You will enter this information when you add the devices.

NOTE: When running the Computer Setup Wizard, do not change the startup page
(leave the ini settings as <default>). Changing the startup page at this point will result
in navigation problems. To change the startup page, see Set a New Page as the
Project Startup Page on page 111.

When running the Computer Setup Wizard: If you choose Multi-Process (Server and
Control Client), you must also choose Networked (connect to other SCADA
computers) at the following screen. Otherwise, reporting functionality may be
affected.

117 © 1990–2017 Schneider Electric All Rights Reserved

7EN02-0403-00 The Design Time Environment
03/2017



The Design Time Environment 7EN02-0403-00
03/2017

Define One I/O Device in a Project
Use the wizard in the I/O Device Manager to add one device at a time. Launch the
wizard from the Start menu (Start > Schneider Electric > IO Device Manager). From the
I/O Device Manager subtab, click Manage a Single Device to open the wizard..

Throughout the I/O device wizard, there are fields that will only accept a valid entry.
They are marked with a red exclamation point (!). The exclamation point remains there
until you enter a response that is of the correct length or includes only the acceptable
characters. The exclamation point disappears when you have entered a valid
response.

Click one of these links to display instructions to add each type of protocol:

Add a TCP Device to a Project on page 118

Add a Serial Device to a Project on page 120

Add a DNP3_TCP Device on page 123

Add an IEC 61850 Device to a Project on page 125

Add a TCP Device to a Project
Use this procedure when you want to add a generic TCP or Modbus TCP device to a
project. Note that these instructions assume that you have two I/O servers, and that you
will be renaming ports.

Before you begin, make sure that you have added at least one cluster and the
appropriate servers for this project (see Add the Cluster, Network Address, and
Servers).

Then, make sure that you have set up each of these clusters in the I/O Device
Manager:

Cluster Setup: Before you add devices, you need to set up each cluster that was
created for the project (you must have added at least one cluster to PowerSCADA
Expert before you do this): 

1. From the I/O Device Manager, under System Devices, click Cluster Setup. Click
Next.

2. At the Enter Instance Information screen, a cluster name displays. Click Next.
3. If there are multiple clusters, the Select cluster screen displays. Choose the cluster

you want to set up. Click Next.
4. If there are multiple I/O servers in the cluster, the Select I/O servers screen displays.

Check Supports Redundancy and select the I/O servers to which you want to add
the device. Click Next. If there are more than two IO servers per cluster, you must
set them up manually (seeWhen You Set Up More than two I/O Servers per Cluster
on page 22).

5. At the Ready to perform action screen, click Next.

If you have more than one cluster to add, repeat steps 3 through 5 for each cluster.

When you are finished adding clusters and I/O servers, you return to the I/O Device
Manager welcome screen.

Add the TCP Device

Follow these steps to add TCP devices:
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1. From the Start menu, run the I/O Device Manager (Schneider Electric > IO Device
Manager).

The I/O Device Manager screen displays:

2. Click Manage a Single Device.
3. From the new I/O Device Manager screen, click Create one I/O Device, then click

Next.
4. At the Choose profile screen, select the first device profile that you want to use to

add a device to the project. Click Next.

NOTE: To ensure that the Alarm Log displays properly with the PM5000 series of
devices, use the correct PM5000S or PM5000S1 driver for devices:

Use the PM5000S driver (for the most recent Alarm Log implementation) with:
— PM51XX
— PM53XX
— PM55XX
— PM5350PB
— PM5350IB with FW version 3.00 and higher

Use the PM5000S1 driver (for previous Alarm Log implementation) with:
— PM5350 with FW prior to version 3.00

5. At the Enter instance information screen, type a descriptive profile name, for
example: CM4Bay1Circuit1 (no spaces or punctuation; to allow space in
PowerSCADA Expert, the preferred limit is 16 characters). The Comment field is
stored in the equipment.dbf file.

NOTE: There are several “description” or “comment” fields throughout the product.
These fields can be used to create copy for translation purposes. If you type a
Comment in this format:

@(XXX), where XXX = the copy that is to be translated,

the copy you typed in the comment field is added to the default language, named
English.DBF. After the project is compiled, this file is located in Documents and
Settings\All Users\Application Data\Schneider Electric\PowerSCADA Expert 8.2
with Advanced Reporting and Dashboards\User\[your project]. English.dbf contains
terms that will be translated from English.
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To create another language file for translation, set the Citect.ini parameter
[Language]LocalLanguage to the specified language, then re-compile. So, for
example, if you set this parameter to French, a French.dbf file is created in the
project folder when you compile. You can then enter the translated text in the
LOCAL field of the file. Repeat this same step for each additional language file you
want in this project.

At runtime, the user will be able to choose the .dbf file that is to be used in the
display, thus changing the language used in the display.

Click Next.
6. At the Select I/O servers screen, choose the primary and standby servers. You can

only set the standby server if you check the "Supports Redundancy" box. Click
Next.

7. If you choose to add an optional sub-profile: At the Configure Sub-Profile
Communications Method screen, choose the communications method used for the
first sub-profile in this project. Click Next.

8. At the Communications Settings screen, type the gateway address and station
address for each of the servers. If you check the "Same as Primary" box for standby,
you will use the same addresses for the primary and standby. Click Next.

9. At the Port Settings screen, you can rename each of the ports. A new port will be
generated for each new name. Click Next. (See more information about naming
ports in Port Names on page 24.)

10. At the Ready to perform action screen, click Next.

After the devices are added, a screen displays telling you that the project was
updated successfully.

To view a detailed list of all of the device profiles and all operations performed in
the project, check the View audit log box. The list displays after the device is added.

To continue adding or removing device profiles, click Next. Repeat steps 3 through
8.

11. When you have finished adding devices, uncheck the Add/remove more equipment
option, then click Finish.

If you checked the View audit ... box, the list displays.

If you did not check the Add/remove... box, the I/O Device Manager closes. If you
checked the Add/remove ... box, the Welcome screen displays again.

12. From any of the three PowerSCADA Expert screens, compile the project.

13. When all errors are corrected, click Run () to view the runtime environment.

Add a Serial Device to a Project
Use this procedure when you want to add a generic serial or DNP3 via serial device to
a project. Note that these instructions assume that you have two I/O servers, and that
you will be renaming ports.

Before you begin, make sure that you have added at least one cluster and the
appropriate servers for this project (see Add the Cluster, Network Address, and
Servers).

Then, make sure that you have set up each of these clusters in the I/O Device
Manager:

Cluster Setup: Before you add devices, you need to set up each cluster that was
created for the project (you must have added at least one cluster to PowerSCADA
Expert before you do this): 
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1. From the I/O Device Manager, under System Devices, click Cluster Setup. Click
Next.

2. At the Enter Instance Information screen, a cluster name displays. Click Next.
3. If there are multiple clusters, the Select cluster screen displays. Choose the cluster

you want to set up. Click Next.
4. If there are multiple I/O servers in the cluster, the Select I/O servers screen displays.

Check Supports Redundancy and select the I/O servers to which you want to add
the device. Click Next. If there are more than two IO servers per cluster, you must
set them up manually (seeWhen You Set Up More than two I/O Servers per Cluster
on page 22).

5. At the Ready to perform action screen, click Next.

If you have more than one cluster to add, repeat steps 3 through 5 for each cluster.

When you are finished adding clusters and I/O servers, you return to the I/O Device
Manager welcome screen.

Adding the Serial Device

Follow these steps to add serial devices.

1. From the Start menu, run the I/O Device Manager (Schneider Electric > IO Device
Manager).

The I/O Device Manager screen displays:

2. Click Manage a Single Device.
3. From the new I/O Device Manager screen, click Create one I/O Device, then click

Next.
4. At the Choose profile screen, select the first device profile that you want to use to

add a device to the project. Click Next.

NOTE: To ensure that the Alarm Log displays properly: Use the correct PM5000S or
PM5000S1 driver for devices:

Use the PM5000S driver (for the most recent Alarm Log implementation) with:
— PM51XX
— PM53XX
— PM55XX
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— PM5350PB
— PM5350IB with FW version 3.00 and higher

Use the PM5000S1 driver (for previous Alarm Log implementation) with:
— PM5350 with FW prior to version 3.00

5. At the Enter instance information screen, type a descriptive profile name, for
example: CM4Bay1Circuit1 (no spaces or punctuation; to allow space in
PowerSCADA Expert, the preferred limit is 16 characters). The Comment field is
stored in the equipment.dbf file.

NOTE: There are several “description” or “comment” fields throughout the product.
These fields can be used to create copy for translation purposes. If you type a
Comment in this format:

@(XXX), where XXX = the copy that is to be translated,

the copy you typed in the comment field is added to the default language, named
English.DBF. After the project is compiled, this file is located in Documents and
Settings\All Users\Application Data\Schneider Electric\PowerSCADA Expert 8.2
with Advanced Reporting and Dashboards\User\[your project]. English.dbf contains
terms that will be translated from English.

To create another language file for translation, set the Citect.ini parameter
[Language]LocalLanguage to the specified language, then re-compile. So, for
example, if you set this parameter to French, a French.dbf file is created in the
project folder when you compile. You can then enter the translated text in the
LOCAL field of the file. Repeat this same step for each additional language file you
want in this project.

At runtime, the user will be able to choose the .dbf file that is to be used in the
display, thus changing the language used in the display.

Click Next.
6. At the Select I/O servers screen, choose the primary and standby servers. You can

add information for the standby server if you check the "Supports Redundancy"
box. Click Next.

7. At the Configure Sub-Profile Communications Method screen, choose the
communications method used for the first sub-profile in this project. Click Next.

8. At the Communications Settings screen, type all of the information for each server
(com port, baud rate, and so on). If you check the "Same as Primary" box for
standby, you will use the same addresses for the primary and standby. Click Next.

9. At the Port Settings screen, you can rename each of the ports. (See more
information about naming ports in Port Names on page 24.)

10. Repeat steps 6 through 8 for the remaining sub-profiles.
11. When you finish adding the last sub-profile, the Ready to perform action screen

displays Click Next.

After the devices are added, a screen displays telling you that the project was
updated successfully.

To view a detailed list of all of the device profiles and all operations performed in
the project, check the View audit log box. The list displays after the device is added.

To continue adding or removing device profiles, click Next. Repeat steps 3 through
8.

12. When you have finished adding devices, click Finish at the Project updated
successfully screen.

If you checked the View audit ... box, the list displays.
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The I/O Device Manager closes.
13. From any of the three screens, compile the project.

14. When all errors are corrected, click Run () to view the runtime environment.

Add a DNP3_TCP Device
Use this procedure when you want to add a DNP3_TCP device to a project. Note that
these instructions assume that you have two I/O servers, and that you will be renaming
ports.

Before you begin, make sure that you have added at least one cluster and the
appropriate servers for this project (see Add the Cluster, Network Address, and
Servers).

Then, make sure that you have set up each of these clusters in the I/O Device
Manager:

Cluster Setup: Before you add devices, you need to set up each cluster that was
created for the project (you must have added at least one cluster to PowerSCADA
Expert before you do this): 

1. From the I/O Device Manager, under System Devices, click Cluster Setup. Click
Next.

2. At the Enter Instance Information screen, a cluster name displays. Click Next.
3. If there are multiple clusters, the Select cluster screen displays. Choose the cluster

you want to set up. Click Next.
4. If there are multiple I/O servers in the cluster, the Select I/O servers screen displays.

Check Supports Redundancy and select the I/O servers to which you want to add
the device. Click Next. If there are more than two IO servers per cluster, you must
set them up manually (seeWhen You Set Up More than two I/O Servers per Cluster
on page 22).

5. At the Ready to perform action screen, click Next.

If you have more than one cluster to add, repeat steps 3 through 5 for each cluster.

When you are finished adding clusters and I/O servers, you return to the I/O Device
Manager welcome screen.

Add the DNP3_TCP Device

Follow these steps to add TCP devices:

1. From the Start menu, run the I/O Device Manager (Schneider Electric > IO Device
Manager).

The I/O Device Manager screen displays:
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2. Click Manage a Single Device.
3. From the new I/O Device Manager screen, click Create one I/O Device, then click

Next.
4. At the Choose profile screen, select the first device profile that you want to use to

add a device to the project. Click Next.
5. At the Enter instance information screen, type a descriptive profile name, for

example: CM4Bay1Circuit1 (no spaces or punctuation; to allow space in
PowerSCADA Expert, the preferred limit is 16 characters). The Comment field is
stored in the equipment.dbf file.

NOTE: There are several “description” or “comment” fields throughout the product.
These fields can be used to create copy for translation purposes. If you type a
Comment in this format:

@(XXX), where XXX = the copy that is to be translated,

the copy you typed in the comment field is added to the default language, named
English.DBF. After the project is compiled, this file is located in Documents and
Settings\All Users\Application Data\Schneider Electric\PowerSCADA Expert 8.2
with Advanced Reporting and Dashboards\User\[your project]. English.dbf contains
terms that will be translated from English.

To create another language file for translation, set the Citect.ini parameter
[Language]LocalLanguage to the specified language, then re-compile. So, for
example, if you set this parameter to French, a French.dbf file is created in the
project folder when you compile. You can then enter the translated text in the
LOCAL field of the file. Repeat this same step for each additional language file you
want in this project.

At runtime, the user will be able to choose the .dbf file that is to be used in the
display, thus changing the language used in the display.

Click Next.
6. At the Select I/O servers screen, choose the primary and standby servers. You can

only set the standby server if you check the "Supports Redundancy" box. Click
Next.

7. At the Configure Sub-Profile Communications Method screen, choose the
communications method used for the first sub-profile in this project. Click Next.
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8. At the Communications Settings screen, type the IP address, port number, and
device address for each of the servers.

NOTE: The DNP3 port number is by definition 20000. You must type 20000 here in
order for communications to work correctly.

If you check the "Same as Primary" box for standby, you will use the same
addresses for the primary and standby. Click Next.

9. At the Port Settings screen, you can rename each of the ports. A new port will be
generated for each new name. Click Next. (See more information about naming
ports in Port Names on page 24.)

10. Repeat steps 6 through 8 for each of the sub-profiles in this project.
11. At the Ready to perform action screen, click Next.

After the devices are added, a screen displays telling you that the project was
updated successfully.

To view a detailed list of all of the device profiles and all operations performed in
the project, check the View audit log box. The list displays after the device is added.

To continue adding or removing device profiles, click Next. Repeat steps 3 through
8.

12. When you have finished adding devices, uncheck the Add/remove more equipment
option, then click Finish.

If you checked the View audit ... box, the list displays.

If you did not check the Add/remove... box, the I/O Device Manager closes. If you
checked the Add/remove ... box, the Welcome screen displays again.

13. From any of the three screens, compile the project.

14. When all errors are corrected, click Run () to view the runtime environment.

Add an IEC 61850 Device to a Project
Use this procedure when you want to add an IEC 61850 device to a project. Note that
these instructions assume that you have two I/O servers, and that you will be renaming
ports.

There will be an additional .dbf file for each translated language. At runtime, the user
will be able to choose the .dbf file that they want to use in the display. This changes the
language in the display.

Before you begin, make sure that you have added at least one cluster and the
appropriate servers for this project (see Add the Cluster, Network Address, and
Servers).

Then, make sure that you have set up each of these clusters in the I/O Device
Manager:

Cluster Setup: Before you add devices, you need to set up each cluster that was
created for the project (you must have added at least one cluster to PowerSCADA
Expert before you do this): 

1. From the I/O Device Manager, under System Devices, click Cluster Setup. Click
Next.

2. At the Enter Instance Information screen, a cluster name displays. Click Next.
3. If there are multiple clusters, the Select cluster screen displays. Choose the cluster

you want to set up. Click Next.
4. If there are multiple I/O servers in the cluster, the Select I/O servers screen displays.

Check Supports Redundancy and select the I/O servers to which you want to add
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the device. Click Next. If there are more than two IO servers per cluster, you must
set them up manually (seeWhen You Set Up More than two I/O Servers per Cluster
on page 22).

5. At the Ready to perform action screen, click Next.

If you have more than one cluster to add, repeat steps 3 through 5 for each cluster.

When you are finished adding clusters and I/O servers, you return to the I/O Device
Manager welcome screen.

Add the IEC 61850 Device

1. From the Start menu, run the I/O Device Manager (Schneider Electric > IO Device
Manager).

The I/O Device Manager screen displays:

2. Click Manage a Single Device.
3. From the new I/O Device Manager screen, click Create one I/O Device, then click

Next.
4. At the Choose profile screen, select the first device profile that you want to use to

add a device to the project. Click Next.
5. At the Enter instance information screen, type a descriptive profile name, for

example: Bay1Circuit1 (no spaces or punctuation; to allow space in PowerSCADA
Expert, the preferred limit is 16 characters). The Comment field is stored in the
equipment.dbf file.

NOTE: There are several “description” or “comment” fields throughout the product.
These fields can be used to create copy for translation purposes. If you type a
Comment in this format:

@(XXX), where XXX = the copy that is to be translated,

the copy you typed in the comment field is added to the default language, named
English.DBF. After the project is compiled, this file is located in Documents and
Settings\All Users\Application Data\Schneider Electric\PowerSCADA Expert 8.2
with Advanced Reporting and Dashboards\User\[your project]. English.dbf contains
terms that will be translated from English.
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To create another language file for translation, set the Citect.ini parameter
[Language]LocalLanguage to the specified language, then re-compile. So, for
example, if you set this parameter to French, a French.dbf file is created in the
project folder when you compile. You can then enter the translated text in the
LOCAL field of the file. Repeat this same step for each additional language file you
want in this project.

At runtime, the user will be able to choose the .dbf file that is to be used in the
display, thus changing the language used in the display.

LDName

In the Additional Information section at the bottom, you can change the original
logical device names for the IED. This is required only if the logical device name
was changed in the SCL file that was imported into the Profile Editor.

BRCBs and URCBs

In the Additional Information, you can also enter BRCB or URCB information.
BRCBs (buffered report control blocks) and URCBs (unbuffered report control
blocks) can be used to return data in blocks rather than in individual tags. To enter
either one, you need to have downloaded an SCL file for the device in question.
When you click the line to add data, you must browse to the SCL file and select the
BRCB/URCB you want. You will need the logical device, logical node, and RCB
names. The Help column gives examples of the formatting that is required.

Click Next.
6. At the Communications Settings screen, browse to the location where you have

saved the SCL file. If there is only one IED, it displays automatically; otherwise,
choose the correct device. Click Next.

7. At the Ready to perform action screen, click Next.

After the devices are added, a screen displays telling you that the project was
updated successfully.

To view a detailed list of all of the device profiles and all operations performed in
the project, check the View audit log box. The list displays after the device is added.

To continue adding or removing device profiles, click Next. Repeat steps 3 through
6.

8. When you have finished adding devices, uncheck the Add/remove more equipment
option, then click Finish.

If you checked the View audit ... box, the list displays.

If you did not check the Add/remove... box, the I/O Device Manager closes. If you
checked the Add/remove ... box, the Welcome screen displays again.

9. From any of the three screens, compile the project.

10. When all errors are corrected, click Run () to view the runtime environment.

Remove a Single I/O Device From a Project
1. Launch the I/O Device Manager window from the Start menu (Start > Schneider

Electric > IO Device Manager).

The I/O Device Manager window displays:
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2. Click Manage a Single Device , then click Next.

The wizard displays.
3. Click Remove one I/O device, then click Next.
4. At the Remove profile instance screen, click the dropdown menu to display the

equipment names that were used when the device profiles were previously added
to the project. From this list, select the device that you want to remove. Click Next.

5. At the Ready to perform action:

To compress the project files after removing this profile, click Pack databases.

Click Next.

After the device is deleted, a screen displays telling you that the project was
updated successfully.

To view a detailed list of devices that you have added or deleted, check the View
audit log box. The list will show all of the device data that has been added, as well
as the data that has been removed in this session. The list displays after you click
Finish.

6. To continue removing devices, check Add/remove more devices, then click Next.
Repeat steps 4 and 5.

7. When you have finished removing devices, uncheck Add/remove more devices,
then click Finish.

If you checked the View audit ... box, the list displays.

If you did not check the Add/remove... box, the window closes. If you checked the
Add/remove... box, the I/O Device Manager window displays again.

Use a CSV File to Define Multiple Devices
The I/O Device Manager makes it easy to commission a PowerSCADA Expert project.
Use this tool to make either single or bulk additions, updates and deletions to the
PowerSCADA Expert device database.

Valid communication protocols are:
• DNP3 Serial
• DNP3 Ethernet
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• Modbus/RTU Gateway
• Modbus TCP
• ION
• ION/Gateway
• IEC60870-5-104 TCP
• IEC61850

You first need to create the .CSV file that you will use to add the devices. For help, see:

Create a CSV File to Add Devices on page 129

After you create the .CSV file, you use it to add multiple devices to the project. See:

Add Multiple Devices to the Project on page 1

Create a CSV File to Add Devices
Follow these instructions to create a CSV file that you will use to add multiple devices
into the project. To view sample CSV files, see:

CSV File Samples on page 133

NOTE: You can edit the CSV file to remove unused columns, or to drag and drop
columns to position them where they are easy to read.

If you leave blank a line, the file will only be read to that point. This is useful later, when
you want to edit a small number of devices. See Update One or All Devices in Project
on page 132

1. For an existing project: Before you begin, make a backup copy of your project.

For a new project: In the PowerSCADA Studio, add a new project, define a cluster;
and add alarm, trend, and I/O servers (see Before You Use the I/O Device Manager
on page 1).

2. In the Profile Editor, create and export a project that includes the device types and
profiles included in this installation. Give the project the same name you used in
step 1. (See Create and Export a Project on page 1 for more information.)

3. In Excel, Open Office, or other .CSV file editor, open the example CSV file for your
device type. The files are named "exampleXX," where XX is the device type, such
as ION or Modbus TCP. These files are located in the Windows Program Data file: 

Program Data > Schneider Electric\PowerSCADA Expert\c8.2\Examples.

NOTE: For sample CSV files, seeCSV File Samples on page 133.
4. In the sample CSV worksheet, enter the following information for each device that

you want to add:

a. ProfileName: the name of the profile that has been exported from the Profile
Editor into the target PowerSCADA Expert project. Type the names of the
profiles that have been selected for this project. To view names, open the Profile
Editor utility.

b. Name: Enter the device name, limit of 32 characters; include only letters,
numbers, and underscores (_). The first character cannot be a number or
underscore. This field becomes the "Name" on the I/O Devices screen and the
"I/O Device" name on the Equipment screen.

c. Cluster: The name of the cluster to which the device will be added. If there is
only one cluster in the project, this column is not required.

d. Equip: Enter the equipment name, limit of 40 characters; include only letters,
numbers, and periods (.). The first character cannot be a number or period. This
is an optional field. If it s not specified, the "Name" (b) is used. You will use this
when adding genies to drawings.
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e. Primary IO Server Name: The name of the primary server I/O server for the
device.. If there is only one I/O server in the project, this field is not required.

f. CommsMethod: Type the communications protocol being used, e.g.,
MODBUS/RTU via Gateway. See list below for alternate communication
connections. When using a composite device, do not use this field. You must
enter a "SubProfile1Description" (and a "SubProfile2Description" for the second
part of the composite device).
NOTES: If the CommsMethod column is missing and you define more than one
CommsMethod in the profile:
- If one of them is Modbus/RTU via Gateway, it will be used.
- If one of them is ION it will be used (if there is no MOdbus/RTU via Gateway).
If the CommsMethod column is missing and you define only one CommsMethod
for the profile, it will be used.
DNP3 Serial
DNP3 TCP
Modbus/RTU via Gateway
Modbus/TCP
ION
ION/Ethergate
IEC60870-5-104 TCP
IEC61850 Native

g. PrimaryIPAddress: Type the IP address for the the primary server (required only
for MODBUS/RTU and MODBUS/RTU via Gateway).

h. PrimaryEquipmentAddress: Type the device address (required only for
MODBUS/RTU and MODBUS/RTU via Gateway).

i. PrimaryPortName: Optional (see description below at Port Names.). Type the
port name of the primary server (required only for MODBUS/RTU and
MODBUS/RTU via Gateway).

j. Standby IO Server Name: If you have a redundant I/O server, type the name
here.

k. StandbyIPAddress: If you have a redundant I/O server, type its IP address.
l. StandbyEquipmentAddress: If you have a redundant I/O server, type the device

address (required only for MODBUS/RTU and MODBUS/RTU via Gateway).
m. StandbyPortName: Optional (see description below at Port Names.) If you have

a redundant I/O server, type the device port name (required only for
MODBUS/RTU and MODBUS/RTU via Gateway).

n. Columns that begin with "SubProfile" followed by a number (e.g., SubProfile1,
SubProfile2, SubProfile3, etc.) are used to provide the same information as the
Primary and Standby columns for composite devices where each SubProfile is
a specific device which is part of the larger composite device.

o. PrimaryPortNumber: Type the port number of the primary server (required only
for MODBUS/RTU and MODBUS/RTU via Gateway).

p. PrimaryComPort: MODBUS/RTU devices only: 1–99
q. PrimaryBaudRate: MODBUS/RTU devices only: 1200–115200
r. PrimaryDataBits: MODBUS/RTU devices only: 1–99
s. PrimaryStopBits: MODBUS/RTU devices only: 0–99
t. PrimaryParity: MODBUS/RTU devices only: None, Odd, or Even
u. Primary SclFileName: For IEC61850 Native, the file path where the CID (SCL)

file is stored.
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v. Primary IedName: For IEC61850 Native, the name of the IED in the CID file.
This was created when the profile was added in the Profile Editor.

w. FTPHost: For IEC61850 Native, the on-board FTP. Not currently used in
PowerSCADA Expert.

x. FTPUserName: For IEC61850 Native, the username for FTP on the device.
y. FTPPassword: For IEC61850 Native, the password for FTP on the device.
z. BRCBS/URCBS: For IEC61850 Native, buffered report control blocks (BRCBs)

and unbuffered report control blocks (URCBs) can be used to return data in
blocks, rather than in tags. These two fields provide the instruction used for
each. The two examples in the example are:
BRCB: CFG/LLN0$BR$BRep01,CFG/LLN0$BR$BRep06
and
URCB: CFG/LLN0$RP$URep02

aa.Optional Parameters: This is optional, and used for functional addressing. This
column is a pipe ("|") delimited list.

ab.Parameter Values: This is optional, and is used in functional addressing. This
column includes pipe ("|") delimited values for each of the Optional Parameters.

ac. Comment: This is an optional description of the device; maximum 254
characters.

5. Close the example .csv file, if it is open.
6. Go to Add Multiple Devices to the Project on page 1 to add the devices from this

.CSV file to your PowerSCADA Expert project.

Port Names
If you enter a port name, it will be used. Undesignated port names are automatically
generated using this format:

Non/TCP Comms (not having an IP address):
Px_BOARDx_PRJx

where Px = a unique port number, BOARDx = a unique board number, and Prjx = a
unique project (e.g., P1_BOARD3_PRJ3).

TCP Comms (having an IP address):
P(ipaddress)_BOARDx_PRJx

where P = port followed by the IP address, BOARDx = a unique board number, and
Prjx = a unique project (e.g., P10_0_0_1_BOARD2_PRJ3).

To generate the port name:
— For PrimaryPortName, the PrimaryIPAddress is used.
— For StandbyPortName, the StandbyIPAddress is used.
— For SubProfileXPrimaryPortName, the SubProfileXPrimaryIPAddress is used.
— For SubProfileXStandbyPortName, the SubProfileXStandbyIPAddress is used.

Add a Comment Line

You can add a comment line that will be ignored during processing. To create a
comment, begin the line with a double forward slash (//). PowerSCADA Expert skips
this line as it processes the device information. See the example below. In the
example, lines 5 and 10 will be skipped.
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Use a CSV File to Define Multiple Devices
The I/O Device Manager makes it easy to commission a PowerSCADA Expert project.
Use this tool to make either single or bulk additions, updates and deletions to the
PowerSCADA Expert device database.

Valid communication protocols are:
• DNP3 Serial
• DNP3 Ethernet
• Modbus/RTU Gateway
• Modbus TCP
• ION
• ION/Gateway
• IEC60870-5-104 TCP
• IEC61850

You first need to create the .CSV file that you will use to add the devices. For help, see:

Create a CSV File to Add Devices on page 129

After you create the .CSV file, you use it to add multiple devices to the project. See:

Add Multiple Devices to the Project on page 1

Update One or All Devices in Project
If you need to change information for devices in your project (e.g., the IP address
changes), do the following. This will update both the CSV file and the project:

1. (optional) If you want to edit only a small number of devices in a very large CSV file,
you can save time by moving the devices you are updating to the top of the CSV
and leaving a blank line between them and the rest of the CSV file. When
PowerSCADA Expert reads the CSV file during the update, it will stop processing
after those devices. Make sure you remember to remove the blank line after you
update.

2. Make the desired changes to the CSV file. This can include editing existing
columns and adding new columns.

NOTE: If you change the name of a device, you must add a new column to the CSV
file. The name will be either from the Equip field. If you did not specify Equip, the
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Name field will be used. For details on CSV fields, seeCreate a CSV File to Add
Devices on page 129.

Name the column OriginalName, and type the device's original equipment name in
that column. Otherwise, the update will fail for that device.

3. Open the I/O Device Manager: From the Start menu, click Start > Schneider Electric
> IO Device manager.

4. In the I/O Device Manager, click Import Devices From CSV to display the Manage
Multiple Devices screen.

5. Click Update Devices.

Changes in the CSV are used to update the devices in the project.

CSV File Samples
When you want to add multiple devices at a single time, you will create CSV files. The
following files are samples of files that may be used for some of the various
communication protocols.

For instructions on defining multiple devices, see Use a CSV File to Define Multiple
Devices on page 132.

DNP3 for Serial and Ethernet

IEC104.2

IEC61850
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Use PowerSCADA Expert One-Lines
Click the following links for related one-line information.

One-Line Flowchart on page 134
What Are PowerSCADA Expert One-Lines? on page 135
One-Line Device (zOL) on page 136
One-Line Colors on page 137
Add INI Settings to AdvOneLine.ini and Citect.ini on page 137
Start and Stop One-Lines on page 139

One-Line Flowchart
This chart provides an overview of the process that you will follow to set up and use
animation in one-lines.

For detailed information on one-lines see:

Running the AOL Configuration Utility:

Review Genie Configurations on page 144

Perform Repairs for One-Lines on page 147

Setting Up Animation Colors:

One-Line Colors on page 137

INI Settings and Passwords:

Add INI Settings to AdvOneLine.ini and Citect.ini on page 137
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After you run the project, ensure that the password is encrypted (see IsEncrypted in
Add INI Settings to AdvOneLine.ini and Citect.ini on page 137).

Ensure that all steps in the Quick Start procedure have been followed: .

What Are PowerSCADA Expert One-Lines?
PowerSCADA Expert one-lines provide the following features. They:
• graphically propagate unknown conditions downstream through a one-line

diagram. When there is a communications loss to a device, the one-line provides
accurate system status, even though information is not available.
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• eliminate "seesaw logic": when bus status temporarily toggles on and off after an
upstream breaker opens

• handle the continuation of a one-line diagram when it extends from one page to
another

• provide built-in support for power flow diagrams; one-line color
"animates," based on the source that is feeding the circuit.

Where are the files located?
Listed below are several important files in one-line animation. Changing any of these
files could make the animation be inoperative.

PLS_Include
AdvOneLine.exe Application running the core one-line bus animation logic engine

AdvOneLine.ini Specifies performance and configuration parameters for AdvOneLine

AdvOneLine.csv One-line example configuration

Current RUN project
AdvOneLine.csv Specifies the system configuration for AdvOneLine

AdvOneLine.ini Specifies performance and configuration parameters for AdvOneLine

AdvOneLineDebugBus.csv
Created at runtime to help debug the AdvOneLine.csv by specifying all
bus connections

AdvOneLineStatusLog.txt Created at runtime to specify status and error messages that might occur

One-Line Device (zOL)
To use one-line graphics, you must create a memory device named zOL. One-line
graphics use the zOL device to drive animation. You must have at least one zOL
device per project.

To add the zOL device:

1. Open the I/O Device Manager.
2. Click Create an I/O Device in the project. Click Next.
3. Select the device called OneLine Device Setup. Click Next.
4. Follow the remaining steps to add the device.

By default, this device will support 100 sources, 1000 buses, 1000 meters, and 1000
breakers. You can modify this via the Profile Editor:

1. On the Setup Projects tab, choose the project.
2. Click the Project Parameters subtab.
3. Enter the optional project parameters (MaxBreakers, MaxBuses, MaxMeters,

MaxSources). Valid entries are from 1 to 9999 (only 200 for MaxSources).
4. On the Selected Device Profiles subtab, click Refresh Tags.
5. Export the project.
6. In the I/O Device Manager: Select the Update one or more I/O Device(s) in the

project option. This updates the zOL I/O device parameters entered in step 3.

The new one-line device is ready to be used in the selected project.
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One-Line Colors
In previous versions of the software, line coloring was determined by the line active
state of the busbar. Driven by the busbar color, this state was then fed to all of the
components on that page.

In PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards, coloring is
based on the source and meter line active states. Sources dictate the colors for each
genie. Meters can only determine if a bus is active. When the bus is live, the meter then
colors based on the source that is connected to the bus. If there is no source, the
default color is used.

NOTE: Depending on how you configure transformers, you can either use this "pass-
through" coloring, or you can use "voltage-level" coloring. See Configure a
Transformer on page 142 for more information.

Assigning Colors
To assign a color to a source, open the Color Configuration tab of the One Line
Configuration Utility (PowerSCADA Studio, Projects tab, click 'Launch the Single Line

Configuration Utility' ( ).

1. Choose the project for which you want to assign colors.
2. Choose the Project Color Palette. Select the project in which the project genies are

defined: usually PLS_Include.
3. For each source or transformer, choose the desired color: click the color cell for that

source/transformer; then choose the color from the dropdown list. You can also
select a color for unknown sources, off, and error. To indicate a flashing color, you
can select two colors.

4. When all colors are assigned, click Save.

Add INI Settings to AdvOneLine.ini and Citect.ini
NOTE: See Application Configuration Utility on page 220 for screens that streamline
configuration.

All .ini settings are made in the OneLineEng section of the .INI files.

You must have correct .INI settings in order for the one-lines to run properly. Ensure
that the following .INI parameters are properly set:

AdvOneLine.ini Settings
The following parameters are set in the Application Configuration Utility (One-Line
Engine on page 224): UpdateInterval, PrimaryServerIP, StandbyServerIP,
HealthTimeout, MaxStartupDelay, LoginUserName, LoginPassword, and
LogFileLength.

Parameter Description Default Value

Updateinterval

The interval at which the system tries to solve the
system one-line. This interval can be changed to slow
down the rate at which the animation is solved.
Specifying a rate faster than possible will force the
engine to solve the system as quickly as possible.

1000msec
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Parameter Description Default Value

PrimaryServerIP

Used by redundant configurations to specify the
IP address of the server on which the primary IOServer
resides. This parameter is required for a redundant
configuration. If either the primary or standby
IP addresses are not specified, the logic engine will
assume that the system is not redundant.

N/A

StandbyServerIP

Used by redundant configurations to specify the IP
address of the server on which the standby IOServer
resides. This parameter is required for a redundant
configuration. If either the primary of standby IP
addresses are not specified, the logic engine will
assume that the system is not redundant.

N/A

HealthTimeout

This is a performance parameter that dictates that
amount of time that must elapse before the one-line
engine is considered non-functioning, and a PC-based
alarm is raised in PowerSCADA.

[Updateinterval] +
[TagSubscribeWait] * 5
milliseconds

Minimum value: 1000msec

DefaultColor

This cosmetic parameter tells the engine the default
color to be assigned to objects on the screen at
system startup. This is useful for identifying
components that have been left out of the CSV or
simply as ameans of having the engine set all
currently unused objects to a color that indicates that
they are not beingmonitored. If an invalid color is
specified, the engine will default to black.

250

MaxStartupDelay

Sets the amount of time the AdvOneLine.exe has to
start up. If this time is exceeded, initial tag
subscriptions will not succeed, and the EXEwill report
an exception.

60 sec

StartupDelay
Sets the amount of time after AdvOneLine.exe has
started for the system to be on line and all
initializations complete.

[Updateinterval] +
[TagSubscribeWait] * 5
milliseconds

Minimum value: 1000msec

LoginUserName
This is the user name to be used for the
ctAPI connection in AdvOneLine.

aol

LoginPassword
This is the user password to be used for the ctAPI
connection in AdvOneLine.

aol

IsEncrypted
Determines if the password is encrypted. The first
time the project is opened in run time, the password is
automatically encrypted, and this will be set to True.

False (changed to True after
the first run and successful
password encryption)

CitectIniPath32

Provides the path to the global Citect.ini file for a 32-bit
operating system install. This settingmust be changed
if SCADA is not installed on the C: drive, or if the
Citect.ini file is moved/installed in another directory.

Default value: C:\Documents
and Settings\All
Users\Application
Data\Schneider
Electric\PowerSCADAExpert
8.2 with Advanced Reporting
and Dashboards\Config

LogFileLength
Suggests the log file length in number of lines. After
surpassing this limit, the log file is saved with suffix
“.bak,” and a new file is created.

Default value: 5000

Allowed values: 10–10000

DebugLevel
Sets the level of logging for AdvOneLine.exe.

Multiple values are separated by | (e.g., Error|Warn).

N/A

Allowed values:

All, Error, Warn, Debug
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Citect.ini Settings

Parameter Description Default Value

AutoRestart
Indicates whether the one-line will restart itself when
the logic engine is not responding.

0 (disabled)

Allowed values: 0, 1

ServerRole

Informs the local instance of PowerSCADAwhere it is
(primary or standby server). This parameter is
controlled by the AdvOneLine.exe application. The user
does not need to create or modify this parameter. It is
set based on the PrimaryServer IP and
StandbyServerIP parameter settings.

Primary

StartupDelay

This is a performance parameter that dictates that
amount of time that must elapse before the one-line
engine is considered nonfunctioning, and a PC-based
alarm is raised in PowerSCADA.

15 sec

Start and Stop One-Lines
If you need to start or stop AdvOneLine.exe, call one of these Cicode functions.

Only call these functions on an I/O server that is communicating with an One-Line
Device (zOL) on page 136.

To stop AdvOneLine.exe, call:

PLS_StopAdvOneLine(STRING sIOServer="",STRING sCluster="")

To start AdvOneLine.exe, call:

PLS_StartAdvOneLine(STRING sIOServer="",STRING sCluster="")

NOTES:
• If the default parameters are used, the functions will run on the local machine.
• If you call the function from a remote server, enter the I/O server name and cluster to

run the function on that server. You must be logged in to perform this action.

Work with Genies
Use these topics to create and configure genies:

Genie Type Descriptions on page 139
Configure an Automatic Transfer Switch (ATS) on page 140
Configure a Busbar on page 140
Configure a Circuit Breaker or Switch on page 141
Configure a Meter on page 141
Configure a Source on page 142
Configure a Transformer on page 142
Enable Lockout/Tagout on page 113
Create New Genies on page 115
SupportedGenies.xml File on page 143

Genie Type Descriptions
In the One Line Configuration Utility, there are several genies. Each one has a certain
defined list of information that displays by default. You can also expand this list to
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include everything that is known about that genie type. To learn about each genie's
data, click one of the following links:

Breaker and Switch Information on page 150
Meter Information on page 151
Source Information on page 151
Transformer Information on page 152

For configuration instructions, see:

Configure a Busbar on page 140
Configure a Circuit Breaker or Switch on page 141
Configure a Meter on page 141
Configure a Source on page 142
Configure a Source on page 142
Configure an Automatic Transfer Switch (ATS) on page 140

See also:

Enable Lockout/Tagout on page 113

SupportedGenies.xml File on page 143

Configure an Automatic Transfer Switch (ATS)
Use this option to configure automatic transfer switches (ATS) that you add to a one-
line in the graphics builder.

1. Display the Transfer Switch window by pasting the appropriate genie on to the
graphics builder page.

Transfer Switch Information: Left/Right/Bottom
2. Breaker Number: Type the ID numbers you want to use for the left side and right

side of this ATS. Valid entries: 1–1000. Each number must be unique within this
one-line.

3. Busbar: Type the numbers of the left and right source busbars, and for the
destination (bottom) busbar. Valid entries: 1–1000.

4. Label: For each ATS side, type the information that you want to appear on the
switch in the runtime environment (example: Pri and Emer).

5. Closed Expression: For each side of the switch, type the information that should
display when that side is closed (example: Tag1 <> 1). Do not use "NOT" in the
expression.

Display Information
1. Label 1/Label 2: Type the descriptive information that you want to appear in the

upper left corner of the genie in the runtime environment.
2. Click OK to save the genie to the page and to return to the graphics builder page.

For information on how colors are determined, see One-Line Colors on page 137.

Configure a Busbar
Use this option to configure busbars that you add to a one-line in the graphics builder.
Using this option, you can assign a busbar number to a busbar, and ultimately, to use
busbars to connect genies on a one-line.

Busbar numbers associate devices within drawings, and they help you set up
animation for genies. The busbar entered here is also used for the associated device.
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1. Display the busbar window by pasting the busbar genie on to the graphics builder
page.

2. Busbar Number: type the number you want to use for this busbar. Valid entries: 1–
1000.

3. Line Active: This field is no longer used.
4. Click OK to save the genie to the page and to return to the graphics builder page.

For information on how colors are determined, see One-Line Colors on page 137

Configure a Circuit Breaker or Switch
Use this option to configure circuit breakers or switches that you add to a one-line in
the graphics builder.

1. Display the circuit breaker or switch window by pasting the appropriate genie on to
the graphics builder page.

2. Equipment: From the drop-down list, choose the name of the equipment
represented by the genie (this is the equipment name that you entered in the
I/O Device Manager, e.g., CM4Main). To view the equipment that is available for
this page, you must have the project selected in the PowerSCADA Studio.

3. Breaker/Switch Number: Type the number you want to use for this breaker or
switch. Valid entries: 1–1000. This number must be unique within this one-line.

4. Source and Destination: When you connect to busbars, type the numbers for the
connection source and destination busbars. Valid entries: 1–1000.

5. Label 1 and Label 2: Type the information that you want to appear in the upper left
corner of the genie in the runtime environment.

6. Value Type: From the drop-down list, choose the tag you want to use for this genie.
The related information displays in the lower left corner of the genie in the runtime
environment.

This tag causes real-time data (such as currents) to display on the genie status
page in the runtime environment. If you do not choose a tag here, the status page
will not display the real-time data. See Use the Equipment Pop-Up Page on page
180 for more information.

7. Units: From the drop-down list, choose the unit that you would like to display on the
genie in the runtime environment. Units that display here were added in the Profile
Editor (see Add or Edit a Base Engineering Unit or Conversion on page 40).

8. Multiplier: Enter the multiplier that is to be applied to the units chosen in step 7.
9. Click OK to save the genie to the page and to return to the graphics builder page.

NOTE: If you choose to resize a circuit breaker genie after you paste it into a page, you
must keep the relative dimensions (proportions) the same. Otherwise, the racked
in/racked out animation will not display correctly.

For information on how colors are determined, see One-Line Colors on page 137.

Configure a Meter
Use this option to configure meters that you add to a one-line in the graphics builder.

1. Display the meter window by pasting the meter genie on to the graphics builder
page.

2. Equipment: From the drop-down list, choose the name of the equipment
represented by the genie (this is the equipment name that you entered in the
I/O Device Manager, e.g., CM4Main). To view the equipment that is available for
this page, you must have the project selected in the PowerSCADA Studio.
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3. Meter Number: Type the number you want to use for this meter (valid entries: 1–
1000). This number must be unique within this one-line.

4. Busbar Number: Type the number for the busbar that connects to the meter. Valid
entries: 1–1000.

5. Line Active: Enter the appropriate Cicode expression (such as MyTag1 > 0) to
determine when the meter detects power on the busbar. See "How do I create and
configure busbars" inAppendix 5: Frequently Asked Questions (FAQs) on page 293
for more information.

6. Label 1 and Label 2: Type the information that you want to appear in the upper left
corner of the genie in the runtime environment.

7. Value Type: From the drop-down list, choose the tag you want to use for this genie.
The related information displays in the lower left corner of the genie in the runtime
environment.

This tag causes real-time data (such as currents) to display on the genie status
page in the runtime environment. If you do not choose a tag here, the status page
will not display the real-time data. See Use the Equipment Pop-Up Page on page
180 for more information.

8. Units: From the drop-down list, choose the unit that you would like to display on the
genie in the runtime environment. Units that display here were added in the Profile
Editor (see Add or Edit a Base Engineering Unit or Conversion on page 40).

9. Multiplier: Enter the multiplier that is to be applied to the units chosen in step 8.
10. Click OK to save the genie to the page and to return to the graphics builder page.

For information on how colors are determined, see One-Line Colors on page 137.

Configure a Source
Use this option to configure sources (e.g., utilities and generators) that you add to a
one-line in the graphics builder.

1. Display the source window by pasting the generator or utility genie on to the
graphics builder page.

2. Source Number: Type the number you want to use for this source (valid entries: 1–
100). This number must be unique within this one-line.

The source number is used when you determine coloring for the one-line. For more
information on this, see One-Line Colors on page 137.

3. Busbar Number: Type the number for the busbar that connects to the source. Valid
entries: 1–1000.

4. Line Active: Enter the appropriate Cicode expression (such as MyTag1 > 0) to
dictate when the source powers the busbar. See "How do I create and configure
busbars" inAppendix 5: Frequently Asked Questions (FAQs) on page 293 for more
information.

5. Click OK to save the genie to the page and to return to the graphics builder page.

For information on how colors are determined, seeOne-Line Colors on page 137.

Configure a Transformer
Use this option to configure transformers that you add to a one-line in the graphics
builder.

1. Display the transformer window by pasting the appropriate genie on to the graphics
builder page.
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2. Top and Bottom Source Number: For each source, whether top or bottom, type a
source number to control voltage-level coloring for the secondary side busbar.
Valid entries: 1–100.

There are two possible configurations:

Pass-through coloring: If you leave these fields blank, the transformer will transfer
the color that is assigned to the primary side (source) to the secondary side
(destination) busbar. For example, if Source 3 feeds the source busbar of a
transformer, and you leave this field blank, then Source 3 will also feed the
destination busbar (and the Source 3 color will be used).

Voltage-level coloring: When you enter top and bottom source numbers, the
transformer colors the one line based on this number. For example, if Source 3
feeds the top of the transformer, but you enter 5 for the bottom source, the
transformer feeds the color from Source 5 to the destination (bottom) busbar.

3. Source and Destination: When you connect to busbars, type the numbers for the
connection source and destination busbars. Valid entries: 1–1000.

4. Label 1 and Label 2: Type the information that you want to appear in the upper left
corner of the genie in the runtime environment.

5. Click OK to save the genie to the page and to return to the graphics builder page.

For information on how colors are determined, see One-Line Colors on page 137.

GenieDefinitions.xml File
Example

Use the GenieDefinitions.xml file to define both completely new (unique) genies and
those that have been copied and modified from an existing genie.

This file defines each genie in detail. It links fields with genie parameters names,
defines validation, and defines how to export each genie for the one-line.

Some fields have limited possibilities. See the comments for each part of the XML file.

See also: SupportedGenies.xml File on page 143

SupportedGenies.xml File
Example

Use this file to define genies that support one-line coloring.

This file links genies in a library to a "genie type." In this file, you need to define the
project name, library name, and genie name. The genie name may be "*": which will
select all genies that library. You can exclude individual genies.

See also:GenieDefinitions.xml File on page 143

Work in the Configuration Utility
Use these topics to learn about how you use the Configuration Utility to review genie
configurations before you compile a project. Then you can view errors and warnings,
and repair and upgrade genies.

One-Line Configuration Utility on page 144

Review Genie Configurations on page 144

One-Line Errors and Warnings on page 145

Perform Repairs for One-Lines on page 147
Automatic Transfer Switch (ATS) Information on page 148
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Busbar Information on page 149
Breaker and Switch Information on page 150
Meter Information on page 151
Source Information on page 151
Transformer Information on page 152

One-Line Configuration Utility
To access this screen from the PowerSCADA Studio. From the left hand panel, click

'Launch the Single Line Configuration Utility' (   ). There are two tabs.

On the Genie Configuration tab, you can:
• view genie types, along with their states (normal, warning, error) and their

properties
• repair genies that are part of a version 7.30 or later project:

— corrects incorrect breaker, source, meter, transformer, and Sim source numbers
— corrects invalid line active when a connected busbar has a valid line active

• repair and upgrade genies that are part of a project from a version earlier than 7.30
— renumbers ALL breaker, source, meter, and Sim source numbers
— corrects invalid line active when a connected busbar has a valid line active
— reassigns ALL valid busbars

See Review Genie Configurations for information about using this tab.

On the Color Configuration tab, you can assign colors to sources. see One-Line
Colors on page 137 for information about using this tab.

Modify AdvOneLine.csv
After you run the One-Line Configuration Utility, open the project to verify that the
animation is working correctly. If the animation is not correct, repeat the process of
running the utility and verifying out animation until all errors are corrected.

Review Genie Configurations
Use the one-line configuration utility to review genie configurations before you compile
your project.

Errors ( ) and warnings ( ). You must correct errors; otherwise, you may not
be able to compile, and the animation will not work. Although you might not need to
correct warnings, you should review them to ensure that their settings are correct. Note
that, as you hover over an error or warning icon, a tooltip tells you what is wrong with
the genie.

Before you use the compile, do the following:
• If you are upgrading from an earlier version, run Update Pages in the Graphics

Builder.
• Create the pages.

To launch the utility:

1. Make sure you are viewing the system for which you want to view information.
2. From the left panel of the PowerSCADA Studio, cclick 'Launch the Single Line

Configuration Utility' (   ).
Click OK to the message that displays.
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The first time you load the utility, a large system could take a couple of minutes to
load. After that, it should load with a minute.

The utility displays with the following information:

Field Description

Project Default: the project selected in PowerSCADA Studio.

Show By:

Type: Information is sorted first by genie type, then by page. This option is useful
when you want to see all genies of a certain type together, regardless of where they
are in the drawing pages.

Page: Information is sorted first by page, then by genie type. This option is useful
when you want to see all genies on a certain page.

Advanced Properties
Check this box to view the basic information plus any additional information relevant
to that genie type.

State Filters:
Check the individual boxes for how you want to view information. For example, you
might only be interested in viewing genies that have error states. This option controls
only the genie information in the right-hand pane.

Genie Types Types are: breakers, busbars, meters, sources, and transformers

Genie Information

Columns of information display:

In the Basic (default) view: themost used information

If you click Advanced Properties, you see the basic information, followed by all of the
information known about the genie(s) you are viewing.

Repair—Upgrade Project

Check this box to cause the repair feature to repair the entire project.

Use this feature only to upgrade projects that are earlier than PowerSCADAExpert
8.2 with Advanced Reporting and Dashboards. This option repairs the entire project,
renumbering all busbars, breakers, meters, duplicate Sim sources, and sources.
Additionally, busbar line active states are used to determinemeter and source line
active states.

DO NOT perform Repair—Upgrade Project more than once, and do not perform it on
a PowerSCADAExpert 8.2 with Advanced Reporting and Dashboards project.

Repair This feature attempts to repair errors and warnings.

For specific information about each type of genie, click a link below:

Breaker and Switch Information on page 150

Busbar Information on page 149

Meter Information on page 151

Source Information on page 151

Transformer Information on page 152

One-Line Errors and Warnings
Typical one-line errors are:
• CSV formatting errors
• files required by the logic engine are locked or open in another process
• nonexistent tags are specified in CSV conditions
• not running the Computer Setup Wizard for the runtime project
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Communication Errors
When communication errors occur, the object that has lost communications gives an
"unknown" status, which is graphically represented in the one-line animation.

Objects in the one-line should be defined to display the communication errors as a
different color. The errors are calculated using the quality of a tag. If a tag or point
becomes invalid, it is assumed that the communication is also off line. When this
occurs, the graphical objects (buses, breaker, and sources) should change to the pre-
set "unknown status" color (the array position 255 in the graphic).

Error Logging
The most common errors in a CSV file are logged to the Run project in a file named
AdvOneLineStatusLog.txt. The file can contain several messages The table below lists
these errors and their descriptions.

Error Message Description

Main Execution Loop Unexpected Failure
Themain logic loop has thrown an exception that has not been
handled by other error messages.

AdvOneLineDebugBus.Csv is locked
Another process or user has this required CSV file locked.
Ensure that you do not have the file open.

PowerSCADAExpertRunning Project
Path: "PATH"Does not Exist. Please
Shutdown your Project and Try Running your
Computer SetupWizard

The Citect.ini "Run" parameter has an invalid project path that
does not exist. Run the Computer SetupWizard, and this path
should be corrected.

PowerSCADAExpertRunning Project Pth Not
Specified. Please Shutdown your Project and
Try Running your Computer SetupWizard

This problem is almost exclusively caused by not running the
Computer SetupWizard.

PLSCADA is not in runtime
Youmust have your project running before you execute the
AdvOneLine.exe file.

Failed to Establish Connection with CTAPI.
PLSEngine.establishPLSConnection
(FAILED CONNECTION)

This error message indicates the PLS API connection has
unexpectedly been disconnected.

Required CSV file is locked
The CSV file specified (AdvOneLine.csv) is locked by another
process or user. Ensure that you do not have the file open.

Invalid prefix located in
CSVParser.FormatCSVData

The CSV parser has detected an invalid component prefix. This
error message should not occur.

ERROR: Duplicate Component Name
Encountered

Check the CSV file to ensure that you do not have two sources,
meters, or breakers with the same component number.

ERROR: Invalid Node1 Number Encountered
In the Bus1 column, you have a node that is not a number
between 1 and 1000.

ERROR: Invalid Node2 Number Encountered
In the Bus2 column, you have a node that is not a number
between 1 and 1000.

ERROR: Node Not Specified You have a component without a Bus1 and/or Bus2 specified.

ERROR: Invalid Condition String
Encountered (MESSAGE)

You have a syntax error in your condition column. Read the
message. It will give details about the syntax error, the line on
which it occurred, and (if applicable) the character at which it
occurred.

One or more of the tags specified in your CSV
file do not exist in your Runtime SCADA
project

Examine your CSV file. Either add the tags listed above the error
message, or remove the tags from the CSV

By default, only exceptions are logged. For more details, see the information on the
Add INI Settings to AdvOneLine.ini and Citect.ini.
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Perform Repairs for One-Lines
Before you begin, back up your project.

CAUTION
DATA CORRUPTION

Always make a backup copy of your project before you perform a repair.

Failure to follow these instructions can result in data loss and corruption of your project.

Follow these steps to view the One Line Configuration Utility, and to make repairs to
your projects:

1. Open the configuration utility: From the Start menu, click All Programs > Schneider
Electric > Configurator.

The first time you launch this utility, it could take several minutes for it to read all of
the project information.

The utility will read the project's graphics pages to analyse the project. If it appears
that the project is from a version prior to PowerSCADA Expert 8.2 with Advanced
Reporting and Dashboards, a message displays, telling you that the project
appears to be out of date. The default "Upgrade Project" is checked in the lower
right corner.

2. Click OK.

Genie information for the selected project displays. For descriptions of the fields on
this page, see Review Genie Configurations.

3. Choose the type of repair you want to perform:

Repair option alone (Upgrade Project not checked) attempts to fix errors and
warnings in a project (used for PowerSCADA Expert 8.2 with Advanced Reporting
and Dashboards).

Repair option with Upgrade Project checked is used to upgrade projects
from previous versions of the product. This option renumbers all genies in the
project. Do not perform this option on a project more than once, and do not perform
it on PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards projects.

NOTE: When two busbars have the same line active, they are assigned the same
busbar number.

The following table describes the repairs made in each option.

Genie Type Repair Repair— Upgrade Project

Breaker Breaker Number ALL Breaker Numbers

Sources
Source Number

Line Active

ALL Source Numbers

Line Active

Meters
Meter Number

Line Active

ALL Meter Numbers

Line Active

Transformers
Sim Source Numbers (top and
bottom)

Sim Source Numbers (top and bottom)

Busbars ----
All valid busbars will be reassigned, including
destination and source busbars for breakers and
transformers

4. Click Repair.
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You see a message that describes the degree of repair that is about to take place.

Each message says that graphics pages "will not be modified by the repair
process." This means that the repairs will not be applied to your project graphics
pages until you press Save.

5. Click Yes to initiate the repair option that you have selected.

A Repair Summary window displays, listing the repairs that have been initiated.
6. To save a .csv copy of this summary, click Export. At the Save As window, type a file

name and choose the location at which you want to save the file.
7. Click OK.

The genie information changes, indicating that the repairs have been made.
8. Click Save.

The Save window appears. This is where the changes are saved to your project.
9. Click Yes to save the changes to the graphics pages of the project.

Or click No to back out of making the changes.

If you click No, click Close, then click No when you are asked whether you want to
save the modified project.

If you click Yes, the changes are saved to the project. For a large project, this might
take several minutes. When the repairs are saved to the project, you see a Save
Summary window, which lists the repairs that were made and saved.

Click Export to save a .csv file of these changes. Click OK to exit the summary
window and return to the One Line Configuration Utility window.

10. It is possible that some errors and warnings will not be repaired, for example,
missing busbar numbers or missing equipment. Click individual errors or warnings
to view them (note that the warning and error icons include a tooltip to tell you what
is wrong). Note the missing information, then go to the graphics builder to make the
necessary changes.

11. Compile the project and then run it.

Automatic Transfer Switch (ATS) Information

ATS Information
The most commonly used information about the ATS genie displays by default.

When the Advanced Properties box is checked, the table expands to include
everything that is known about the selected ATS.

Basic ATS information includes:

Column Description

State
Normal ( ), Warnings ( ), or Errors ( ). See the following table for

explanations of errors.

Page
Name of the page on which the genie is found (displays only from the folder
level).

ID
This is the breaker number for the left side, assigned when adding it to a
page of a one-line.

ID2
This is the breaker number for the right side, assigned when adding it to a
page of a one-line.
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Column Description

Source Busbar1 The number of the source busbar for the left side.

Source Busbar2 The number of the source busbar for the right side.

Dest. Busbar The number of the destination busbar.

ATS Errors
Before you use the drawing, you must correct all errors. Otherwise the project might not
compile; and the animation will not work.

Errors that you might see for ATSs are:

State Solution

Errors ( )

Breaker numbers must be a
number greater than 0 and
unique.

The breaker numbers aremissing, or they are less than or equal to 0. Add or
change the breaker numbers.

Source busbar numbers must be
a number greater than 0.

The source busbar numbers aremissing, or they are less than or equal to 0.
Add or change the source busbar numbers.

Destination busbar number must
be a number greater than 0.

The destination busbar number is missing, or it is less than or equal to 0. Add
or change the destination busbar number.

Source and Destination busbars
must not be equal.

The source and destination busbars have the same number; change one
number.

Either the Source or Destination
Busbar number must exist
(busbar may link to a Busbar,
transformer, meter, source, or
another breaker)

At least one busbar must be linked to this ATS.

Busbar Information
The most commonly used information about the busbar genie displays by default.

When the Advanced Properties box is checked, the table expands to include
everything that is known about the selected busbar(s).

Basic busbar information includes:

Column Description

State
Normal ( ), Warnings ( ), or Errors ( ). See the following

table for explanations of errors and warnings.

Page
Name of the page on which the genie is found (displays only from the
folder level).

ID
This is the busbar number, assigned when adding it to a page of a
one-line.

Busbar Errors
Before you use the drawing, you must correct all errors. Otherwise the project might not
compile; and the animation will not work.

Errors that you might see for busbars are:
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State Solution

Errors ( )

Busbar number must be a
number greater than 0.

The busbar number is missing, or it is less than or equal to 0. Add or
change the busbar number.

Breaker and Switch Information
The most commonly used information about the breaker genie displays by default.

When the Advanced Properties box is checked, the table expands to include
everything that is known about the selected breaker(s).

Basic breaker information includes:

Column Description

State
Normal ( ), Warnings ( ), or Errors ( ). See the following table for

explanations of errors.

Page
Name of the page on which the genie is found (displays only from the folder
level).

ID This is the breaker number, assigned when adding it to a page of a one-line.

Equipment
The equipment name entered when adding the genie via the I/O Device
Manager.

Source Busbar The number of the source busbar.

Dest. Busbar The number of the destination busbar.

Breaker and Switch Errors
Before you use the drawing, you must correct all errors. Otherwise the project might not
compile; and the animation will not work.

Errors that you might see for breakers are:

State Solution

Errors ( )

Breaker number must be a
number greater than 0 and
unique.

The breaker number is missing, or it is less than or equal to 0. Add or change
the breaker number.

Source busbar number must be a
number greater than 0.

The source busbar number is missing, or it is less than or equal to 0. Add or
change the source busbar number.

Destination busbar number must
be a number greater than 0.

The destination busbar number is missing, or it is less than or equal to 0. Add
or change the destination busbar number.

Source and Destination busbars
must not be equal.

The source and destination busbars have the same number; change one
number.

Equipment must be present.
There is no equipment attached to the breaker. Add the appropriate
equipment.

Either the Source or Destination
Busbar number must exist
(busbar may link to a Busbar,
transformer, meter, source, or
another breaker)

At least one busbar must be linked to this breaker.
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Meter Information
The most commonly used information about the meter genie displays by default.

When the Advanced Properties box is checked, the table expands to include
everything that is known about the selected breaker(s).

Basic meter information includes:

Column Description

State
Normal ( ), Warnings ( ), or Errors ( ). See the following table for

explanations of errors and warnings.

Page
Name of the page on which the genie is found (displays only from the folder
level).

ID This is themeter number, assigned when adding it to a page of a one-line.

Equipment
The equipment name entered when adding the genie via the I/O Device
Manager.

Source Busbar The number of the incoming busbar.

Line Active
The Cicode expression (such as MyTag1 >0) that determines when the
meter detects power on the busbar.

Meter Errors and Warnings
Before you use the drawing, you must correct all errors. Otherwise the project might not
compile; and the animation will not work.

Warnings indicate settings that might be incorrect. Verify that the settings indicated by
the warnings are what you want.

Errors and warnings that you might see for meters are:

State Solution

Errors ( )

Meter number must be a number
greater than 0 and unique.

Themeter number is missing, or it is less than or equal to 0. Add or change
themeter number.

Busbar number must be a
number greater than 0.

The busbar number is missing, or it is less than or equal to 0. Add or change
the busbar number.

Equipment must be present.
There is no equipment attached to themeter. Add the appropriate
equipment.

Busbar number must exist
(busbar may link to a Busbar,
transformer, meter, source, or
breaker)

At least one busbar must be linked to this meter.

Warnings ( )

Line Active should be present. Line Active should be entered to determine when themeter detects power.

Busbars across all meters should
be unique.

Verify that all busbars connected to this meter have the correct, unique,
numbers.

Source Information
The most commonly used information about the source genie displays by default.
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When the Advanced Properties box is checked, the table expands to include
everything that is known about the selected source(s).

Basic source information includes:

Column Description

State
Normal ( ), Warnings ( ), or Errors ( ). See the

following table for explanations of errors and warnings.

Page
Name of the page on which the genie is found (displays
only from the folder level).

ID
This is themeter number, assigned when adding it to a
page of a one-line.

Busbar
The number of the source that powers the connected
busbar.

Line Active
The Cicode expression (such as MyTag1 >0) that
determines when the source detects power on the busbar.

Source Errors and Warnings
Before you use the drawing, you must correct all errors. Otherwise the project might not
compile; and the animation will not work.

Warnings indicate settings that might be incorrect. Verify that the settings indicated by
the warnings are what you want.

Errors and warnings that you might see for sources are:

State Solution

Errors ( )

Source number must be a
number greater than 0
and unique.

The source number is missing, or it is less than or equal to
0. Add or change the source number.

Busbar number must be a
number greater than 0
and unique across
sources.

The busbar number is missing, or it is less than or equal to
0. Add or change the busbar number.

Busbar number must
exist (busbar may link to
a Busbar, transformer, or
breaker)

At least one busbar must be linked to this source.

Warnings ( )

Line Active should be
present.

Line Active should be entered so the source can detect
power on the busbar.

Transformer Information
The most commonly used information about the transformer genie displays by default.

When the Advanced Properties box is checked, the table expands to include
everything that is known about the selected transformer(s).

Basic transformer information includes:
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Column Description

State
Normal ( ), Warnings ( ), or Errors ( ). See the following table for

explanations of errors.

Page
Name of the page on which the genie is found (displays only from the folder
level).

ID This is the breaker number, assigned when adding it to a page of a one-line.

Source Busbar The number of the source busbar.

Dest. Busbar The number of the destination busbar.

Sim. Source This is the top source number used when adding the transformer.

Sim. Source 2 This is the bottom source number used when adding the transformer.

Transformer Errors
Before you use the drawing, you must correct all errors. Otherwise the project might not
compile; and the animation will not work.

Errors that you might see for transformers are:

State Solution

Errors ( )

Source busbar number must be a
number greater than 0.

The source busbar number is missing, or it is less than or equal to 0. Add or
change the source busbar number.

Destination busbar number must
be a number greater than 0.

The destination busbar number is missing, or it is less than or equal to 0. Add
or change the source busbar number.

Source and Destination busbars
must not be equal.

The source and destination busbars have the same number; change one
number.

Either the Source or Destination
Busbar number must exist
(busbar may link to a Busbar,
transformer, meter, source, or
another breaker)

At least one busbar must be linked to this transformer.

If a top or bottom source is
identified, it must be greater than
0.

The number for the top or bottom source for this transformer must be greater
than zero (for voltage-level transformers) or must be left blank (for pass-
through transformers).

Add Custom Images to Graphics Pages
A user might want to add custom images developed in external imaging software to a graphics page in Power-
SCADA Expert. One example might be a floor plan of a facility or an image depicting a physical piece of
switchgear, such as an elevation drawing.

1. Create you image in your imaging editor of choice. Several file types are supported, but bitmaps
tend to look the best when added to PowerSCADA Expert.

2. In the PowerSCADA ExpertGraphics Builder, select File >Import and select your image.
3. Re-size the image as necessary.
4. Overlay the image with any genies or data display objects that need to be displayed.
5. (Optional). If the image is intended to function as a button, it can be configured to do so by right-

clicking and configuring properties similar to configuring any buttons or images that are native to
PowerSCADA Expert. As an example see the imported bitmap below and the properties that can be
configured such that the bitmap acts as a button in the runtime environment.
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For more information see the Citect PC-Based help topics:

l Using PowerSCADA Expert > Graphic Pages > Configure Graphic Objects > Import Dialog Box
l Using PowerSCADA Expert > Graphic Pages > Configure Graphic Pages > The Bitmap Editor

Work with Alarms
In this section, you will find these topics:

Alarms Overview on page 154
Set Up Alarm Pages on page 155
Add Setpoints and Delays on page 155
Set Up an Alarm Based on an Enumeration on page 155
Change an Alarm Severity on page 156
Enable Waveforms for Onboard Alarms on page 156
Set Parameters for Event Log Length and Historical Logging of Events on page 156
Add an Onboard Alarm Tag on page 157
Set Up Audible Alarms on page 157

Alarms Overview
This section discusses two alarm types: time stamped analog and time stamped digital.
To access the alarms: From PowerSCADA Studio, select the System Model tab, then
click Alarms. Select the alarms to edit; it the might-hand, then click Alarms. In the right-
hand pane, the alarm types display. Double-click the one you want to view/edit.

PC-Based Alarms
1. PC-based alarm tags are added in the Profile Editor, when adding each device

profile. See Add Edit or Delete Device Profile on page 59for instructions. For
instructions on entering setpoints and delays, see Add Setpoints and Delays on
page 155.
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Onboard Alarms
If onboard alarms have been configured in a supported device, you can use the Profile
Editor to map these alarms to digital time-stamped alarms in PowerSCADA Expert.

You cannot configure new onboard alarms from PowerSCADA Expert. You must add
the alarm at the device, then you can create the alarm tag for it here. See Add an
Onboard Alarm Tag on page 157.

Set Up Alarm Pages
Use this procedure to create separate alarm pages for each alarm type in the project.
Follow these steps for each alarm page you want:

1. From the PowerSCADA Studio, click Visualization tab > Menu Configuration.
2. In the Menu Command column, add the Cicode method that will open the page:

PLSDspShowAlarm(INT nType)

where nType = the type of alarm (e.g., 1=unacknowledged, 3=disabled)

Example (for disabled alarms):
PLSDspShowAlarm(3)

For information about alarm types, see AlarmDsp in the Cicode Programming
Reference help file.

Add Setpoints and Delays
Any time you change setpoints, you should immediately restart the project. Otherwise,
setpoints will not be properly read (they will be truncated and either rounded down or
up to a whole integer).

There are two ways to add setpoints and delays for analog alarms. Before you enter
setpoints and delays, ensure that you have configured the alarm server so that Publish
Alarm Properties is set to TRUE.
• From the Analog Alarms window (accessible from the PowerSCADA Studio), you

can type the setpoint and delay values for each alarm.
• When in the runtime environment, you can edit setpoints/delays that were set by the

method above. See Use Use the Equipment Pop-Up Page on page 180 for
instructions.

Also, set the following parameter to allow persisting of alarm parameters at runtime.

[Alarm] UseConfigLimits = 1

Set Up an Alarm Based on an Enumeration
For instructions on defining an enumeration in the Profile Editor, see Define an
Enumeration on page 84.

An example of an enumeration alarm is:

0 = unknown

1 = good

2 = warning

3 = alarm

To add an alarm that is based on an enumeration, follow these steps:

1. Open the analog alarm in PowerSCADA Expert.
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2. To alarm on states 0, 2, and 3:

Set Low = 1 (if the value < 1, the alarm indicates an unknown state)

Set High = 1 (if the value > 1, the alarm indicates a warning)

Set High High = 2 (if the value > 2, the alarm indicates an alarm)
3. In the Category field, ensure that the correct alarm level is entered (_PLSALM_

HIGH, _PLSALM_MEDIUM, _PLSALM_LOW, _PLSALM_EVENT).
4. Replace the alarm.

Change an Alarm Severity
To change the severity of an alarm, follow these steps:

1. Open the analog alarm in PowerSCADA Expert.
2. In the Category field, ensure that the correct alarm level is entered (_PLSALM_

HIGH, _PLSALM_MEDIUM, _PLSALM_LOW, _PLSALM_EVENT).
3. Replace the alarm.

Enable Waveforms for Onboard Alarms
To enable waveforms, making them available for viewing in the runtime environment,
follow these steps:

1. At the device, or via the meter configuration software (PMCU), add the alarm and
enable the automatic capture of a waveform when the alarm occurs.

2. In the Profile Editor, on the Create Device Profiles tab, for the same alarm you
added in PMCU, check the Waveform box.

When this alarm occurs at the device, the waveform will be captured. The files will
be transmitted to PowerSCADA Expert and will be available for viewing. The
amount of time this takes depends on the number of I/O servers you have and the
number of serial devices on a chain. On a very large system with numerous serial
devices, this could take as much as an hour.

You can view the waveform from the Alarm Log in the runtime environment. See
Use the Equipment Pop-Up Page on page 180 for instructions.

Set Parameters for Event Log Length and Historical Logging of Events
You can use two parameters to determine the maximum number of entries in the Event
Log and whether you want to log entries after they are FIFO’d out of the Event Log.

Event Storage: [Alarm]SummaryLength Parameter
The maximum number of alarms that can be stored is controlled by the Alarm Summary
length parameter, which defines the maximum number of alarm summary entries
(Event Log entries) that can be held in memory. You can view these alarm summary
entries on the Alarm Log page. Each event requires 256 bytes of memory, plus the
length of the comment. 32,000 entries will require at least 8 MB of memory. If you have
many events, you should ensure that there is enough memory to store them in RAM.

The default value is 5000.

When the value is set to a number greater than 1000 for a multiple-cluster system, the
alarm log might not display correctly. The list of alarm history that displays on a client
might be shorter than the actual history stored on the alarm server. To avoid this
problem, do one or more of the following:
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• Set alarm filtering in the alarm viewer to reduce the number of alarms that are
returned by the server.

• Only support a one-cluster system.
• If a multiple-cluster system is necessary, display a separate alarm page for each

cluster.

Add an Onboard Alarm Tag
When a device onboard alarm has not been included in PowerSCADA Expert, you can
add it from the Profile Editor. You need to follow these steps to include the device’s
unique identifier. Otherwise, the alarm will not annunciate in the Graphics page.

You can only add onboard alarms for devices using the CM4, PM8, Micrologic, or
Sepam drivers. CM4, PM8, and Micrologic unique IDs must be decimal; SEPAM
unique IDs must be hexadecimal.

1. From the device, obtain the unique identifier for this alarm. Additionally, for
MicroLogic, you need to include the unique sub-identifier.

2. You also need the file number in which alarms on stored on the device.
3. From the Profile Editor, add the onboard alarm (see Onboard Alarm Tag Addresses

on page 53 in Editing Tag Addresses.

Set Up Audible Alarms
You can use a variety of Windows wave files for audible alarms. To enable this feature,
follow these steps:

1. Define the alarm sound to be used and the repeat interval for each priority in the
alarm you want to be audible. Enter the following information in the Citect.ini file:

a. [Alarm]
b. Sound<priority>=<wave file name>
c. Sound<priority>Interval=<repeating interval in milliseconds>

If the device is added through the I/O Device Manager, the alarm priority will be 1,
2, and 3 for _PLSALM_HIGH, _PLSALM_MEDIUM, _PLSALM_LOW alarms
respectively.

The user can define specific wave files for the sounds. We support the following
Windows operating system sounds:

SystemAsterisk

SystemExclamation

SystemQuestion

SystemDefault

SystemHand

SystemExit

SystemStart
2. After alarms are set up: When an alarm occurs, its specified alarm sound will play

continually according to the specified interval. The alarm sound will stop when
either:
— the user clicks Silence Alarm on the alarm page
— the alarm is acknowledged
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Set Up Tag Viewer
The tag viewer is a feature that displays in the graphics page during runtime . Use the
tag viewer to view details about equipment. This screen provides the status of project
tags.

To add the tag viewer to a project graphics page, follow these steps:

1. From the PowerSCADA Studio, click Visualization tab > Menu Configuration.
2. In the Menu Command line, add the Cicode method that will open the page:

PLSPageDisplay("PLSTagView")

When viewing the tag viewer in runtime, as long as the screen resolution is one that
PowerSCADA Expert supports, the view will be correct.

For information about viewing tags, see View the Tag Viewer on page 184.

Restore and Back Up Projects
In this section, you will find these topics:

Restore a Project on page 158
PowerSCADA Expert Backup on page 158

Restore a Project
To restore a project, overwriting its current settings, follow these steps:

1. From the PowerSCADA Studio, Projects tab, click Backup > Restore;, select the
project you want to restore; click Toos > Restore.

2. In the Restore from box, browse to the location of the file you will use to restore.
3. In the To box, check Current Project.
4. In the Options box, check Configuration files to restore backed up INI files and the

TimeSyncConfig.xml file (used to store time synchronization settings). If you backed
up the sub-directories under the project, the directories will be listed under Select
sub-directories to restore. You can restore all or no sub-directories, or you can
select specific sub-directories to restore.

5. Click OK.

PowerSCADA Expert Backup
Use this feature to back up aPowerSCADA Expert project file. To back up a Profile
Editor project file, see Profile Editor Export on page 74.

1. From the PowerSCADA Studio, Projects tab, click Backup.
2. At the Backup Project window, select the project you want to back up.
3. Browse to the location where you want to store the backup file.
4. In the Options box, check "Save sub-directories." This saves the

ProfileInstanceConfigurations file, which is used in upgrades.
5. In the Options box, check “Save configuration files.” This saves the citect.ini file.
6. Click OK.

The backup .CTZ file is written to the location that you choose during backup. This is a
Zip file; you can open it with WinZip.
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Use Cicode to Customize a Project
Cicode is a programming language designed for use in this product to monitor and
control plant equipment. It is a structured language similar to Visual Basic or 'C'. You
need no previous programming experience to use it. However, it is assumed that you
will have received Cicode training before you attempt to use Cicode.

Using Cicode, you can access all real-time data (variables) in the project: variable
tags, alarms, trends, reports, and so on. You can also use Cicode to interface with the
computer's operating system and communication ports.

For information about driver-specific INI parameters that you can configure, see
Appendix 2: Citect INI Parameters on page 248 .

For information about other parameters, see the Cicode Reference help file in the
citectSCADA.chm help file (Program Files> Schneider Electric > PowerSCADA Expert
> v8.2 > bin).

Use Cicode in PLS_Include
Several Cicode modules have been written specifically for use in PLS_Include. This
section describes each module.

Click to view descriptions/instructions for each module:

PLSProviderEngine.ci Module on page 159
Clear Cache and Refresh Platform on page 161

PLSProviderEngine.ci Module
Use this module when you want to invoke a provider to produce results that can be
displayed or acted on in a custom table or report that you create. Providers invoked by
this method must be written so that they take a single string as input and return a single
string as output.

Module Construction
The following string functions are included in this module:

CallProvider

This function invokes a provider (whose GUID-based identifier must appear in the
sProvider argument) with a single string as input (the sArgs argument). The input string
can consist of anything that is meaningful to the provider that you invoke.

The provider then returns a string-based token.

Construction of CallProvider:
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STRING FUNCTION CallProvider(STRING sProvider, STRING sArgs)

INT hHandle;

STRING sResult;

ErrSet(1);

sProvider = "^"" + sProvider + "^"";

sArgs = "^"" + sArgs + "^"";

hHandle = DLLOpen("ProviderGatewayUnmanaged.dll", "MakeRequest",
"CCC");

sResult = DLLCall(hHandle, sProvider + "," + sArgs);

DLLClose(hHandle);

IF IsError() THEN RETURN "ERROR"; END

RETURN sResult;

END

--------------

GetProviderStatus

This function reports the status of a provider invocation by showing the percentage of
its completeness. A provider has completed its work when the status reaches 100
percent,

To retrieve status with this function, pass in a token (obtained previously by calling
CallProvider) and examine the number contained in the function's return string (from 0
to 100).

Construction of GetProvider Access:

------------

STRING FUNCTION GetProviderStatus(STRING sToken)

INT hHandle;

INT iPercent;

ErrSet(1);

sToken = "^"" + sToken + "^"";

hHandle = DLLOpen("ProviderGatewayUnmanaged.dll", "GetPercent",
"JC");

iPercent = DLLCall(hHandle, sToken);

DLLClose(hHandle);

IF IsError() THEN RETURN "ERROR"; END

RETURN iPercent;

END

-------------

GetProviderResult

This function retrieves the result from a provider. Pass a unique token (obtained
previously by calling CallProvider) to this function. It returns the provider result as a
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string. Note that you should only call this function after you verify that the provider work
is 100 percent complete.

Construction of GetProviderResult:

------------

STRING FUNCTION GetProviderResult(STRING sToken)

INT hHandle;

STRING sResult;

ErrSet(1);

sToken = "^"" + sToken + "^"";

hHandle = DLLOpen("ProviderGatewayUnmanaged.dll", "GetResult",
"CC");

sResult = DLLCall(hHandle, sToken);

DLLClose(hHandle);

IF IsError() THEN RETURN "ERROR"; END

RETURN sResult;

END

--------------

Clear Cache and Refresh Platform
When you add, delete, or update a device or topic, you need to shut down and then
restart, the PowerSCADA Expert run mode. At that time, we recommend that you also
clear the cache and then refresh the platform. This will ensure that data is made
available to App Mods.

When you clear the cache, you remove data that is potentially out-of-date. Thus, we
recommend that you clear the cache of outdated material.

After you clear the cache, you need to refresh the platform. This step will refresh the
Schneider Electric CoreServiceHost, updating its list of devices and topics

Each of these methods uses the PLSProviders.ci module. See PLSProviderEngine.ci
Module on page 159 for instructions on creating the statements needed.

PLS_CLearCache
In the Schneider Electric CoreServiceHost, when you call a provider and it returns its
result, it caches that result for a given amount of time (which varies by provider). If
someone calls that provider again, the system will return the cached result.

If someone adds a device during this time, and then restarts run mode, the device is
not available for features like LiveView or basic reporting. Thus, if someone tries to
view a table or run a basic report, using the new device, it will not display. The next call
that is made to the cache will refresh it.

NOTE: You may also wish to create a graphics page that includes a button that calls
the cache and/or refresh.

To clear the cache, call the PLS_ClearCache function by doing one of the following:
• If the Schneider Electric CoreServiceHost is on the machine from which you are

invoking the function, you can call it with no input parameters:
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PLS_ClearCache();

This may be done during startup or using a button handler.
• If the Schneider Electric CoreServiceHost is on a different machine, you must

supply parameters to identify where the Application Services core resides. For
example, if the customer's Schneider Electric CoreServiceHost resides on an
IOServer named "IOServer1" on "Cluster1", to call PLS_ClearCache, enter:

PLS_ClearCache("IOServer", "IOServer1", "Cluster1");

This cannot be done at startup; you must do it after the startup routine is run. For
example, you might use a button handler.

PLS_PlatformRefresh
After you clear the cache, run the platform refresh to update the Schneider Electric
CoreServiceHost, causing it to refresh its list of devices and topics.

To run the refresh, call the PLS_PlatformRefresh function by doing one of the
following:
• If the Schneider Electric CoreServiceHost is on the machine from which you are

invoking the function, you can call it with no input parameters:

PLS_PlatformRefresh();

• If the Schneider Electric CoreServiceHost is on a different machine, you must
supply parameters to identify where the Application Services core resides. For
example, if the customer's Schneider Electric CoreServiceHost resides on an
IOServer named "IOServer1" on "Cluster1", to call PLS_PlatformRefresh, enter:

PLS_PlatformRefresh("IOServer", "IOServer1", "Cluster1");

Customize Default Behaviours
In this section, you will find these topics:

Time Zone Settings on page 162
Time Synchronization on page 163
Trend Tag Scan Intervals on page 163
Disk Storage Calculation for Trends on page 164
Deadbands and Ignored Devices and Topics on page 164

To learn about the parameters that you can use to configure drivers, see Appendix 2:
Citect INI Parameters on page 248.

Time Zone Settings
The system allows you to interact with devices located in a different time zone than the
PowerSCADA Expert I/O Server. To do this, the system converts any alarm/waveform
timestamp as well as the actual time sent within the Set Time command from / to the
local time zone. In order to take into account daylight savings properly, the Windows
time zones database is used. Thus, time zone names must be taken directly from this
database (case-insensitive), otherwise the system will default to using the I/O server’s
local time zone. The Windows time zone database is located in the Windows registry in
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Time
Zones\. Examples of time zone names are
• AUS Central Standard Time
• China Standard Time
• Pacific Standard Time (Mexico)
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Time zones for remote devices can be specified on two levels:

1. Use section [ProtocolName.ClusterName.PortName.IODeviceName] to specify the
time zone for a particular device, e.g.

[PLOGIC870.Cluster1.PM870_Port.PM870_Device1]

Timezone = Singapore Standard Time
2. Use general section [POWERLOGICCORE] to specify the time zone for all devices,

e.g.

[POWERLOGICCORE]

Timezone = Mountain Standard Time

The device-specific time zone specification takes precedence. In other words, if both of
the above examples are present in the Citect.ini file, the PM870_Device1 would be
located in “Singapore Standard Time” time zone, and all the other I/O devices in the
project would be located in “Mountain Standard Time” time zone.

If there is no time zone specification (or if it does not match the time zone from
Windows database), the device would be in the same time zone as the machine where
the I/O Server is running; thus, no time conversion will be done.

If only the first of the above examples is present within the Citect.ini file, the PM870_
Device1 would be located in “Singapore Standard Time,” and all the other devices use
the current local time zone.

Time Synchronization
Current time can be sent to the corresponding device by means of Set Time command
or (in case of Sepam) by writing directly to the corresponding registers within the
device. In addition to the manual procedure, this process can be scheduled to occur
periodically (using PowerSCADA Expert events).

Non-manual time synchronization causes the Set Time command to be sent
automatically, based on a device state or event originating from within the device.

Automatic time synchronization applies only to Micrologic and PM devices and takes
place based on the following rules:

1. For Micrologic devices, the value of the top-most bit of the register 679 is examined
(for both the Circuit Breaker Manager and the Chassis Manager). If the bit is equal
to 1, it means that the device is out of sync and needs to be synchronized.

2. For PM devices, an alarm 50700 (“Unary Power Up / Reset”) indicates that the
device needs to be synchronized. In addition, bit 6 of register 3055 of the device is
examined. If this bit is equal to 1, the device has a real-time clock; so automatic time
synchronization should never take place.

Trend Tag Scan Intervals
When you select a trend tag for a device profile (Add/Edit Device Profile screen), the
tag will be scanned at the “long” interval” (every 15 minutes, with FIFO storage of 12
months); but certain trend tags have an additional “short” scan interval. This interval is
set by default at 5 seconds, with FIFO storage of two weeks.

The default tags are: Current A, Current B, Current C, Voltage A-B, Voltage B-C,
Voltage C-A, Power Factor Total, Apparent Power Total, Reactive Power Total, Real
Power Total, and Frequency. When you choose one of these tags for trending, you will
get both long and short interval trending. The long interval trend will use the trend tag
name from the Profile Editor. The short interval trend tag will have the same name as
the long tag with an “s” appended to it.
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You can edit the Profile Editor.exe.config file to add or delete tags that will have short
scan intervals, and to change the short scan interval for all of the tags that are listed.

To edit short scan interval settings, follow these steps:

1. Locate and open Profile Editor.exe.config in Notepad:

[Project Drive]\Program Data\ Schneider
Electric\PowerSCADA Expert\v8.2\Applications\Profile Editor

2. To change the short scan interval, scroll the "TrendShortIntervalSamplePeriod"
setting. The default value is 00:00:05, or five seconds (HH:MM:SS). Changing this
rate will change the interval for all of the tags that are listed in the setting in step 3.

3. To change the tags that are included in the short scan interval, scroll to the
"TrendShortIntervalTags" setting. The numbers listed (defaults:
1003,1004,1005,1050,1046,1042,1014,1015,1016,1001,1034) are the tag IDs.
You can add or delete tags. Tag IDs are listed on the Define Device Type Tags tab
(when the Advanced Properties option checked).

NOTE: If you choose a device that includes the tags in this list, you will always
have these short scan interval tags included.

For example, if you wanted to change the scan interval to ten seconds and add
Overcurrent A for a CM4000, you would edit these two lines in this way:

"TrendShortIntervalSamplePeriod" value="00:00:10"

"TrendShortIntervalTags"
value="1003,1004,1005,1050,1046,1042,1014,1015,1016,1001,1034,19"

Disk Storage Calculation for Trends
There are two methods of calculating disk space usage for trends: scaled and floating
point. The Profile Editor uses floating point by default. For more information on these
calculations, see Calculating Disk Storage in the citectSCADA.chm help file
(Program Files> Schneider Electric > PowerSCADA Expert > v8.2 > bin).

Deadbands and Ignored Devices and Topics
These two features allow you to limit information that you see in system queries and
data acquisition. You set the limits for these features in the Configuration.xml file
(C:\Program Files (x86) > Schneider Electric > PowerSCADA Expert > v8.2 >
Applications > AppServices > bin > Configuration.xml).

Deadbands

<ConfigurationItem Key="Deadbands" Category="Platform Mapping"
Application="CitectPlatform">

<Value />

</ConfigurationItem>

Use this line in Configuration.xml to reduce the sensitivity to minor changes in real-time
data. You can set default deadbands for variable tags. To set a deadband, enter the
following in the value field:

<Value>XX|NN;</Value>

where XX is the IEC 61850 tag name and NN is the percentage. For example, to set
Current A to 5% and Current B to 10%, you would enter the following:
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<Value>mmxu1\A\phsA|5.0;mmxu1\A\phsB|10.0;</Value>

Ignored Devices/Ignored Topics

Use these two lines in the Configuration.xml to develop a list of devices and topics that
you want to ignore in system queries/data acquisition. Typically, you will use this to
exclude devices such as the memory device zOL. Ignored devices and topics will not
appear in Reporting or LiveView.

To set a value for ignored devices, type the PowerSCADA Studio device names (semi-
colon delimited) that you want to ignore. For example, to exclude zOL (the one-line
memory device) and the network tags device (for monitoring comms loss), type:

<Value>zOL;NetworkTagsDev</Value>

In the Ignored Topics list, type the topic names (semi-colon delimited) that you want to
ignore. Do not include the device name prefix that displays in the PowerSCADA Studio
project tag names. For example, to exclude AlarmUnhandled and
AlarmInvalidTimestamp, type:

<Value>AlarmUnhandled;AlarmInvalidTimestamp</Value>

Save your changes.
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Waveform Management
This chapter discusses how waveforms are stored and associated with alarms. In this
section, you will find these topics:

Waveform Storage on page 166
Waveform Database and Special Waveform Tags on page 166

Waveform Storage
Waveform records are organized within devices into files. These files are periodically
checked for and downloaded as they appear on the device. When downloaded, on the
PowerSCADA Expert I/O server the files are converted into a Comtrade format and
then stored in a hierarchical fashion.

A single waveform will be stored as follows:

<Waveform DB
root>\<ClusterName>\<IODeviceName>\Waveforms\<UTCTimestamp>.CFG

<Waveform DBroot>\<ClusterName>\<IODeviceName>\Waveforms\
<UTCTimestamp>.DAT

For example,

C:\Data\Cluster1\Sepam_IODev\Waveforms\

DST_00000000001203566197_0000000511_utc.CFG

DST_00000000001203566197_0000000511_utc.DAT

Waveform DB root path is configured in the WaveformDB configuration section.

NOTE: in case of redundant I/O devices, only the name of the primary I/O device will be
used when waveform storage path is constructed.

The CFG file is a Comtrade configuration file, and the DAT file is the Comtrade data
file. Within the CFG file is a timestamp that reflects the device time start time of the
waveform (this time is not adjusted to the I/O Server time zone or daylight saving, but it
is stored per the device configuration). The file name has the UTC time in seconds
since 1970 of the waveform.

The prefix of waveform file name reflects the type of the waveform. Currently,
waveforms of the following types are supported:

DST_ Disturbance waveform

ADT_ Adaptive waveform

SST_ Steady state waveform

If it is detected that the waveform data file has changed while it is being downloaded,
the file gets discarded and is not stored on the IOServer.

Waveform Database and Special Waveform Tags
PowerSCADA Expert allows you to browse the waveform database for specific I/O
devices. Search for all waveforms within certain time frame is also supported, allowing
you to search for all waveforms that could be linked with a given alarm. When you
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perform this search, a list of all matching waveforms displays. If there are multiple
waveforms in the list, you can select the waveform you want to view.

In addition, there are two special digital waveform tags defined (0 = FALSE, 1 = TRUE):
• WaveformDownloading: indicates whether a waveform file is currently being

downloaded
• WaveformCollectionEnabled: indicates whether the waveform collection is

enabled at all

The figure below illustrates a configuration example and replication and linkage
processes.
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The Runtime Environment
This chapter discusses the Graphics page in the runtime environment. In this section,
you will find these topics:

Open Firewall Ports for PowerSCADA Expert Runtime on page 169

Launch and Close the Runtime Environment on page 169
View the Graphics Page in the Runtime Environment on page 170

Log On to the Runtime Environment on page 170
View the Interface on page 170
View the Alarms/Events Page on page 172
When Alarms do not Display Correctly on page 174
Event/Alarm Log Columns Table on page 175
Alarm/Event Filter Form on page 176
Use the Analysis Page on page 179
Use the Equipment Pop-Up Page on page 180
Perform IEC 61850 Advanced Control on page 185

EcoStruxure WebServices (EWS) on page 186
Use Basic Reports on page 187

Set up the Runtime Environment for Basic Reports on page 187
Set Up a Display Client for Basic Report Viewing on page 188
Tasks in the Basic Reporting Application on page 188
Single Device Usage Reports on page 196
Multi Device Usage Reports on page 197
Tabular Reports on page 197
Trend Reports on page 198
Enable Windows Authentication for Basic Reporting on page 198
URL Routing for Basic Reports on page 199
Localization for Basic Reports on page 200

Use LiveView on page 200
LiveView Viewer on page 207
Set Up LiveView on page 209
LiveView Formulas on page 213
LiveView Placeholders on page 212
LiveView Thresholds on page 214
LiveView Formatting on page 211

Multi-Monitor Support on page 219
The Demo Mode on page 219

Application Configuration Utility on page 220

Application Services on page 221
Application Services Host—Citect Data Platform on page 223
Applications on page 223
Diagnostics Page/I/O Device Settings on page 225
Single Sign On on page 235
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Open Firewall Ports for PowerSCADA Expert Runtime
For the system to properly run, you need to ensure that the following ports are properly
set.

Before you begin, define the primary and standby alarm servers, trend servers, and I/O
servers. Then, to enable communication for runtime operations, use the information in
the following tables. Each server has a unique default port assigned to it. Use this
default port only with that type of server. If you attempt to use a default port on another
type of server, you will see a compilation error:

Invalid port number (2073-2082,20222,21) are reserved.

Default Port Numbers and Associated Server Types

Default
Port Legacy Port Server Type Server Role

21 N/A FTPServer

IDC

Page downloads for IDC

Internet Display Server/Client communications

2073 N/A CTAPI CTAPI communications

2074 N/A Client Cicode debugging

2084 2075 Reports server Reports server communications

2080 2076 Alarm server Alarm server communications

2085 2077 Trends server Trends server communications

2078 N/A I/O server Legacy I/O communications (version 6 or earlier)

2080 2076 Alarm server Alarm properties connector

2082 2078

(client server comms only)

I/O server Publish, subscribe I/O server communications

20222 N/A ODBC ODBC server

5482 N/A Alarm server Database port

SCADA Web Server/Web Client Configuration

Default Port Server Type Server Role

80 Web server Project files for web client

2084 Reports server Reports server communications

2080 Alarm server Alarm server communications

2085 Trends server Trends server communications

2078 I/O server Legacy I/O communications (version 6 or earlier)

2080 Alarm server Alarm properties connector

2082 I/O server Publish, subscribe I/O server communications

5482 Alarm server Database port

5500–5509 Web client/

web server

Range of ports for server advise between web server and web client, for alarm notifications. Inbound on
client; outbound on server.

Launch and Close the Runtime Environment
Launch Runtime: To launch the runtime environment: from left side of the
PowerSCADA Studiowindow, click Run ().

Close Runtime: There are two ways to shut down the runtime environment:
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• Click the “X” in the upper right corner of the screen. Then enter a user name and
password. (It is important to define at least one user in your project.)

• From the computer taskbar, click the Runtime Manager:

Click Shutdown All.

There is no required user name/password. Unless you disable this feature on the
taskbar, users can shut down the runtime environment without having to enter any
information.

View the Graphics Page in the Runtime Environment
In the runtime environment, the Graphics Page displays with the appearance that is
determined by the Menu Configuration file for this project. If you need to change the
appearance of tabs and menus, see Use Menu Configuration to Edit Pagemenu.dbf
(Change the Graphics Page Appearance) on page 114.

In this section, you will find these topics:

Log On to the Runtime Environment on page 170
View the Interface on page 170
View the Alarms/Events Page on page 172

Use Security Viewer on page 178

Security Viewer Filter on page 178

When Alarms do not Display Correctly on page 174

Event/Alarm Log Columns Table on page 175
Alarm/Event Filter Form on page 176
Use the Analysis Page on page 179
Use the Equipment Pop-Up Page on page 180
Perform IEC 61850 Advanced Control on page 185

View the Tag Viewer on page 184

Log On to the Runtime Environment
In the upper right-hand corner, click the Login link. Then enter your User ID and
password. The features that are available will vary, depending on your user level.

View the Interface
The runtime environment page includes a variety of tabs. If your page is created based
on the Normal template from the pls_include_1 library, you will see the following:

In the upper left corner of the screen, the project name is listed. Your logon name is
below that. At the top of the page, there are left and right navigation arrows that allow
you to go to previously visited pages.

These two arrows allow you to go back and forward one page in your navigation
history. To see the history of visited pages, click the small down arrow next to the right
arrow. This displays a listing of visited pages (the current page is checked). To jump to
a page in this list, click it in the menu.
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Just beneath the left and right arrows is the alarm banner. It lists the last five active
alarms.

Beneath the alarm banner is a tabbed-style menu. Its contents are determined by the
information entered in the Menu Configuration tool: Use Menu Configuration to Edit
Pagemenu.dbf (Change the Graphics Page Appearance) on page 114. These tabs
display in rows:
• The upper row (Line 1 in the Menu Configuration file) is typically used for

organizing pages into several topics (or tabs). A typical system would include topics
for single lines, alarms/events, analysis (for trends), and system supervision (allows
you to view the network connection topics).

• The lower rows (Lines 1–4) list the links/pages under the topic that is currently
selected in the upper row. If you select the single lines topic on the upper row, the
lower row displays all of the links to individual single line pages.

If there are more links available than the ones that fit on the page, a small arrow
displays at the right hand side of the row. Click the arrow to display a pop-up menu of
the remaining links. Click a link in the menu to shift the contents of the row to make it
visible for selection.

NOTE: When viewing the single lines: if the busbars and circuit breakers do not display
as expected, it could be that a custom genie is not set up correctly. See Create New
Genies on page 115 for details on customizing genies.

Lockout/Tagout Icon
This feature causes an icon (see below) to display when a tag attribute for a device
indicates that the equipment should be locked out and tagged out. For example, you
could assign a tag value from a PLC or other indicating device that reads the condition
of the device.

Lockout/tagout icon:

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

• Do not rely solely on the display of the icon on the one-line. Before working on the equipment, verify that
the device is physically locked out/tagged out before performing work on it or any downstream equipment.

• Ensure that all safety regulations and procedures have been followed before you work on the equipment.

Failure to follow these instructions will result in death or serious injury.

See Enable Lockout/Tagout on page 113 for instructions on enabling the
lockout/tagout feature.

NOTE: Do not incorrectly configure the tag, as this can lead to unexpected equipment
operation. Also consider the possibility of communications loss that could yield false
readings.

Communications Loss
When there is a communication loss for a device, the genie or any part of the genie on
the one-line page should have cross-hatches (gray dots) over the affected area, and a
communication loss (CL) indication displays on the genie. An alarm should also
annunciate. The color state before communication was lost will remain unchanged.
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However, the indication of loss of communications does not filter through the
entire bus animation: the downstream part of the drawing may still appear as if
communication is working. When any part of a one-line drawing loses
communication, do not continue to trust downstream readings until you address
the loss of communication.

View the Alarms/Events Page
See also: Use the Equipment Pop-Up Page on page 180

To view the alarms or events, click the Alarms/Events tab; then select the tab for the
Alarm Log or Event Log. The Event Log displays all alarms and events that have
occurred. The Alarms Log displays enabled alarms.

See The Alarm Log, below, for descriptions of color codes.

Equipment Column
On the left side of the page, there is an equipment column. To hide or display this
column, click the splitter:

All of the equipment in the project is listed. Most of the equipment is grouped by
voltage level. By default, none of the names are checked, which means that
information for all of them will display. To list alarms and events for a shortened list of
equipment, check the box(es) to the left of the equipment name(s).

The number to the right of the equipment name is the number of active alarms for that
equipment.
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Filter Information
To filter the information that displays, click Filter, just above the Date column (see
Alarm/Event Filter Form on page 176 for more information). From the Alarm Filter
window, you can select from a variety of filters.

Remove/Insert/Move Columns
To remove a column from the list, right-click its header and select Remove Column.

To insert a column, right-click a column header, select Insert Column, then check the
name of the column from the dropdown list. The new column displays to the left of the
column you right-clicked. If you right-click the white area to the right of existing
columns, you will insert the column to the right of the last column.

To move a column, left-click the column that is to be moved. Drag the column to the
position you want it.

Sort by Column
To sort on the information in a single column (such as the Equipment column), double-
click the column header. It will toggle between ascending and descending order.

The Event Log
The Event Log lists alarm/event activity, most recent first (provides sequence of events
information). The time is reported to the millisecond. You can display the Message
column to see the most detail (such as, "Alarms disabled" and "Alarm xxx
acknowledged").

The Alarm Log
To filter the alarms that display, click Filter, just above the Date column (see
instructions on using the filter option in Alarm/Event Filter Form on page 176). From the
Advanced Alarm Filter window, you can filter by date range, by text matches for various
attributes, or by alarm type.

Notice the alarm colors:
• Acknowledged active alarms display in a normal red font.
• Unacknowledged active alarms display in a bold red font.
• Acknowledged inactive alarms display in a normal gray font.
• Unacknowledged inactive alarms display in a bold gray font.

Each alarm provides additional options. To view these options, right-click the alarm.
Then you can do the following. Note that these changes will remain only until you
leave the page. To set the order, use the parameters,
• acknowledge or disable the alarm
• view alarm detail (similar to the genie status page in the single lines of the runtime

environment)
• view waveforms: (If the [equipment name Waveform] option does not display, there

are no waveforms for this alarm.) Waveforms can display only if the device is set to
“acquire on event,” and the waveform option is checked in the Profile Editor (see
Enable Waveforms on page 57).

When the waveform is available for viewing, the Search Waveform dialog displays.
From this dialog, click Time Range, and then select the appropriate times; or click
All Available to see all waveforms for this equipment. Click OK to display a list of
waveforms that fit the date criteria. Highlight the waveform and click View.
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After the selected waveform displays, you can view a PDF file that describes the
operation of the waveform viewer. Access this file (WaveWeb.pdf in the
PowerSCADA Studio Bin folder (64-bit example: C:\Program Files (x86)\Schneider
Electric\PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards\Bin).

Waveforms must be correctly set up before they will display. See Enable
Waveforms for Onboard Alarms on page 156 for more information. See Use the
Equipment Pop-Up Page on page 1 for instructions on viewing waveforms.

When you select the waveform option, you may see a message telling you “please
try again after waveform has been acquired.” This means one of two things:
— the alarm has been acquired at the device, but it has not yet been passed to

PowerSCADA Expert
— the device was not set to acquire a waveform, and the waveform option was

checked in the Profile Editor

NOTE: If there are multiple waveforms captures for this alarm, and if there is a
disturbance waveform, it is the only one that is available here. If there are both an
adaptive and transient, but no disturbance, the one with the earliest time stamp
displays.

Unacknowledged Alarms and Disabled Alarms
As with the Alarm Log, these logs display either unacknowledged alarms or disabled
alarms. The sort and filter options operate as they do in the Alarm Log.

Acknowledge, Silence and Print
Each of the logs includes these buttons:

Button Description

Acknowledge Current Page of Alarms: Click to acknowledge all of the alarms that display on the
current page.

Note: You can acknowledge individual alarms in this way: Right-click the alarm that you want to
acknowledge, then choose Acknowledge. On a touch screen, tap twice on the alarm row to display
themenu, then tap "Acknowledge."

Silence Alarms: Click to silence all active alarms. This does not clear unacknowledged alarms or
make alarms inactive; it only stops the audible portion of the alarm.

Print/Export Alarms: Click to begin printing or exporting part or all of the log. Select All or the number
of pages, then choose whether to print or export (to HTML file, which can then be opened in Excel
or OpenOffice). When printing, the default location is:

Windows XP: Documents and Settings\All Users\Application Data\Schneider Electric\PowerSCADA
Expert 8.2 with Advanced Reporting and Dashboards\Data

Vista operating systems or later: ProgramData\Schneider Electric\PowerSCADAExpert 8.2 with
Advanced Reporting and Dashboards\Data

Notes: When printing: To avoid truncation of data, choose the Landscape orientation.

When using Internet Explorer 8 and a dot matrix printer, youmight have problems with overlapping
columns in the printout. To solve this, either switch to Internet Explorer 7 or select a "square"matrix
(e.g., 180 x 180 DPI).

When Alarms do not Display Correctly
Alarms may display incorrectly for a variety of reasons. The following table lists some
common issues and resolutions.
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Issue Cause Resolution

Alarm Log and Event Log
do not display any data.

If there are two alarm
servers, primary and
redundant (standby), they
may be synchronizing. This
causes data to display
slowly.

Data will display; but it could take several minutes.

Alarms display in Alarm
Log, but not in Event Log or
Banner

Themissing alarm(s) were
triggered while the runtime
graphics page was not
running.

These alarms will only display in the Alarm Log
unless they are triggered again while the runtime
graphics page is running. This will only affect
alarms that were triggered before the runtime
screen was running.

PC-based and onboard
alarms do not appear or
disappear as expected.

This is due to the difference between way the two alarm types are handled:

When an alarm is enabled, the system processes alarms for that tag. If the alarm
is disabled, the system cannot process alarms for that tag.

For the PC-Based alarm, the condition for this is, for example, IA > 80; if the tag
value for IA is > 80, the appearance will show. The tag is constantly scanned, so
the condition triggers the alarm once it is enabled.

For the Onboard alarm, the condition for this is a digital tag, which is set by the
driver when a new alarm record on the device is read. If the alarm was disabled,
the driver cannot set the digital tag. When the alarm is enabled, nothing happens
because the alarm was already "processed" by the driver and will never get
reprocessed.

Thus, there is no resolution.

The number of alarms that
display is fewer than the
limit set by Alarm Summary
length parameter.

This happens when the
number of alarms exceeds
1000 and the system has
multiple clusters.

Use one or more of these procedures:

Set alarm filtering in the alarm viewer to reduce the
number of alarms that can display.

Only support a one-cluster system.

If a multiple-cluster system is necessary, display a
separate alarm page for each cluster.

Cannot filter on categories
for alarms.

The new categories do not
display in the list when you
want to select them.

Use Custom Filter 8 instead. Currently, it is the
only means available for adding custom filtering to
alarms. For more information, seeAlarm/Event
Filter Form on page 176.

Page Down button causes
an empty page to display.

The last alarm was on the
previous page. When there
are nomore alarms,
pressing Page Down
displays a blank page.

Click Page Up to return to the previous page (and
the last alarms for the system).

Event/Alarm Log Columns Table
This table lists the column headings that are available for use when viewing the event
log and alarm logs. To add a column to the table, right-click the column-heading row,
then select Insert Column and choose the column from the list. The column displays to
the left of where you right-clicked. To move columns left or right, drag and drop them.
To insert a column to the right of the table, right-click the white space next to the
existing columns.

To remove a column from the table, right-click its header and select Remove Column.

Column Name Description

AlmComment
alarm log only: these entries come from the time-stamped digital alarm window
“Comment” fields

Area area, value needs to be set between 0 and 255
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Column Name Description

Category event; or high, medium, or low alarm

Change
alarm logs only: when the alarm changes state:
first state, second state

Cluster cluster name to which the alarm belongs

Comment alarm log only: displays comments from the alarm

Custom3 through 8 custom filters

Date date (MMDDYYYY) that the event occurred or that the alarm annunciated

Description description of alarm e.g., Sag Vcn or Under Voltage B-C

Equipment default equipment name displays; used for alarm filtering and viewing

Help help page

Location Onboard or PC-Based

LogState alarm logs only: The last state that the alarm passed through.

Millisec alarm logs only: time (MS) that alarm annunciated

Operator user name from the PowerSCADA Studio users list

Priority the alarm category's priority

Priv privilege = security level

State
event log: state of the entry in the event log.. event

alarm log: disappearance, appearance

Tag alarm tag

Time time (HH:MM:SS:MS) that alarm annunciated

TimeQuality

This column displays the quality (accuracy) of the time stamp for alarms/events.

Use the "Time Sync" filter to display only data that has confirmed time quality in the log
(seeAlarm/Event Filter Form on page 176 for instructions on enabling the filter).
When there is no SER data, this column reads "No Time Sync Information."
When the filter is set to Yes, the view displays only the available time sync information
from SER devices.
Note: If there is no SER data from any device and the filter is set to Yes, the entire log
will be blank.

Alarm/Event Filter Form
This topic describes the PLSCADA filter form. The information in the Citect filter form is
the same, but is presented differently on the page. To change the filter form, use the
UsePLSFilter parameter:

[Alarm] UsePLSFilter

default: 1 (use PLSCADA filter form)

Change to 0 to use the Citect filter form.

To filter for the information that displays in the alarm logs and the event log, click Filter
(in the upper left corner of the screen). The Advanced Alarm Filter screen displays. The
table below describes its settings.

Filter Option Description: Display all alarms for:

Basic Filter box:
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Filter Option Description: Display all alarms for:

Start Date/End
Date

a date range.
Choosing only a start date displays alarms from that date to the current date.
Choosing only an end date displays alarms for the past year up to that date.
For example, to display alarms only for today’s date, enter only a start date.

Start Time/End
Time

a time range.
Choosing only a beginning time displays alarms from that time through the end of the day
(23:59:59 or 11:59:59 p.m.).
Choosing only an ending time from the start of the day (00:00:00 or 12:00:00 a.m.) through
the time selected.

Tag

a single tag; use tag name only, do not include equipment name. For example, enter
MMXU1\A\phsA, not MainCM4\MMXU1\A\phsA.

To filter on tag and equipment, enter the tag here and the equipment in the Equipment
Name field.

Equipment Name
a device entered when using the I/O DeviceManager; (listed in PowerSCADA Studio >
System Model >Equipment > Name)

Cluster
a single cluster, which was added when setting up the project (listed in the
PowerSCADA Studio)

Alarm Description
Alarm Desc from Time Stamped Digital Alarms: a customized on and off text description,
such as “active” and “inactive”

Custom Filter

There are eight custom filters, which can be assigned by the customer in each alarm. A
group of alarms in a specific location could have the same name in CUSTOM8 so that
custom filtering can be easily applied.

Custom8 has a default assignment of “Equipment.” To add or change custom filter
assignments, use the AlarmFormat parameter (PowerSCADA Studio >Settings tab >
Parameters). This is the only means available for filtering on a custom field. When viewing
the log, you can use the new custom filter by typing it into the Custom  Filter field.

Group Filter box:

Categorization

These “alarm filters” are created in the Profile Editor when alarms are created.

Alarm Type

Alarm Group

Subcategorization

Alarm Level

Type Filter box: These are advanced topics; see PowerSCADAExpert help for more information.

Area the area associated with the alarm

Category

This is the alarm category. There are four predefined categories (high, medium, low, and
event).You can assign alarms to their own categories by changing the equipment profiles
and then re-generating the database.

See the following table (Categories and Priorities) for a list of the categories and their
defaults.

Keep inmind that alarms that are categorized as events need to keep the category of _
PLS_ALM_EVENT (category 1004).

Priority

This is the priority of the alarm category; not used in the default PLS_Include project.

As with the category, priority has defaults (see Categories and Priorities table below). You
can change these settings in the equipment profiles. However, be sure that you use
priority 1 for events.

Time Sync

Yes = in the Alarm or Event Log, only events/alarms with time quality information will be
listed. The time sync data displays in the TimeQuality column of the log. Data displays to
the accuracy recorded at the device.

Default: no
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Category Label Category Number Priority Number

_PLSALM_HIGH 1001 1

_PLSALM_MEDIUM 1002 2

_PLSALM_LOW 1003 3

_PLSALM_EVENT 1004 0

Use Security Viewer
Use this feature to view user activity within your system. This screen lists all user
actions that are captured in the Event Log.

View this information from the runtime environment: Click the Alarms/Events tab; then
select the Security Viewer subtab.

The screen displays a table with these default columns:

Date The date that the activity was logged

Operator User name from the PowerSCADA Studio users

Time The time that the activity was logged

Classification The class of the event.

Message From theMessage field in the Alarm Log

UserLocation URL of the computer at which the activity occurred

For more information on these fields, see Alarm SOE fields in the citectSCADA.chm
help file (Program Files> Schneider Electric > PowerSCADA Expert > v8.2 > bin).

To change the view of the log, you can use any of the sort or filter features that are
available in the Event Log.

There are three ways to filter information:
• To the left of the log, you can check one or more of the devices in the system. This

filters information to include data only for those devices. When nothing is checked,
all devices are included.

• You can turn columns "on" and "off." To add columns, right click in the header area
of the log, then choose Insert Column. From the list that drops down, you can check
an additional column title. The new column displays to the left of the column you
clicked.

To remove a column, right click on the header of the column you want to delete,
then click Remove Column.

• You can filter that data that is included. To do this, use the Security Viewer filter. For
instructions on filtering the columns in the log, see Security Viewer Filter on page
178.

Security Viewer Filter
To filter for the information that displays in the security viewer log, click Filter (in the
upper left corner of the screen). The Security View Filter screen displays. The table
below describes its settings.

Filter
Option Description: Display all alarms for:

Basic Filter box:
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Filter
Option Description: Display all alarms for:

Start
Date/End
Date

Choosing only a start date displays alarms from that date to the current date.
Choosing only an end date displays alarms for the past year up to that date.
For example, to display alarms only for today’s date, enter only a start date.

Start
Time/End
Time

Choosing only a beginning time displays alarms from that time through the end of the day
(23:59:59 or 11:59:59 p.m.).
Choosing only an ending time from the start of the day (00:00:00 or 12:00:00 a.m.) through the
time selected.

Cluster
This is a single cluster, which was added when setting up the project (listed in
PowerSCADA Studio, Topology window; click Edit, then choose Clusters from the dropdown
link)

Area
Area (Between 0 and 255). SeeAlarm SOE fields in the citectSCADA.chm help file (Program
Files>Schneider Electric >PowerSCADA Expert > v8.2 > bin).

Classification
The class of the event. SeeAlarm SOE fields in the citectSCADA.chm help file (Program
Files>Schneider Electric >PowerSCADA Expert > v8.2 > bin).

Operator The user ID of the person who has logged on PowerSCADAExpert.

Message This comes from theMessage field in the Alarm Log.

Custom Filter

There are eight custom filters, which can be assigned by the customer in each alarm. A group of
alarms in a specific location could have the same name in CUSTOM8 so that custom filtering
can be easily applied.

Custom8 has a default assignment of “Equipment.” To add or change custom filter
assignments, use the AlarmFormat parameter (PowerSCADA Studio >Setup tab >
Parameters). This is the only means available for filtering on a custom field. When viewing the
log, you can use the new custom filter by typing it into the Custom  Filter field.

Use the Analysis Page
The Analysis Page offers two options for viewing data trends. In either option, you must
select the tag(s) that are to be included. To be available for viewing in trends, a tag
must be included in a device profile, and it must have the “Trend Tag” box checked
(see for more information).

Trend data is automatically logged when you check “Trend Tag” for tag and then add it
to the project. If too many tags are chosen as trend tags, it could cause the hard drive to
fill up.

NOTE: The maximum number of tags (pens) that will display correctly on the screen is
ten. If you exceed ten pens, labels for these pens will not display correctly. Use one of
these methods to correct this issue:

1. Enlarge the window to accommodate the extra pens/labels.
2. Write custom code to cause the labels to always be in the same position,

overlapping each other when the trend pen is created. The user can then move the
label around for better viewing.

3. As with option number two, control the label positions with code; but then, move the
labels back to that same spot when a user selects the trend pen again.

There are two methods of calculating disk space usage: scaled and floating point. For
more information on these calculations, see Calculating Disk Storage in the
citectSCADA.chm help file.
• Trending: Use this option to view historical trends. To select tags, click the Add Pen

button on the toolbar:
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Then associate the pen with a tag. By default, most trend data is polled every 15
minutes, and it is stored for one year in the trend tags, or until it is FIFO’d out. Some
tags are polled every 5 seconds and are stored for two weeks. These tags are:

Current A
Current B
Current C
Apparent Power Total
Reactive Power Total
Real Power Total
Voltage A-B
Voltage B-C
Voltage C-A
Frequency
Power Factor Total

• Instant Trend: Use this option to view real-time trends. This allows viewing of data
that is not set up for storage. To select tags for this trend, click the Instant Trend
Selector on the toolbar:

NOTE: If one of the pens returns a value of "1.#R,' the tag selected was not valid; no
number could be reported for it. None of the values for any of the pens in the trend
will be updated. To solve this issue, close the trend and open it again. This time, do
not include the pen that gave the invalid return.

In either trending option, click Help for help using the tool:

Use the Equipment Pop-Up Page
See also: View the Alarms/Events Page on page 172

This page displays when you click on a device symbol/genie on a single-line page.
This page shows a detailed status for a particular device. Some controls on this page
are available only to users with certain privilege levels (see Add and Modify User
Accounts on page 237 for user access levels).

One of two status pages displays. The page on the left illustrates the status page for a
meter genie. The page on the right illustrates the status page for a circuit breaker
genie.
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At the top of the page, the most recent alarms and events are listed (racked in/out,
Comms Loss, and so on). To view details about an individual alarm or event, right-click
the alarm. You can view:
• a waveform. (If you do not see “Waveform” in the list when you right-click the alarm,

there are no waveforms for this alarm.) Waveforms can display only if the device is
set to “acquire on event,” and the waveform option is checked in the Profile Editor
(see Enable Waveforms on page 57).

When the waveform is available for viewing, it displays when you click this link. For
information about how the waveform viewer works, see the WaveWeb.pdf file in the
PowerSCADA Studio bin folder (64-bit example: C:\Program Files (x86)\Schneider
Electric\PowerSCADA Expert\v8.2\bin).

Waveforms must be correctly set up before they will display. If there are multiple
waveforms, you must select from the list that displays (by default, the waveform
search returns all waveform files acquired within the 24 hours prior to the time of
the alarm). See Enable Waveforms for Onboard Alarms on page 156 for more
information. See Use the Equipment Pop-Up Page on page 1 for instructions on
viewing waveforms.

When you select the waveform option, and no waveforms are returned, one of two
things is likely:
— the alarm has been acquired at the device, but it has not yet been passed

PowerSCADA Expert
— the device was not set to acquire a waveform, and the waveform option was

checked in the Profile Editor
• details about the device (currents, voltages, powers, resets, others.),
• Finally, you can acknowledge or disable the alarm. Acknowledged and disabled

alarms are moved to their own sub-tabs.

On the left side of the of the status page, status messages display, based on the tags
defined for equipment referenced in this genie. The list varies, depending on the
device. Possible tags are:

XCBR1\Pos Position (circuit breakers only)
XCBR1\CCBRkdPos Racked Out (circuit breakers only)
XCBR1\CBRkdPos Matching Fault/Trip Circuit Supervision (circuit breakers only)
XCBR1\Loc Local/Remote (circuit breakers only)
XCBR1\ESwPos Earth Switch (circuit breakers only)
PTRC1\Op Tripped
LPHD1\EEHealth Communication Failure

NOTE: For MicroLogic Type P devices, circuit breaker status fields will display #COM if
the device does not have a CCM. Thus, you should not add any tags that refer to the
CCM, such as Racked In/Racked Out.

On the right side of the page, real-time values will display for the tag type that you
chose in the Value field when you added the genie in the design-time mode. For
example, if you enter MMXU1\A\phsA as the value, you will see real-time currents here,
as illustrated above. If you did not enter anything in the Value field when adding the
genie, this area will be blank.

At the bottom left corner of the circuit breaker status page, Open, Close, Reset (for
circuit breakers).

At the bottom right corner, are the Setpoints, Trend, and List options. See the following
sections for descriptions.
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Perform IEC61850 Advanced Control
To begin using the advanced control feature, click Check in the lower left section of the
window. See Set Up IEC 61850 Advanced Control on page 116 for information on
setup. See Perform IEC 61850 Advanced Control on page 185 for information on
performing this advanced control.

View Waveforms
After you select a waveform for viewing from the genie status page, the external
waveform viewer displays it. For instructions on using the tool's analysis feature, see
WaveWeb.PDF, located in the Bin folder of the PowerSCADA Expert 8.2 with
Advanced Reporting and Dashboards Bin folder (example: C:\Program Files (x86)
\Schneider Electric\PowerSCADA Expert 8.2 with Advanced Reporting and
Dashboards\Bin.

Enter Setpoints for Alarms
NOTE: Any time you change setpoints, you should immediately restart the project.
Otherwise, setpoints will not be properly read (they will be truncated and either
rounded down or up to a whole integer).

To add setpoints for alarms, follow these steps:

1. View the page, then click the genie for which you want to enter setpoints. A status
window displays with the name of the genie.

2. Click Setpoints, then choose Analog, Digital, or All. When the Alarm Setpoints
screen displays, select the first value you want to change. At the “keypad” screen
(see below), enter the new value. Click OK to save it. Do this for each setpoint that
you want to change.

Based on these setpoints, alarms can begin to display both in the alarms window at the
top of the runtime screen and on the Alarms/Events tab (assuming you have set one up
for this installation).

When there is a comms loss for a device: the last state before the loss happened is
displayed on the screen.

The indication of loss of communications does not filter through the entire bus
animation: the downstream part of the drawing may still appear as if
communication is working. When any part of a one-line drawing loses
communication, do not continue to trust downstream readings until you address
the loss of communication.

View Real-Time Trends
This option displays an historical trend. The data that displays is determined by the
value that was selected in the Value Type field when this genie was added to the one-
line page.
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To view a trend: From the one-line page in the runtime environment, click a genie to
view its status window. Click Trend, in the lower right corner. The Analyst screen
displays for that trend.

You can select the timeframe for the trend. You can also uncheck phases to remove
them from the trend, or highlight a phase to bring it to the front of the trend. For detailed
information about the buttons on the screen, click “?” at the top of the page.

View Lists of Real-Time Information for the Genie
To view lists of real-time currents, voltages; powers; resets and controls; and
miscellaneous readings, click List, in the lower right corner, then click an item from the
list: Currents, Voltages, Powers, Resets, or Others.

For resets and controls, which are interactive, you should assign users a high level of
security. For a list of the default user levels, see Add and Modify User Accounts on
page 237. That link also includes information on creating unique users.

When you click an item from the list, individual tag readings display for that tag type
(depending on the tags that you have chosen for this device type). When you click any
item in that list, the tag pop-up menu displays with these options: Trend, Override Tag,
Control Inhibit Tag, and Tag Status. See Override Tag Status, below, for details.

Override Tag Status
From the list, you can right-click individual tags and override status settings. To access
this feature, the user account must be at least level 4.

Trend: This link allows you to view a trend for the tag that you clicked.

Override Tag: You can use this feature to override a real-time value that is incorrect, or
to test graphics. Enter the value that you want the system to "read" for this tag in the
Override Value line. When you click Apply, the tag is highlighted. When you have
finished the test, return to this list to remove the override.

Control Inhibit Tag: When this feature is ON, you will not be able to process writes for
this tag. To enable this inhibit, click Apply for this tag from the list. The tag reading is
highlighted. To disable this feature, return to the list view of this tag; click Remove.

You can perform control inhibit on an entire device. To do this, you will use the
IODeviceControl Cicode function. For more information, see the I/O Device
Properties topic in the citectSCADA.chm help file (Program Files> Schneider Electric
> PowerSCADA Expert > v8.2 > bin).

Tag Status: This screen views the status of the display value, override status, control
inhibit status, and field value. You can also change the override status and control
inhibit status on this screen.

Changing background colours: Default colors are assigned for the tag override and
control inhibit. Change the default background colors in the parameters, not in the ini
file.

To change the color for tag overrides, use OverrideTextBackgroundColor. To change
the color for control inhibits, use ControlInhibitTextBackgroundColor. For detailed help,
see Page Parameters in the Parameters.chm help file (Start > Programs > Schneider
Electric > PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards >
PowerSCADA Expert Web-based Help).
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View the Tag Viewer
Use the tag viewer to learn the status of all of your project tags. This can provide
information that you need to troubleshoot the project while you are commissioning it.

You can filter the tags that you view by individual equipment included in the project.
You can also filter on strings that are part of the tag description or tag name. The tag
viewer will work in all supported screen resolutions.

To view tags:

Click the tab for the page that was used when setting up the tag viewer, then select the
tag viewer. The viewer displays in a screen similar to this:

Note the following features:
• Filter by equipment: The left-hand pane gives you the option to filter by equipment

name. Most equipment is grouped by voltage level. You can select one equipment
node, and you will view the tags for that equipment.

• Filter by tag: In the upper right corner of the screen, type the tag name. You can
type a string, such as "power factor," and you will retrieve a list of tags that have
"power factor" in their tag description or tag name.

NOTE: Any time you display a tag, you add to the dynamic point count. See
"Dynamic-point Count Licensing" in the citectscada.chm help file (default location:
Program Files > Schneider Electric >PowerSCADA Expert > v8.2 > bin) for more
information about point counts.

The viewer includes the following columns:
• Tag Description/Tag Name: the description and name used when the equipment

was added to PowerSCADA Expert.
• Value/Timestamp: The real-time value that was read at the date/time shown.
• Quality: The data quality (for example, Good or Bad) of the tag from

PowerSCADA Studio.

Use the Previous and Next links at the bottom right of the page to scroll through
multiple pages.
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Perform IEC 61850 Advanced Control
The advanced control window provides these options for IEC 61850 IEDs:
• run synchro check on the selected equipment
• run interlock check on the selected equipment
• send a command to open or close the equipment

You can either check the features without sending an open/close command, or you can
send an open/close command without running the checks..

Only users who have privilege level of Engineer or Admin can perform these checks or
operate the equipment.

WARNING

UNINTENDED EQUIPMENT OPERATION

• Do not incorrectly configure the tag, as this can lead to unexpected equipment operation.
• Ensure that you understand the effects of using the "bypass" option so you do not shut down critical equip-

ment.
• Also consider the possibility of communications loss that could yield false readings.
• Ensure that all safety regulations and procedures have been followed before you work on the equipment.

Failure to follow these instructions can result in death or serious injury.

NOTE: For information on enabling this feature, see Set Up IEC 61850 Advanced
Control on page 116

To access the advanced control window, open the equipment genie pop-up page on
the one-line. Note that, after you enable this feature, there is a "Check" button on the
lower left:

Click Check, and the advanced control window opens:
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Synchro Check: Use synchro check to verify that the waveforms for the equipment's
power factor, voltage, and current are all aligned.

On the Synchro Check line, click Check to perform the synchro check, or click Bypass
to ignore the synchro check. Default: Check.

Interlock Check: Use interlock to verify that there are no blocking conditions that
need to be considered before switches are opened or closed.

On the Interlock Check line, click Check to perform the interlock check option, or click
Bypass to ignore the interlock check. Default: Check.

Test: Click Operate if you want to send the command to the equipment and to
complete the "value" setting. Click Test if you want to send the command to the
equipment, and to verify the synchro and/or interlock statuses, but not complete the
"value" setting. Default: Operate.

NOTE: If you choose "Check" for the synchro and/or interlock checks and "Operate" for
the Test line, the open/close operation will not occur if the equipment fails the checks.

Value: Choose the command that you want to send to the equipment: open or close.
Default: Closed if the breaker is open; otherwise, Open.

Send: Click to send the command to the device to perform the action(s) that you
selected.

EcoStruxure WebServices (EWS)
EcoStruxure Web Services (EWS) for PowerSCADA Expert was developed to share
real-time, historical, and alarm data with StruxureWare Building Operations (SBO) and
historical data with Power Monitoring Expert (PME). Do not confuse this feature with
the EWS server that was released as a part of PowerSCADA Expert/Vijeo Citect
version 7.40 (which is for tag level process data).

EWS uses web-based http protocol to transfer data. It enables two-way data transfers,
which allows the acknowledgment of alarms from SBO. To include this new EWS
implementation in your installation, select the EWS Server checkbox during
installation.

EWS is set up and configured using the Application Configuration Utility (Start > All
Programs > Schneider Electric > PowerSCADA Expert 8.2 with Advanced Reporting
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and Dashboards > Config Tools > Application Config Utility. For details, see
EcoStruxure Web Services Setup on page 222 .

Use Basic Reports
The reporting feature is an IIS web application that is typically hosted on the same
server as the PowerSCADA services. The PLS_Inlude project defines a PLS_
ReportPage (along with its screen resolution-specific variant pages). PLS_ReportPage
contains a Microsoft Web Browser ActiveX control in which the reporting web pages
are displayed.

Before you can set up Basic Reports and generate/view reports, you must set up data
acquisition parameters. To do this, use the Application Configuration Utility. See
Application Services Host—Citect Data Platform on page 223 and (for receiving reports
via email) Basic Reports on page 225 for instructions.

In the PowerSCADA Studio, Visualization page, use the Menu Configuration page to
configure menu tabs to use the new "PLS_ReportDsp()" Cicode function to send URLs
to the web browser control at runtime. The control then browses to the available
reporting web pages. See the PLS_Example project for examples of this functionality.

When switching between PowerSCADA Expert projects in runtime, you must restart the
Schneider Electric Service Host (CoreServiceHost) service before you run the
reporting application. This allows the reporting application to load data from the
currently running PowerSCADA Expert project.

To get started setting up a report, see Set up the Runtime Environment for Basic
Reports on page 187.

For descriptions of each report type, see PowerSCADA Expert Basic Reports on page
195.

NOTE: If you install Matrikon Explorer on the same computer as PowerSCADA Expert
8.2 with Advanced Reporting and Dashboards, the LiveView and reporting features
will not launch. To prevent this, install Matrikon before you install PowerSCADA Expert
8.2 with Advanced Reporting and Dashboards. If you install Matrikon after you install
PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards, you need fix the
issue in this way: Go to IIS > ISAPI Filters, and then reset the dll that is already selected
(click browse and re-select v4.0.30319 aspnet_filter.dll). Click OK.).

Set up the Runtime Environment for Basic Reports
Follow these steps to add new items to the project, add the necessary INI parameters
for CtAPI and basic report security, and create the CtAPI connection for reporting.

Create the Menu Items for Report Page
For a complete discussion of reporting web application URLs, see Create and View
Basic Reports on page 189.

The following steps describe how to interact with the reporting web application via the
runtime environment.

1. From the PowerSCADA Studio, click Visualization tab > Menu Configuration.
2. Add the new menu item that you want for each of your basic reports.
3. In each of these menu items, in the Menu Command line, add the Cicode method

that will display a report tab. You can create your own custom method or use the
default:
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PLS_ReportDsp(STRING sIPAddress, STRING sName, STRING sOptions = "", STRING

sTitle="")

Examples:
PLS_ReportDsp(“10.10.10.10", "SingleDeviceReport”,

"ShowConfiguration/MyConfiguration", “Single Device Usage Report”);

which opens a configured single device report with the saved configuration name
"MyConfiguration"

or
PLS_ReportDsp(“10.10.10.10", "SingleDeviceReport”, "", “Single Device Usage

Report”);

which opens an unconfigured single device usage report at the parameters entry
page

Add the Following INI Parameters
To allow trend queries that yield the desired amount of historical data:

[Trend]MaxRequestLength =100000000,
allowable range: 1–100000000
(example: a value of 70080 would yield two years of data for one device/one topic,
assuming 15-minute trends)

To allow CtAPI to connect remotely:

[CtAPI]Remote = 1

To define a privilege level for users to view reports:

[Reporting]PrivLevel - Default = 0

To define an area for users to view reports:

[Reporting]Area - Default = 0

Set Up a Display Client for Basic Report Viewing
To be able to properly interact with the basic reporting web application at a display
client, you must set a registry key to force the Microsoft Web Browser ActiveX control to
use Internet Explorer 9 emulation.

Create the following DWORD value at the following registry key path:

Path: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Internet
Explorer\MAIN\FeatureControl\FEATURE_BROWSER_EMULATION

Value Name: Citect32.exe

Value: 9999 (decimal)

NOTE: This registry setting affects the Citect32.exe process only. It has no effect on
other applications that use the MS Web Browser ActiveX control.

Tasks in the Basic Reporting Application
You can use the following tasks within the reporting application to create, view, and
email basic reports:

Perform IEC 61850 Advanced Control on page 185

Create and View Basic Reports on page 189
Configure Email Settings to Send Basic Reports on page 191
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Send Basic Reports via Email on page 192
Read, Export, Print, and Edit Basic Reports on page 194

Create and View Basic Reports
This section explains how you can create basic reports and save report configurations
using a web browser (e.g., Internet Explorer).

For instructions on interacting with the reporting web application via the runtime
environment, see Set up the Runtime Environment for Basic Reports on page 187.

You can generate basic reports in two ways:
• run a new report by entering parameters
• run a report from a saved configuration

Run a New Basic Report

There are two options for this:

1. Browse directly to the URL of the report. Use this format:

http://<ServerName>/Reporting/Report/<ReportName>

where:

<ServerName> = the name or IP of the reporting server

<ReportName> = the name of the report you wish to view

Standard report names are:
— MultiDeviceReport
— SingleDeviceReport
— TabularReport
— TrendReport

2. Browse to the default reporting URL, and click the report you want to view.

An example of this format is:

http://<ServerName>/Reporting/

where:

<ServerName> = the name or IP of the reporting server

Additional formats are required, depending on the operating systems. For more
information, see URL Routing for Basic Reports on page 199.

Run a Basic Report and Save its Configuration

NOTE: If you plan to view a basic report using Rapid Access Labels on page 217, you
must save a configuration. After it is saved and you generate a rapid access label, do
not change the configuration name. If the configuration name is changed, you must
generate a new rapid access label.

To create and save a basic report configuration so you can view it later:

1. Visit the "build configuration" URL of the report you wish to use. Use this format:

http://<ServerName>/Reporting/Report/<ReportName>/BuildConfiguration

where:

<ServerName> = the name or IP of the reporting server

<ReportName> = the name of the report you wish to view
2. Enter the report query parameters.

NOTE: If you enter a fixed date range, all reports that you generate with this
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configuration will use that date range. The best practice is to use one of the relative
date ranges, such as "last month."

3. After the report displays, scroll to the bottom of the page. You should see a text box
with XML. This XML represents your saved report configuration. Copy the entire
contents of the text box into the text editor of your choice.

4. Save this new file to the Reporting\ReportConfigurations\ directory, located on the
application root install directory (which is also the physical directory behind the
reporting web application's virtual path in IIS).

Example (64 bit):
C:\Program Files (x86)\Schneider Electric\PowerSCADA Expert\PowerSCADA
Expert Reporting\Reporting\ReportConfigurations\

The filenamemust be in the following format:
<ReportName>_<ConfigurationName>.cfg

where:

<ReportName> = the name of the report (such as MultiDeviceReport,
SingleDeviceReport)

<ConfigurationName> = a name for this configuration (alphanumeric only)

If you use Notepad, ensure that you apply the correct suffix (.cfg) and not the default
(.txt).

View a Basic Report Using a Saved Configuration

To view a basic report with a saved configuration, browse to the URL of the report and
specify the configuration. This method runs the report directly with the saved
configuration (you cannot change the parameters).

This URL is in the following format:

http://<ServerName>/Reporting/Report/<ReportName>/<ReportConfiguration>

where:

<ServerName> = the name or IP of the reporting server

<ReportName> = the name of the report you wish to view

<ReportConfiguration> = the name of the saved configuration to use

Modify and View a Basic Report Using a Saved Configuration

Use this procedure to modify a configuration that you saved according to "Run a Basic
Report and Save its Configuration," above.

Browse to the "show configuration" URL for the report that you want to modify. Use this
format:

http://<ServerName>/Reporting/Report/<ReportName>/<ReportConfiguration>/ShowC
onfiguration

where:

<ServerName> = the name or IP of the reporting server

<ReportName> = the name of the report you want to view/modify

<ReportConfiguration> = the name of the saved configuration to use

Run the report as you normally would, editing selections on the parameter entry page
as necessary.
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After the report runs, a text box displays at the bottom of the finished report. It contains
the new XML of your saved configuration.

Copy and paste this new XML into your saved configuration file (overwriting the old
XML).

Remove a Saved Configuration

To remove a saved configuration, delete the saved configuration file from
Reporting\ReportConfigurations\ directory, described above:

Example (64 bit):
C:\Program Files (x86)\Schneider Electric\PowerSCADA
Expert\v8.2\Applications\Reporting\ReportConfigurations

Configure Email Settings to Send Basic Reports
Follow these steps to configure email settings so that you can send PowerSCADA
Expert basic reports to multiple email addresses.

NOTE: You must configure the SMTP server and email list(s) before you email reports.
See Send Basic Reports via Email on page 192 for instructions on sending these
emails.

SMTP Server and From Address

For instructions on setting up the SMTP server, see Basic Reports on page 225.

Email Lists

Before you can send email via the URL or ReportMailer method, you must create at
least one email list:

1. Open your preferred text editor; enter one or more email addresses (one per line,
no commas).

2. Save this text file in the Reporting\ReportConfigurations\ directory, located on the
application root install directory (which is also the physical directory behind the
reporting web application's virtual path in IIS).

Example (64 bit):
C:\Program Files (x86)\Schneider Electric\PowerSCADA Expert\PowerSCADA
Expert Reporting\Reporting/ReportConfigurations\

The filename must be in the following format:

Email_<EmailListName>.cfg

where:

<EmailListName> = an alphanumeric (no spaces) name for the email list (for
example, Administration)

Email Body

The email body that you send is contained in a resource (.resx) file in the
Reporting\bin\Resources\Reporting.en-US.resx\ directory, located on the application
root install directory (which is also the physical directory behind the reporting web
application's virtual path in IIS).

Example (64 bit):
C:\Program Files (x86)\Schneider Electric\PowerSCADA Expert\PowerSCADA
Expert Reporting\bin\Resources\Reporting.en-US.resx\
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The email body is the same for all Report Configurations and Email Lists, but you can
modify the entry for ReportEmailBody to change the body of the email that is sent.

Send Basic Reports via Email
Before you can send PowerSCADA Expert basic reports via email, you must configure
the SMTP server and email list(s) before you email reports. See Configure Email
Settings to Send Basic Reports on page 191 for instructions on configuring this
information.

There are three ways to send basic reports via email:

1. The Report Viewer email button

Use this method to send a customized one-time email to an individual or group of
email addresses.

1. Run the report as normal.

2. Click the Email icon (  ) in the report viewer.
3. Enter the requested information in the pop-up dialog.
4. Click Send.

2. Visit a Specific URL

NOTE: Each visit to a URL causes the email to be sent. Be sure that you have the
correct report and email list before you visit this URL/send the email. Also, you should
secure this URL using the web.config file. For information on modifying/using the
web.config file, see http://support.microsoft.com, and search on kb 815179.

To send a basic report to an existing email list, visit the following URL:

http://<ServerName>/Reporting/Report/<ReportName>/<ReportConfiguration>/Email/<
EmailList>

where:

<ServerName> = the name or IP of the reporting server

<ReportName> = the name of the report you wish to view

<ReportConfiguration> = the name of the saved configuration to use

<EmailList> = the name of the email list you wish to use

You must use a saved configuration (see Create and View Basic Reports on page
189 for instructions). You cannot change report parameters from this URL.

No progress bar or update will display, as these interfere with some scheduling
clients.

3. Use Cicode via ReportMailer

You can use a utility called ReportMailer to email basic reports. This command line
utility is located in the PLS_Include project. It can be called by Cicode. You can create
a button on the graphics page and have it call the Cicode function or use a scheduled
process to trigger an email.

Before you can use ReportMailer, you need to create or edit the file called
ReportMailer.ini file that is in your project (not in PLS_Include). The ReportMailer.ini
file must include the text listed in the table below:
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Text Field Required Setting Description

LoginUsername demo
Username for logging in to reporting system for emailing
reports

LoginPassword demo User's password, will be encrypted on the first run

IsEncrypted False

Flag that indicates if the password is encrypted. If you
change the password, edit the field (replacing the unreadable
encrypted entry, if one exists). Then change this value to
False. The new password will be encrypted at the next
startup cycle, and this field will be updated to True.

ScadaBinPath

C:\Program Files (x86)
\Schneider
Electric\PowerSCADA
Expert 8.2 with
Advanced Reporting
and Dashboards\Bin

The bin path of PowerSCADAExpert

LogOnUrl
http://SCADASERVER/
Reporting/LogOn.aspx

The URL of the logon page(this is an example; use your own
server name)

ReportServerName SCADASERVER
The name or IP address of the server running the reporting
application

LogLevel All

The level of logging you want in the report mailer application.
This log is saved to a ReportMailerLog.txt file in the running
project's directory. Possible settings are ALL, DEBUG,
ERROR,WARN.

After this file is configured, run the ReportMailer.exe with the following syntax:

ReportMailer.exe <ReportName> <ReportConfiguration> <EmailList>
<ScadaProjectPath>

where:

<ReportName> = the name of the report you wish to view

<ReportConfiguration> = the name of the saved configuration to use

<EmailList> = the name of the email list you wish to use

<ScadaProjectPath> = the full path to your SCADA project

This command line application may be called from Cicode following the below
example:

FUNCTION

PLS_EmailReport()
ErrSet(1);
STRING FilePath = ParameterGet("CtEdit","User","") + "\PLS_
Include\ReportMailer.exe " +
"MultiDeviceReport SampleConfiguration SampleList " +
"^"C:\ProgramData\Schneider Electric\PowerSCADA Expert 8.2 with
Advanced Reporting and Dashboards\User\PLS_Example^"";
Exec(FilePath);

END

NOTES
— The SCADA project path must be enclosed in escaped quotes (^").
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— This is an asynchronous (non-blocking) call. While the EXEC() method will
return immediately, it may take a few moments to run and email the report. See
the web.config timeout value (see option 2 above) for more information.

— You can also call the ReportMailer application directly from a command line. In
this case, you can add the term "blocking" to the command line (as a fifth
parameter). This causes ReportMailer to act in a synchronous state (block the
call) and to return any error messages to the console. Never use the "blocking"
parameter by Cicode, as it could prevent EXEC() from returning in a timely
fashion.

Scheduling Basic Reports

You can schedule the emailing of basic reports by executing the above Cicode as an
action from a timed event. For more information, see Configuring Events in the
CitectSCADA.chm help file (Program Files> Schneider Electric > PowerSCADA Expert
> v8.2 > bin).

You can also use the Windows Task Scheduler to send these reports. Refer to
Microsoft's documentation on the task scheduler at: http://windows.microsoft.com/en-
US/windows7/schedule-a-task.

Read, Export, Print, and Edit Basic Reports
After you create a basic report, you can:
• change its appearance (Page Setup)
• print it
• change its view: HTML or PDF
• scroll to the beginning, previous page, next page, or last page
• export it to a variety of formats
• email it

The toolbar options table below describes these options.

Toolbar Options

The report toolbar includes several options:

Option Description

Parameters/Report
Toggle between viewing the parameters (setup)
page and the report.

Parent/Child reports Not currently used.

Hide/Show Not currently used.

Page Setup
Click this link to open the Page setup window,
where you can determine paper size, and page
orientation andmargins.

Print
Click this link to print the report.

NOTE: For best formatting of the report, you
should export to PDF, and then print.

Print Preview
In HTMLmode, click this link to view the print
output.
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Option Description

Viewer Mode
You can view in HTML or PDF mode. Select the
mode, then click Viewer Mode to change the
view.

Viewer Mode Set ( )
Click to confirm the choice of viewer mode.

Pagination Click the left and right arrows to page backward
and forward in the report. Or type the page
number you want to see.

Select a format
For exporting, choose the format (not HTML)
that you want.

Export ( ) See instructions below for exporting a report.

Email ( )

Click this link, and then enter the requested
information. Click Send.

 For other ways to email reports, seeSend Basic
Reports via Email on page 192.

Export a Basic Report

Before you can print a basic report, you must export it into a format that can be printed.

You can export to:
• Acrobat (Pdf) File
• Web Archive
• Word Document
• Xml File
• XLS Document

To export:

1. While viewing the report, select a format, then click Export ( ).
2. Type the location at which you want to save the file.
3. Set any other properties you wish.
4. Click Export.

Edit the Basic Report Appearance

With the report displayed, you can:
• Change the paper size
• Change the paper source
• Change the page orientation
• Change the page margins
• Change the number of pages per sheet
• Add a watermark

PowerSCADA Expert Basic Reports
During runtime, you can create, view, save, and print basic reports.

Before you can view basic reports, there must be data logged for the project. See Use
the Analysis Page on page 179 for help.
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You must also create a report tab for the graphics page in runtime mode. See Set up
the Runtime Environment for Basic Reports on page 187.

NOTE: If the Schneider Electric CoreServiceHost has not been refreshed after devices
or topics have been added, you should clear the cache and refresh the platform in
order to access the new devices or topics.

See Clear Cache and Refresh Platform on page 161 for instructions.

After you have logged trend information, you can create and view basic reports. From
the graphics page in the runtime environment, click the reports tab and choose the
basic report type you want to create:

Single Device Usage Reports on page 196

Multi Device Usage Reports on page 197

Tabular Reports on page 197

Trend Reports on page 198

Rapid Access Labels on page 217

See also:

Localization for Basic Reports on page 200

Single Device Usage Reports
Use single device usage reports to display historical energy data from a single device
and multiple topics. A single device report includes only usage and consumption
topics.

NOTE: The report is optimized for up to five topics. If you choose too many topics, the
chart legend can become unreadable.

Before you can create and view a report, you must set up reporting in the runtime
environment. See Set up the Runtime Environment for Basic Reports.

To set up a single device usage report, follow these steps:

1. Browse to the single device report in the reporting web application. When
prompted, enter your PowerSCADA Studio user account information. Click Login.

2. At the next screen:
— Type a report title.
— In Reporting Period, choose the date range for this report, for example, last

week.
If you choose Custom..., the Start Date/Time and End Date/Time fields display.
Enter the date and hour:minutes:AM/PM. (The date/time fields do not apply for
the other reporting periods.)

— From the Period Grouping dropdown box, choose the interval by which you
want to see the data reported. (The options here vary, depending on the date
range selected.)

— Highlight the name of the device that you want for the report.
— Check the topics to be included.

3. Click Generate Report.

After the report is generated, it displays on the screen. It includes a usage summary
table, and a graph and table for each topic you selected. You will probably have to
page forward in the report to see all of the information.

For information about reading, exporting, printing, or editing reports, see Read, Export,
Print, and Edit Basic Reports.
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Multi Device Usage Reports
Use multi device usage reports to display historical energy data for multiple devices
and one topic. A multi device usage report includes only usage and consumption
topics.

NOTE: If you choose too many devices, the chart legend can become unreadable.

Before you can create and view a report, you must set up reporting in the runtime
environment. See Set up the Runtime Environment for Basic Reports.

To set up a multi device usage report, follow these steps:

1. Browse to the multi device usage report in the reporting web application. When
prompted, enter your PowerSCADA Studio user account information. Click Login.

2. At the next screen, do the following:
— Type a report title.
— In Reporting Period, choose the date range for this report, for example, last

week.
If you choose Custom..., the Start Date/Time and End Date/Time fields display.
Enter the date and hour:minutes:AM/PM. (The date/time fields do not apply for
the other reporting periods.)

— From the Period Grouping dropdown box, choose the interval by which you
want to see the data reported. (The options here vary, depending on the date
range selected.)

— Check the names of the devices for the report.
— Highlight the topic to be included.

3. Click Generate Report.

After the report is generated, it displays on the screen. It includes a usage summary, a
value table by interval for all of the devices selected, and a pie chart. You will probably
have to page forward in the report to see all of the information.

For information about reading, exporting, printing, or editing reports, see Read, Export,
Print, and Edit Basic Reports.

Tabular Reports
Use tabular reports to display a system's historical data in a table format. Tabular
reports can include one or more devices and one or more topics. A tabular report can
include all available topics.

NOTE: The report is optimized for up to five topics. If you choose too many devices or
topics, the chart legend can become unreadable.

Before you can create and view a report, you must set up reporting in the runtime
environment. See Set up the Runtime Environment for Basic Reports.

To set up a tabular report, follow these steps:

1. Browse to the tabular report in the reporting web application. When prompted, enter
your PowerSCADA Studio user account information. Click Login.

2. At the next screen, do the following:
— Type a report title.
— In Reporting Period, choose the date range for this report, for example, last

week.
If you choose Custom..., the Start Date/Time and End Date/Time fields display.
Enter the date and hour:minutes:AM/PM. (The date/time fields do not apply for
the other reporting periods.)
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— From the Period Grouping dropdown box, choose the interval by which you
want to see the data reported. (The options here vary, depending on the date
range selected.)
If you leave the default By Interval, you will get every data point in the selected
date range.

— Check the name(s) of the device(s) for the report.
— Check the topic(s) to be included.

3. Click Generate Report.

After the report is generated, it displays as a table on the screen. It lists data for all of
the tags according to their timestamps. You will probably have to page forward in the
report to see all of the information.

For information about reading, exporting, printing, or editing reports, see Read, Export,
Print, and Edit Basic Reports.

Trend Reports
Use trend reports to display a system's historical data in a trend (line) and table
formats. Trend reports can include one or more devices and one or more topics. A
trend report can include all available topics.

NOTE: The report is optimized for up to five topics. If you choose too many devices or
topics, the chart legend can become unreadable.

Before you can create and view a report, you must set up reporting in the runtime
environment. See Set up the Runtime Environment for Basic Reports.

To set up a trend report, follow these steps:

1. Browse to the trend report in the reporting web application. When prompted, enter
your PowerSCADA Studio user account information. Click Login.

2. At the next screen, do the following:
— Type a report title.
— In Reporting Period, choose the date range for this report, for example, last

week.
If you choose Custom..., the Start Date/Time and End Date/Time fields display.
Enter the date and hour:minutes:AM/PM. (The date/time fields do not apply for
the other reporting periods.)

— From the Period Grouping dropdown box, choose the interval by which you
want to see the data reported. (The options here vary, depending on the date
range selected.)
If you leave the default By Interval, you will get every data point in the selected
date range.

— Click the name(s) of the device(s) for the report.
— Click the topic(s) to be included.

3. Click Generate Report.

After the report is generated, it displays on the screen. It includes a trend for each topic
included (selected data points over the period of the trend) followed by a table with
every timestamp in the period selected. You will probably have to page forward in the
report to see all of the information.

For information about reading, exporting, printing, or editing reports, see Read, Export,
Print, and Edit Basic Reports.

Enable Windows Authentication for Basic Reporting
You may want to use Windows Authentication for logging in to the Basic Reports
application. This could be to authenticate from Active Directory or to provide a single-
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sign-on. Follow the steps below to configure Windows Authentication.

NOTE: These steps are specific to Windows 7; they may be different for other operating
systems. For further assistance, view Microsoft's documentation on this topic at:

http://technet.microsoft.com/en-us/library/cc754628(v=ws.10).aspx

1. Turn on the Windows Authentication feature:

a. From the control panel, click Programs and Features > Turn Windows features
on or off.

b. Check Windows Authentication.
2. Enable Windows Authentication in IIS:

a. From the Control Panel > Administrative Tools, choose Internet Information
Services (IIS).

b. Select the root node from the tree on the left (or the Reporting website, if this
server hosts multiple sites).

c. From the right hand pane, in the IIS section, click Authentication.
d. Enable Windows Authentication.

3. Modify web.config to specify Windows Authentication:

a. From the root of the Reporting direction, locate web.config.
b. Change the line:

<authentication mode="Forms">
to
<authentication mode="Windows">

4. Add roles to web.config:

You must add roles to web.config to allow access to the basic reporting application.
For example, to allow the role (group) Administrators, add the following to the
web.config file:

<authorization>
<allow roles="Administrators"/>
<deny users="?" />

</authorization>

Modifying the web.config file is an advanced topic that is covered on the Microsoft
website.

See the following link for instructions provided on the Microsoft website:

http://www.iis.net/configreference/system.webserver/security/authentication/window
sauthentication

Additional information may be available in the following knowledge base article:

http://support.microsoft.com, and search on kb/815179.

URL Routing for Basic Reports
The basic reporting application uses Asp.NET extensionless URL routing. Depending
on your operating system, you may need to follow additional steps to enable
URL routing in your project.

Windows 2008 R2 and Windows 7
Microsoft has discovered an issue with extensionless URL routing in certain
installations of IIS 7.0 and IIS 7.5. To address this issue, Microsoft has released a hotfix
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referenced by KB article 980368. This hotfix is available at
http://support.microsoft.com/kb/980368.

This hotfix is included in Service Pack 1 for Windows 2008 R2 and Windows 7. To
receive the hotfix, you should install Service Pack 1. This installation provides
additional important updates to the operating system. To obtain Service Pack 1 for
Windows 2008 R2 and Windows 7, go to either Windows Update or
http://support.microsoft.com/kb/976932.

Windows XP
When you install IIS on a Windows XP operating system, IIS version 5.1 is installed.
When browsing to the default URL, you must append to the URL "default.aspx".

Example:

http://<servername>/Reporting/default.aspx

Localization for Basic Reports
To localize basic reports, you must first rename and translate the .resx files into the
target language(s), called "culture names." The .resx files are located in the
PowerSCADA Expert Resources directory (default location: C:\Program Files (x86)
\Schneider
Electric\PowerSCADA Expert\v8.2\Applications\AppServices\bin\Resources).

Make copies of the .resx files listed in the table below. Change the extensions of the
copies into the culture name for the target language. Note that you do not need to
include both the culture ("es") and the region ("ES"), unless you specifically want a
language that is different from the default.

For example, BinningResources.en-US.resx would be named BinningResources.es-
ES.resx when you localize it into Castillian Spanish.

For a list of the culture names you can use, see the National Language Support (NLS)
API Reference, currently at:

NLS API

After you change the extensions, provide translations for the strings in each .resx file.

Store the localized .resx files in the same Resources folder as the English versions.

Template Editor
Use theTemplate Editor to begin creating, duplicating, modifying, and deleting
LiveView templates and views.

See Set Up LiveView on page 209 for complete instructions.

Use LiveView
PowerSCADA Expert provides the ability to create and view LiveView templates and
views. Some basic predefined templates are included with the software; you can create
new templates or make copies of the predefined templates and edit the copies.

Before you view LiveView templates and views, you must set up data acquisition
parameters. To do this, use the Application Configuration Utility. See Application
Services Host—Citect Data Platform on page 223 for instructions.

NOTES:
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• If you find that a predefined table does not include enough cells for the data you
want to display, use the duplicate feature to make a copy of the predefined table.
Then add the needed cells to the duplicate.

• If you install Matrikon Explorer on the same computer as PowerSCADA Expert 8.2
with Advanced Reporting and Dashboards, the LiveView and reporting features will
not launch. To prevent this, install Matrikon before you install PowerSCADA Expert
8.2 with Advanced Reporting and Dashboards. If you install Matrikon after you
install PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards, you
need fix the issue in this way: Go to IIS > ISAPI Filters, and then reset the dll that is
already selected (click browse and re-select v4.0.30319 aspnet_filter.dll). Click
OK.).

You can only view data in these templates if your system is online and you are
connected to devices that provide data.

To begin creating LiveView templates, click Start > Programs > Schneider Electric >
PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards > Config Tools
> Table Editor. The LiveView Template Editor screen displays.

To view a template, see LiveView Viewer on page 207.

To create a new template, see Set Up LiveView on page 209.

See also:

LiveView Formulas on page 213

LiveView Placeholders

LiveView Thresholds on page 214

LiveView Formatting on page 211

LiveView Tables
Click any of the following links to learn about the live view tables:

LiveView Basic Readings Summary on page 201
LiveView Power Flow Summary on page 202
LiveView Energy Summary on page 202
LiveView Energy Readings on page 202
LiveView Fundamental Phasor Readings on page 203
LiveView THD Current Summary on page 203
LiveView THD Voltage Summary on page 203
LiveView Uptime Summary on page 204
LiveView Incremental Reactive Energy Summary on page 204
LiveView Incremental Real Energy Summary on page 204
LiveView Harmonic Apparent Power Flows on page 204
LiveView Harmonic Reactive Power Flows on page 205
LiveView Harmonic Real Power Flows on page 206
LiveView Demand Current Summary on page 206
Live View Demand Voltage Summary on page 206

LiveView Basic Readings Summary
This summary displays real-time basic power information for a selected device or
devices. After opening the basic readings summary template, you set the update
interval for this summary. You can also add or remove devices from the summary.
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Make your selections, and click Display Table.

The basic readings summary provides this data:
• voltage A-B (V)
• current A (A)
• real power (kW)
• power factor

LiveView Power Flow Summary
This summary displays a power flow summary for your system devices. Use the
information from this table to help optimize the system's power flow.

After opening the power flow summary template, you set the update interval for this
summary. You can also add or remove devices from the summary.

Make your selections, and click Display Table.

The power flow summary provides this data:
• real power (kW)
• reactive power (kVAR)
• apparent power (kVA)
• demand average (kW)
• demand peak (kW)
• predicted demand (kW)

LiveView Energy Summary
This summary displays an energy summary for your system devices. Use the
information from this table to help monitor the system's energy consumption.

After opening the energy summary template, you set the update interval for this
summary. You can also add or remove devices from the summary.

Make your selections, and click Display Table.

The energy summary provides this data:
• real power (kW)
• reactive power (kVAR)
• apparent power (kVA)
• block demand real power (kW)
• thermal demand real power (kW)
• peak block demand real power (kW)
• peak thermal demand real power (kW)
• block demand real power predicted (kW)
• thermal demand real power predicted (kW)

LiveView Energy Readings
This table displays accumulated energy readings for a single device. Data is
accumulated beginning with the last energy reset for the device.

Energy values, will be according to one of these accumulation methods:

Absolute (unsigned): The device stores positive energy values, regardless of the
direction of power flow. The energy value increases, even during reverse power flow.
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Signed: The device stores both positive and negative energy values. The energy
value increases or decreases, depending on the direction of the power flow.

After opening the live view energy readings table, choose the device you want and set
the update interval for this table. Click Display Table.

The live view energy readings table provides these accumulated readings:
• real energy (kWHr)
• reactive energy (kVARHr)
• apparent energy (kVAHr)

LiveView Fundamental Phasor Readings
This summary displays a fundamental phasor readings table for a single device, to
confirm that the system is properly wired.

After opening the fundamental phasor reading template, choose the device for which
you want readings and set the update interval for this table. Click Display Table.

The fundamental phasor readings table provides a phasor diagram that indicates
current and voltage magnitudes and angles for each phase.

LiveView THD Current Summary
This summary displays a THD current summary for your system devices. Use the
information from this table to monitor your equipment and system power quality.

After opening the THD current summary template, you set the update interval for this
summary. You can also add or remove devices from the summary.

Make your selections, and click Display Table.

The THD current summary provides this data:

THD current (%):
• phase A
• phase B
• phase C
• neutral

LiveView THD Voltage Summary
This summary displays a THD voltage summary for your system devices. Use the
information from this table to monitor your equipment and system power quality.

After opening the THD voltage summary template, you set the update interval for this
summary. You can also add or remove devices from the summary.

Make your selections, and click Display Table.

The THD current summary provides this data:

THD voltage (%):
• Vab
• Vbc
• Vca
• Van
• Vbn
• Vcn
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LiveView Uptime Summary
This summary displays an uptime summary for your system devices. Use the
information from this table to view the number of seconds the equipment has been in
uptime (defined as all three phases > 10% nominal), and to view the percentage of
uptime vs. total time. The summary includes the last 12 months.

After opening the uptime summary template, you set the update interval for this
summary. You can also add or remove devices from the summary.

Make your selections, and click Display Table.

The uptime summary provides this data:

For the past 12 months:
• Uptime %
• Uptime
• Downtime

LiveView Incremental Reactive Energy Summary
This summary displays an incremental reactive energy summary for your system
devices. Use the information from this table to monitor transmission of energy beyond
the previous baseline, to help achieve optimum loading.

After opening the incremental reactive energy summary template, you set the update
interval for this summary. You can also add or remove devices from the summary.

Make your selections, and click Display Table.

The incremental reactive energy summary provides this data:
• incremental reactive energy into the load (kVARHr)
• incremental reactive energy out of the load (kVARHr)
• date/time of the last incremental energy update

LiveView Incremental Real Energy Summary
This summary displays an incremental real energy summary for your system devices.
Use the information from this table to monitor the energy usage and production above
the previous baseline, to help achieve optimum loading.

After opening the incremental real energy summary template, you set the update
interval for this summary. You can also add or remove devices from the summary.

Make your selections, and click Display Table.

The incremental real energy summary provides this data:
• incremental real energy into the load (kVARHr)
• incremental real energy out of the load (kVARHr)
• date/time of the last incremental energy update

LiveView Harmonic Apparent Power Flows
The harmonic apparent power flows table displays real-time apparent power flow
information. Use this information to help determine the impact of harmonics on system
equipment.

After opening the harmonic apparent power flows template, select the device, then
click Display Table.

In the upper right, you can set the update interval for this table.
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You can set meter registers to enable frequency domain analysis of waveforms and the
format used in analysis. Harmonics and trend tables reflect these register settings. For
details about these settings, read the Notes to the right of the table.

The harmonic apparent power flows table provides this data:
• meter type
• wiring type
• FFT magnitudes
• FFT enable
• FFT status
• FFT hold time
• remaining hold 
• total voltage harmonic distortion for all three phases
• total current harmonic distortion for all three phases
• harmonic components for all three phases:

— power flow in from the utility
— power flow out to the utility
— apparent power

Magnitudes and angles are available for all odd harmonics from H1 through H31.

LiveView Harmonic Reactive Power Flows
The harmonic reactive power flows table displays real-time reactive power flow
information. Use this information to help determine the impact of harmonics on system
equipment.

After opening the harmonic reactive power flows template, select the device, then click
Display Table.

In the upper right, you can set the update interval for this table.

You can set meter registers to enable frequency domain analysis of waveforms and the
format used in analysis. Harmonics and trend tables reflect these register settings. For
details about these settings, read the Notes to the right of the table.

The harmonic reactive power flows table provides this data:
• meter type
• wiring type
• FFT magnitudes
• FFT enable
• FFT status
• FFT hold time
• Remaining hold 
• total voltage harmonic distortion for all three phases
• total current harmonic distortion for all three phases
• harmonic components for all three phases:

— power flow in from the utility
— power flow out to the utility
— reactive power

Magnitudes and angles are available for all odd harmonics from H1 through H31.
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LiveView Harmonic Real Power Flows
The harmonic real power flows table displays real-time real power flow information.
Use this information to help determine the impact of harmonics on system equipment.

After opening the harmonic real power flows template, select the device, then click
Display Table.

In the upper right, you can set the update interval for this table.

You can set meter registers to enable frequency domain analysis of waveforms and the
format used in analysis. Harmonics and trend tables reflect these register settings. For
details about these settings, read the Notes to the right of the table.

The harmonic real power flows table provides this data:
• meter type
• wiring type
• FFT magnitudes
• FFT enable
• FFT status
• FFT hold time
• remaining hold 
• total voltage harmonic distortion for all three phases
• total current harmonic distortion for all three phases
• harmonic components for all three phases:

— power flow in from the utility
— power flow out to the utility
— real power

Magnitudes and angles are available for all odd harmonics from H1 through H31.

LiveView Demand Current Summary
This summary displays a demand current summary for your system devices. Use the
information from this table to help monitor the system's demand current.

After opening the demand current summary template, you set the update interval for
this summary. You can also add or remove devices from the summary.

Make your selections, and click Display Table.

The demand current summary provides this data:

average demand current and peak demand (both in amps)
• Ia
• Ib
• Ic

Live View Demand Voltage Summary
This summary displays a demand voltage summary for your system devices. Use the
information from this table to monitor the system's demand voltage.

After opening the demand voltage summary template, you set the update interval for
this summary. You can also add or remove devices from the summary.

Make your selections, and click Display Table.

The demand voltage summary provides this data:
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demand voltage
• Vab
• Vbc
• Vca
• Van
• Vbn
• Vcn

LiveView Viewer
Use this screen to view table templates, and to view or create table views, in the
LiveView Viewer.

To open this screen, in Runtime mode, click the menu links that have been set up
when you created the graphics page (see Create Menu Item for LiveView Page on
page 210). In the PLS_Example project, there is a tab for LiveView. For information
about an individual table, click a link from the Contents folder.

NOTE: If you plan to view a table using the Rapid Access Labels on page 217 feature,
do not change its name after you print the QR code. If the name is changed, you must
generate a new rapid access label.

Open LiveView from a URL Link
Before you can open LiveView from a URL link, you must select a template and the
desired devices, display the table, and save it as a View.

To open this view using a URL link, use one of these options:
• From the computer where LiveView is installed, enter

http://localhost/LiveViewViewer
• From a remote client computer, enter

http://10.10.10.10/LiveViewViewer
(where 10.10.10.10 is the URL of the server where LiveView resides)

To automatically open a specific table when you launch LiveView Viewer, add the
table name to the end of the address. For example, to open the basic readings
summary view while on the local computer, you would enter:

http://localhost/LiveViewViewer/Basic Readings Summary View

LiveView Viewer Display
The Live View Viewer displays with two tabs, Templates and Views.

Templates: A template includes all setup data (placeholders, formulas, thresholds,
and formatting); but it does not have devices selected. The templates include those that
are predefined (designated by the locked symbol: ), as well as those that have

been defined in the Setup window.

To view a template, select it from the list. Then, select the device(s) for which you want
to display values. (Only devices that have at least one assigned topic from the topic
placeholders in this template are available for selection.

Click Display Table to view the template in the right-hand pane.

To save a template as a view, display the template. Click (  ) on the upper right of

the Viewer page. In the View Name window, edit the name, then click OK. The new
view is saved in Tables > Views on the server. The view will also display in the left-
hand pane of the Views tab.
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Views: A view is a template that is saved with its device selection(s). The views listed
are saved on the server in Tables > Views. Views are available to all users, whether on
the server or a client. They also display on the Views tab of the Live View Viewer.

To open a view, highlight its name, then click Display. The view displays in the right-
hand pane with updated data. You can delete a view (click Delete, to the right of the
View tab). You can change a view by adding or deleting devices and then either
overwriting the view or saving it as a new view.

Update List: This link forces the cached table and view lists to be refreshed, displaying
any newly added tables and views.

Select Device(s) and Update Device List: This link forces any new devices (with at
least one assigned topic) to display. In the Select Device(s) list, you can move devices
higher or lower in the list that you see, so that they display in the order you prefer. To
do this, right-click and highlight a device, then click one of these icons:

: Move to the top (double arrow) or move up one step (single arrow)

: Move to the bottom (double arrow) or move down one step (single arrow)

Where's My Device? on page 209: Click this link to explain why an expected device
does not display in the table.

Template and View Features

The template (after you click Display) or view displays with devices and data. The
following information is included:

Placeholders: All placeholders that were added during setup will display with the
appropriate device name or tag value.

Thresholds: If any of the tag values are outside of the normal range established in
the Thresholds that were added during setup, the font color will reflect the high or low
status of that tag.

On the right-hand side of the top of the screen are these buttons:

Save (  ): Click to save a template as a "view." You are prompted to name the

view (default: table name appended with "view"). The view is saved in Tables
> Views on the server. The view includes the devices that were selected for the
table.

Notes (  ): Click to display a description of the table that was added when the table
was set up.

Print (  ): Click to print a copy of the table with its current values.

Last Update: This is the most recent date/time that the template or view values were
updated.

Update Interval: Choose the interval of time that will pass between requests to update
the data in the template or view. Options are:

Manual: Updates only occur when you click Update Now.
5 seconds
10 seconds
30 seconds
1 minute
10 minutes
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Update Now: Click to manually update values and refresh the template or view.

Where's My Device?
This help topic displays when you click "Where's My Device?" below the device list in
LiveView Viewer.

Missing Topics
Only devices that have topics available for the selected template will appear in the
device selection list. If you do not see an expected device, it is missing because it does
not include topics that are used in this template.

If this is a template that you have created, you can open the template in the LiveView
Placeholders on page 212 screen of LiveView Template Editor to add the placeholder
(s). If this is a predefined template, you cannot change it; you will need to make a
duplicate template and then add the desired placeholder(s).

Clear Cache and Platform Refresh
If the Schneider Electric CoreServiceHost has not been refreshed after devices or
topics have been added, you should clear the cache and refresh the platform in order
to access the new devices or topics.

See Clear Cache and Refresh Platform on page 161 for instructions.

Set Up LiveView
Use this application to begin creating, duplicating, modifying, and deleting LiveView
templates and views.

You can configure a LiveView template in LiveView Template Editor, and then display
it on the server or on a web client. A "template" includes all of the setup data except
devices.

You can create "views" of templates in LiveView Viewer. A "view" is a template that
includes devices.

To access LiveView Template Editor, click Start > Programs > Schneider Electric >
PowerSCADA Expert > v8.2 Config Tools >Template Editor.

Only one user at a time can access LiveView Template Editor. When a user accesses
LiveView Template Editor, a file called TemplateEditor.lock is saved on the
PowerSCADA Expert folder of the server (default location: Program Files > Schneider
Electric > PowerSCADA Expert > v8.2 > Applications > LiveView > Viewer). If
necessary, an administrator can unlock the utility by deleting TemplateEditor.lock from
the server.

Here you can see:
• Notes icon (  ):This opens a free-form field to add any descriptive information

about the template that will be useful. The information displays in a notes field, to
the right of the template. This field closes when you click Done.

• In the left-hand pane are the following:

New: (You are prompted to save if you are editing a template that is not saved.)
Click to save the template you are editing, and then to add a new template. The
"New Template" name displays in the list, a new template file is uploaded to the
server in Table > Templates, and an empty template displays in the right-hand
pane. All fields are set to their defaults.
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Duplicate: Click to save a copy of the selected template. The current template
name is used with "Copy" appended. Use this option to edit a predefined template.

NOTE: If you find that a predefined table does not include enough cells for the data
you want to display, create a duplicate. Then add the needed cells to the duplicate.

Delete: Click to delete the current template (you cannot delete predefined
templates). Confirm that you want to delete it. All views associated with the template
will also be deleted.

Select Template: This list includes all of the templates that are set up. Predefined
templates display a lock icon (  ) to the left of the name. These templates cannot

be deleted or edited.

Template Name: Overwrite the current name, which updates the template here
and in the list of templates. This will also update the views that are associated with
this template.

Single Device/Multiple Device: Click the radio button for the type of template
you want (default: Single Device).

View Area: Use this field to determine the area of the table that will be viewed in
LiveView Viewer. When you set up a table, there may be information (such as
formulas or notes) that you do not want to display in the final table in the Viewer. To
select only the material that you want to view, do one of the following:
— In the View Area text field, type the cell range that you want to view (for

example, A1:D20).
— Select the cells that you want to include, then press Use Selection.

In either case, a border displays around the cells in the range you select.

Save the template. When you view it in LiveView Viewer, it will only include the
cells you selected.

Save: This button becomes live only after you make a change to a template that is
being edited. The template is saved as an .xlsx file; it is uploaded to the server in
Table > Templates. The saved template appears in the View tab after you click
Save. (You do not need to click Save when you create a new template or a
duplicate; these files are automatically saved.)

To create a new template, see Create a LiveView Template on page 211.

To modify an existing template, see Modify LiveView Template on page 215.

To duplicate a template, see Duplicate LiveView Template on page 215.

To delete a template, see LiveView Delete on page 216.

See also:

LiveView Formulas on page 213

LiveView Placeholders on page 212

LiveView Thresholds on page 214

LiveView Formatting on page 211

Create Menu Item for LiveView Page
The following steps describe how to interact with the LiveView application via the
runtime environment.

1. From the PowerSCADA Studio, click Visualization tab > Menu Configuration.
2. Add the new menu item that you want for each of your LiveView tables.
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3. In each of these menu items, in the Menu Command line, add the Cicode method
that will display a LiveView tab. You can create your own custom method or use the
default:

PLS_LiveViewDsp(STRING sIPAddress, STRING sViewName = "", STRING
sTitle = "")

Example:

PLS_LiveViewDsp(“10.10.10.10", "BasicReadingsSummary”,
"ShowConfiguration/MyConfiguration", “Basic Readings Summary”);

which opens a configured LiveView table view with the saved configuration name
"MyConfiguration".

Create a LiveView Template
To add a new LiveView template:

1. Open LiveView Setup, then click New.

An empty template displays with a "New Template" name.
2. Overwrite the template name with a name of your choice, up to 100 characters

(limited to A–Z, a–z, 0–9, spaces, underscores, hyphens, and parentheses).
3. To continue setting up the template, click one of the links below.

Template Name: default: New Template (or, if an earlier New Template exists,
appended with a 1)

Single Device/Multiple Devices. The default is single device. If you want a
multiple device table, click Multiple Devices.

NOTE: Table grid lines do not display in the LiveView Viewer, but they do display in
LiveView Setup.

See also:

To add data formulas to the real-time table, see LiveView Formulas on page 213.

To add data (device names and tag names) to the real-time table, see LiveView
Placeholders on page 212.

To add visual alerts (color changes) when the value of the tag associated with a cell
becomes too high or too low, see LiveView Thresholds on page 214.

To add formatting to cells, such as font and font size, see LiveView Formatting on page
211.

LiveView Formatting
Use this feature to add cell formatting, such as font, font size, and color. To use this
feature, click the Formatting subtab in LiveView Template Editor. A formatting toolbar
displays on the screen. It allows you to set the appearance of the cells in the template.

NOTE: Formatting changes become visible only after you click outside of the cell that
you change.

To format a cell or range of cells, select the cell(s). When you select a format, the active
cell(s) will be set to the specified format attribute. When a cell becomes active, the
format selections on the toolbar will reflect the selections for that cell. When you select
multiple cells, the format selections will reflect those of the first cell you select.

Then you can format the cell appearance:
• Choose font and font size.
• Choose whether to apply bold, italics, or underline.
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• Choose a color for the font (default is black), and for the background of the cells
(default is white).

• Choose the horizontal alignment: flush left, centered, or flush right.
• Choose the vertical alignment: top, center, or bottom.
• If more than one cell is selected, Merge Cells is enabled. Check this box to merge

the selected cells into one large cell.
• In the Data Type drop-down box, select the type of data that will be in the selected

cell(s):
— Text (default); theWrap Text box displays; check this box if you want text to

wrap and stay within the cell.
— Date; In the Format field that displays, type the format you want to use (Excel

formatting is supported):
24-hour format: m/d/yy h:mm:ss
AM/PM format: m/d/yy h:mm:ss AM/PM or m/d/yy hh:mm:ss AM/PM

— Number; In the Decimal Places field that displays, choose the number of
decimal places you want; if desired, check the Use 1000 Separator box to insert
the separator (for example, comma, depending on your regional settings).

• You can resize the row height or column width by dragging row/column header. A
tooltip displays the height or width as you resize it.

Alternatively, right click anywhere in the template to display a context menu that
allows you to insert/remove columns or rows, or to type the column width and row
height.

Save your changes.

See also:

To add data formulas to the Live View template, see LiveView Formulas on page 213.

To add data (device names and tag names) to the Live View template, see LiveView
Placeholders on page 212.

To add visual alerts (color changes) when the value of the tag associated with a cell
becomes too high or too low, see LiveView Thresholds on page 214

See also:

LiveView Formulas on page 213

LiveView Thresholds on page 214

LiveView Placeholders on page 212

LiveView Placeholders
Placeholders provide the data (device names and tag names) to a LiveView template.
The placeholders are the identifiers that are added when setting up the template, but
are replaced with the name of the selected device or the tag value when the template
is viewed.

To use this feature, click the Placeholder subtab in LiveView Template Editor.Then
enter the appropriate information in the following fields.

1. To begin, place the cursor in a cell. Note that the Insert Location displays the cell
number for the placeholder you are setting.

2. TAG Value/Device Name:
From the drop-down field in the top left corner of the page, choose either Tag Value
or Device Name.
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Tag Value: Select the tag group, such as Alarm, Current, Energy. Beneath the tag
group, select the specific tag you want. The list is filtered to include only the most
common tags that belong to the group you selected. To view all of the tags
available in this tag group, check Show Advanced.

Device Name:The list of devices is filtered to include only devices for which this
template's data is available. To display the device name in this cell of the template,
select Device Name. You will choose the actual device during runtime.

3. Insert Location: This offers a second way of inserting the placeholder location.
After choosing the device or tag, type the cell number for the placeholder cell.

4. Insert: Click to add the selected placeholder to the specified cell.

Continue adding placeholders as needed.

See also:

LiveView Formulas on page 213

LiveView Thresholds on page 214

LiveView Formatting on page 211

LiveView Formulas
Follow these instructions to add the formulas needed to include data in a Live View
template. You can add formulas to:
• add, subtract, multiply, or divide the contents of two individual cells
• add, multiply, or average the contents of a range of cells

To use this feature, click the Formulas subtab in LiveView Template Editor. Then
choose one of the following fields:
• Cell: Use this field to enable a formula for two individual cells. Then enter:

Cell 1 Address: Type the cell address. The cell address displays in this field.
Operator: Choose the operator you want to use: +, –, *, or /.
Cell 2 Address: Type the cell address. The cell address displays in this field.

• Cell Range: Use this field to enable a formula for a range of cells. Then enter:
Operation: Choose average, product, or sum.
Cell Range: Type the cell range (format C4:C20), or select the range of cells to
include in the formula. The cell range displays in this field.

• Insert Location: Type the cell number.
• Insert: Click this button to build the formula you have specified, and to add it to the

cell you added to Insert Location.

Repeat the above procedure for the rest of the formulas you want to use for this Live
View template.

NOTES:
• You must "Protect Current Sheet" in order for formulas to be maintained and visible

in the LiveView Template Editor.
• If you want to use conditional formulas ("IF" formulas), you must first create them in

Excel. To do this, you must access the template you want on the server (Program
Files > Schneider Electric > Applications > LiveView > TemplateEditor >Templates
Temp). Open the template in Excel and add the conditional formula(s) that you
want. After you save the changes, the formula(s) will function correctly in Live View.
You must copy the IF statement into every cell of the column that displays the result
of the IF statement.
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• In multiple device tables that rely on formulas to display information for each
device, the results column will display zeroes when that row has no device in it. To
avoid this, use a formula that will display no result if there is no device in that row. In
the following example, when no device is in cell A2, no results will display (no
zeroes) in cell E2.

See also:

LiveView Placeholders on page 212

LiveView Thresholds on page 214

LiveView Formatting on page 211

LiveView Thresholds
Use this feature to display tag readings that fall outside of the normal range. You can
apply it to an individual cell or a range of cells. You determine the tag or tags for which
you want to display out-of-normal (threshold) readings. When the value of the tag in a
cell (or any tag in a cell range) is below the minimum or above the maximum that you
set, the tag value displays in the threshold cell.

You can set both minimum and maximum values for a cell or cell range. Use different
colors to indicate the high and low readings.

To use this feature, click the Threshold subtab in LiveView Setup. To add a threshold:

1. Cell: For a single cell: Select the cell for which you want the font color to change.
The font color will change when the value for the tag in that cell goes above the
specified Max Value (or below the Min Value) for the threshold.

or

Cell Range: For a range of cells, either select the range, or type the range in the
format C4:C20.

NOTE: When setting up a multiple-device table, you should use a cell range to
ensure that threshold font colors display for each device in the table.

2. Min Value: Type the low value for the "normal" range. If the tag value drops below
this value, the cell font color will change as specified in step 3.

3. BelowMin Threshold Color: Open the color palette and select the font color that
you want to indicate the "low" status.

4. Max Value: Type the high value for the "normal" range. If the tag value goes above
this value, the cell font color will change as specified in step 5.

5. Above Max Threshold Color: Open the color palette and select the font color that
you want to indicate the "high" status.

6. Insert Location: Choose an empty cell, one that is not part of the table. This cell will
be the location for the threshold definition that you are creating.

The default cell for the threshold definition is the next available cell in the template.
For example, if the tag in cell B7 has an unused cell to the right of it (C7), the
threshold definition defaults to C7. Then, when the value in B7 exceeds the
threshold defined in C7, the value in B7 displays in the font color you specified. To
override the default cell location, change it in the Insert Location field.
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7. Insert: Click here to create the threshold(s).

The threshold definition is in the form: <<Threshold;B2:B20;Min=100;Max=1000>>

See also:

LiveView Formulas on page 213

LiveView Placeholders on page 212

LiveView Formatting on page 211

Modify LiveView Template
You can modify any template except one that is predefined. Predefined templates have
a lock icon (  ) beside their names.

1. Open LiveView Template Editor. In Runtime mode, click the menu links that have
been set up when you created the graphics page (see Create Menu Item for
LiveView Page on page 210). In the PLS_Example project, there is a tab for
LiveView.

2. Highlight the name of the template that you want to modify.

The template displays.
3. You can change any field on the template. Click any of the subtabs (Placeholder,

Formula, Threshold, or Formatting) to edit the related information. For help on the
subtabs, see the "See Also" links below.

4. When you have finished making changes, click Save.

Continue working with other templates.

See also:

LiveView Placeholders on page 212

LiveView Formulas on page 213

LiveView Thresholds on page 214

LiveView Formatting on page 211

Duplicate LiveView Template
Use this feature to make an exact copy of any template, including predefined
templates. The duplicate will not be locked, allowing you to edit and save it as a
different template.

1. Open LiveView Template Editor. In Runtime mode, click the menu links that have
been set up when you created the graphics page (see Create Menu Item for
LiveView Page on page 210). In the PLS_Example project, there is a tab for
LiveView.

2. Highlight the name of the template that you want to duplicate.

The template displays.
3. Click Duplicate (on the top of the left-hand pane).

The duplicate template is added to the list. It has the same name of its original
template, appended with "Copy."

4. Change the name of the duplicated template to differentiate it from its original.
5. Make the desired changes and then click Save to save them.
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LiveView Delete
You can delete any template except one that is predefined.

1. Open LiveView Template Editor. In Runtime mode, click the menu links that have
been set up when you created the graphics page (see Create Menu Item for
LiveView Page on page 210). In the PLS_Example project, there is a tab for
LiveView.

2. Highlight the name of the template that you want to delete.

The template displays.
3. Click Delete (on the top of the left-hand pane).

You are prompted to verify the deletion.
4. Click Yes to delete the template, or click No to cancel the deletion.

Continue working with other templates.

LiveView Template Localization
You can easily localize your LiveView templates. To do this, you will need to replace
English terms with the localized ones. Follow these instructions to create the localized
file:

1. Choose the language that you need for your localized terms.
— Go to Control Panel > Internet Options > Languages. In the Language

Preference box, click Add to display the possible languages.
— Highlight the language you need. For example, French for France is: French
(France) [fr-FR]. Click OK.

— In the Language Preference box, highlight the new language and click Move up
to move it to the top of the list of languages. Click OK.

2. Locate the file called LiveViewViewer.resx. The default location is in the App_
GlobalResources folder.

3. Make a copy of the resx file.
4. Use Visual Studio to open the copy resx file.
5. Replace the English terms in the right hand column with the localized terms that

you need.
6. Save this file with a new extension, which must match the language. For the

example above, the new file name would be:

LiveViewViewer.fr-FR.resx

The LiveView template fields that you replaced will now display in the localized
language.

Enable Windows Authentication for LiveView
You may wish to use Windows Authentication for logging in to LiveView. If you want to
use Windows Authentication, you must follow standard IIS authentication methods.
Follow the steps below to configure Windows Authentication.

NOTE: These steps are specific to Windows 7; they may be different for other operating
systems. For further assistance, view Microsoft's documentation on this topic at:

http://technet.microsoft.com/en-us/library/cc754628(v=ws.10).aspx

1. Turn on the Windows Authentication feature:
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a. From the control panel, click Programs and Features > Turn Windows features
on or off.

b. Check Windows Authentication.
2. Enable Windows Authentication in IIS:

a. From the Control Panel > Administrative Tools, choose Internet Information
Services (IIS).

b. Select the root node from the tree on the left (or the LiveViewViewer node, if this
server hosts multiple sites).

c. From the right hand pane, in the IIS section, click Authentication.
d. Enable Windows Authentication.

3. Modify web.config to specify Windows Authentication:
a. Locate web.config:

C:\Program Files\Schneider Electric\PowerSCADA Expert\
v8.2\Applications\LiveView\Viewer

b. Change the line:
<authentication mode="Forms">
to
<authentication mode="Windows">

4. Add roles to web.config:

You must add roles to web.config to allow access to the LiveVIew application. For
example, to allow the role (group) Administrators, add the following to the
web.config file:

<authorization>
<allow roles="Administrators"/>
<deny users="?" />

</authorization>

Modifying the web.config file is an advanced topic that is covered on the Microsoft
website.

You will enable Windows Authentication in IIS and modify web.config to specify Live
View.

See the following link for instructions provided on the Microsoft website:

http://www.iis.net/configreference/system.webserver/security/authentication/windowsa
uthentication

Additional information may be available in the following knowledge base article:

http://support.microsoft.com, and search on kb/815179.

Rapid Access Labels
Use this report to create quick-response code (QR code) stickers that can be placed on
your system equipment to provide quick access to PowerSCADA Expert standard
reports and LiveView table views. You can also generate a label for any URL. After you
create and print the code stickers, you will be able to read them with a QR code reader
that is installed on a Smart Phone, iPhone, or other device.

Before You Begin
Make sure that you have completely configured your system. This includes:
• Set up all servers, equipment, and addressing
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• Create the reports and LiveView views that you want to see. Note that the report
configuration names and Live View view names cannot be changed after you
create the QR stickers, as the links would be broken to the reports/table views.

• To view a report, you must first save the report configuration. See Run a Report and
Save its Configuration in Create and View Basic Reports on page 189 for
instructions.

• All devices that will be used to scan QR codes must be on the same network with
the server.

• Purchase the label stock paper for the labels you will print. Use Avery 6578
Label Stock, or equivalent. Other label stock may not be spaced correctly, which
could result in the labels not printing correctly.

Create the Sticker
1. Ensure that you have a laser printer set up and available for printing.
2. At the printer that you will use to print the labels, insert the blank label stickers. Use

Avery 6578 Label Stock or equivalent.
3. Browse to the Rapid Access Labels report in the reporting web application. When

prompted, enter your PowerSCADA Studio user account information. Click Login.

The Rapid Access Labels screen displays.
4. From the Server Address drop down list, choose the IP address that is connected to

the same network as the wireless access points.
Do not use an IP provided by DHCP, as the IP address can change frequently.
If your network supports DNS, we recommend that you use the machine name of
the server.

5. In the Port box, accept the default "80" or, if necessary, enter a different port.
6. In the Select items to generate labels box, check the report configuration(s) and

LiveView table(s) for which you want to print stickers.
7. Optional: You may wish to print a sticker for a different URL (such as a corporate

website). To do this, enter the URL in the URL line of the Manual URL Entries box
(the site name automatically displays in the upper box).

8. Optional: On the Caption line, you can type any text that you want to have printed
above the QR code on the sticker. If you want the output table or report to have a
title, enter it here.

9. Click Generate Report.

NOTE: To print correctly, use the icon on the report control bar, not the one from the
browser (which would add a header and footer, and throw off alignment).

Read the Sticker
The sticker(s) print at the designated printer. Each one has a title that is one of the
following:
• a report configuration name
• a LiveView name
• user-entered text from the Caption text box

Place each sticker in the desired location, such as next to the device that is being
monitored.

To read a sticker, use a QR code reader (such as a Smart phone or iPhone). The
reader must have access to the network and server. We recommend that you use the
QR Droid application if you are viewing reports/tables from an Android phone.
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Troubleshooting
If you cannot read the QR code, verify the following:
• Your phone/reader has access to the wireless network, and the server can be

reached by the IP you selected when generating labels.
• The server address and port name are correct.
• The report configuration name or LiveView table name are correct (and have not

been changed or deleted).

Multi-Monitor Support
PowerSCADA Expert provides the means for viewing the runtime environment from
multiple monitors. This setup allows you to view unrelated information at separate
monitors that are placed beside each other. In this example, there are four monitors,
configured left to right in a single row:

Main Monitor Monitor 2 Monitor 3 Monitor 4

(displays Windows Start button)

In the Citect.ini file for the project, add the following instructions:

Add the following instructions to the Citect.ini file (changes can be added directly to the
Citect.ini file):

[MultiMonitors]
Monitors = 4
StartupPage1 =
StartupPage2 =
StartupPage3 =
StartupPage4 =

where

Monitors = n; n = number of monitors used to display the pages in the project

The windows display according to the formation of the monitors—such as left-to-right,
top-to-bottom or grid—set in the Windows operating system. By default, this is set via
the Windows Start menu > Control Panel > Display applet.

StartupPage1 = startup page that needs to be displayed on monitor 1

StartupPage2 = startup page that needs to be displayed on monitor 2

StartupPage3 = startup page that needs to be displayed on monitor 3

StartupPage4 = startup page that needs to be displayed on monitor 4

The Demo Mode
You can run PowerSCADA Expert without the hardware key in demonstration (Demo)
mode. In demonstration mode, you can use all product features normally, but with
restricted runtime and I/O.

If you configure PowerSCADA Expert to run as multiple processes on one CPU or
multiple CPUs, you cannot use it in demo mode; but if you run it as one process, you
can use a demo mode. The following demonstration modes are available:
• The one-line engine will run for 60 minutes.
• Reporting and LiveView do NOT work, because it requires a valid license.
• 15 minutes with a maximum of 50,000 real I/O.
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• 10 hours with a maximum of one dynamic real I/O. This is useful for demonstrations
using memory and disk I/O. PowerSCADA Expert starts in this mode if no hardware
key is available. If the system detects that you are using more than one real I/O
point at runtime, it will switch to the 15-minutes demo mode.

Writing to any tag through DDE, CTAPI, or ODBC will cause that tag to contribute to
the dynamic point count, even if it is a memory or disk I/O point. So, if you write to
more than one point through these interfaces, it will switch to the 15-minute demo
mode.

• 8 hours with a maximum of 42,000 real I/O. This is only available through special
PowerSCADA Expert Integration Partners (CIP) keys.

Application Configuration Utility
Use the Application Configuration Utility to easily configure many features that would
require more time-consuming effort if performed via INI settings. See Add INI Settings
to AdvOneLine.ini and Citect.ini on page 137 for details about these settings.

Options that are available on every page are:

Project Name: Located at the top of the page, this option allows you to choose the
project. Unless you change it, this project will then remain selected for each window in
the Application Configuration Utility.

Restart Services: This feature is available only when changes are made to the Citect
Data Platform page. Click this link to restart Application Services. If you click inside any
field of this area and then click Display Selected or Display All, you are prompted to
save your changes before the configuration file displays.

Expander Toggle: Click the triangle that is on the vertical bar that separates the left
and right panels of each screen (shown below). This toggles open or closed the menu
in the left-hand column.

Display Selected: Click this link to display the settings that have been entered in
specific area of the Application Configuration Utility (Application Services, Application
Services Host, Applications, Security) that you are viewing.

Display All: Click this link to view the settings that have been entered for the entire
Application Configuration Utility.

Search: Click this link to open a search window. Type the key word or phrase you want
to search on, then click to view the list of screens on which the word or phrase are
found. Click a screen name, and the screen displays. Click the 'x' in the upper right
corner of the search results to close the search window.

Tooltips: To view help for an individual field, point your mouse and hover over the field.

The Application Configuration Utility includes these sections:

Application Services: The Application Services on page 221 section includes screens
for setting up:
• Diagnostics on page 221
• EcoStruxure Web Services Setup on page 222 (EWS)
• Event Notification Service on page 222
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Application Services Host: This includes:

Application Services Host—Citect Data Platform on page 223: four tabs contain
settings to configure server/user name, ignored devices and topics, deadbands, and to
display the license of the server.

Applications: This includes:

Basic Reports on page 225: Use this screen to set up the delivery mode and email
address from which PowerSCADA Expert 8.2 with Advanced Reporting and
Dashboards basic reports will be sent.

One-Line Engine on page 224: Two tabs contain settings to configure one line engine
behaviors.

Diagnostics page: The Diagnostics Page/I/O Device Settings on page 225 provides a
quick view of the I/O device INI settings for all protocols, clusters, servers, ports, and
devices. Use this information as the first step in troubleshooting device/communication
issues in your system.

Security
• One-Time Password (Two-Factor Authentication) on page 226
• Single Sign On on page 235

Application Services
Use this section to configure services that connect with PowerSCADA Studio. There
are three tabs:

Diagnostics on page 221: This is a read-only list of web services hosted by the
Schneider Electric CoreServiceHost, details about them, and whether they are running.
You can also choose the logging level.

EcoStruxure Web Services Setup on page 222: EWS uses web-based http protocol to
transfer data. It enables two-way data transfers, which allows the acknowledgment of
alarms from SBO.

Event Notification Service on page 222: This feature serves alarms and events to the
Event Notification Module application through a web service endpoint named
Alarms/Alarm Proxy.

Diagnostics
Logging Level:

This feature turns on extra diagnostic information that can be useful when diagnosing
problems that occur in application services or its hosted applications (such as
LiveView). Choose the level of logging to be used in all applications. Debug and
Verbose increase the amount of information that is logged during runtime for
applications such as Basic Reports and LiveView.
• Normal: Use when the project is live.
• Debug: includes additional logging statements (in the Windows event log named

PowerLogic). This logging should not affect performance in the system during
runtime.

• Verbose: releases additional diagnostic information, such as large lists, that could
affect system performance.

Service Inventory:

This is a read-only list of web services hosted by the Schneider Electric
CoreServiceHost, details about them, and whether they are running.
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EcoStruxure Web Services Setup
This feature configures the PowerSCADA Expert EcoStruxure Web Services (EWS)
server. (See EcoStruxure WebServices (EWS) on page 186 on page 1 for a description
of this server.). Do not confuse this information with the EWS server that was released
with PowerSCADA Expert 7.40. That implementation is specific to the
PowerSCADA Studio core. It was developed only for real-time tag data acquisition. The
implementation being released with this product also acquires historical data and
alarms.

The fields are:
• Alarm Acknowledgment Wait Period: The amount of time allowed for PowerSCADA

Expert to process an alarm acknowledgment request. Choose a value that allows
the system enough time to allow acknowledgments to be processed, while not so
long as to delay processing.

• Initial Alarm Request Length:The number of days worth of alarm to request
from PowerSCADA Expert.

• Max Request Size: The number of alarms returned with one request. The default
(1000 alarms) should be sufficient to maintain alarm data integrity (ensuring that all
alarms are returned in each call), while also maintaining system performance.

• Alarm Settle Time: The number of seconds "grace period" to allow the
PowerSCADA Studio Alarm Server to finish inserting alarms that are in process at
the time of the poll. If you set this too low, you could miss alarms. If you set it too
high, it may take longer for alarms to come into EWS.

• EWS/Citect User Association: Use this block to manage user names and
passwords. This provides EWS Digest Authentication for the user, permitting them
to view data. However, for the user to be able to acknowledge alarms, the
username/password must match a username/password added to the PowerSCADA
Expert project. When this user acknowledges an alarm through EWS,
PowerSCADA Studio verifies the credentials of the user and acknowledges the
alarm under this user's identity.

To add a user, click Add. At the Add User screen, type an established
PowerSCADA Studio username and password. Click Test Citect Credentials to
verify the name and password. When you enter a valid username and password, a
message displays telling you they are valid.

Avoiding EWS Provider Timeouts
When you attempt to retrieve a large amount of data from the EWS server, you could
see an error telling you that the call has timed out.To correct this, you can temporarily
increase the timeout period, which will allow the target application to receive the data.
To do this, modify the key named ProviderTimeoutInMinutes, found in the EWS virtual
directory, under Web.config.

Default location;

C:\Program Files (x86)\Schneider Electric\PowerSCADA
Expert\v8.2\Applications\EWS\Web.config

After the data that you want is processed, you need to return this key to its original
setting.

Event Notification Service
This feature serves alarms and events to the Event Notification Module (ENM)
application through a web service endpoint named Alarms/Alarm Proxy. The fields are:
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• Maximum Number of Alarms/Events per Call: This field controls the maximum
number of alarms or events that can be requested in one poll. As the requesting
client continues to request data, additional data will be served at the same rate.

• Poll Period: The frequency at which the Event Notification Service polls runtime for
alarms (in seconds).

• Alarm Settle Time: The number of seconds "grace period" to allow the Alarm Server
to finish inserting alarms that are in process at the time of the poll. If you set this too
low, you could miss alarms. If you set it too high, it may take longer for alarms to
come into ENM.

Application Services Host—Citect Data Platform
This section relates to how the Schneider Electric CoreServiceHost connects to
PowerSCADA Studio.

Use this page to link a PowerSCADA Studio user name and password to be used
when the Schneider Electric CoreServiceHost services connect with runtime. Before
you begin:
• Add the username/password to the PowerSCADA Studio project.
• Have the project running in runtime mode.

Follow these steps:

1. In the Citect .ini file, set [ctAPI] Remote = 1
2. Citect I/O Server Address: Choose the server address for the project that is

running.
3. Citect User Name: Type the user name for this user.
4. Citect Password: Type the password for this user.
5. Test Credentials: Click to verify these credentials. If you see an error, verify the

name and password, and that runtime is running, and try again.

When your project is running and the credentials are valid, you see Connection
Successful. The user name and password can be used to connect to
PowerSCADA Studio.

Citect Licensing Details: This is a read-only field that displays the license key
currently in use on the server machine.

NOTE:

To provide extra security, you can use the following method. You will run as a Service.
PowerSCADA Studioand services must both run on Session 0.

1. In the Citect .ini file, remove [ctAPI] Remote or set it to 0.
2. Leave Citect I/O Server Address blank.
3. Leave Citect User Name blank.
4. Leave Citect Password blank.
5. When you Test Credentials, the test will fail. However, you can verify that the

service has started by viewing the Event Log.

Applications
Use this section to set up information for:

Basic Reports on page 225

One-Line Engine on page 224
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One-Line Engine
To access this feature, click Start > All Programs > Schneider Electric > PowerSCADA
Expert 8.2 with Advanced Reporting and Dashboards > Config Tools > Configurator.
There are two tabs in the One-Line Engine module. On either tab, two buttons at the
bottom allow you to:

Restart AOL: Click to manually restart the Advanced One Line engine.

Save: Click to save the settings you have entered.

General: You can edit the following parameters that enable one lines to run properly.
For more complete descriptions of the parameters, see Add INI Settings to
AdvOneLine.ini and Citect.ini on page 137. If you are not setting up a redundant
system, the default settings should be sufficient.
• Update Interval: interval in seconds at which the system tries to solve the system

one-line
• Max Startup Delay: sets the amount of time in seconds the AdvOneLine.exe has to

start up
• Health Timeout: performance parameter; dictates the amount of time in seconds

that must elapse before the one-line engine is considered to be non-functioning
• Log File Length: suggests the log file length in number of lines
• Debug Level: selects the level of logging for AdvOneLine.exe

Redundancy:
• Primary Server IP: used in redundant configurations to specify the IP address of the

primary IOServer. Click Clear to remove the current address, then type the correct
address for the primary server.

• Standby Server IP: used in redundant configurations to specify the IP address of the
standby IO Server. Click Clear to remove the current address, then type the correct
address for the secondary server.

Use the following two buttons to save an encryption key and export it to another
computer as an .aes file.

NOTICE
LOSS OF SYSTEM CONFIDENTIALITY/INTEGRITY/AVAILABILITY

Do not save the .aes encryption file to the local computer. Always export it to a secure site, such as a secure net-
work or to the target computer.

Failure to follow these instructions can result in unauthorized access to, modification of, and unavail-
ability of the system.

This allows you to move an INI file from one computer to another and to have its
contents unencrypted for use by that computer.
• Export Key: After making/verifying changes here or in the AdvOneLine.ini file, click

to save a configuration that you can use on another computer.

A Save As window displays, allowing you to browse to the preferred location. Save
the .aes to a secure location, such as a secure network drive or a flash drive.

• Import Key: After you save the .aes file to the secure drive, ensure that the drive is
accessible to new computer. At the new computer, click this button to access the
.aes file.
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After you access the .aes file at the new computer, copy the INI file to the new
computer. You will be able to access and use it.

Remove the .aes files from the source computer.

Basic Reports
Use this screen to set up the delivery method and email address from which
PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards basic reports will
be sent. These settings specify the SMTP server for emailing basic reports. They are
not used for Event Notification Service.

Define the following:
• Timeout: The number of seconds PowerSCADA Expert will attempt to deliver an

email before no longer attempting
• Delivery Method: Network (default), Pickup Delivery from IIS, or Specified Pickup

Directory. This is an SMTP-specific setting. In most cases, use Network. For more
information on SMTP, see the Micrologic Developer Network website.

• 'From' Address: the address from which reports will be sent.
• Host: The IP or network address of the SMTP server.
• Port: The network port to be used; default for SMTP is 25.
• Use Default Credentials: If required by the SMTP server being used, uncheck the

box and enter the appropriate user name and password. If not required, check the
box and enter the SMTP user name and password used for reporting.

Diagnostics Page/I/O Device Settings
The Diagnostics page provides a quick view of the I/O device INI settings for all
protocols, clusters, servers, ports, and devices. Use this information as the first step in
troubleshooting device/communication issues in your system.

When you click the Diagnostics tab, a short description and help link display on the
right-hand side. The basic steps you follow are below. See the section after the steps
for the logic behind how data displays.

1. To view data, click the Diagnostics link in the left-hand pane of the
Application Configuration Utility. Then click the I/O Device Settings sub-link.

2. Ensure that your project is selected from the Project Name link at the top of the
page.

3. From the Servers column, click a cluster and then a server.

Note the server type on the bottom line of each server. You could have multiple
servers: I/O, alarm, and trend.

4. (I/O servers only): A"Component" column displays. .From this column, choose a
protocol and then the port and device.

5. View the data for that server/device:
— The top row of the Settings are a "breadcrumb," showing the device information

from cluster to device.
— The second row, just above Effective Settings, displays details about the device,

equipment name, number of tags, address, priority, memory mode and startup
mode.

— The remaining sections display information only if there have been changes
made to the default settings.

Data Selection Logic

Depending on the server type that you select, the Settings on the right display with
different information.
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All three server types display settings that include:
• Default Settings: the device default before any changes have been made; displays

above the Effective Settings section.
• Effective Settings: the current settings, including any changes made, combining

changes from the protocol, port, and device. In all cases, port changes will override
protocol changes, and device changes will override port changes.

• Protocol Settings/Port Settings/Device Settings: If there are any overrides to the
default settings, they display here.

I/O servers alone display a separate column: When you select an I/O server, the
Protocol column displays beside it. You will select protocol, port, and device.

Data is retrieved in this manner:
• Protocol settings are retrieved from the Param.dbf file and then from the citect.ini

file.
• These two lists of settings are merged. If there are duplicate settings, the citect.ini

file changes take precedence.
• Finally, device settings are retrieved and merged. If there are duplicate settings, the

device settings take precedence.

For example, for a given device:

The Protocol Setting for CacheRefreshTime = 2000.

The Port Setting = 1000.

There is no additional Device Setting to override the other settings.

The Effective Setting uses the CacheRefreshTime of 1000 from the Port Setting.

Security
Use this section to set up information for:

One-Time Password (Two-Factor Authentication)

Single Sign On

One-Time Password (Two-Factor Authentication)
Two-factor authorization (2FA) requires users to provide two pieces of proof of identity,
such as a password and one other component. This feature allows you to add an
additional layer of protection when user credentials are required (for example, at login
and shutdown).

Traditionally, two-factor authentication requires a password and another piece of
identity, such as an email address or a phone number (with SMS texts). For example,
some websites require the user to provide a password followed by a code that is sent
via text message or email.

PowerSCADA Expert uses a one-time password (OTP) to accomplish two-factor
authentication. The OTP mechanism eliminates the need for email or text messaging.
The OTP/2FA can be deployed on a completely isolated network.

OTP is implemented in PowerSCADA Expert using a small USB-key device called a
YubiKey. The YubiKey device is designed to fit on a key ring or attached to a badge. It
must be plugged into the client machine when the user authenticates. There are
multiple models of YubiKeys available. Included is one model with Near Field
Communication (NFC) capability in the event that USB ports cannot be used.
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To log in, the user enters their user name and password. PowerSCADA Expert then
prompts the user to press a button on the YubiKey device (which has been plugged
into a USB port on the client). The YubiKey will send a string of characters (the OTP) to
PowerSCADA Expert for authentication. If both the password and the OTP authenticate
successfully, then the user is logged in. Note that the OTP is only authenticated
successfully one time. Once successful, the OTP expires. This means that if the string is
captured (snooped from the network, for example) and reuse is attempted, the OTP will
fail.

How Does It Work?

A YubiKey is assigned to a PowerSCADA Expert user (see below). After that, the
YubiKey and the assigned user account share a secret code. The YubiKey uses this
secret code to generate encrypted strings of text (the OTPs) when the user presses the
button on the YubiKey.

Using the secret code, PowerSCADA Expert decrypts the OTP to determine if the OTP
is valid (ensuring that it has not been replayed, it is assigned to the current user, etc.).
After successful authentication, PowerSCADA Expert marks the OTP as expired and
will no longer accept it as valid.

Select the YubiKey

YubiKeys are not shipped with PowerSCADA Expert. Instead, you must buy them from
a third-party vendor, such as Amazon. The following table describes the various
YubiKey models that are compatible with PowerSCADA Expert.

Model Number Description

YubiKey Standard Standard YubiKey, suitable for most deployments

YubiKey Nano
Small form factor, designed to remain inserted in the USB port. Suitable for
use in clients with a dedicated single user account.

YubiKey Edge
Similar to Standard, includes advanced features not useful for
PowerSCADAExpert. Recommend YubiKey Standard instead. May not
support auto configuration.

YubiKey Edge-N
Similar to Nano, includes advanced features not useful for PowerSCADA
Expert. Recommend YubiKey Nano instead. May not support auto
configuration.

YubiKey NEO
Similar to Standard, includes NFC capability. Note: NFC setup requires
Yubico personalization tool (free) and a compatible NFC reader.

YubiCo NEO-N
Similar to Nano, includes NFC capability.

Note: NFC setup requires Yubico personalization tool (free) and a
compatible NFC reader.

For more information about these keys, see http://www. yubico.com.

Deployment Guidelines

Keep in mind these points when you are ordering or using a YubiKey.
• You must set "Allow RPC" to TRUE for all roles that are using YubiKey.
• YubiKey is compatible with all thick clients and web clients.
• YubiKey requires access to a USB port at each client (or must include NFC

capability).
• While technically compliant, NFC has not been validated for use with PowerSCADA

Expert.
• Each PowerSCADA Expert I/O server must have Application Services (Core

Service Host) running.
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• Multiple I/O servers may reside on a physical machine. In this case, only one
instance of Application Services resides on the machine.

• Yubikey must be configured and synchronized across all I/O Servers (this includes
redundant pairs and distributed systems).

• YubiKey is enabled on each client independently.
• It is possible to configure YubiKey on one machine, export the configuration for all

users, and import the configuration to all remaining machines.
• It is not necessary to re-program YubiKey when changing passwords. The YubiKey

constantly changes the OTP (as it is only valid once); so it is not susceptible to
replay attacks.

• YubiKey is authenticated against all physical servers that contain at least one I/O
server. All physical servers must successfully authenticate the OTP for success. If a
single physical server does not authenticate (due to misconfiguration, etc), the user
will not be able to log in.

• If a physical machine (with an I/O Server) is not available, it is not included in the
authentication scheme (this means that, if a primary server is down, the secondary
can still successfully authenticate the OTP).

• If no physical servers (with I/O Servers) are available, the user will not be able to
log in on clients that have YubiKey enabled.

Add the Citect Parameter

You need to add the parameter that allows PowerSCADA Expert to communicate with
the YubiKey. You can do this before after you configure the YubiKey.

From the PowerSCADA Studio, click Setup; from the top toolbar, choose Parameters.
At the Parameters screen, type the following:
• Section Name: Security
• Name: OneTimePasswordRequired
• Value: true

Click Add, then compile the project to add the parameter.

To be able to use YubiKey in PowerSCADA Expert, you must set "Allow RPC" to
TRUE for all roles that include users with assigned YubiKeys. The default for
PowerSCADA Expert 8.2 with Advanced Reporting and Dashboards is False. To
change this to True, access the user account through Roles in the
PowerSCADA Studio, Security tab. Change "Allow RPC" to TRUE.

Autoconfigure the YubiKey

To avoid the lengthier process of programming the key, in most cases you can choose
to autoconfigure it.
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NOTES:
• This procedure requires that you have a USB port on your computer. It will not work

for virtual machines.
• An option for computers without USB ports is to autoconfigure on a local

workstation, then export the settings to a shared drive and import the settings onto
the computer where you need them. (See Import and Export One-Time Password
Settings on page 233, below.)

• You can only have one YubiKey inserted at a time.
• If Autoconfigure will not work, and you must manually program the YubiKey, see

Program the YubiKey on page 230 for instructions.

To autoconfigure, follow these steps:

1. Insert the YubiKey into the USB port of the computer.
2. In the Application Configuration Utility, navigate to the One-Time Password screen

from the Security menu:

3. Click Assign Key.

The grayed-out fields become live.

4. In the User field, type the PowerSCADA Expertusername to which you want to
assign the YubiKey.

5. Click Autoconfigure YubiKey (in the lower half of the screen). You see this
message:
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This message tells you that all settings on the key will be erased, including any key
assignments.

6. To continue, click Yes. The key will receive a new secret key.
7. Click Accept.

Program the YubiKey

If you cannot autoconfigure, use this procedure. After you obtain the YubiKey from a
third-party vendor, (such as Amazon), you need to download the YubiKey
Personalization Tool from the Yubico website (www.yubico.com; click Products >
Services & Software > Personalization Tools > Download Yubikey Configuration
Tools).

1. Download and install the YubiKey Personalization Tool.
2. Launch the tool, and this screen displays:

3. Insert the YubiKey into a USB port of your computer. Click the Yubico OTP Mode
link. At the next screen, click Advanced.

This screen displays:
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If you want to use both of the key's configuration slots, download the YubiKey doc-
umentation, found under the Support tab of the Yubico website.

To configure a single slot, follow these steps:
4. Click the checkbox for the slot you want to configure.
5. Under Yubico OTP Parameters, check Public Identity. Click Generate.
6. Leave the Public Identity Length at its default, 6.
7. Check Private Identity. Click Generate.
8. Click Generate beside Secret Key.
9. Make a note of the secret key that displays, including all characters and spaces.

You will need it when you add the key to the Application Configuration Tool.
10. Click Write Configuration.
11. Click the Settings tab. This screen appears:
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Enter the following information:

1. Under Output Settings, do not enable any of the tab buttons (when enabled, a
button turns blue). Click Enter to enable it.

This causes a return and an "OK" to automatically occur when you press the
Yubikey as part of login in PowerSCADA Expert.

2. Ignore the remaining settings. Press Update Settings at the bottom right of the
screen.

The key is programmed. Follow the next procedure to manually configure it at the
PowerSCADA Expertcomputer:

1. Access the One-Time Password screen.
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2. Click Assign Key.

The fields on the lower half of the screen become live.

3. User: Type the user name that you are adding. This should be a
PowerSCADA Studiouser.

4. Serial Number: Type the number that is printed on the underside of the key.
5. Secret Key: Enter the Secret Key from the YubiKey Personalization Tool (created

above). Enter the secret key exactly as it was created, including all spaces. After
you enter it, the key will be encrypted and will display as bullets (••••) in the future.

6. Press the button on the top of the YubiKey.
7. Yubikey String: This field is populated when you press the button in step 6.
8. Click Accept.
9. Repeat the steps above for any additional keys.

Import and Export One-Time Password Settings

To copy and use one-time password settings on multiple server computers, use this
procedure.

NOTE: When you import password settings into another server, you will overwrite any
password settings that already exist there. You are not simply adding the new
password settings to the existing ones.

1. On the One-time Password screen, create the password settings that you want to
use.

2. Click Export. A file named ExportedOTPConfiguration.xml is generated. You can
rename it if you wish. Save it where you can access it from other servers, or place it
on a jump drive.
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3. From a server to which you want to import the password settings, click Import. You
are prompted for a location.

4. Browse to the location where you placed the .xml file. Click Open and accept the
.xml file.

Disabling YubiKeys

To "disable" a YubiKey, use the Citect Parameter that you created for the YubiKey (see
Add the Citect Parameter on page 228). Scroll to the parameter for the Yubikey.
Change the Value from true to false. Click Replace, then compile the project.

Log in with a Programmed YubiKey and One-Time Password

After the key is programmed and associated with a user in PowerSCADA Expert, and
you have enabled YubiKey usage, the user will use the key to log in to the system. To
log in:

1. Insert the programmed YubiKey into a USB port of the PowerSCADA Expert server.
2. Launch PowerSCADA Expert Runtime, or access runtime via a remote web client.
3. Run the project you want to view.
4. In the upper right corner of the Startup screen, click Login.

You see the PowerSCADA Studio login screen:

5. Enter your name and password. Click OK.

The One-time Password screen appears:

6. Press the button on the YubiKey.

The one-time password is generated. The key and software communicate behind
the scenes to verify the uniqueness of the one-time password and to click OK.
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You can start using runtime screens.

Single Sign On
Use this feature to associate a project user with either a PowerSCADA Expert
(PowerSCADA) or Power Monitoring Expert (PME) username/password. When the
user is logged in to runtime and accesses an external application (such as
Dashboards), the SSO user password is used to authenticate with the external
application.

We recommend, when you use Single Sign On, that you maintain the components on
the same computer or on a secure network. If higher security is needed, use SSL
(https).

NOTICE
LOSS OF SYSTEM CONFIDENTIALITY/INTEGRITY/AVAILABILITY

Ensure that all single sign on information is secured, either on the same computer or a secure network.

Failure to follow these instructions can result in unauthorized access to, modification of, and unavail-
ability of the system.

The fields are:
• Application: From the drop-down list, choose the application (such as Dashboards,

Basic Reporting, Advanced Reporting, Diagrams, LiveView) for which you want
PowerSCADA project user-to-SSO user mapping.

• Timeout: The time after which the system will stop trying to find a match. If no match
is found, single sign on for this user will not take place.

• Guest User: This feature allows the PowerSCADA runtime operator to access any
of the integrated applications in PME or PowerSCADA Expert(basic reports), but
the operator will be acting as a Guest User and will have fewer feature privileges.

Check Guest User, then click Edit to launch the Edit User dialog. In the Edit User
dialog, type the SSO user and password that match the username and password of
the PME or PowerSCADA user to which the Guest User is mapped. For example,
you could create a guest user that only has access to dashboards, and link a PME
user to this account. The PowerSCADA operator could then access dashboards
without logging into the PowerSCADA runtime interface.

• Users: Add/modify the users to have access to the selected application. Use this
area to add users who do need to have a PowerSCADA project user account.
— Citect User: the project username for the user logging in to

the PowerSCADA runtime interface.
— SSO User/SSO Password: The established credentials for this user, either from

PowerSCADA Expert or Power Monitoring Expert.

Single Sign-On (SSO) Calls from a Web Client
PowerSCADA Expert automatically detects calls that are made from a web client. The
calls are sent to an I/O server. For this to work properly, the user needs RPC privileges
for web client access. The default is False. To change this to True, access the user

account throughthe Security link (  ) on the System menu. Change "Allow RPC" to
TRUE.

Note: see the Integration Parameters topic for information regarding further
INI parameters that must be set for Single-Sign On with integrated applications.
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Assign and Control User Privileges
NOTE: You need to give users appropriate levels of access, depending on the work
they will do. For safety reasons, only advanced users should be given access to such
features as controls and resets.

This chapter discusses how to establish user security for the system. This section
includes the following topics:

Default User Access Settings (Privileges) on page 236
Add and Modify User Accounts on page 237
Change Access Rights on page 238

Default User Access Settings (Privileges)
These user access rights (privileges) are created to be parallel to those in Power
Monitoring Expert. The following table describes the access rights. These privileges
are included in PLSSecurity.ci file (in the PLS_Include project). Any changes made to
this file will be overwritten when PLS_Include is updated (every new release). You
need to document every change you make, so that you can update PLSSecurity.ci
when PLS_Include is upgraded.

Access Right Roles / Global Privileges

DescriptionI Access Level Label

Acce
ss
Level
Value

Operato
r1

Operato
r2

Engine
er

Administra
tor

Kern
el

2 4 6 7 8

Circuit breaker,
switch control

PL_Sec_CBControl 1 X X X X

IED configuration PL_Sec_IEDConfig 2 X X X

Circuit breaker
tagging

PL_Sec_Tagging 3 X X X

Alarms
acknowledgment

PL_Sec_AlmAck 4 X X X X X

Alarm deletion PL_Sec_AlmDelete 5 X X X

Alarm configuration PL_Sec_AlmConfig 6 X X X

Add/remove log-in
users

PL_Sec_UserConfig 7 X X

Reset alarms in
device

PL_Sec_AlmReset 8 X X X

Shutdown runtime PL_Sec_Shutdown 9 X X X

View waveforms
PL_Sec_
ViewWaveform

10 X X X X X

NOTE: Privileges 1, 3, and 5 are currently unused. You can use them as you wish. See
Change Access Rights on page 238 for instructions on changing access level
privileges.

A method of limiting access to the design time/configuration environment is to remove
the user rights to certain PowerSCADA Expert files. From the server, use Windows
security to remove user accounts from individual features. For example, access to the
following list of .exe files should be restricted to users who have design
time/configuration privileges.
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• CtDraw32.exe - Graphics builder
• CtExplor.exe - PowerSCADA Studio
• ProfileWizard.exe - I/O Device Manager
• ColorSwap.exe - Color Swap Tool
• ProfileEditor.exe - Profile Editor

All of these files need to have the same level of security, as they are interrelated.

Additionally, to prevent users from accessing and changing the code responsible for
enforcing user security in the runtime environment, you need to lock down the user
rights for the Cicode files (.ci extension) in the PLS_Includes project.

NOTE: Another way to lock users out from changing an existing project is to implement
read-only projects.

Add and Modify User Accounts
You must add at least one user to any project before you can run and view it. Each
user must have a role and a user account. Terms you need to understand are:
• privilege: the level of access that is applied to a system element; a user account

has individual privileges, which the user can then control
• role: contains a defined set of privileges that are assigned to users

NOTE: A security parameter in Citect.ini controls whether users are required to enter a
password when they initiate a breaker control in runtime. The default setting is 1 (true),
meaning that all users will be forced to enter a password to operate a control, even if
they are logged in. The 0 setting (false) means that no user will ever be required to
enter a password when operating a control. See Security Parameters on page 256 for
parameter information.

The Users screen controls all of the user access levels for each project. To assign user
access, follow these steps:

1. From the PowerSCADA Studio Projects page, choose the project for which you
want to assign user access.

2. Click the Security link (  ) on the left hand side of the window.
3. For each user, assign a user role, Windows group name (optional), and global

privileges. If you need additional information, click Help from that screen. For global
privileges, see the table in Default User Access Settings (Privileges) on page 236
for the level of each type of access right.

Note that the record count increases by one with each addition. To view the users
one at a time, scroll through the list.

Use Windows Integrated Users
Instead of using the above method to define users in the project, you can incorporate
PowerSCADA Expert users and security options with the standard Windows security
system. Using the integrated Windows security feature, the Windows user can log on to
PowerSCADA Expert runtime with runtime privileges and areas configured within the
project. For a Windows user to be able to log on to runtime, it must be linked to a
PowerSCADA Expert "role," which is defined in the project with associated privileges.

To link a Windows user to a PowerSCADA Expert role, you should add the "role" that
specifies the Windows group of which the Windows user is a member.

The pre-existing AutoLogin capability is extended to include the client, when the user
is a Windows user, having an associated PowerSCADA Expert role. In order to invoke
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this functionality for a Windows user, you need to set the [Client]AutoLoginMode
parameter in the Citect.ini file.

Instead of using auto-login when the system starts up, users can also log in to
PowerSCADA Expert using any Windows user credential that is a member of the linked
group.

When the name of a PowerSCADA Expert user also has the same name as a Windows
user, the PowerSCADA Expert user takes priority at runtime. However, if a valid
PowerSCADA Expert user login does not succeed for some reason, the Windows user
credentials will not be checked and an alert will be generated to advise that the login
was not effective.

For more information, see Using PowerSCADA Expert with Windows
Security in the citectSCADA.chm help file (Program Files> Schneider Electric >
PowerSCADA Expert > v8.2 > bin).

Change Access Rights
You can edit the default access rights to each of the eight levels, thus changing the
privileges that are available at each level. This is done in the PLSSecurity.ci file (in the
PLS_Include project).

To change access rights:

1. Open PLSSecurity.ci.
2. Locate the AccessRights section.
3. For each right that you want to add (for example, to add access privileges for

working with switches), add a new CASE.
4. Save and close PLSSecurity.ci.

NOTE: PLSSecurity.ci is overwritten any time that the PLS_Include project is
overwritten. This happens with every release of the product, including service packs.
To ensure that you do not lose changes that you enter, you need to:
• Note the changes that you make. Keep a copy of these changes.
• Re-merge the changes every time that the PLS_Include project is overwritten.
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Appendix 1: Default Genie Library
The genie library includes a number of general genies for objects such as motors and
pumps. There are also genies that are specific to PowerSCADA Expert. These genies
use a particular naming convention, which is described in the table below. In the
PowerSCADA Expert library, each genie name begins with “pls,” and is followed by a
description of the type of genie according to this table:

first second third fourth

pls

indicates PowerSCADAExpert library

alarm =alarm base =primitive genies 1 = small

ansi =ANSI style cb = circuit breaker 2 = large

display = equipment details sw = switchgear

gen =generic cmd = control genies

iec = IEC style eq = equipment (devices)

style = navigation

Additionally, the actual genies have abbreviated names. When you highlight a genie
name, the abbreviation displays above the top row of genie icons.

The following tables list and define the individual genies in each of the PowerSCADA
Expert libraries.

PLS_ALARM
This library includes genies that provide functionality to alarm displays.

Genie Abbreviation Description

Field data portion of an alarm row

Row a genie with a collection of fields

Selector for column resizing

Setpoint a setpoint row

PLS_ANSI_BASE_1 / PLS_ANSI_BASE_2
These libraries include a variety of base symbols used to created genies for
ANSI equipment.
1 = small size
2 = large size

Genie Abbreviation Description

sl_battery_gen single-cell battery

sl_battery_multi multiple-cell battery

sl_capacitor capacitor

sl_capacitor_vari variable capacitor

SL_Closed_HV closed circuit breaker position

sl_closed_knife closed knife switch
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Genie Abbreviation Description

sl_closed_lv closed low-voltage circuit breaker

sl_conductive_path_1 conductive path 1

sl_conductive_path_2 conductive path 2

sl_conductive_path_3 conductive path 3

sl_conductor_junction conductor junction

sl_contact_nc_closed contact break, closed

sl_contact_nc_open contact break, open

sl_contact_no_closed contact make, closed

sl_contact_no_open contact make, open

sl_contact_term contact terminal

sl_ct current transformer

sl_in_cb_rack incoming, circuit breaker racked out, plug

SL_In_Rack incoming, circuit breaker racked out, socket

sl_in_sw_head incoming switch head

sl_inductor inductor

sl_inductor_adjust adjustable inductor

sl_inductor_gen general inductor

sl_inductor_magcore magnetic core inductor

sl_inductor_vari variable inductor

sl_open open symbol

sl_open_fuse_sw open isolating fuse-switch

SL_Open_HV open high-voltage circuit breaker

sl_open_knife open knife-type switch

SL_Open_LV open low-voltage circuit breaker

sl_out_cb_rack outgoing, circuit breaker racked out, plug

SL_Out_Rack outgoing, circuit breaker racked out, socket

sl_pb_break push-button, break

sl_pb_make push-button, make

sl_pb_term push-button, terminal

sl_pt potential transformer

sl_relay relay

sl_resistor resistor

sl_resistor_adjust adjustable resistor

sl_resistor_vari variable resistor

sl_separable_con_closed separable connector, closed

sl_separable_con_open separable connector, open

sl_separable_con_plug separable connector plug

sl_separable_con_socket separable connector socket
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PLS_ANSI_CB_1 / PLS_ANSI_CB_2
These libraries include genies for ANSI-type high-voltage and low-voltage drawout
circuit breakers.
1 = small size
2 = large size
Additional definitions:

bus = busway

cb = circuit breaker

hv = high voltage

lv = low voltage

dr = drawout

nd = non-drawout

fd = earth at bottom (feeder)

inc = earth at top (incomer)

nes = no earth

nc = not remote control

c = remote control

Genie Abbreviation Description

hv_cb_bus_dr_c high-voltage drawout circuit breaker, remote control

hv_cb_bus_dr_nc high-voltage drawout circuit breaker, not remote

hv_cb_bus_nd_c high-voltage non-drawout circuit breaker, not remote

hv_cb_bus_nd_nc high-voltage non-drawout circuit breaker, not remote

hv_cb_fd_dr_c high-voltage, drawout circuit breaker, remote control, with earth at bottom

hv_cb_fd_dr_nc
high-voltage, drawout circuit breaker, no remote control, with earth at
bottom

hv_cb_fd_nd_c
high-voltage, non-drawout circuit breaker, remote control, with earth at
bottom

hv_cb_fd_nd_nc
high-voltage, non-drawout circuit breaker, no remote control, with earth at
bottom

hv_cb_inc_dr_c high-voltage, drawout circuit breaker, remote control, with earth at top

hv_cb_inc_dr_nc high-voltage, drawout circuit breaker, no remote control, with earth at top

hv_cb_inc_nd_c high-voltage, non-drawout circuit breaker, remote control, with earth at top

hv_cb_inc_nd_nc
high-voltage, non-drawout circuit breaker, no remote control, with earth at
top

hv_cb_nes_dr_c high-voltage drawout circuit breaker, remote control, no earth

hv_cb_nes_dr_nc high-voltage drawout circuit breaker, no remote control, no earth

hv_cb_nes_nd_c high-voltage non-drawout circuit breaker, remote control, no earth

hv_cb_nes_nd_nc high-voltage non-drawout circuit breaker, no remote control, no earth

lv_cb_bus_dr_c
low-voltage drawout circuit breaker, remote control, busbar-type with earth
at bottom
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Genie Abbreviation Description

lv_cb_bus_dr_nc
low-voltage drawout circuit breaker, no remote control, busbar-type with
earth at bottom

lv_cb_bus_nd_c
low-voltage non-drawout circuit breaker, remote control, busbar-type with
earth at bottom

lv_cb_bus_nd_nc
low-voltage non-drawout circuit breaker, no remote control, busbar-type
with earth at bottom

lv_cb_fd_dr_c
low-voltage drawout circuit breaker, remote control, earth on load side
(bottom of drawing)

lv_cb_fd_dr_nc
low-voltage drawout circuit breaker, no remote control, earth on load side
(bottom of drawing)

lv_cb_fd_nd_c
low-voltage non-drawout circuit breaker, remote control, earth on load side
(bottom of drawing)

lv_cb_fd_nd_nc
low-voltage non-drawout circuit breaker, no remote control, earth on load
side (bottom of drawing)

lv_cb_inc_dr_c
low-voltage drawout circuit breaker, remote control, earth on feeder (top of
drawing)

lv_cb_inc_dr_nc
low-voltage drawout circuit breaker, no remote control, earth on feeder (top
of drawing)

lv_cb_inc_nd_c
low-voltage non-drawout circuit breaker, remote control, earth on feeder
(top of drawing)

lv_cb_inc_nd_nc
low-voltage non-drawout circuit breaker, no remote control, earth on feeder
(top of drawing)

lv_cb_nes_dr_c low voltage drawout circuit breaker, no earth, remote control

lv_cb_nes_dr_nc low voltage drawout circuit breaker, no earth, no remote control

lv_cb_nes_nd_c low voltage non-drawout circuit breaker, no earth, remote control

lb_cb_nes_nd_nc low voltage non-drawout circuit breaker, no earth, no remote control

PLS_ANSI_SW_1 / PLS_ANSI_SW_2
These libraries include ANSI-style switches:
1 = small size
2 = large size

Genie Abbreviation Description

sw_fused switch: feeder, fused

sw_fused_isolated switch: feeder, fused, isolated

sw_general switch: feeder, general

sw_knife switch: knife type

PLS_DISPLAY
This library includes two genies that provide data row items for equipment.

Genie Abbreviation Description

equiplistitem data row for the equipment tag list

EquipValueItem data row for the equipment popup
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PLS_GEN_BASE_1 / PLS_GEN_BASE_2
These libraries include a variety of "parts" related to generators, motors, and
transformers.

Genie Abbreviation Description

chassis_ground chassis ground

Dev_Base device base

es_inc earth switch, incomer

es_out earth switch, feeder

Gen_1 generator, option 1

Gen_2 generator, option 2

gen_AC generator: AC

gen_DC generator: DC

genset engine-generator

ground ground

Motor_1 motor, option 1

Motor_2 motor, option 2

motor_ac motor: AC

motor_dc motor: DC

motor_synch motor: synchronous

SL_Base circuit breaker base symbol

sl_br_in circuit breaker line in, non-drawout

sl_br_out circuit breaker line out, non-drawout

SL_Bustie bus tie

SL_CommLoss comms loss

SL_Discrepancy position discrepancy

sl_harmonic_filter_1 harmonic filter 1

sl_harmonic_filter_2 harmonic filter 2

SL_In incoming bus

SL_Local local, rather than remote control

SL_Out feeder

SL_Tripped tripped

Test_CB_Control health test for the circuit breaker control

transformer_1_in transformer 1: general, on-line

transformer_1_in_y transformer 1: star (wye), on-line

transformer_1_out transformer 1: general, off-line

transformer_1_out_d transformer 1: delta, off-line

transformer_1_out_y transformer 1: star (wye), off-line

transformer_2_in transformer 2: general, on-line
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Genie Abbreviation Description

transformer_2_in_Y transformer 2: star (wye), on-line

transformer_2_out transformer 2: general, off-line

transformer_2_out_D transformer 2: delta, off-line

transformer_2_out_Y
transformer 2: star (wye), off-line (no 2 IN
D? or 1 IN D?)

PLS_GEN_CMD_1 / PLS_GEN_CMD_2
These libraries include genies that control display of popups and values:
1 = small size
2 = large size

Genie Abbreviation Description

CmdDetail provides access to the equipment detail popup

cmddetail_meter provides access to themeter detail popup

Control control in a circuit breaker

value value section of a circuit breaker

value_meter value section of ameter

PLS_GEN_EQ_1 / PLS_GEN_EQ_2
These libraries include the general equipment used to make up generators, motors,
and transformers:
1 = small size
2 = large size

Genie Abbreviation Description

busbar_horz horizontal busbar

busbar_vert vertical busbar

gen_ac generator: AC

gen_dc generator: DC

gen_nd_1 generator 1: no current designation

gen_nd_2 generator 2: no current designation

mot_ac motor: AC

mot_dc motor: DC

mot_nd_1 motor 1: no current designation

mot_nd_2 motor 2: no current designation

mot_syn motor, synchronous

trans_nd_1 transformer 1: no connection designation

trans_nd_2 transformer 2: no connection designation

trans_sd_1 transformer 1: star-delta (wye-delta)

trans_sd_2 transformer 2: star delta (wye-delta)

trans_ss_1 transformer 1: star-star (wye-wye)

trans_ss_2 transformer 2: star-star (wye-wye)
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PLS_IEC_BASE_1 / PLS_IEC_BASE_2
These libraries include a variety of symbols for IEC equipment:
1 = small size
2 = large size

Genie Abbreviation Description

sl_cap_bank_tuned_3 capacitor bank 3: tuned

sl_cap_bank_tuned_4 capacitor bank 4: tuned

sl_capacitor capacitor

sl_capacitor_vari capacitor, variable

sl_closed closed switch

sl_contact_nc contact break

sl_ct contact

sl_fuse_1 fuse, option 1

sl_fuse_2 fuse, option 2

SL_Head head

sl_head_2 head

sl_in_cb_rack incoming, circuit breaker when racked out, plug

SL_In_Rack incoming, circuit breaker when racked out, socket

sl_in_sw_hd_isol incoming, switch head, isolated

sl_in_sw_head incoming, switch head

sl_inductor inductor

sl_inductor_adjust inductor, adjustable

SL_Open open

sl_out_cb_rack feeder, circuit breaker when racked out, plug

SL_Out_Rack feeder, circuit breaker when racked out, socket

sl_resistor resistor

sl_resistor_adjust resistor with adjustable contact

sl_resistor_vari resistor, variable

sl_sw_static_1 static switch 1

sl_sw_static_2 static switch 2

PLS_IEC_CB_1 / PLS_IEC_CB_2
These libraries include high-voltage drawout circuit breakers:

1 = small size
2 = large size

Genie
Abbreviation Description

hv_cb_bus_dr_c high-voltage drawout circuit breaker, remote control

hv_cb_bus_dr_nc high-voltage drawout circuit breaker, no remote control

hv_cb_bus_nd_c high-voltage non-drawout circuit breaker, remote control
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Genie
Abbreviation Description

hv_cb_bus_nd_nc high-voltage non-drawout circuit breaker, no remote control

hv_cb_fd_dr_c
high-voltage, drawout circuit breaker, remote control, earth at
bottom

hv_cb_fd_dr_nc
high-voltage, drawout circuit breaker, no remote control, earth
at bottom

hv_cb_fd_nd_c
high-voltage, non-drawout circuit breaker, remote control, earth
at bottom

hv_cb_fd_nd_nc
high-voltage, non-drawout circuit breaker, no remote control,
earth at bottom

hv_cb_inc_dr_c
high-voltage, drawout circuit breaker, remote control, earth at
top

hv_cb_inc_dr_nc
high-voltage, drawout circuit breaker, no remote control, earth
at top

hv_cb_inc_nd_c
high-voltage, non-drawout circuit breaker, remote control, earth
at top

hv_cb_inc_nd_nc
high-voltage, non-drawout circuit breaker, no remote control,
earth at top

hv_cb_nes_dr_c high-voltage drawout circuit breaker, remote control, no earth

hv_cb_nes_dr_nc
high-voltage drawout circuit breaker, no remote control, no
earth

hv_cb_nes_nd_c
high-voltage non-drawout circuit breaker, remote control, no
earth

hv_cb_nes_nd_nc
high-voltage non-drawout circuit breaker, no remote control, no
earth

PLS_IEC_SW_1 / PLS_IEC_SW_2
These libraries include IEC-style switches:

1 = small size
2 = large size

Genie Abbreviation Description

sw_general general switch

sw_isolated isolated switch

PLS_METER
This library includes meter symbols.

Genie Abbreviation Description

circuit monitor PowerSCADAExpert circuit monitor

egx PowerSCADAExpert EGX

generic_meter generic meter

ion_7650 ION 7650meter

micrologic all Mircologic meters

power_meter PowerSCADAExpert power meter
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Genie Abbreviation Description

quantum PowerSCADAExpert Quantum

sepam all Sepam metersI 

ITEM1
This library includes miscellaneous symbols.

Genie Abbreviation Description

Item1 value type and units block for a circuit breaker

Item2 value type and units block for a circuit breaker

tab1 menu tab

Tab2 menu tab
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Appendix 2: Citect INI Parameters
There are a number of Citect INI parameters that you may use to configure driver
parameters. These settings may be configured at the protocol level, cluster level, port
level, or device level. More specific settings will override a general one. The order of
precedence is:

Protocol Name > Cluster Name > Port Name > I/O Device Name

The level at which you want the INI settings to be in effect determines the name you
define. For example:

To set the default timeout for all devices using the Micrologic protocol, use:
[MICROLOGIC]
Timeout = 2000
To override this default for cluster ‘Cluster_1,’ use:
[MICROLOGIC.Cluster_1]
Timeout = 1000
To override the default value for port ‘Port_1’ on cluster ‘Cluster_1,’ use:
[MICROLOGIC.Cluster_1.Port_1]
Timeout = 3000
To override the default value for I/O device ‘CircuitBreaker_1’ on port ‘Port_1’ on
cluster ‘Cluster_1,’ use:
[MICROLOGIC.Cluster_1.Port_1.CircuitBreaker_1]
Timeout = 4000
Most settings can be configured to be specific to a particular I/O device. Exceptions are
noted in the description for the individual parameter.

Parameters Database
All INI parameters described in the sections below can be set in the Parameters
database. Using special syntax, you can access the parameters from the
PowerSCADA Studio (click Setup, then choose Parameters from the top toolbar).
• The section name generally corresponds to the INI section name, although it

includes the protocol name, cluster name, and primary device name only.
• The name is the INI value name.

If the parameter is set in the Parameters database, it becomes a new default for either
protocol, cluster, or a concrete device (depending on the section name hierarchy).

Examples:

Section Name: [MICROLOGIC.Cluster_1.Breaker_1]
Name: Timeout
Value: 2000
This defines a new default timeout value for a redundant pair of MicroLogic devices
(primary device is named Breaker_1 in Cluster_1).

Section Name: [PWRMODBUS.Cluster1]
Name: UseWriteMultiRegistersOnly
Value: 0

This sets UseWriteMultiRegistersOnly to 0 for all PWRMODBUS devices in Cluster 1.

The INI file is read after the parameter database is processed; thus the override options
are set in the Parameters database.

In this section, you will find parameters organized into these categories:
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General PowerSCADA Expert Parameters on page 249
Performance Tuning Parameters on page 256
Waveform Parameters on page 263
Sepam Event Reading Parameters on page 265
MicroLogic Modules Configuration Parameters on page 266
Data Replication Parameters on page 267

General PowerSCADA Expert Parameters
The following parameters are common to all PowerSCADA Expert devices.

watchtime
Controls how often the product will interrogate the driver to determine whether it is still
online. This parameter can only be configured for an entire driver, and hence will have
the driver dll name as its section name. Where another setting may be [PM870], to set
this setting it must be [PLOGIC], as PLOGIC is the name of the dll. This is the only
parameter whose section name is defined in this fashion.

Parameter type: seconds
Default Value: 2
Example: [SEPAM] watchtime = 5

kernelStatisticUpdateRate
Controls how frequently the statistics displayed in the driver kernel window are
updated. This time period can be increased in order to decrease CPU load. This
parameter can only be configured for the entire protocol (as with the watchtime
parameter); it will have the driver dll name as its section name.

Parameter type: milliseconds
Default value: 5000

Examples:
[SEPAM40]
kernelStatisticUpdateRate = 20000

[SEPAM80]
kernelStatisticUpdateRate = 10000

UseWriteMultiRegistersOnly
Controls PWRMODBUS driver behaviour when a single register is to be written. This
parameter is set to 1 by default, enabling all writes to be made using "write multiple
registers" MODBUS function. Setting this parameter to 0 allows driver to perform write
using "write single register" function if (and only if) one MODBUS register is about to be
written in current operation.

Parameter type: integer
Default value: 1

Examples:

[PWRMODBUS]
UseWriteMultiRegistersOnly = 1

[PWRMODBUS.MYCLUSTER.PORT_1.BCM1]
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UseWriteMultiRegistersOnly = 0

timeout
Controls how long the driver waits for a response from a device before setting that
device as offline. This value should be greater than the device/gateway timeout period.
A timed out request will not be retried. The reason for this is that TCP is a guaranteed
transport mechanism, and the lack of a response indicates that the device is offline or
communication has been lost with that device. A device connected via a gateway
should use the gateway's retry mechanism.

Parameter type: milliseconds
Default value: 5000

Examples:

[SEPAM40]
Timeout = 2000

[SEPAM40.MYCLUSTER.PORT_1.SLOW_SEPAM]
Timeout = 15000

retry
Defines the number of retry attempts for specific MODBUS requests. Retries may occur
either when the request is timed out or certain MODBUS exception reply messages are
received. The exact behaviour is controlled by the RetryTimeout and RetryException
parameters.

Parameter type: number of attempts
Default value: 3

Examples:

[SEPAM40]
retry = 1

[SEPAM40.MYCLUSTER.PORT_1.SEPAM_DEVICE]
retry = 5

RetryTimeout
When enabled (by default), the driver will re-try a timed-out MODBUS request.

Parameter type: long (boolean)
Default value: 1

Examples:

[SEPAM40]
RetryTimeout = 1

[SEPAM40.MYCLUSTER.PORT_2.SEPAM_DEVICE]
RetryTimeout = 0

RetryException
When enabled (disabled by default), the driver will re-try a MODBUS request that has
received MODBUS Exception messages. The number of retries is defined by the Retry
parameter.
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When Retry Exception is enabled, retry occurs when any of the following MODBUS
exception messages is received:

SLAVE_DEVICE_FAILURE_EXCEPTION = 0x5
GATEWAY_PATH_UNAVAILABLE_EXCEPTION = 0xA
GATEWAY_TARGET_DEVICE_FAILED_TO_RESPOND_EXCEPTION = 0xB
SLAVE_DEVICE_BUSY_EXCEPTION = 0x6
MEMORY_PARITY_ERROR_EXCEPTION = 0x8
NEGATIVE_ACKNOWLEDGE_EXCPETION = 0x7

Parameter type: long (boolean)
Default value: 0

Examples:

[SEPAM40]
RetryTimeout = 1

[SEPAM40.MYCLUSTER.PORT_2.SEPAM_DEVICE]
RetryTimeout = 0

standbyRefreshRate
Controls how often a standby IO server attempts to poll a device to update its cache.
This time period determines the maximum age that values may be when switching from
a primary IO server to a standby. Decreasing this value degrades communications to
the device.

Parameter type: seconds
Default value: 60

Examples:

[SEPAM40]
standbyRefreshRate = 30

[SEPAM40.MYCLUSTER.PORT_1.SLOW_SEPAM]
standbyRefreshRate = 120

standbyCheckTime
Controls how often the driver will enquire of PowerSCADA Expert as to whether it is in
standby or primary mode. This value can be increased to reduce CPU load.

Parameter type: milliseconds
Default value: 500

Examples:

[SEPAM40]
standbyCheckTime = 500

[SEPAM40.MYCLUSTER.PORT_1.SLOW_SEPAM]
standbyCheckTime = 1000

statusUnitCheckTime
This parameter defines how frequently the driver will try to re-establish the connection
with a device that has gone offline on a port that is not disconnected. It sets the
maximum rate at which the driver enquires of the device, to determine if it is still
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operational. If the "watchtime" parameter is set to a longer time, that value will be used
instead.

NOTE: If a network gateway has multiple devices connected to it, and one device is
disconnected, the driver takes it offline and does not try to reconnect it according to this
parameter's schedule. If the port is taken offline and then is reconnected, the driver will
reconnect the devices immediately.

Parameter type: seconds
Default value: 5 (20 for MicroLogic)

Example:

[SEPAM40]
statusUnitCheckTime = 5

[SEPAM40.MYCLUSTER.PORT_1.SLOW_SEPAM]
standbyCheckTime = 10

initUnitCheckTime
Controls how long the driver waits before attempting to bring a device online after it
has gone offline. This value can be decreased to bring offline devices back into service
in a shorter period of time. In a multi-drop scenario, this time should be relatively long,
to prevent init unit requests from stalling communications to the rest of the devices on
that port.

Parameter type: seconds
Default value: 120

Examples:

[SEPAM40]
initUnitCheckTime = 5

[SEPAM40.MYCLUSTER.PORT_1]
initUnitCheckTime = 120

initCacheTimeout
Controls how long the driver will spend attempting to populate the cache before
bringing a device online. When a tag has been incorrectly configured, the device will
come online after this period of time.

Parameter type: seconds
Default value: 60

Examples:
[SEPAM40]
initCacheTimeout = 60

[SEPAM40.MYCLUSTER.PORT_1.SLOW_SEPAM]
initCacheTimeout = 30

cacheRefreshTime
Controls the maximum rate at which the driver will attempt to repopulate its cache. If the
driver cannot refresh its cache within the time period specified, it will collect data as fast
as the network allows.
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Parameter type: milliseconds
Default value: 500

Examples:
[SEPAM40]
cacheRefreshTime = 1000

[SEPAM40.MYCLUSTER.PORT_1.FAST_SEPAM]
cacheRefreshTime = 200

[SEPAM40.MYCLUSTER.PORT_1.UNIMPORTANT_DEVICE]
cacheRefreshTime = 5000

TimeSync
Enables/disables time synchronization for the PM5000S driver. On startup and on a
15-minute schedule, the driver reads each device clock. If a device clock is not within
the specified 10-second drift, the driver sets the time on that device to the current
system time.

Parameter type: boolean
Default value: 0 (PM5000S) or 1 (PM5000S1)

NOTE: This is a driver-level parameter, not a protocol-level parameter. All entries must
be under the PM5000S section of the .ini file. By default, the PM5000S1 protocol
enables time sync. For the PM5000S, it is disabled by default because most devices
will have battery backup and GPS time sync availability.

Example:
[PM5000S] TimeSync = 1

StatusRegister
Defines a holding register that the driver reads to determine whether a device is
responding to communication requests. The result of this read is not important,
however it must be a valid register address within the device.

Parameter type: register address
Default value: 1100 (2 for Sepam) (PM1200 requires that this value be set to 3911)

Examples:

[PWRMODBUS]
statusRegister = 1000

[PWRMODBUS.MYCLUSTER.PORT_DEVICE_PM1200]
statusRegister = 3911

StatusRegistersCount
Defines the number of registers that the driver reads to determine whether a device is
responding to communication requests. The result of this read is not important,
however it must be a valid register address within the device.

Parameter type: number of registers
Default value: 1 (PM1200 requires that this value be set to 2)

Examples:

[PWRMODBUS]
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statusRegistersCount = 2

[PWRMODBUS.MYCLUSTER.PORT_DEVICE_PM1200]
statusRegistersCount = 2

StatusRegisterType
Used together with StatusRegister; defines the type of the status register. Can only be
configured for the PWRMODBUS driver. This parameter can have one of the following
values:

0 - HOLDING register (default)
1 - INPUT register
2 - COIL register
3 - DIGITAL input (input coil) register

Any other value equals the default.

Parameter type: register type
Default value: 0

Example:

[PWRMODBUS]

statusRegister = 1000

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]

statusRegister = 16000

statusRegisterType = 2

ModbusBase
Defines the base address for a device. Some MODBUS device registers are defined
using a base address of 1. in this case, reading register 100 would actually require
reading register 99. In other devices (such as the Sepam) the base address is 0. This
parameter allows the base address to be configured according to the device.

Parameter type: integer
Default value: 0 for Sepam; 1 for all other drivers

Examples:

[PWRMODBUS]
ModbusBase = 1

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]
ModbusBase = 0

RegMode
Specifies the order of bytes in a device register. It can only bet set for PWRMODBUS
driver, and is supposed to be unit-specific. Value values are:

RegMode Order of bytes

Big endian (default) 0 1 0

Little endian 1 0 1

© 1990–2017 Schneider Electric All Rights Reserved 254



Any other value reverts to big endian.

Parameter type: integer
Default value: 0

Examples:

[PWRMODBUS]
RrMode = 0 # Default

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]
RegMode = 1 # This device has little endian registers

timeZone
Time zone names are taken directly from the Windows registry database (case-
insensitive), and will otherwise default to using the I/O server's local time zone. The
Windows time zone database is located in the Windows registry in:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Time
Zones\. The examples of time zone names are:
AUS Central Standard Time
China Standard Time
Pacific Standard Time (Mexico)

Use the general section [POWERLOGICCORE] to specify the time zone for all devices,
e.g.
[POWERLOGICCORE]
Timezone = Mountain Standard Time

This sets the default time zone for all devices (Sepam, PLogic, Micrologic,
PWRMODBUS). Otherwise the time zone can be specified for each device with
precedence taken as described in the start of this section.

Examples:

[PLOGIC870.Cluster1.Singapore_Port]
Timezone = Singapore Standard Time

[PLOGIC870.Aus_Cluster]
Timezone = Aus Central Standard Time

Not having a time zone specification means that the device is in the same time zone as
the machine where the I/O Server is running. No time conversion will be done.

Alarm Parameters
The following parameters are used for alarms.

UsePLSFilter
Controls whether alarm/event filtering is done by the PLSCADA filter form or the
PowerSCADA Studio filter form. Both forms cause the same information to display on
the page, but each is presented in a different format.

Parameter type: integer

Default value: 1 (PLSCADA filter form)

Example: [ALARM] UsePLSFilter = 1
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Security Parameters
Use the following security parameters to add system security

EnterPasswordForControl
This parameter controls whether users must enter a password when they control a
breaker. Regardless of whether the user is logged in, a setting of 1 (true) will require a
password when the user initiates breaker control. When set to 0 (false), the password
check is removed. In this case, no user will be required to enter a password to control a
breaker.

Parameter type: integer

Default: 1 (true)

Performance Tuning Parameters
Several parameters are provided to allow tuning of the performance. These
parameters fall into three broad categories; bandwidth allocation, packet blocking
optimisation, and tag scan rates.

Bandwidth Allocation Parameters
Bandwidth can be allocated for the different types of data as desired. The parameters
to perform this are as follows:

[Parameter] [Default Value] [Parameter Type]

EventBandwidth 25 integer

WaveformsBandwidth 12 integer

CommandsBandwidth 13 integer

RealTimeBandwidth 50 integer

The percentage bandwidth allocated to each queue will be the ratio of an individual
queue's value when compared to the total sum of defined bandwidths. The default
values have a sum of 100 for ease of reference. Any unused bandwidth will be shared
amongst the other categories.

Bandwidth can be configured at the port level, but not the device level.

Example:
[SEPAM40]
EventsBandwidth 30
WaveformsBandwidth 5
CommandsBandwidth 15
RealTimeBandwidth 50

[SEPAM40.MYCLUSTER.PORT_1]
EventsBandwidth 50
WaveformsBandwidth 30
CommandsBandwidth 10
RealTimeBandwidth 10
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BandwidthAllocation
This parameter allows the ratio of bandwidth assigned to each device sharing a port to
be configured. This parameter can only be configured at the device level.

Parameter type: integer
Default value: <equal split>

Example:
[SEPAM40.MYCLUSTER.PORT_1.DEVICE_A]
BandwidthAllocation 70

[SEPAM40.MYCLUSTER.PORT_1.DEVICE_B]
BandwidthAllocation 30

Packet Blocking Optimisation Parameters
For all devices except the Sepam, parameters can be configured to optimise the
MODBUS packets that are created for collection of data from the device. Sepam
devices have pre-configured blocks that are already optimised.

The parameters that control the blocking are as follows:

enableScatteredReads
This causes the driver to use the ‘scattered read’ extension that can help improve
blocking. This option should be enabled for devices that support this extension.

Parameter type: Boolean flag
Default value: 0 for generic Power MODBUS driver, 1 for PowerLogic driver

Example:
[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]
enableScatteredReads 1

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_B]
enableScatteredReads 0

percentBlockFill
This parameter defines the maximum percentage of configured registers contained in a
block before the drivers creates fixed blocks instead of scattered blocks. The following
figure illustrates now a block of N registers can be constructed:
• If M<N registers are configured, the block builder can either create a scattered

block or a multi-register block.
• If M/N*100% is less than PercentBlockFill, the block builder creates a scattered

registers block.
• If the percentage of configured registers ≥ PercentBlockFill, the block builder

creates a multi-register block.
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Parameter type: percentage
Default value: 50

Example:
[PM870.MYCLUSTER.PORT_1.PM_DEVICE]
percentBlockFill 50

[CM4000.MYCLUSTER.PORT_1.CM_DEVICE]
percentBlockFill 80

maxBlockSize
This parameter defines the maximum number of registers that can be read in a single
request. By default, this is 124, but some devices can read more than this.

Parameter type: integer
Default value: 124

Example:

[PWRMODBUS.MYCLUSTER.PORT_1.DEVICE_A]
maxBlockSize 1024

minBlockSize
This parameter defines the minimum number of registers to read as a fixed block
before the block builder will instead add those registers to a scattered block. If latency
is low, and scattered reads are expensive, this value should be lower. If latency is high,
or scattered reads are inexpensive, it is better to set this value higher. Only applicable
when scattered reads are enabled.

Parameter type: integer
Default value: 20

Example:
[PM870.MYCLUSTER.PORT_1.LOW_LATENCY_DEVICE]
minBlockSize 10
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[CM4000.MYCLUSTER.PORT_1.HIGH_LATENCY_DEVICE]
minBlockSize 100

Tag Scan Rate Parameters
Each tag can be configured at a priority level from 1-3 where 1 is the highest.
Parameters exist to adjust the relative scan rates of the high and low priority tags in
comparison to the nominal tag scan rate.

HighScanRate
Parameter type: percent relative to nominal
Default value: 50

LowScanRate
Parameter type: percent relative to nominal
Default value: 200

Using the default parameters, the high priority tags will be refreshed twice as fast as
the normal priority tags, and the low priority tags will be refreshed at half the rate of the
normal priority tags. These parameters can be configured at the port level and higher.

Using the default settings and a nominal tag refresh rate of 1 second:

Low Priority Tag Refresh: 2000 ms
Normal Priority Tag Refresh: 1000 ms
High Priority Tag Refresh: 500 ms

Example:
[PM870.MYCLUSTER.PORT_1]]
HighScanRate 25
LowScanRate 500T

Advanced Tag Block Capabilities (Invalid Memory Access Blocks defined)
Some devices may restrict access to certain memory registers. Such registers may be
available for read only, write only or may not be available at all, resulting in a MODBUS
exception when the registers are addressed.

Definition: Blocks of registers that cannot be read or written to are referred as “invalid
memory access blocks.”

These devices create a challenge for the PWRMODBUS driver. If the device has
invalid blocks that do not support scattered reads (or they are disabled for this device),
the driver may try to read registers in blocks that intersect with the registers that cannot
be read. This can result in the whole block being invalidated and, in certain cases, may
also result in device being taken offline. Figure 1 (below) illustrates an invalid block in
the middle of an address space.
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Figure 1 shows how the "invalid memory access block" affects MODBUS register
blocking. In this situation, if the driver does not know that the block of 3 inaccessible
registers exists, it will try to block all registers from 1 to N (depending on data that was
requested by the real-time data collector). This block, however, will never be read
successfully, as the device will respond with an exception to all attempts to read invalid
registers.

If the configuration includes information about invalid memory access blocks, the driver
will create two blocks instead of one, as shown in Figure 2:

In Figure 2, invalid registers were taken into account when the block was constructed.
When configuring device that has invalid memory areas, it is especially important to
define all blocks that may interfere with any of the tags.

Invalid Block Tag Definition Syntax
Invalid access memory areas are defined as variable tags, using the following format
for the address:

T:IB;{m|i|c|s}:<start_register>:u<count>;E:1;L:P:0

where

• m, i, c and s define the type of MODBUS register

• <start_register> is the first register address of the invalid access block

• <count> defines the number of registers in the invalid access block

Example:

T:IB;m:300:u10;E:1;L:P:0
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This defines an invalid access block of ten holding registers starting from register 300.

Configuration Notes
When one or more invalid access blocks is defined according to the syntax above, tags
configured to read any of invalid registers will be affected by it. If any of the tag
registers fall into an invalid memory access block, this tag will not be readable; any
attempt to read its value will result in #COM, as shown on Figure 3:

However, such tags do not affect other tags, because the PWRMODBUS driver
implements algorithms that prevent tags from being invalidated by invalid memory
block logic.

Tags that try to use invalid registers are detected on startup and can be found by
analysing the log file. This is an example trace:

[DEBUG] [REAL][GeneralDriver::BaseDatapointBuilder::BuildDataPoints
()] Adding datapoint. Tag - BCM1\H_QIVR34\SwlStr Address -
T:SS;m:283:2;E:1;L:P:26 Datapoint: class Datapoints::Status_SS

[DEBUG] [REAL][RealTimeData::DeviceCache::Subscribe()] Init
Registers: Polled Registers: Address:283 Type:3

[ERROR] [MISC] [RealTimeData::BlockBuilder::AddDataPoint()] Cannot
add datapoint, one or more invalid memory addresses fall into non-
splittable block

[ERROR] [MISC]
[GeneralDriver::BaseDatapointBuilder::BuildDataPoints()] Could not
init datapoint. Tag BCM1\H_QIVR34\SwlStr Address
T:SS;m:283:2;E:1;L:P:26. Analyze other messages, this tag address
may contain invalid registers

Such output is expected when a holding register with address 283 is declared invalid.
This trace helps figure out any configuration issues.

Write-only Memory
If a certain register range is accessible for write only, no additional configuration may
be needed. However, to prevent the driver block optimizer from including these
registers in a poll, they also must be configured by adding “invalid block” tags as
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described in the Invalid Block Tag Definition Syntax, described above. Declaring these
registers invalid will not prevent drivers from trying to write to them. Figure 4 illustrates
a write-only memory configuration:

Write-only registers should not be confused with write-only datapoints that internally
read a register before attempting to write. Declaring the register they read invalid will
result in a datapoint not working; such mistake should be avoided. Figure 4 shows
“WriteOnlyDP” as an example; this tag cannot be read (it will result in #COM), but
internally it needs to get the register value before writing into it. If this register was
declared invalid, tag writes would also not succeed.

Figure 5 illustrates a write-only datapoint:

Tag Blocking Notes
The drivers support an advanced blocking mechanism for tags. That is, real-time tags
are no longer blocked together with write-only tags.
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Tags found invalid, due to intersection with invalid memory areas, are not blocked with
“good” real-time tags and will not therefore interfere with them.

Write-only Tags
Beginning with driver version 2.0.1.1, the write-only tags feature is fully supported.

There are no special logic codes or address formats for write-only tags. If a tag
references memory that was declared invalid (see Invalid block tag definition syntax,
above), and its datapoint has writing capabilities, the tag becomes write only. No
preliminary checks are performed to verify that the memory can be written to, and no
additional configuration is needed. It is assumed that, if the tag is configured to write
into memory that has been declared “invalid,” the memory can actually be written to.

It is important to understand that scaled write tags (code 110) will become write-only
tags, if that scale register can be read. Tag Device\TagN on Figure 6 explains this
case: the datapoint needs to read the scale value from the scale register in order to
write scaled value to write-only register. However, as long as the actual register
belongs to the memory that can only be written to (and it is configured using T:IB tag
syntax as explained in Invalid Block Tag Definition Syntax above), this tag cannot be
read.

The fact that the tag mentioned before cannot be read will not affect other tags reads
(see Tag Blocking Notes, above).

Note: The write-through feature of the device cache is disabled for write-only tags.

Waveform Parameters
The following parameters configure the waveform downloading behaviour. These
parameters are only applicable for Sepam devices and PowerLogic devices that
support waveforms.

[Parameter] [Default Value] [Parameter Type]

WaveformsDisable 0 Boolean value
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WaveformMatchMargin 10 seconds

WaveformCheckTime 30 seconds (PM/CM)

WaveformZone 1 integer (Sepam)

WaveformsDisable
This parameter enables or disables waveform downloading for a particular device.

Parameter type: Boolean value
Default value: 0

Example:
[SEPAM40.MYCLUSTER.PORT_1.DEVICE_A]
WaveformsDisable 1 //Disable waveform downloading

NOTE: This INI setting is a global setting that sets the default at startup. You can set this
for any set of devices (such as clusters, individual devices)

There is also a tag that will change an individual device's setting at runtime (it will reset
to the default when you restart the project). This tag is
LLNO\WaveformCollectionEnabled. 1 = True, 0 = False.

WaveformMatchMargin
Alarms are matched to waveforms by the timestamp of each. This parameter is the
maximum difference between alarm timestamp and waveform timestamp for the
product to consider it a match.

Parameter type: seconds
Default value: 10

Example:
[SEPAM40]
WaveformMatchMargin 2

WaveformCheckTime (PM, CM, and Sepam)
This parameter defines the time the driver will wait between checking for new
waveforms.

Parameter type: seconds
Default value: 30

Example:
[SEPAM40.MYCLUSTER.PORT_1.DEVICE_A]
WaveformCheckTime 60 (checks every 60 seconds)

WaveformZone (Sepam)
This parameter defines the Sepam waveform zone that the Sepam driver will use to
collect waveforms from the device. This allows two masters to extract waveforms from
the same device. Valid values are 1 or 2.

Parameter type: integer
Default value: 1

Example:
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[SEPAM40.MYCLUSTER.PORT_1.DEVICE_A]
WaveformZone 2

Sepam Event Reading Parameters
These two Sepam parameters are described below.

EventTable
This parameter defines the Sepam event table that the Sepam driver uses to collect
alarms from a device. This allows two masters to extract alarms from the same device.
Valid values are 1 or 2.

Parameter type: integer
Default value: 1

Example:
[SEPAM40.MYCLUSTER.PORTO_1.DEVICE_A]
EventTable 2

EventIdle
This parameter defines the time that the driver will wait before requesting the next
event from a Sepam device. It may be possible to reduce this value to increase the rate
at which alarms can be retrieved from the device.

Parameter type: milliseconds
Default value: 500

Example:
[SEPAM40.MYCLUSTER.PORTO_1.DEVICE_A]
EventIdle 200

Sepam Device Driver INI Configuration Settings
Sepam devices support two event buffers, which enables two concurrent masters to
read events. For all Sepam devices, the first buffer starts at register 0x40, and the
second starts at register 0x70. By default, the first buffer is used; however, in certain
configurations, there may be a need to tell the driver to use the second buffer. This can
be done by adding the following section to citect.ini (see Use Cicode to Customize a
Project on page 159):

[Sepam]

[Parameter] [Default Value] [Parameter Type]
EventTable 1 //Valid values are 1 and 2.

Value 2 tells the driver to use event buffer starting at 0x70; any other value falls back to
0x40.

NOTE: If the installation uses any other software—such as SMS, CET, or ION—the
setting in that application should be buffer 2.

[Parameter] [Default Value] [Parameter Type]
EventIdle 500 Integer

‘EventIdle’ is the time the driver will wait before requesting the next event from the
Sepam device. It may be possible to reduce this value to increase the rate at which
alarms can be retrieved from the device.
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Example.
[SEPAM40.MYCLUSTER.PORT_1.DEVICE_A]
EventIdle 200

See Edit Tag Addresses on page 52 for information about PowerLogic device driver
addresses.

MicroLogic Modules Configuration Parameters
A MicroLogic unit consists of three or four modules, each acting as a separate
MODBUS device; however the I/O server views MicroLogic as one I/O device. The
communication control module (CCM) is optional for MicroLogic; its presence may be
detected by the driver or specified in the INI file.

IFE/IFM
This parameter specifies whether the Micrologic device is connected through an
IFE/IFM, or through the CCM (cradle comms module) or a Modbus Gateway.

0 - connection is through a Modbus Gateway

1 - connection is through an IFE/IFM

MicrologicType
This parameter, which indicates the Micrologic Type, enables/disables functionality
that can increase system performance.

1 - Type A: Only the Circuit Breaker Manager (BCM) alarm file is read.

2 - Type E: Only the Circuit Breaker Manager (BCM) file is read.

3 - Type P: The Circuit Breaker Manager (BCM) and Protection Manager (PM) alarm
files are read.

4 - Type H: The Circuit Breaker Manager (BCM), Protection manager (PM), and
Metering Manager (MM) alarm files are read. Waveform files are also read.

CCM
The CCM parameter specifies whether a CCM is present on the device or if the driver
should try to detect its presence ("auto mode"). Valid values are:

CCM not present - 0
CCM present - 1
Auto mode - 2 (default)

Any other value reverts to auto mode.

Parameter type: integer
Default value: 2

Example:
[Micrologic.MYCLUSTER.PORT_1.DEVICE_A]
CCM=1

Module-Specific Packet Blocking Optimisation Settings
Due to different firmware versions, MicroLogic modules may require different blocking
settings. This is especially true when MicroLogic contains a BCM that supports
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MODBUS "read multiple registers" requests for up to 124 registers, and an MM or a
PM module that supports 21 register reads at max. The MicroLogic driver allows
blocking optimisation parameters to be overridden for each of the device's modules, as
in the following example:
[Micrologic.MYCLUSTER.PORT_1.DEVICE_A]
maxBlockSize = 124

[Micrologic.MYCLUSTER.PORT_1.DEVICE_A.BCM]
maxBlockSize = 21

The parameter set for the device applies to all of its modules unless overridden in a
module-specific section (e.g., [Micrologic.MYCLUSTER.PORT_1.DEVICE_A.BCM])

These parameters can be overridden:
• enableScatteredReads
• minBlockSize
• maxBlockSize
• PercentBlockFill

This applies to the BCM, CCM, MM, and PM modules.

MicrologicV INI Settings
The MicrologicV device driver includes these additional INI settings:
• Level3: This is the level 3 device password (four digits), used by the driver when

executing commands.
• Level4: This is the level 4 device password (four digits), used by the driver when

executing commands.

If you do not supply this parameter, the driver uses the default device passwords.

Data Replication Parameters
These parameters are used to configure the data directory paths of your servers. These
settings are server wide, and must be added to the ‘WaveformDB’ area of the ini file.

Database root folder path
Waveform databases for all units will locate on the filesystem under the same common
folder. The path to the root folder will be specified in the citect.ini file:

[WaveformDB]
LocalRoot = c:\path\to\the\database\root

This path must be specified as local path.

By default, the PowerSCADA Expert[DATA] directory is be used as database root
folder.

Database root UNC path
For waveform files to be accessible by the remote clients, the database root folder must
be available as network shared folder. The UNC name of this folder must be specified
in the INI file

[WaveformDB]
UNCPath = \\computerName\shareToTheLocalRootAbove
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If the UNC path to the database root is not specified, all waveform file names returned
by the library will be local file names for the I/O server, making viewing the waveforms
on the remote clients impossible.

Replication destination configuration
In redundant scenario, the replication target folder must be specified for replication to
work

[WaveformDB]
ReplicationDestinationRoot=\\OtherMachine\share\path

The destination path is the name of the network share on the redundant machine
where its waveform database root is located. It must also allow write access.

No default value for it is assumed.

If not set or share is not accessible, no replication will be preformed.

Graphics Library Parameters

Maximum number of entries that can be held in Event Log
The Alarm Summary length parameter in Citect.ini defines the maximum number of
entries that can be held in the Event Log (default = 5000 entries). You can view all
events in the Event Log and alarms in the alarm logs (Alarm Log, Unacknowledged
Alarms, Disabled Alarms).

Each event requires 256 bytes of memory, plus the length of the comment. 32,000
entries will require at least 8 MB of memory. If you have many events, you should
ensure that there is enough memory to store them in RAM.

After the parameter number is reached, older events are FIFO’d out to storage in
[Installed Project Directory]\Schneider Electric\PowerSCADA Expert 8.2 with Advanced
Reporting and Dashboards\Logs

Parameters for Alarm and Event States

[Alarm]
UseConfigLimits = 1
CacheLength = 2500

!Sound1 = <wave file name>
!Sound1Interval = <repeating interval in milliseconds>
!Sound2 = <wave file name>
!Sound2Interval = <repeating interval in milliseconds>
!Sound3 = <wave file name>
!Sound3Interval = <repeating interval in milliseconds>

[AlarmFormat]
EventLog=OnDate | Date, OnTimeMS | Time, Custom1 | Equipment, Name | Descrip-
tion,
SumState | State | Custom2 | Location, UserName | User

[AlarmStateText]
ON=<default text for ACTIVE state>
OFF=<default text for INACTIVE state>
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ACK=<default text for ACKNOWLEDGED state>
ENA=<default text for ENABLE state>
DIS=<default text for DISABLE state>
CLE=<default text for CLEAR state>

These parameters are read only when the system starts up. The user must restart
PowerSCADA Expert if they change these parameters.

If you do not specify any value for these parameters, these default values will be used,
in this order: .

Appearance

Disappearance

Acknowledge

Enable

Disable

Clear

[General] IODevCheckStartupDelay
Delay time before the I/O server starts checking for I/O device status at start-up. The
delay allows time for the I/O devices to come online. Otherwise, the I/O server would
have triggered alarms to indicate that communication was not successful for the rel-
evant equipment.
Allowed Values: ≥ 0
Default Value: 0

[General] IODevCheckInterval

The time interval in seconds that the I/O server repeats the I/O device status check.
Allowed Values: ≥ 2
Default Value: 2

Integration and Single Sign-On Parameters
The following parameters deal with single sign-on and integration of
PowerSCADA Expert, Power Monitoring Expert and Event Notification Module.

[Applications]PSEHostName

Required in order to use PowerSCADA Expert basic reports. This parameter specifies
the IP address for the PowerSCADA Expert server.

[Applications]HostName

This parameter specifies the IP address for Power Monitoring Expert.

[Applications]WebReachServer

Default value: empty string. This parameter specifies the host name or IP address of
the WebReach server machine. In most cases this is the same as the Hostname above.
Required for integration with WebReach to display Diagrams in the PowerSCADA
Expert runtime graphic pages.

[Applications]PrivLevel

Default value: 0. Allows the use of the “privilege level” field associated with
PowerSCADA project users. It can be configured on a per-application level including:
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PSEReporting, Advanced Reports (PME), WebReach, Dashboards, and provides the
ability to limit use of Single Sign-On operations to specific privileges.

[Applications]Area

Default value: 0. Allows the use of the “area” field associated with PowerSCADA
project users. It can be configured on a per application level including: PSEReporting,
Advanced Reports(PME), WebReach, and Dashboards, and provides the ability to limit
the use of Single Sign-On operations to specific areas.

[Applications]UseHTTPS

Default value: FALSE.Required if the Power Monitoring Expert server has
SSL certificates installed and enabled.

[Applications]PSEHostPort

Default value: 23103. Only used for configuring Single Sign-On to PowerSCADA
Expert web applications - Basic Reports and LiveView.

[Applications]ENMServer

Default value: localhost. Must be set in order to configure PowerSCADA Expertgraphic
pages to display the Event Notification Module Configuration web page.

[Applications]ENMPort

Default value: 82. Must be set to '82' in order to configure PowerSCADA Expertgraphic
pages to display the Event Notification Module Configuration web page.
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Appendix 3: Additional INI Parameters
The following parameters are added to support device types as they are added to the
system.

Quantum PLC Time-Stamped Events
The PWRMODBUS driver supports Quantum time-stamped events. You must set the
following INI parameter to enable time-stamped alarms downloading:

[PWRMODBUS]

TSEventsEnabled = 1
0 by default, valid values 1 or 0

TSMailboxAddress = 1104
1104 by default

TSAddrLost = 705
705 by default
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address

The address contains all the information the SCADA system needs to get values from a
known device, and to return a value determined by the values read from the device
and the calculation rules defined in the address.

alarm categorization

Added when setting up custom tags, this is one of the alarm filters. which will be used
for filtering and sorting alarms in the Alarm Log. Categories are: normal, over, over hs,
rate of change, reversal, sag, swell, transient, under, and under hs.

alarm text (On/Off)

For onboard alarms, this is the text (added while adding a custom tag) that displays
when the alarm is on or off. This text will display in the Alarm Log.

alarm filters

Setup in the Profile Editor, these filters help you filter and sort data that displays in the
Alarm Log.

alarm groups

Added when setting up custom tags, this is one of the alarm filters. which will be used
for filtering and sorting alarms. Groups are: frequencies, motors, power factors, powers,
temperatures, time, and voltages.

alarm levels

Added when setting up custom tags, this is one of the alarm filters. which will be used
for filtering and sorting alarms. Levels are: event, high, medium, and low.

alarm types

Added when setting up custom tags, this is one of the alarm filters. which will be used
for filtering and sorting alarms. Types are: diagnostic, power quality, protection, and
system.

bandwidth

The amount of space or processor resource being used by a part of the system. You
can use the bandwidth allocation parameters to allocate bandwidth for different types
of data.

baud rate

The speed of transmission of electrical signals on a line. This is often described in bits
per second (bps), although the baud rate and bps are not truly interchangeable. The
baud is actually the measurement of how frequently the sound changes on the line.

bitmask

A mask is defined as data that is used with an operation to extract information that is
stored in another location of the code. A bitmask is the most common mask used. It
extracts the status of certain bits in a binary string or number (a bit field or bit array).
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Cicode

This programming language, which is similar to Visual Basic or "C," allows you to
access and edit real-time data in the project. Although not difficult to use, the person
working in Cicode must have received Cicode training.

cluster

A discrete group of alarms servers, trends servers, reports servers, and I/O servers. It
would usually also possess local control clients. For a plant comprising several
individual sections or systems, multiple clusters can be used, one cluster for each
section.

CommsMethod (communications method)

This is the communication protocol, such as MODBUS/RTU via Gateway, that is being
used by a device. When adding devices in the I/O Device Manager, you will need to
specify the CommsMethod.

ComPort

(also COM port) The computer's communications port used to connect to devices, for
sending and receiving serial data.

composite device type

A composite profile can be made from more than one device type. Each device type
included in the composite profile can use its own protocol for communication. The
composite device type allows the engineer to use two devices for one monitoring point,
e.g., a breaker and a monitoring device. PowerSCADA Expert combines the
functionality of the two devices so that the end user only needs to consider one device
when analysing that location in their system.

configuration environment

(See design time environment.)

control

This is a command written to a device register that then causes an action within some
equipment. There are a series of default control tags in PowerSCADA Expert to
achieve these actions. For example, in the Sepam 40, there are control tags to operate
a circuit breaker and enable a recloser.

custom device type

This is a "new" device type that is added to a system. Although the Profile Editor
includes many standard device types, it may be necessary to add a new device type
that includes custom tags, or one that includes a different set of tags than the standard
device types.

custom tag

This is a "new" tag that is added to the system. Although the Profile Editor includes
many standard tags, you may need to add a tag for a third party device, or to edit an
existing tag to change its attributes. In these cases, you need to add a custom tag.
These tags are then added to a customized device type to be made available in
profiles and projects. The custom tag creation interface applies rules to the tag creation
to help guide the user to making tags that will correctly retrieve the desired information
from devices.
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DataBits

This is the number of data bits used in data transmission. The I/O device and the
ComPort must have the same value.

data type

Data types are restricted to these types that are supported by the SCADA system:
digital, int, long, real, and string.

demomode

This demonstration mode allows you to run the product without a hardware key. You
can use all of the product features, but with limited runtime and I/O options. See The
Demo Mode on page 219 for details.

design time environment

To be used only by the person who is creating and installing the project for the end
user, this is the environment in which you add devices, profiles, and projects, as well
as create genies and one-lines.

device category

Used in the I/O Manager to logically group device profiles, to make them easier to
locate. The default category is "Schneider Electric, and the default subcategories are
"Monitoring Device," "PLC," and "Protective Device." Do not confuse these terms with:
• categorization and subcategorization (alarm filters, used during runtime, to filter

and sort alarm data)
• category type: real-time filters that provide metadata for future reporting

device profile

A subset of the device type: where the device type includes all of a device type's
attributes, the device profile includes only the specific tags that are used by an
individual customer. A device profile is set up like a device type, except that it is
specially configured for a particular need. For example, a CM4000 that is being used to
monitor the main at a given facility would have a different profile from the CM4000 that
is used to monitor water and gas at a facility. The profile also allows you to designate
that some tags will be used for trending and/or for PC-based alarming.

device type

A device type contains all the information for retrieving the available information from a
given device type. This information is stored in the form of tags. Tags can be of these
types: real-time, onboard alarms, controls, and Resets. Real Time tags can be further
separated into groups such as Currents or Energies.

A device type has a name and has one or more drivers associated with it. It also has
one or more tags associated with it; for each driver/tag combination, the device type
can have an address.

device type drivers

These are programs that allow PowerSCADA Expert to interact with a device or series
of devices. PowerSCADA Expert includes several generic drivers (generic MODBUS,
Sepam 40 Range, MicroLogic 5P and 6P, CM4000 series, and PM800 series) that
interact with "standard" device types.

engineering unit templates
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Used for conversions between base units and their conversions (for example, inches to
centimeters or amperes to kiloamps).

enumeration (used for the circuit breaker status)

This is a single value (0-5) that defines a condition that is determined by multiple bits.
They allow for dynamic contingencies, such as when you need to use multiple bits to
describe the position of a circuit breaker.

format code

These codes define the attributes of the address field of a tag. See Format Code
Definitions on page 85 for a list of format codes.

functional addressing

Creates addressing for a device that has data residing in different registers. Functional
addressing dynamically addresses the device, based on its configuration (using C#,
you can write code to account for user-defined variables). When you add the profile to
a project, you will enable functional addressing. Then, when exporting to the I/O
Manager, you are prompted for the variable(s) related to these device types.

genie

A genie is a multi-layer graphic that is used on the Graphics page to indicate an object,
such as a motor, generator, circuit breaker, or switch. Using genies, you only have to
configure common behaviours of that object once. The default genie library includes a
large number of pre-defined genies. A graphics page can contain any number of
genies.

ICD file

IED capability description: This is the file that is imported into the Profile Editor from an
IEC 61850 device. Editing for ICD files is limited to the ability to add/delete datasets
and control blocks, and the ability to edit buffered and unbuffered control blocks that
were created in the Profile Editor.

IEC tag name

The IEC 61850-compatible name that is created when a tag is created. This is the
name that is used by the SCADA system. The tag names provided use an abbreviated
form of the IEC 61850 naming convention. A tag name cannot include any special
characters except ( _ \ ). It can be a maximum of 32 characters.

IED

Intelligent electronic device

IID

Instantiated IED description: defines the configuration of one IED for a project; is used
as the data exchange format. This file contains data for just the IED that is being
configured.

I/O Manager

This tool allows you add device profiles to, or delete them from, a project. From the
Profile Editor, you export profile data into a file that can be used in the project. From
there, you use the I/O Manager to add the device profile into a project.

logic code
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Logic codes tell the program how to mathematically certain values in device registers,
thus providing values that the user needs. Examples of logic codes are date and time
for a circuit monitor or a Sepam device, digital inputs/outputs, and IEEE power factor.

metadata

Metadata provides data about other data. In PowerSCADA Expert, metadata might
include additional information about a custom tag: its category type, utility type,
statistical type, or quantity. It is often used for reporting purposes.

multi-monitor support

This option allows you to view the runtime environment from multiple computer
monitors. In PowerSCADA Expert, this allows you to view a different startup page on
each monitor.

onboard alarm

Onboard alarms are alarms that are detected and stored in a device's data logs. If an
onboard alarm is configured within a device, you can map it, via the Profile Editor, to a
digital time-stamped alarm in PowerSCADA Expert. These alarms and associated
waveforms can be read and displayed in the Alarm Log.

parity

Parity is used as a simple means of detecting error by verifying that the result is odd or
even. In PowerSCADA Expert, parity is required for the generic serial or MODBUS/RTU
comms methods, when adding a device.

PC-based alarms

PC-based alarms are alarms that are detected from a device and are stored in the
software. You can add them to the Profile Editor when you create the device profile. All
PC-based alarms are analog by default.

PMCU

The Meter Configuration Help Utility. Use this application to set up the features within
PowerLogic devices, and enabling such features as onboard alarms and waveforms.
The information that is generated from PMCU is then available for use within
PowerSCADA Expert.

point (see SCADA tag)

polling priority

When adding a custom tag, this field determines the level of priority that PowerSCADA
Expert uses when reading data from the related device. Options are low, normal, or
high.

PowerSCADA Expert tag name library

This library includes electrical parameters, or measurements or topics. A tag name has
three parts:
• an easy to read name (such as Current Phase A)
• a unique identifier
• meta data (attributes used to categorize the data for intelligent display/analysis)

Profile Editor

© 1990–2017 Schneider Electric All Rights Reserved 276



This tool allows you to create device type tags, device types, and device profiles. This
information is then imported into PowerSCADA Expert, for use in creating graphics
pages.

project

A project is made up of any number of profiles. Profiles that have been added to a
project can be imported into the SCADA system and made available for setting up
actual devices in the SCADA system.

A project name must match exactly between the Profile Editor and
PowerSCADA Studio.

Each project includes: a unit template, display name, and one or more instantiated
device profiles (instantiated by choosing a device profile and specifying a name). The
following is a simple example of how device profiles and projects inherit information
from the device type.
• The device type myCM4Type can use either the Modbus driver or the IEC 61850

driver.
• The device profile myCM4Profile inherits this device type.
• The projectmyCM4Project instantiates the myCM4Profile and calls it

myModbgusCM4, and it specifies that it uses the Modbus driver.
• When this project is imported into the SCADA system, Modbus addressing will be

used.

register scaling

This is a conversion that is the result of applying a scaling multiplier to a register value.

resets

This feature allows you to reset data from a device. There are some pre-defined resets,
such as device date/time and onboard data logs, You can also add custom resets.

reserved names

The following terms are reserved for use in the Include project. If you use them in
projects that you create, they can cause compilation errors:
• IO_Server
• Report_Server
• Alarm_Server
• Trend_Server
• Client

runtime environment

This is where the end user views system information. This environment includes the
one-line diagrams with interactive objects, alarm and event pages, and analysis pages
(from which users can view trends and waveforms).

SCADA tag (SCADA point)

A SCADA tag is an extension of the tag name. A SCADA tag is made up of five parts:
two in addition to those already defined in the PowerSCADA Expert tag library:
• an easy to read name (such as Current Phase A)
• a unique identifier
• an address (where on a device to read the raw data from)
• a formatting scheme (what to do with the data after it is read to scale it)
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• meta data (attributes used to categorize the data for intelligent display/analysis).

SCL

Substation Configuration Language, the configuration description language for
communication in electrical substations related to IEDs (defined by IEC 61850-6). This
language is used when importing/exporting ICD files. SCL files are used in such
devices as G3200 gateways.

StopBits

The number of bits that signals the end of a character in asynchronous transmission.
The number is usually 1 or 2. Stop bits are required in asynchronous transmissions
because the irregular time gaps between transmitted characters make it impossible for
the server or I/O device to determine when the next character should arrive.

super-genie

Dynamic pages (usually pop-ups) to which the system can pass information when the
runtime page displays. You can use super-genies for pop-up type controllers (for a
very specific task that may not be always needed).

tag

Any quantity or measurement (topic) that is recorded by the device; for example,
current A. All tag names will use the IEC61850 naming convention. The user can
create custom tags; the naming convention will be in the following format:

<EquipmentName>\<PointName>

Where <EquipmentName> uses '_' (underscore character as a separator)

Where <PointName> uses '\' (backslash as a separator)

For example: SST_MV_BUSA_INC1\XCBR1\Pos

A tag contains a tag description, units, tag name, data type, and address.

Tags include the following (* indicates required information):

tag name*
display name*
group*
data type*
engineering units
Citect formatting
polling priority
alarm "on" text
alarm "off" text
category type
utility type
statistical type
quantity
alarming categorization
alarm type
alarm group
alarm subcategorization
alarm level
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The tag's group determines the tag's class:

If the tag's group is onboard alarm, control, or reset, the tag's class is the same.

If the tag's group is anything else, the tag's class is real time.

tag address

This "address" includes everything you need to know about a tag (quantity/topic).
Included are the data type, priority, and logic code; and how the tag is displayed in
registers. You can change address attributes on the Edit Address screen. The full tag
address displays on the Define Device Type Tags tab when "Advanced Properties" is
selected.

tag description

The tag description is a human readable name which can include spaces and special
characters (except for \ / : * ? < > | ). The description can be a maximum of 32
characters long.

tag group

The basic groups include: real-time, of which there are several sub-groups (for
example, currents, energies, frequencies and power factors); onboard; control; and
reset.

units

Units are the standard measurement associated with the quantity measured by a tag.
Units come in two types: base units and conversion units.

Some information is common to all units, and some applies only to conversion units:

Common Information: base unit name, base unit abbreviation

Conversion Unit Information: conversion unit name, conversion unit abbreviation,
offset, multiplier

units template

The units template defines the conversion factor that must be applied to the standard
units provided in order to give the user their information in their desired units. The units
profile applies to an entire project. For example, If the standard unit for a device is MW,
but the user wants their project to display KW, they must define this units conversion in
the units template and then apply it to an entire project.

user privileges (user access, user rights)

This feature allows you to control the amount of access that each user has to the
system. User privileges are password-protected. SeeDefault User Access Settings
(Privileges) on page 236 for more information.

vector math

Vector math and vector math IEEE are two logic codes. They are the result of math that
use vectors, which are directed quantities.

Appendix 5: Frequently Asked Questions (FAQs)
The following items provide information about topics that generate frequent questions.
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If I don't use PowerLogic drivers, how do I create device profiles?
The easiest way to do this is to:

Create a device type using a non-PowerLogic driver (like MODNET).
1. Using that device type, create a device profile.
2. You need to change the addressing of the new device type. The easiest way to do

this is to copy the addressing from a known device type, and then make the
necessary changes for the new device type.

How should we manage categories and subcategories?
We recommend that each integration team decide in advance which categories and
subcategories they will use. The I/O Device Managere requires the entire Profile name
(which uses the category and subcategory as part of its name). Thus, you must be
consistent in naming if the profiles are going to be shared and re-used.

1. Category should be used for a vendor.
2. Subcategory should be used to describe a type of device.
3. From the master computer that has the Profile Editor installed, create the categories

and subcategories that you plan to use.
4. Copy the DeviceTypeCategories.xml file (located in the OS-specific data directory:

Data/Profile Editor/ Vx.x ) to every computer being used to create profiles.

When should I create a device type rather than device profile?
Create a new device type, instead of a profile, when the addressing for a specific tag
needs to change. An example:

The integration team can choose which Input to which they will wire circuit breaker
status and position. In this case, the tags for circuit breaker status and position would
have different addressing, based on how that particular circuit breaker is wired. We
recommend a new device type in this case.

How do we synchronize a new PC with the master Profile Editor PC?
To synchronize a new machine with the latest device types and profiles from your
master Profile Editor PC, you can:
• Use the Import feature to import tags, device types, and profiles from either an

existing project or from SCL files. See Import Files into the Profile Editor on page 76
for full details.

• On the source PC: From the OS-specific Data/Profile Editor/ Vx.x directory, copy the
entire OS-specific Data/Profile Editor/ Vx.x directory to the corresponding directory
on the destination machine.

What do I do before I add or remove devices in the I/O Device Manager?
1. You must close all open dbf files.
2. If you are removing a device, check “pack database after removal” on the last page

of the wizard.
3. Any changes that you made inside the when setting up the project (such as

setpoints or data type modifications) are lost when you delete the device
from PowerSCADA Expert.
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What are the requirements for device names?
Device Name:

Keep Device name ≤ 16 characters. Use _ as a separator.

If you use a naming convention that incorporates location, you will be able to do
filtering on alarm location.
• For example, Site_Building_Panel_device would be named Sx_Bx_Px_Device.

(Site1_Building1_Panel1_CM41 — S1_B1_P1_CM41).
• The fewer levels you have, the more characters you can have in each level.

Device Comment:

Use this field for an alias of the device name.

This comment will be placed in the Equipment database, which is accessible from
Cicode.

How do I troubleshoot device communications issues?
PowerSCADA Expert drivers provide default communication settings that work with
most devices. However, in cases when communication losses occur, use this checklist
for finding the issues.

1. Initial checks, if the device is attached via a gateway:
— Ensure that all communication settings are correct on the gateway and device.
— Check the gateway timeout. A setting that is too low will cause many timeouts to

occur. A setting that is too high will impact performance. We recommend a 3
second timeout, because most devices work well with this setting. Some
devices may require a higher timeout (5 seconds).

2. In all communication setups (also see the driver help for parameters):
— Ensure that the PowerSCADA Expert driver timeout is correct. We recommend

that you set this to:
gateway timeout x number of clients + padding
Example: If the gateway timeout is 3 seconds and there are 3 clients, set the
timeout in PowerSCADA Expert to 10 seconds.

— Check the maximum block read size. Some devices do not handle large block
reads well. When you lower the maximum block read size, the requests are
smaller and faster. The downside is that more requests will be sent to the
device, and tags will refresh more slowly.

— Check the device to see if there are registers that it cannot read. Some devices
do not allow access to all registers.
Example: Data is in register 100-125 and 130-150. PowerSCADA Expert will
perform one read from 100-150. If 126-129 do not allow reading, this packet will
return an exception. Use the appropriate logic code to mark these registers as
invalid reads.

— If there are still timeout/no response issues, enable retries on exception. Some
devices may not respond if they are performing other functions. In this case,
a0x0A or 0x0B exception will be returned to PowerSCADA Expert, which will
cause a communication loss. Enabling the "retry on exception" will re-try the
request.

How do I use MODBUS communications methods?
MODBUS TCP/IP via Gateway: Use this for any device that is not speaking TCP/IP
natively. These devices connect through a gateway device such as an EGX or ECC.
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MODBUS TCPIP: Use this for any device that can speak TCP/IP natively. This includes
CM4 or PM8 devices that have an ECC card installed.

What are the naming conventions for servers and clusters?
There is no enforced naming convention for server and cluster names, other than the
restriction that each server name and cluster name must be unique. Cluster names
must be a maximum of 16 characters, no spaces; they may not begin with a number.

Each team should come up with a naming convention for the servers and clusters. If
the team is consistent, it will make it easier to edit/create the automation spreadsheet
used for device addition.

How and when do I create users for the Runtime environment?
New projects do not have any users created by default.

The default graphics objects (such as circuit breakers and alarm pages) are
constructed using a pre-defined set of user privileges the security grid). During
development, you must have users of various privilege levels for testing purposes.
Create users for each of the various levels according to the security grid. To make the
best use of these privileges, we recommend that you use this security grid when
adding users as you create new projects.

See Default User Access Settings (Privileges) on page 236. For additional information,
see Using Security in the citectSCADA.chm help file (Program Files> Schneider
Electric > PowerSCADA Expert > v8.2 > bin).

How do I manage projects in the PowerSCADA Studio?
Although the designer may wish to organize each project in a particular way to suit
customer's needs, the following is a recommended best practice:

1. Keep original ‘Master’ copies of the PLS_Example and the PLS_Include projects
for reference.

2. The Services group may develop a group-wide “include” project that will act as a
conduit between the PLS_Include project and all customer projects (e.g., "Group_
Include"). This will make the upgrading of PLS_Include much easier, as it will be
the only project that must be modified to be compatible with the new version in the
group-wide include project.

Any changes made to the PLS_Include project should be made at the Group_
Include project level. This would involve removing portions of the code from the
PLS_Include project, modifying the code and saving it in the Group_Include project.
By removing (or commenting out) the original code and placing the new code in the
Group_Include project, a layer of abstraction is preserved, further simplifying the
upgrade process. In other words, the only changes to PLS_Include should be code
removal.

3. When a new customer project is started, also create a customer-level “include”
project.

Always back up and restore the customer project and its associated include
projects together.

Always restore include project(s) before restoring the customer (or top-level)
project.
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4. Upgrading PLS_Include:

Document all changes to PLS_Include. This is absolutely necessary when
upgrading to a new version of the PLS_Include project.

Minimize changes to the PLS_include project.

Abstract as many changes to the PLS_Include project as possible. This should be
accomplished by the use of multiple include projects as shown in the diagram
above.

New versions of PLS_Include will include a detailed description of each change,
allowing you to merge the old and new versions.

New versions of PLS_Include will maintain backward compatibility where possible.

On the Graphics page, what do I need to know about creating genies?
1. Creating a new genie:

The easiest way to create a new genie is to use an existing genie from the library.
This ensures that the new genie is compatible with the system, and that it preserves
this feature:
— A sizing guide (a dotted rectangle) is included; it displays during graphics edit

mode. This guide ensures that new genies can be swapped with existing
genies without the need to recreate portions of the drawing. Save the new genie
in the appropriate project (do not overwrite the provided genies).

Save the new genie in the appropriate project (do not overwrite the provided
genies).

2. Copying a genie to another project:

Open the genie in the graphics editor, and do a <save as> into another
project/library.

3. Genie Form Files:
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Any new genie (copied or created) will not have a .frm file entry associated with it.
While the new genie is functional, it will show a cryptic unformatted properties box
in the Graphics Editor. You can create your own .frm file with the needed entries by
following the instructions available in the PowerSCADA Studio Knowledge base.

If you want to use the .frm dialog box that belongs to the genie you copied, go to the
PLS_Include library; locate the .ctm and .ftm files. Each library has its own .ctm/.ftm
files that include the description for every genie in the library. (This is an ascii text
file that you can open in any text editor.) Find the genie that you copied (or on
which you're basing the new form). Copy the portion that matches the copied genie,
and create a .frm file that has the desired library name on it. Copy in the text from
the .frm file. Restart PowerSCADA Studio or it will not detect the new .frm.

4. Genie Sizing

The provided genies come in two sizes: size 1 and size 2. When making a new
genie for reuse among multiple projects, it will be beneficial to create a genie for
both sizes. Follow the same steps for both sizes (sizing guides are provided for
both sizes).

How do we customize existing templates?
Template Editing:

All objects on the page contain one or more Animation Numbers (ANs). Symbols take
one AN while genies may take tens to hundreds of ANs. Placeholder ANs allow you to
add objects to a template that is used on existing pages.

Some default templates contain ANs that have associated Cicode functions that rely on
the animation number to remain a fixed number. For this reason, we have pre-
allocated a set of ANs for the default templates. The base normal template uses ANs
1–263, and it has placeholder ANs from 264–500. When customizing this template,
you should use the placeholder ANs as required.

You can place an AN (or a placeholder AN) on the page by using the “System 3.x/4.x
tools available in the Graphics Builder under Tools< Options.

The default template uses ANs 1–263 and it has placeholder ANs from 264–500.

New objects added to a page or template will take the next available ANs. Any
previously used (and now abandoned) ANs will be reused.

To add an object on the template, you must:

1. Open the template.
2. View the page properties and change the page width to 2000. This will reveal the

hidden placeholder ANs on the page. You may have to change the width to a wider
dimension for widescreen templates.

3. Determine how many ANs the new object requires. (You can place the new object
on a blank page and then view the object in the object browser.)

4. Remove exactly the amount of ANs to allow the new object to be placed on the
template. Remove ANs beginning with the lowest available placeholder AN (in the
default template, this would be 264).

5. Place the object on the template.
6. Save the template.
7. Create a new page based on this template.

8. Drop a numeric object on the page.
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a. This object’s AN should be 502 (501 is reserved for placing the template on the
page).

b. If the object has an AN less than 502 then you have unused AN(s) on the
template. This must be resolved. (Place additional ANs on the template to rectify
this situation.)

c. If the object has an AN greater than 502 then you have too many ANs on the
template (a AN on the template is going beyond the 500 limit). You must find the
culprit (via the object browser) and rectify the situation using the steps above.

How do I change the default pickup/dropout text for alarms?
The default ‘pickup/dropout’ text is shown as Appearance/Disappearance.

To change globally:

This text may be changed by configuring INI parameters in the citect.ini file. For
more information, see the System Integrator’s Guide (Graphics Library Parameters
on page 268)

This is the global fallback text that will be used in the event that pickup/dropout text
is not specific on a per-alarm basis in the Device Profile. You can specify the per-
alarm pickup/drop-out text on the profile tab in the Profile Editor.

To change on an individual basis:

See the System Integrator's Guide (View Device Profiles on page 57, "Alarm On
Text" and "Alarm Off Text").

What can I modify during runtime?
See the PowerSCADA Expert Design Guide, "Updates to the System While Online," for
a list of items you can modify during runtime.

Why do the browser navigation buttons not work?
If the browser navigation buttons do not work when you are viewing the runtime
window, you have probably added a new page, but have not done the following:
• added the startup page to the Page parameter. See Set a New Page as the Project

Startup Page on page 111 for help.
• left the INI settings at <default>. In the Computer Setup Wizard, General Options

Setup screen, do not change the StartupPage field; leave it as <default>.

What can I set up in logging and archiving?
Event Logging and Archiving:

Event fields that are logged to disk may be configured by adjusting the AlarmFormat
parameter.

There is no automatic maintenance performed on the log files. It is important that the
log/waveform data be cleared out periodically (to prevent the hard drive from filling up;
this does not affect performance).

How do I create and configure busbars?
When drawing one-line diagrams:

Analyse the drawings at a customer site.

Number the busbars consistently on the one line diagram(s). If busbar 14 spans
across multiple pages, it should be numbered busbar 14 on all pages. Label the
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voltage level (0–3) on each busbar.

Uses for Line Active:
Page Connections: Many one-line diagrams will span multiple pages. To connect
these pages together, you must use the line active field of the ‘incomers’ of the
second and subsequent pages. Set the line active field of the incoming busbars on
these pages to an expression that references the nearest device on the same
busbar of the previous page.

Metered Busbar: Many busbars are actually metered. It is more accurate to allow
these metering devices to dictate state than to rely solely on the simulation (see
Expressions below).

Configuration of Line Active:
Simulation: If the Line-Active field is left blank, the busbar state will be determined
by surrounding devices.

Expressions:
A Cicode expression in the form of Device\Tag > Nominal Voltage (I.E., S1_B1_P1_
CM41\MMXU1\PhV\zavg > 120).

If the expression is TRUE, the ACTIVE color will be shown. The active color is
determined by the voltage level assigned.

If the expression is FALSE, the DE-ENERGIZED color will be shown.

Hard-Coded:
If no upstream devices are available (in the event of an incomer, for example), you
may have no other choice than to ‘hard code’ this field to a ‘1’. This forces the
busbar to always be ACTIVE.

What INI parameters should I use for debugging?
We recommend that you contact Technical Support before performing any debugging.

Parameter: [PowerLogicCore]
DebugCategory = All

DebugLevel = All (or Error)

LogFileArchive = Deprecated; no longer used. Use [Debug]SysLogArchive instead.

LogFileSize = Deprecated; no longer used. Use [Debug]SysLogSize instead.

Parameter Details:

DebugCategory defines which message categories to log. (See table below).
DebugLevel defines debug levels of messages to be logged. (See table below).
Debug Levels
The following debug levels are accepted by PowerLogic driver core library:

WARN: log all warning level messages

ERROR: log all error messages

TRACE: log all trace messages

DEBUG: log all debug messages

ALL: include all level messages

Debug Categories
PowerLogic core library and drivers messages are grouped in categories. Each of
these categories can be enabled independently from others in any combination.
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MISC: miscellaneous messages that do not all into any other category

ALARM: messages related to alarms, regarding collection and detection

WAVE: messages related to waveforms -- waveforms download, processing

REAL: messages related to real-time data collection

STATE: messages related to internal object-state changes

CORE: core events that do not fall into driver-specific logic

MODBUS: TCP/MODBUS messages

ENTRY: trace messages produced when driver API entry points are called

PORT: traces related to the port events

UNIT: traces related to specific unit events

WAVETOALARM: not used

DATAPOINT: debug messages related to data points

STATISTICS: enables driver statistics data output

COMMAND: messages related to commands

REPLICATION: messages produced by replication subsystem

ALL: enables all categories

Parameter: [Debug]
Menu = 1

Parameter Details:

The Menu parameter determines whether the Kernel option is displayed on the control
menu of the runtime menu. This can also be enabled using the Computer Setup Editor.

How do I tune my system for best performance?
There are several parameters that you can use to enhance your system's performance:

Driver-tuning parameters:
Parameter (Back Polling Rate): [SEPAM40]
CacheRefreshTime = 1000

InitUniCheckTime = 120

Retry = 3

Timeout = 1000

Parameter Details:
The CacheRefreshTime parameter controls the maximum rate at which the driver
will attempt to repopulate its cache. If the driver cannot refresh its cache within the
time period specified, it will collect data as fast as the network allows.

This back polling rate can be global to all devices or tuned up to a specific I/O
device.

The InitUniCheckTime parameter controls how long the driver will wait before
attempting to bring a device online after it has gone offline. This value can be
decreased to bring offline devices back into service in a shorter period of time. In a
multi-drop scenario, this time should be relatively long, to prevent init unit requests
from stalling communications to the rest of the devices on that port.

The Retry parameter defines the number of retry attempts for specific MODBUS
requests. Retries will only occur in response to the MODBUS errors which are
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defined below.

The Timeout parameter controls how long the driver will wait for a response from a
device before setting that device as offline. This value should be greater than the
device/gateway timeout period.

Parameter: [Device]
WatchTime = 5000

Parameter Details:
Device WatchTime is the frequency that PowerSCADA Expert checks devices for
history files and flushes logging data to disk.

Default: 5000

Range: 1000–3600000 milliseconds.

Miscellaneous Parameters

Parameter: [Kernel]
Task = 20000

Parameter Details:
Kernel Task is the number of tasks. Increasing the number of kernel tasks is used
when “Out of Kernel Task” message is received. The change will be likely for large
systems.

Default Value: 256

Range: 50–32767

Parameter: [Page]
ScanTime = 250

Parameter Details:
Page ScanTime determines how often the Animator refreshes a graphics page at
runtime.

Default: 250

Range: 1–60000 milliseconds

Parameter: [ALARM]
ScanTime = 500

Parameter Details:
Alarm ScanTime determines the rate at which alarms are scanned and processed.
Default: 500

Range: 0–60000 milliseconds

If a tag is configured, how is it polled in the device?
In other words, is a tag only polled on demand when it is requested by a client (for
example, when the operator displays a page with the tag on it)? Or are all configured
tags polled all of the time, with the relative polling rates/communications bandwidth
carefully managed?

The ModNet driver polls real-time tags on a user demand basis (when a user opens a
page with the tags on it). Therefore, the time to retrieve data will vary, depending not
only on the communications bandwidth, but on the amount of data being requested.
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This can vary significantly, depending on which pages are displayed by the operators
at any particular time.

The PWRMODBUS driver polls all configured tags; however, different types of tags can
be polled at different relative rates, and the available communications bandwidth is
carefully managed. This approach means that tag update rates are not subject to the
scalability issues associated with operator actions (as is the case for the ModNet
driver). It is also advantageous in that performance issues associated with
communications bandwidth or IODevice response times can be determined at
SAT/time of implementation and are not subject to significant change during operation.

The different tag types can be allocated relative importance in data requests,
expressed as a percentage. (See Bandwidth Allocation Parameters in Performance
Tuning Parameters on page 256.) Keep in mind that any unused bandwidth allocation
(from, for example, events retrieval) is made available for other data types to use. If the
event does not need the default 25% allocation, it will be made available to the other
parameters (real-time tag retrieval, etc). This potentially increases the update rate of
real-time tags.

Additionally, the real-time tag relative scan rate based on priority can be set to three
different levels. (See Tag Scan Rate Parameters in Performance Tuning Parameters
on page 256.) This means that, if some real-time tags are more important that others,
you can set their relative priorities. For example, configuration tags vs. important real-
time tags vs. normal real-time tags.

Device popup from a one-line: Why do the fields overlap?
This is controlled by a parameter entry:

Section: Page

Name: EquipDetailDescLength (the total number of characters in a single row of this
popup)

Default = 48. The problem will occur with a larger font or if the window is resized. The
default value of 48 can be changed or the window and associated genies can be
resized.

Can I change the %CLUSTER% name in the I/O Device Manager?
No. If you change the placeholder %CLUSTER% to any other name in the I/O Device
Manager, the system will be unable to find the actual cluster to which it refers.

A device can prevent writes to its registers: how do I ensure that writes are suc-
cessful?

PowerSCADA Expert cannot provide feedback about whether a write to a device
register is successful. If a device is capable is preventing (blocking) writes to its
registers (for example, Sepam), you need to verify that its “block” feature is not
enabled. Do this at the device.

NOTE: In Cicode, you can also use the tagwrite function in blocking mode, i.e., bSync
parameter = true; Check the return code: 0 = success, anything else = error. For more
information, see the Cicode Programming Reference help file.
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How do I prevent PowerSCADA Expert from accidentally making invalid areas in
memory available to reads and writes?

PowerSCADA Expert normally optimises its packets for greatest performance. This
optimisation can sometimes includes invalid areas of memory in devices. These invalid
areas can be specifically defined and excluded from optimisation packets created by
PowerSCADA Expert. See Advanced Tag Blocking Capabilities in Performance Tuning
Parameters on page 256 for more information.

How do I create an audit in the Event Log for user logins and logouts?
//LOGOUT

FUNCTION

PLSLoginUser()

//INT iPage = PageInfo(1);

INT iPage = WinNumber();

IF mbLoginFormShown[iPage] = TRUE THEN

RETURN; //form already shown

END

//prevent multiple forms

mbLoginFormShown[iPage] = TRUE;

IF (UserInfo(0) <> "0") THEN

// Confirm User Action

IF (0 = Message(StrToLocalText("@(Confirm)"), StrToLocalText("@
(Logout)"), 1+32)) THEN

PLSAlmDspEventAdd(0, 0, 1, "User Logout", Name(), "Logout", "");

Logout();

END

mbLoginFormShown[iPage] = FALSE;

RETURN;

END

IF (0 = LoginForm())

PLSAlmDspEventAdd(0, 0, 1, "User Login", Name(), "Login", "");

END

mbLoginFormShown[iPage] = FALSE;

END

Why am I seeing #COM for circuit breaker status in the genie status page?
If this is a Micrologic P device, and it does not have a CCM, you will not be able to view
data referring to circuit breaker status, e.g. racked in/racked out. When there is no
CCM, the device profile should not have tags that refer to the CCM.
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Why can't I acquire waveforms in the waveform viewer?
The "acquire" feature (the "A" button on the waveform viewer) does not work in
PowerSCADA Expert. You can, however, view waveforms from device onboard
waveform files. To do this:
• At the device or in the meter configuration software, add the appropriate alarm, and

enable automatic capture of the waveform when the alarm occurs.
• In the Profile Editor (Create Device Profiles tab), check the Waveform box for the

alarm you added.
• When the alarm occurs, the waveform is captured. You can view the waveform in

the Alarm Log. You can also view alarms/waveforms from a drawing in the runtime
environment. Click the genie for the device; right-click the alarm to view the
waveform.

Note that, in very large systems, it could take as much as an hour for the waveform
to appear.

Why won't the Excel DBF Add-In toolbar install?
When you are installing the Excel DBF Add-In toolbar, you may see this error: "Error
1308. Source file not found....."

You can click "ignore" at this error, and the install will finish. The next time you open
Excel, the DBF toolbar will display.

What causes the "First dbf record" error message? How do I keep it from hap-
pening?

The error message "First dbf record" tells you that a project is not found. This happens
when you add a project, and then rename it or delete it. Then, when you try to create a
new project, you see this error message.

To resolve this issue, simply shut down and then restart the PowerSCADA Studio.

Why is my device in comms loss?
When you bring your system on line, and you find that PowerSCADA Expert has lost
communications with a device, check the following:
• Verify that the physical correction is correct and secure.
• Verify the IP address.
• Verify the Modbus address.
• Check the statusRegister, statusRegistersCount, and statusRegisterType (see for

details)

How do I set up select before operate?
For systems in which you can determine that a single user is selecting a device prior to
sending an open/close command, you can add a "select before operate" button.

To do this:

1. Locate the Select Before Operate tag in the variable tags.
2. Append \str to the end of the tag name.
3. Change the data type to STRING.
4. Click Add.
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This creates the SBOw tag for the IEC 61850 advanced control screen. For more
information about advanced control, see:

Set Up IEC 61850 Advanced Control on page 116

Perform IEC 61850 Advanced Control on page 185
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Appendix 5: Frequently Asked Questions (FAQs)
The following items provide information about topics that generate frequent questions.

If I don't use PowerLogic drivers, how do I create device profiles?
The easiest way to do this is to:

Create a device type using a non-PowerLogic driver (like MODNET).
1. Using that device type, create a device profile.
2. You need to change the addressing of the new device type. The easiest way to do

this is to copy the addressing from a known device type, and then make the
necessary changes for the new device type.

How should we manage categories and subcategories?
We recommend that each integration team decide in advance which categories and
subcategories they will use. The I/O Device Managere requires the entire Profile name
(which uses the category and subcategory as part of its name). Thus, you must be
consistent in naming if the profiles are going to be shared and re-used.

1. Category should be used for a vendor.
2. Subcategory should be used to describe a type of device.
3. From the master computer that has the Profile Editor installed, create the categories

and subcategories that you plan to use.
4. Copy the DeviceTypeCategories.xml file (located in the OS-specific data directory:

Data/Profile Editor/ Vx.x ) to every computer being used to create profiles.

When should I create a device type rather than device profile?
Create a new device type, instead of a profile, when the addressing for a specific tag
needs to change. An example:

The integration team can choose which Input to which they will wire circuit breaker
status and position. In this case, the tags for circuit breaker status and position would
have different addressing, based on how that particular circuit breaker is wired. We
recommend a new device type in this case.

How do we synchronize a new PC with the master Profile Editor PC?
To synchronize a new machine with the latest device types and profiles from your
master Profile Editor PC, you can:
• Use the Import feature to import tags, device types, and profiles from either an

existing project or from SCL files. See Import Files into the Profile Editor on page 76
for full details.

• On the source PC: From the OS-specific Data/Profile Editor/ Vx.x directory, copy the
entire OS-specific Data/Profile Editor/ Vx.x directory to the corresponding directory
on the destination machine.

What do I do before I add or remove devices in the I/O Device Man-
ager?

1. You must close all open dbf files.
2. If you are removing a device, check “pack database after removal” on the last page

of the wizard.
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3. Any changes that you made inside the when setting up the project (such as
setpoints or data type modifications) are lost when you delete the device
from PowerSCADA Expert.

What are the requirements for device names?
Device Name:

Keep Device name ≤ 16 characters. Use _ as a separator.

If you use a naming convention that incorporates location, you will be able to do
filtering on alarm location.
• For example, Site_Building_Panel_device would be named Sx_Bx_Px_Device.

(Site1_Building1_Panel1_CM41 — S1_B1_P1_CM41).
• The fewer levels you have, the more characters you can have in each level.

Device Comment:

Use this field for an alias of the device name.

This comment will be placed in the Equipment database, which is accessible from
Cicode.

How do I troubleshoot device communications issues?
PowerSCADA Expert drivers provide default communication settings that work with
most devices. However, in cases when communication losses occur, use this checklist
for finding the issues.

1. Initial checks, if the device is attached via a gateway:
— Ensure that all communication settings are correct on the gateway and device.
— Check the gateway timeout. A setting that is too low will cause many timeouts to

occur. A setting that is too high will impact performance. We recommend a 3
second timeout, because most devices work well with this setting. Some
devices may require a higher timeout (5 seconds).

2. In all communication setups (also see the driver help for parameters):
— Ensure that the PowerSCADA Expert driver timeout is correct. We recommend

that you set this to:
gateway timeout x number of clients + padding
Example: If the gateway timeout is 3 seconds and there are 3 clients, set the
timeout in PowerSCADA Expert to 10 seconds.

— Check the maximum block read size. Some devices do not handle large block
reads well. When you lower the maximum block read size, the requests are
smaller and faster. The downside is that more requests will be sent to the
device, and tags will refresh more slowly.

— Check the device to see if there are registers that it cannot read. Some devices
do not allow access to all registers.
Example: Data is in register 100-125 and 130-150. PowerSCADA Expert will
perform one read from 100-150. If 126-129 do not allow reading, this packet will
return an exception. Use the appropriate logic code to mark these registers as
invalid reads.

— If there are still timeout/no response issues, enable retries on exception. Some
devices may not respond if they are performing other functions. In this case,
a0x0A or 0x0B exception will be returned to PowerSCADA Expert, which will
cause a communication loss. Enabling the "retry on exception" will re-try the
request.
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How do I use MODBUS communications methods?
MODBUS TCP/IP via Gateway: Use this for any device that is not speaking TCP/IP
natively. These devices connect through a gateway device such as an EGX or ECC.

MODBUS TCPIP: Use this for any device that can speak TCP/IP natively. This includes
CM4 or PM8 devices that have an ECC card installed.

What are the naming conventions for servers and clusters?
There is no enforced naming convention for server and cluster names, other than the
restriction that each server name and cluster name must be unique. Cluster names
must be a maximum of 16 characters, no spaces; they may not begin with a number.

Each team should come up with a naming convention for the servers and clusters. If
the team is consistent, it will make it easier to edit/create the automation spreadsheet
used for device addition.

How and when do I create users for the Runtime environment?
New projects do not have any users created by default.

The default graphics objects (such as circuit breakers and alarm pages) are
constructed using a pre-defined set of user privileges the security grid). During
development, you must have users of various privilege levels for testing purposes.
Create users for each of the various levels according to the security grid. To make the
best use of these privileges, we recommend that you use this security grid when
adding users as you create new projects.

See Default User Access Settings (Privileges) on page 236. For additional information,
see Using Security in the citectSCADA.chm help file (Program Files> Schneider
Electric > PowerSCADA Expert > v8.2 > bin).

How do I manage projects in the PowerSCADA Studio?
Although the designer may wish to organize each project in a particular way to suit
customer's needs, the following is a recommended best practice:

1. Keep original ‘Master’ copies of the PLS_Example and the PLS_Include projects
for reference.

2. The Services group may develop a group-wide “include” project that will act as a
conduit between the PLS_Include project and all customer projects (e.g., "Group_
Include"). This will make the upgrading of PLS_Include much easier, as it will be
the only project that must be modified to be compatible with the new version in the
group-wide include project.

Any changes made to the PLS_Include project should be made at the Group_
Include project level. This would involve removing portions of the code from the
PLS_Include project, modifying the code and saving it in the Group_Include project.
By removing (or commenting out) the original code and placing the new code in the
Group_Include project, a layer of abstraction is preserved, further simplifying the
upgrade process. In other words, the only changes to PLS_Include should be code
removal.

3. When a new customer project is started, also create a customer-level “include”
project.

Always back up and restore the customer project and its associated include
projects together.
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Always restore include project(s) before restoring the customer (or top-level)
project.

4. Upgrading PLS_Include:

Document all changes to PLS_Include. This is absolutely necessary when
upgrading to a new version of the PLS_Include project.

Minimize changes to the PLS_include project.

Abstract as many changes to the PLS_Include project as possible. This should be
accomplished by the use of multiple include projects as shown in the diagram
above.

New versions of PLS_Include will include a detailed description of each change,
allowing you to merge the old and new versions.

New versions of PLS_Include will maintain backward compatibility where possible.

On the Graphics page, what do I need to know about creating genies?
1. Creating a new genie:

The easiest way to create a new genie is to use an existing genie from the library.
This ensures that the new genie is compatible with the system, and that it preserves
this feature:
— A sizing guide (a dotted rectangle) is included; it displays during graphics edit

mode. This guide ensures that new genies can be swapped with existing
genies without the need to recreate portions of the drawing. Save the new genie
in the appropriate project (do not overwrite the provided genies).

Save the new genie in the appropriate project (do not overwrite the provided
genies).

2. Copying a genie to another project:
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Open the genie in the graphics editor, and do a <save as> into another
project/library.

3. Genie Form Files:

Any new genie (copied or created) will not have a .frm file entry associated with it.
While the new genie is functional, it will show a cryptic unformatted properties box
in the Graphics Editor. You can create your own .frm file with the needed entries by
following the instructions available in the PowerSCADA Studio Knowledge base.

If you want to use the .frm dialog box that belongs to the genie you copied, go to the
PLS_Include library; locate the .ctm and .ftm files. Each library has its own .ctm/.ftm
files that include the description for every genie in the library. (This is an ascii text
file that you can open in any text editor.) Find the genie that you copied (or on
which you're basing the new form). Copy the portion that matches the copied genie,
and create a .frm file that has the desired library name on it. Copy in the text from
the .frm file. Restart PowerSCADA Studio or it will not detect the new .frm.

4. Genie Sizing

The provided genies come in two sizes: size 1 and size 2. When making a new
genie for reuse among multiple projects, it will be beneficial to create a genie for
both sizes. Follow the same steps for both sizes (sizing guides are provided for
both sizes).

How do we customize existing templates?
Template Editing:

All objects on the page contain one or more Animation Numbers (ANs). Symbols take
one AN while genies may take tens to hundreds of ANs. Placeholder ANs allow you to
add objects to a template that is used on existing pages.

Some default templates contain ANs that have associated Cicode functions that rely on
the animation number to remain a fixed number. For this reason, we have pre-
allocated a set of ANs for the default templates. The base normal template uses ANs
1–263, and it has placeholder ANs from 264–500. When customizing this template,
you should use the placeholder ANs as required.

You can place an AN (or a placeholder AN) on the page by using the “System 3.x/4.x
tools available in the Graphics Builder under Tools< Options.

The default template uses ANs 1–263 and it has placeholder ANs from 264–500.

New objects added to a page or template will take the next available ANs. Any
previously used (and now abandoned) ANs will be reused.

To add an object on the template, you must:

1. Open the template.
2. View the page properties and change the page width to 2000. This will reveal the

hidden placeholder ANs on the page. You may have to change the width to a wider
dimension for widescreen templates.

3. Determine how many ANs the new object requires. (You can place the new object
on a blank page and then view the object in the object browser.)

4. Remove exactly the amount of ANs to allow the new object to be placed on the
template. Remove ANs beginning with the lowest available placeholder AN (in the
default template, this would be 264).

5. Place the object on the template.
6. Save the template.
7. Create a new page based on this template.
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8. Drop a numeric object on the page.

a. This object’s AN should be 502 (501 is reserved for placing the template on the
page).

b. If the object has an AN less than 502 then you have unused AN(s) on the
template. This must be resolved. (Place additional ANs on the template to rectify
this situation.)

c. If the object has an AN greater than 502 then you have too many ANs on the
template (a AN on the template is going beyond the 500 limit). You must find the
culprit (via the object browser) and rectify the situation using the steps above.

How do I change the default pickup/dropout text for alarms?
The default ‘pickup/dropout’ text is shown as Appearance/Disappearance.

To change globally:

This text may be changed by configuring INI parameters in the citect.ini file. For
more information, see the System Integrator’s Guide (Graphics Library Parameters
on page 268)

This is the global fallback text that will be used in the event that pickup/dropout text
is not specific on a per-alarm basis in the Device Profile. You can specify the per-
alarm pickup/drop-out text on the profile tab in the Profile Editor.

To change on an individual basis:

See the System Integrator's Guide (View Device Profiles on page 57, "Alarm On
Text" and "Alarm Off Text").

What can I modify during runtime?
See the PowerSCADA Expert Design Guide, "Updates to the System While Online," for
a list of items you can modify during runtime.

Why do the browser navigation buttons not work?
If the browser navigation buttons do not work when you are viewing the runtime
window, you have probably added a new page, but have not done the following:
• added the startup page to the Page parameter. See Set a New Page as the Project

Startup Page on page 111 for help.
• left the INI settings at <default>. In the Computer Setup Wizard, General Options

Setup screen, do not change the StartupPage field; leave it as <default>.

What can I set up in logging and archiving?
Event Logging and Archiving:

Event fields that are logged to disk may be configured by adjusting the AlarmFormat
parameter.

There is no automatic maintenance performed on the log files. It is important that the
log/waveform data be cleared out periodically (to prevent the hard drive from filling up;
this does not affect performance).

How do I create and configure busbars?
When drawing one-line diagrams:

Analyse the drawings at a customer site.
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Number the busbars consistently on the one line diagram(s). If busbar 14 spans
across multiple pages, it should be numbered busbar 14 on all pages. Label the
voltage level (0–3) on each busbar.

Uses for Line Active:
Page Connections: Many one-line diagrams will span multiple pages. To connect
these pages together, you must use the line active field of the ‘incomers’ of the
second and subsequent pages. Set the line active field of the incoming busbars on
these pages to an expression that references the nearest device on the same
busbar of the previous page.

Metered Busbar: Many busbars are actually metered. It is more accurate to allow
these metering devices to dictate state than to rely solely on the simulation (see
Expressions below).

Configuration of Line Active:
Simulation: If the Line-Active field is left blank, the busbar state will be determined
by surrounding devices.

Expressions:
A Cicode expression in the form of Device\Tag > Nominal Voltage (I.E., S1_B1_P1_
CM41\MMXU1\PhV\zavg > 120).

If the expression is TRUE, the ACTIVE color will be shown. The active color is
determined by the voltage level assigned.

If the expression is FALSE, the DE-ENERGIZED color will be shown.

Hard-Coded:
If no upstream devices are available (in the event of an incomer, for example), you
may have no other choice than to ‘hard code’ this field to a ‘1’. This forces the
busbar to always be ACTIVE.

What INI parameters should I use for debugging?
We recommend that you contact Technical Support before performing any debugging.

Parameter: [PowerLogicCore]
DebugCategory = All

DebugLevel = All (or Error)

LogFileArchive = Deprecated; no longer used. Use [Debug]SysLogArchive instead.

LogFileSize = Deprecated; no longer used. Use [Debug]SysLogSize instead.

Parameter Details:

DebugCategory defines which message categories to log. (See table below).
DebugLevel defines debug levels of messages to be logged. (See table below).
Debug Levels
The following debug levels are accepted by PowerLogic driver core library:

WARN: log all warning level messages

ERROR: log all error messages

TRACE: log all trace messages

DEBUG: log all debug messages

ALL: include all level messages

Debug Categories
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PowerLogic core library and drivers messages are grouped in categories. Each of
these categories can be enabled independently from others in any combination.

MISC: miscellaneous messages that do not all into any other category

ALARM: messages related to alarms, regarding collection and detection

WAVE: messages related to waveforms -- waveforms download, processing

REAL: messages related to real-time data collection

STATE: messages related to internal object-state changes

CORE: core events that do not fall into driver-specific logic

MODBUS: TCP/MODBUS messages

ENTRY: trace messages produced when driver API entry points are called

PORT: traces related to the port events

UNIT: traces related to specific unit events

WAVETOALARM: not used

DATAPOINT: debug messages related to data points

STATISTICS: enables driver statistics data output

COMMAND: messages related to commands

REPLICATION: messages produced by replication subsystem

ALL: enables all categories

Parameter: [Debug]
Menu = 1

Parameter Details:

The Menu parameter determines whether the Kernel option is displayed on the control
menu of the runtime menu. This can also be enabled using the Computer Setup Editor.

How do I tune my system for best performance?
There are several parameters that you can use to enhance your system's performance:

Driver-tuning parameters:
Parameter (Back Polling Rate): [SEPAM40]
CacheRefreshTime = 1000

InitUniCheckTime = 120

Retry = 3

Timeout = 1000

Parameter Details:
The CacheRefreshTime parameter controls the maximum rate at which the driver
will attempt to repopulate its cache. If the driver cannot refresh its cache within the
time period specified, it will collect data as fast as the network allows.

This back polling rate can be global to all devices or tuned up to a specific I/O
device.

The InitUniCheckTime parameter controls how long the driver will wait before
attempting to bring a device online after it has gone offline. This value can be
decreased to bring offline devices back into service in a shorter period of time. In a
multi-drop scenario, this time should be relatively long, to prevent init unit requests
from stalling communications to the rest of the devices on that port.
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The Retry parameter defines the number of retry attempts for specific MODBUS
requests. Retries will only occur in response to the MODBUS errors which are
defined below.

The Timeout parameter controls how long the driver will wait for a response from a
device before setting that device as offline. This value should be greater than the
device/gateway timeout period.

Parameter: [Device]
WatchTime = 5000

Parameter Details:
Device WatchTime is the frequency that PowerSCADA Expert checks devices for
history files and flushes logging data to disk.

Default: 5000

Range: 1000–3600000 milliseconds.

Miscellaneous Parameters

Parameter: [Kernel]
Task = 20000

Parameter Details:
Kernel Task is the number of tasks. Increasing the number of kernel tasks is used
when “Out of Kernel Task” message is received. The change will be likely for large
systems.

Default Value: 256

Range: 50–32767

Parameter: [Page]
ScanTime = 250

Parameter Details:
Page ScanTime determines how often the Animator refreshes a graphics page at
runtime.

Default: 250

Range: 1–60000 milliseconds

Parameter: [ALARM]
ScanTime = 500

Parameter Details:
Alarm ScanTime determines the rate at which alarms are scanned and processed.
Default: 500

Range: 0–60000 milliseconds

If a tag is configured, how is it polled in the device?
In other words, is a tag only polled on demand when it is requested by a client (for
example, when the operator displays a page with the tag on it)? Or are all configured
tags polled all of the time, with the relative polling rates/communications bandwidth
carefully managed?

The ModNet driver polls real-time tags on a user demand basis (when a user opens a
page with the tags on it). Therefore, the time to retrieve data will vary, depending not
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only on the communications bandwidth, but on the amount of data being requested.
This can vary significantly, depending on which pages are displayed by the operators
at any particular time.

The PWRMODBUS driver polls all configured tags; however, different types of tags can
be polled at different relative rates, and the available communications bandwidth is
carefully managed. This approach means that tag update rates are not subject to the
scalability issues associated with operator actions (as is the case for the ModNet
driver). It is also advantageous in that performance issues associated with
communications bandwidth or IODevice response times can be determined at
SAT/time of implementation and are not subject to significant change during operation.

The different tag types can be allocated relative importance in data requests,
expressed as a percentage. (See Bandwidth Allocation Parameters in Performance
Tuning Parameters on page 256.) Keep in mind that any unused bandwidth allocation
(from, for example, events retrieval) is made available for other data types to use. If the
event does not need the default 25% allocation, it will be made available to the other
parameters (real-time tag retrieval, etc). This potentially increases the update rate of
real-time tags.

Additionally, the real-time tag relative scan rate based on priority can be set to three
different levels. (See Tag Scan Rate Parameters in Performance Tuning Parameters
on page 256.) This means that, if some real-time tags are more important that others,
you can set their relative priorities. For example, configuration tags vs. important real-
time tags vs. normal real-time tags.

Device popup from a one-line: Why do the fields overlap?
This is controlled by a parameter entry:

Section: Page

Name: EquipDetailDescLength (the total number of characters in a single row of this
popup)

Default = 48. The problem will occur with a larger font or if the window is resized. The
default value of 48 can be changed or the window and associated genies can be
resized.

Can I change the %CLUSTER% name in the I/O Device Manager?
No. If you change the placeholder %CLUSTER% to any other name in the I/O Device
Manager, the system will be unable to find the actual cluster to which it refers.

A device can prevent writes to its registers: how do I ensure that writes
are successful?

PowerSCADA Expert cannot provide feedback about whether a write to a device
register is successful. If a device is capable is preventing (blocking) writes to its
registers (for example, Sepam), you need to verify that its “block” feature is not
enabled. Do this at the device.

NOTE: In Cicode, you can also use the tagwrite function in blocking mode, i.e., bSync
parameter = true; Check the return code: 0 = success, anything else = error. For more
information, see the Cicode Programming Reference help file.
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How do I prevent PowerSCADA Expert from accidentally making
invalid areas in memory available to reads and writes?

PowerSCADA Expert normally optimises its packets for greatest performance. This
optimisation can sometimes includes invalid areas of memory in devices. These invalid
areas can be specifically defined and excluded from optimisation packets created by
PowerSCADA Expert. See Advanced Tag Blocking Capabilities in Performance Tuning
Parameters on page 256 for more information.

How do I create an audit in the Event Log for user logins and logouts?
//LOGOUT

FUNCTION

PLSLoginUser()

//INT iPage = PageInfo(1);

INT iPage = WinNumber();

IF mbLoginFormShown[iPage] = TRUE THEN

RETURN; //form already shown

END

//prevent multiple forms

mbLoginFormShown[iPage] = TRUE;

IF (UserInfo(0) <> "0") THEN

// Confirm User Action

IF (0 = Message(StrToLocalText("@(Confirm)"), StrToLocalText("@
(Logout)"), 1+32)) THEN

PLSAlmDspEventAdd(0, 0, 1, "User Logout", Name(), "Logout", "");

Logout();

END

mbLoginFormShown[iPage] = FALSE;

RETURN;

END

IF (0 = LoginForm())

PLSAlmDspEventAdd(0, 0, 1, "User Login", Name(), "Login", "");

END

mbLoginFormShown[iPage] = FALSE;

END

Why am I seeing #COM for circuit breaker status in the genie status
page?

If this is a Micrologic P device, and it does not have a CCM, you will not be able to view
data referring to circuit breaker status, e.g. racked in/racked out. When there is no
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CCM, the device profile should not have tags that refer to the CCM.

Why can't I acquire waveforms in the waveform viewer?
The "acquire" feature (the "A" button on the waveform viewer) does not work in
PowerSCADA Expert. You can, however, view waveforms from device onboard
waveform files. To do this:
• At the device or in the meter configuration software, add the appropriate alarm, and

enable automatic capture of the waveform when the alarm occurs.
• In the Profile Editor (Create Device Profiles tab), check the Waveform box for the

alarm you added.
• When the alarm occurs, the waveform is captured. You can view the waveform in

the Alarm Log. You can also view alarms/waveforms from a drawing in the runtime
environment. Click the genie for the device; right-click the alarm to view the
waveform.

Note that, in very large systems, it could take as much as an hour for the waveform
to appear.

Why won't the Excel DBF Add-In toolbar install?
When you are installing the Excel DBF Add-In toolbar, you may see this error: "Error
1308. Source file not found....."

You can click "ignore" at this error, and the install will finish. The next time you open
Excel, the DBF toolbar will display.

What causes the "First dbf record" error message? How do I keep it
from happening?

The error message "First dbf record" tells you that a project is not found. This happens
when you add a project, and then rename it or delete it. Then, when you try to create a
new project, you see this error message.

To resolve this issue, simply shut down and then restart the PowerSCADA Studio.

Why is my device in comms loss?
When you bring your system on line, and you find that PowerSCADA Expert has lost
communications with a device, check the following:
• Verify that the physical correction is correct and secure.
• Verify the IP address.
• Verify the Modbus address.
• Check the statusRegister, statusRegistersCount, and statusRegisterType (see for

details)

How do I set up select before operate?
For systems in which you can determine that a single user is selecting a device prior to
sending an open/close command, you can add a "select before operate" button.

To do this:

1. Locate the Select Before Operate tag in the variable tags.
2. Append \str to the end of the tag name.
3. Change the data type to STRING.
4. Click Add.
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This creates the SBOw tag for the IEC 61850 advanced control screen. For more
information about advanced control, see:

Set Up IEC 61850 Advanced Control on page 116

Perform IEC 61850 Advanced Control on page 185
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symbol

creating 116

tag

deleting 52

deleting when associated with a device
type 52

editing 51

custom tag

adding 50

customer support contact information 26

customize tag names

sub-tab 69

customizing a project with Citect.ini 159

customizing tag names 69, 72

D

data concentrator

setup 66

data points

defining individually in an address 43

data replication parameter 267

datasets

adding/editing 62

DBF Add-In toolbar will not install 291, 304

deadbands 164

debugging

INI parameters to use 286, 299

define

device types and tags 41

enumeration 84

demand current summary 206

demand voltage summary 206

demo mode

using 219

design-time environment

described 109

device

adding to the PowerSCADA Expert project 118

name

requirements 281, 294

popup

overlapping fields 289, 302

profile

adding 70

creating 57

deleting 60

editing 60

removing from a PowerSCADA Expert pro-
ject 127

tags

defining 41

type

adding, editing, deleting 44

defining 41

deleting 46

editing 45

locking 35

unlocking 36

device communications issues

troubleshooting 281, 294

device profile

add as default 71
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device type

category/subcategory

adding 48

deleting 48

editing 48

composite 65

drivers

INI parameters 162

drivers and protocols

list of supported 18

name

limitations 44

Device Wizard

before you use it 117

devices

add via CSV file 129

devices in the PowerSCADA Expert project

editing 132

diagnostics (Application Conifguration Utility 221

Diagnostics page 225

disabling "tag not exist" prompt. 112

disk storage calculations 164, 179

display client

basic report viewing 188

display projects button

adding a project in the Profile Editor 71

DNP3-TCP device

adding 123

DNP3 protocol support 68

DNP3_serial

adding to PowerSCADA Expert project 120

documentation in this release 26

driver parameters

editing 19

selecting for a profile 66

setting up in the Profile Editor 60

drivers

choosing for device types 45

general PowerSCADA Expert 249

generic power device 18

how they work 18

subscription expirations 19

subscription types 18

duplicate devices

defined 19

E

EcoStruxure Web Services (EWS)

configuration 222

avoid timeouts 222

introduction 186

email

configure to send basic reports 191

sending reports 192

encryption

aes file for saving INI file to a different
computer 224

password 135, 138

energy readings 202

energy summary 202

engineering template

creating 37
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engineering units

adding 40

exceptions 39

adding from the Project tab 71

deleting 41

editing 41

multipliers and offsets 39-40

English.dbf

used in translation 120, 122, 124, 127

ENMPort

ini parameter 270

ENMServer

ini parameter 270

entering copy for translation 24, 119, 122, 124,
126

enumeration

defining 84

setting up alarm based on 155

status enumeration logic code 91

equipment column

alarms/events pages 172

equipment name

adding via I/O Device Manager 129

using when creating a one-line 112

equipment pop-up page 180

Equipment.Profiles

file storage location 74

viewing 70

errors

ATS 149

breaker 150

busbar 149

meter 151

sources 152

switch 149-150

transformer 153

errors and warnings

correcting in the graphics page 112

one-line 145

event filters 176

event log 173

acknowledge, silence, print 174

logging data to disk 174

problem with alarms not displaying 156

event notification serivce

Application Configuration Utility 222

events

historical logging 156

storage limitations 156

Example Automation.xls

using to export multiple devices 129

Excel DBFAdd-In toolbar will not install 291, 304

export

PowerSCADA Export 73

Profile Editor (backup) 74

project files from Profile Editor 72

SCL files 75

F

FAQs 279, 293

#COM error for circuit breaker status 290, 303

adding/removing devices in I/O Device Man-
ager 280, 293
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auditing user logins/logouts in the Event
Log 290, 303

browser navigation buttons do not work 285,
298

can I change %CLUSTER% name 289, 302

changing default pickup/dropout text 285, 298

creating and configuring busbars 285, 298

creating device profiles without PowerLogic
drivers 280, 293

creating users in Runtime 282, 295

device name requirements 281, 294

device type vs device profile 280, 293

device writing to its registers 289, 302

Excel DBF Add-In toolbar will not install 291,
304

How do I troubleshoot device communications
issues? 281, 294

how to use MODBUS communications
methods 281, 295

if tag is defined, is it polled 288, 301

INI parameters used for debugging 286, 299

managing categories and subcategories 280,
293

managing projects in PowerSCADA
Export 282, 295

naming conventions for servers/clusters 282,
295

overlapping fields in device popup 289, 302

performance tuning parameters 287, 300

preventing reads/writes to invalid ares of
memory 290, 303

synchronize new PC with master PC 280, 293

what are genies 283, 296

what can be set up in logging and
archiving 285, 298

what can I modify during runtime? 285, 298

working with templates 284, 297

FileFormat parameter

historical logging of alarms and events 157

filter

import data 79-80

filter genie states 145, 175

filter the alarm and event logs 176

filters

real time and alarm 51

firewall ports

opening for runtime 169

First dbf record

error 291, 304

force edit 81

format codes

alarm definitions 86

control definitions 86

custom control 87

definitions 85

predefined control 87

real-time definitions 85

reset 87

frm file

associated with new genie 284, 297

FRM file

formatting genie appearance 115-116

functional address 43, 71

definition 275

edit 49

functional constraints

IEC 61850 77

7EN02-0403-00 Index
03/2017

313 © 1990–2017 Schneider Electric All Rights Reserved



fundamental phasor readings 203

G

G3200 setup 67

generic I/O points

assigning tags 46

generic MODBUS drivers

included in system 18

genie

adding to a drawing 111

auto assign 144, 147

auto configure 144, 147

busbar 140

configuration

viewing 144

creating and editing 115

grouping 145

icon 111

in Graphics page 283, 296

libraries

ITEM1 247

PLS_ALARM 239

PLS_ANSI_BASE_1 / PLS_ANSI_BASE_
2 239

PLS_ANSI_CB_1 / PLS_ANSI_CB_2 241

PLS_ANSI_SW_1 / PLS_ANSI_SW_2 242

PLS_DISPLAY 242

PLS_GEN_BASE_1 / PLS_GEN_BASE_
2 243

PLS_GEN_CMD_1 / PLS_GEN_CMD_
2 244

PLS_GEN_EQ_1 / PLS_GEN_EQ_2 244

PLS_IEC_BASE_1 / PLS_IEC_BASE_
2 245

PLS_IEC_CB_1 / PLS_IEC_CB_2 245

PLS_IEC_SW_1 / PLS_IEC_SW_2 246

PLS_METER 246

meter 141

repairing 147

resizing 141

source 142

state filters 145

switch/circuit breaker 141

transformer 142

genie color

changing in project pages 111

GenieDefinitions.xml file

one-line 143

genies

PowerSCADA Expert 139

GetProviderResult

PLSProviders.ci 160

GetProviderStatus

PLSProviders.ci 160

getting more information 26

graphics library parameters 268

graphics page

adding in PowerSCADA Export 110

setting as startup page 111

Graphics runtime environment

editing appearance 114

group by type or page 145

guest user

single sign on 235
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H

harmonic apparent power flows 204

harmonic reactive power flows 205

harmonic real power flows 206

help files 26

historical parameters of alarms

setup 156

historical trends

viewing 179

viewing from a one-line 182

HostName

ini parameter 269

I

I/O Device Manager

adding a device 117

adding a device to a project 118

before you use it 117

editing device information in a PowerSCADA
Expert project 132

removing device 127

I/O Diagnostics 225

ICD file

editing 75

icons

locked and custom 35

IEC

import filter for ICD files 77

IEC 61850

adding device to PLS project 125

advanced control setup 116

datasets

adding/editing 62

functional constraints 77

general workflow 25

perform advanced control 185

re-match 80

report control blocks 77

adding/editing 63

tag construction 83

tags

logic codes described 87

IED

defined 275

IF logic

Live View 213

IFE parameter 266

IFM parameter 266

ignored devices and topics 164

IID

defined 275

import

files into Profile Editor 76

filter data 79

ignore 81

match option 81

project files into Profile Editor 72

removing import templates 82

SCL files 77

set to unmatched 81

template

applying 76
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using 81

import filter

IEC 61850 files 77

import Import reconciliation screen 78

incremental reactive energy summary 204

incremental real energy summary 204

INI parameters 248

for historical reports 188

for supported device type drivers 162

to use in debugging 286, 299

instant trend

pens stop updating 180

viewing 180

interlock check

IEC 61850 devices 185

internationalization

real-time tables 216

Internet Explorer 9 emulation

reporting 188

intervals

trend tags 66

invalid or missing tag address

correction 42

Is Device Tag

reporting for composite devices 59

J

JBus

adding 18, 45

L

launchiing the profile editor 35

LiveView

basic readings summary 201

conditional formulas 213

create menu item 210

create new template 211

data format 212

delete 216

demand current summary 206

demand voltage summary 206

does not launch (Matrikon Explorer) 201

duplicate 215

edit predefined template 210

energy readings 202

energy summary 202

formatting 211

formulas 213

fundamental phasor readings 203

harmonic apparent power flows 204

harmonic reactive power flows 205

harmonic real power flows 206

incremental reactive energy summary 204

incremental real energy summary 204

internationalization 216

introduction 200

lock setup 209

minimum/maximum readings 214

modify 215

placeholders 208, 212

power flow summary 202

save a template 210

save a view 208
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setup 209

tables list 201

templates 207

THD current summary 203

THD voltage summary 203

thresholds 214

update device list 208

update intervals 208

update list 208

update now 209

uptime summary 204

URL link to launch 207

view area 210

viewer window 207

views 208

Where's my device? 209

LiveView Template Editor 200

locked device type

cannot delete 46

unlocking 36

locked icon 35

locking a device type 35

lockout/tagout 171

enable 113

logging level 221

logic codes

definitions 87

M

main menu options 36

manuals 26

Matrikon

LiveView and reporting do not launch 187, 201

memory device

one-lines 136

menu

main options 36

Menu Configuration 113-115

used to edit Graphics page menu
information 114

metadatafields.xml

use to edit alarm filters 177

meter

configuring 141

errors 151

information 151

Micrologic

genie in Graphics Builder 246

MicrologicV INI settings 267

MicrologicType

parameter 266

migration utility 27

MODBUS communications methods 281, 295

multi-device reports 197

multiple monitor support 219

N

naming ports 24

navigation arrows

runtime environment 170

NetworkTagsDev I/O device

adding 22
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normally closed

control tags 43

O

onboard alarm tag

adding 157

onboard alarms 155

one-line

adding to a graphics page 111

coloring 137

communication errors 146

PowerSCADA Expert

described 135

repairing 147

one-line animation file locations 136

One-Line Configuration Utility 144

one-line device 136

one-line engine

configuration 224

one-line flowchart 134

one-line memory device 136

one-time password 226

log in 234

opening firewall ports for runtime 169

optional parameters

CSV 131

OriginalName

CSV file 132

override

tag name 59, 65

override tag status 183

P

pack

using to delete data 117

Pagemenu.dbf

editing 114

parameter

Sepam device driver configuration settings 265

parameters

advanced tag block capabilities 259

alarm and event state 268

AlarmFormat 177, 179

AlarmSummaryLength 156

AlarmUseConfigLimits 155

Bandwidth Allocation (port level) 256

BandwidthAllocation (device level) 257

cacheRefreshTime 252

CCM (Micrologic) 266

Citect INI 248

ClientAutoLoginMode

used to set up Windows integrated
user 238

CommandsBandwidth 256

data replication 267

database described 248

driver

editing 19

selecting for a profile 66

enableScatteredReads 257

EventBandwidth 256

EventIdle 265

EventTable 265
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general PowerSCADA Expert drivers 249

graphics library 268

HighScanRate 259

IFE (Micrologic) 266

IFE/IFM (Micrologic) 266

IFM (Micrologic) 266

initCacheTimeout 252

initUnitCheckTime 252

kernelStatisticUpdateRate 249

LowScanRate 259

maxBlockSize 258

Micrologic 266

MicrologicType 266

MicrologicV INI settings 267

minBlockSize 258

ModbusBase 254

module-specific packet blocking optimisation
settings 266

packet blocking optimization 257

percentBlockFill 257

performance tuning 256, 287, 300

RegMode 254

retry 250

retryexception 250

retrytimeout 250

security 256

Sepam Event Reading 265

standbyCheckTime 251

standbyRefreshRate 251

statusRegister 253

statusregistertype 254

statusUnitCheckTime 251

Tag Scan Rate 259

time synchronization 163

time zone settings 162

TimeBandwidth 256

timeout 250

TimeSync 253

timeZone 255

usewritemultiregistersonly 249

watchtime 249

waveform 263

WaveformBandwidth 256

WaveformCheckTime 264

WaveformMatchMargin 264

WaveformsDisable 264

WaveformZone 264

Parameters file

changing 106

password

one-time 226

password encryption 135, 138

pc-based alarms 154

setting up 59

performance tuning parameters 256, 287, 300

pickup/dropout text

changing for alarms 285, 298

platform refresh 161

LiveView 209

reporting 196

PLS export 73

PLS_ClearCache 161
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PLS_Example project 109

PLS_PLatformRefresh 162

PLS_ReportDsp()

Cicode function

used in report configuration 187

PLS_ReportPage

used in report definition 187

PLSAnimBusbar()

Cicode function for custom genie
animation 116

PLSProviders.ci module 159

PM5000

device profiles for the I/O Device Manager 119,
121

PM5000S 119, 121

PM5000S1 119, 122

PMCU

adding onboard alarms and waveform
captures 156

defined 276

polling rules for tags 288, 301

port renaming

serial 120

ports

naming 24

renaming

serial 122

TCP 120, 125

power flow summary 202

PowerSCADA Expert

backup 158

described 17

naming conventions 282, 295

project

creating 109

uninstall and reinstall 25

PowerSCADA Expert one-lines

described 135

error logging 146

genie introduction 139

GenieDefinitions.xml file 143

introduction 144

SupportedGenies.xml file 143

predefined control format codes 87

predefined project

PLS_Example 109

printing

CSV file 47

printing the alarm log 174

privileges

user

PowerSCADA Expert 236

PrivLevel

ini parameter 269

profile editor

export 74

launching 35

overview 31

Profile Editor

importing files into 76

Profile Editor.exe.config

using to change trend tag scan intervals 164
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profiles

adding, editing, deleting 59

enabling waveforms 57

file storage location 74

name limitations 59

viewing 57

project

adding 70

cannot add 291, 304

creating in PowerSCADA Expert database 73

deleting 72

editing 71

exporting (to PowerSCADA Studio from Profile
Editor) 73

managing in PowerSCADA Expert 282, 295

name limitations 71

problems when renaming in PowerSCADA Stu-
dio 109

reusing 109

setting up 68

project parameters

sub-tab 69

using to add information for imports 69

Project Parameters sub-tab 72

project setup

introduction 19, 99

project XML files

storage location 74

PSEHostName

ini parameter for SSO 269

PSEHostPort

ini parameter 270

Q

Quantum PLC

genie in Graphics Builder 247

time-stamped events 271

R

rack position

displaying incorrectly 141

Rapid Access Label

configure the report 189

create and use 217

label stock 218

view LiveView tables 207

re-match IEC 61850 items 80

read logic codes 87

read/write logic codes 97

real-time format codes definitions 85

real-time lists

viewing from genies 183

redundant I/O servers

cluster setup 22

refreshing tags in the Project tab 70, 73

repair

one lines 147

project 145

upgrade project 145

report configuration

saving 189

report control blocks

IEC 61850 77

reporting basic

application tasks 188
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ReportMailer utility

sending email reports 192

reports

adding to runtime menu 187

basic

accessing, creating, modifying,
removing 189

configure email to send 191

editing appearance 195

export 195

exporting, printing, saving 194

localization 200

set up a display client for report
viewing 188

set up delivery method and email
address 225

URL routing 199

do not launch (Matrikon Explorer) 187

enable Windows Authentication 198

feature described 187

INI parameters 188

introduction 195

multi device usage 197

PLS_ReportDsp() 187

PLS_ReportPage 187

sending via email 192

setting up in the runtime menu 187

single device usage 196

SMTP server and from address 191

tabular 197

trend 198

using ReportMailer 192

reserved names

do not use in projects 277

reset format codes 87

resets

adding custom 54

how they operate 43, 55

restart services 220

restore

project file 158

resx files

localization 200

reusing a project file 74, 109

roles

adding for access to LiveView 217

adding user 237

link to users in Project Setup 102

link users in Project Setup 102

RPC

set to TRUE for YubiKey 228, 235

runtime environment

described 18

launching and closing 169

viewing 170

S

SBOw tag

creating 291, 304

SCADA

defined 16

scan intervals

trend tags 163
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scattered reads

using enableScatteredReads parameter 257

SCL

defined 278

export 75

SCL files

importing 77

screen resolution

Profile Editor 36

security parameters 256

security viewer 178

filter 178

select before operate

setup 291, 304

Select Devices

LiveView 208

Selected Device Profiles

sub-tab 69

selecting 39

Sepam

genie in Graphics Builder 247

Sepam device driver configuration settings 265

sequence of events

alarm/event logs 176

SER (sequence of events recorder) 18, 65, 176-
177

serial device

adding to PowerSCADA Expert project 120

servers/clusters

naming conventions 282, 295

service inventory 221

setpoints and delays

entering 155

entering from the runtime environment 182

setting up

alarm based on an enumeration 155

audible alarms 157

device type categories 47

normally closed/normally open controls 43

severity

changing for alarms 156

show by type or page 145

sim source

transformer top and bottom 153

single device reports 196

single sign on 235

guest user 235

SMTP server

for reports 191

sorting the alarm log 58, 172-173

source

configuring 142

errors 152

information 151

start and stop AdvOneLine 139

startup page

setting 111

state filters 145

storage limitations

calculating disk space 164, 179

subscriptions

drivers 18
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support

technical 26

SupportedGenies.xml file

PowerSCADA Expert one-lines 143

switch

configuring 141

errors 150

information 148, 150

symbol

creating custom for custom genie 116

synchro check

IEC 61850 devices 185

set up

IEC 61850 116

synchronize new PC with master PC 280, 293

T

tabular usage reports 197

tag

custom

adding 50

customizing the name 69

IEC 61850 described 83

refreshing in the Project tab 70

tag-polling rules 288, 301

tag addresses

adding 56

control 55

correcting missing or invalid 42

editing 52, 56

generic 56

onboard alarm 53

real-time 52

reset 54

tag count

driver subscriptions 18

tag definitions

printing the CSV file 47

tag names

customizing 72

tag override 59, 65

tag status

overriding 183

tag types 83

tag viewer

setup 158

viewing 184

tags

assigning to generic I/O points 46

scanning intervals for trend tags 66

TCP device

adding to PowerSCADA Expert project 120,
125, 127

adding to project 118

technical support 26

Template Editor

LiveView 200

lock 209

templates

creating 37

deleting 39

imports 81

working with 284, 297
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THD current summary 203

THD voltage summary 203

time-stamped events

Quantum PLC 271

time quality

alarm/event logs 176

Time Sync

filter for alarm or event log 177

time synchronization parameter 163

time zone setting parameter 162

transfer switch

configuring 140

transformer

configuring 142

errors 153

information 152

top and bottom 153

voltage-level and pass-through 137, 143, 153

translation

using description fields 24

trend tag intervals 179

changing in the Profile Editor 61

trend tag scan intervals 66, 163

trend usage reports 198

trending (Analysis Page)

described 179-180

trends

maximum number of pens 179

setting up in Profile Editor 59, 61

viewing from within a one-line 182

two-factor authentication 226

typical workflow

creating a graphics page 108

creating a project in Profile Editor 69

Profile Editor 31

U

uninstalling and reinstalling PowerSCADA
Expert 25

unique ID

determining for onboard alarms 54, 157

units (engineering) and conversions

creating or editing a units template 37, 39

deleting 41

deleting a unit template 39

editing 41

exceptions 39

uptime summary 204

URCB

entering for IEC 61850 device 127

URL

visit to send reports via email 192

URL link

launch Live View Viewer 207

URL reporting for basic reports 199

UseHTTPS

ini parameter 270

UsePLSFilter

alarm/event filter parameter 176, 255

user access

adding and modifying 236

changing rights 238

Windows integrated 237
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useraccess

default settings 236

users

add in Project Setup 102

creating in Runtime environment 282, 295

using block writes 98

V

value type

controlling real-time display 181

Variable tags not found

disabling the prompt 112

W

waveform

why can't Iacquire? 291, 304

waveform parameters 263

waveforms

enabling in Create Device Profiles tab 57, 70

enabling onboard 156

linking to alarms 166

management 166

special digital tags 167

storage rules 166

viewing from the Alarm Log 174

viewing from the runtime environment 173

viewing in the runtime environment 182

WaveWeb waveform viewer 174

PDF location 182

web.config

securing a URL for sending reports via
email 192

SMTP server used when sending email 191

specify Windows Authentication, adding roles
for LiveView 217

specify Windows Authentication, adding roles
for Reporting 199

specifyWindows Authentication, adding roles
for Live View 217

WebReachServer

ini parameter 269

Where's my device? 209

Windows Authentication

enable for Live View 216

enable for reports 198

in Project Setup 103

Windows integrated user accounts 237

Windows security

using to remove user access rights 236

write logic codes 97

writes (logic codes) 97

X

XML files

storage for project files 74

Y

YubiKey 228

add the Citect parameter 228

disable 234

import and import password settings 233

programming 230

Z

zOL

memory device for one-lines 136
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